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Filter Implementation and Analysis
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In this section...

“Filtering Overview” on page 1-2

“Convolution and Filtering” on page 1-2
“Filters and Transfer Functions” on page 1-3
“Filtering with the filter Function” on page 1-4

Filtering Overview

This section describes how to filter discrete signals using the MATLAB® filter function
and other Signal Processing Toolbox functions. It also discusses how to use the toolbox
functions to analyze filter characteristics, including impulse response, magnitude and
phase response, group delay, and zero-pole locations.

Convolution and Filtering

The mathematical foundation of filtering is convolution. The MATLAB conv function
performs standard one-dimensional convolution, convolving one vector with another:

conv([l 1 1],[1 1 11)
ans =
1 2 3 2 1

Note Convolve rectangular matrices for two-dimensional signal processing using the
conv? function.

A digital filter's output y(k) is related to its input x(k) by convolution with its impulse
response h(k).

k=Y hOxtk-0)

[=—c0

If a digital filter's impulse response h(k) is finite in length, and the input x(k) is also of
finite length, you can implement the filter using conv. Store x(k) in a vector x, h(k) in a
vector h, and convolve the two:
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X = randn(5,1); % A random vector of length 5
h=1[11111/4; % Length 4 averaging filter
y = conv(h,x);

The length of the output is the sum of the finite-length input vectors minus 1.

Filters and Transfer Functions

In general, the z-transform Y(2) of a discrete-time filter's output y(n) is related to the z-
transform X(2) of the input by

1 -n
Y(2) = H2)X(2) = b1)+b62)z " +...+bn+1)z X(2)

aD+a@zt+. . +am+1z™

where H(2) is the filter's transfer function. Here, the constants b(i) and a(i) are the filter
coefficients and the order of the filter is the maximum of n and m.

Note The filter coefficients start with subscript 1, rather than 0. This reflects the
standard indexing scheme used for MATLAB vectors.

MATLARB filter functions store the coefficients in two vectors, one for the numerator and
one for the denominator. By convention, it uses row vectors for filter coefficients.

Filter Coefficients and Filter Names

Many standard names for filters reflect the number of a and b coefficients present:
* When n = 0 (that is, b is a scalar), the filter is an Infinite Impulse Response (IIR), all-
pole, recursive, or autoregressive (AR) filter.

* When m = 0 (that is, a is a scalar), the filter is a Finite Impulse Response (FIR), all-
Zero, nonrecursive, or moving-average (MA) filter.

* Ifboth n and m are greater than zero, the filter is an IIR, pole-zero, recursive, or
autoregressive moving-average (ARMA) filter.

The acronyms AR, MA, and ARMA are usually applied to filters associated with filtered
stochastic processes.

1-3
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Filtering with the filter Function

It is simple to work back to a difference equation from the Z-transform relation shown
earlier. Assume that a(1) = 1. Move the denominator to the left side and take the inverse
Z-transform.

y(B)+a@)yk—1)+...+alm +1)y(k—m)=b(1)xk)+b(2)x(k—1)+...+ Bn+1)x(k — n)

In terms of current and past inputs, and past outputs, y(k) is

y(k) =bQ)x(k) +b2x(k -1 +...+bn+)x(k—n)—a@)y(k-1)—...—am +1)y(k—m)

This is the standard time-domain representation of a digital filter, computed starting with
y(1) and assuming a causal system with zero initial conditions. This representation's
progression is

¥(1) = b(1)x(1)
¥(2) =oDx(2) +b(2)x(1) - a(2)y(1)
¥(3) = b(1)x(3) + b(2)x(2) + b(3)x(1) — a(2) y(2) —a(3)y(1)

A filter in this form is easy to implement with the filter function. For example, a simple
single-pole filter (lowpass) is

B
A

Numerator
Denominator

1;
[1 -0.9];

[)
i)
[)

i)

where the vectors B and A represent the coefficients of a filter in transfer function form.
Note that the A coefficient vectors are written as if the output and input terms are
separated in the difference equation. For the example, the previous coefficient vectors
represent a linear constant-coefficient difference equation of

y(n) —0.9y(n—-1) =x(n)
Changing the sign of the A(2) coefficient, results in the difference equation

y(n) +0.9y(n-1) = x(n)

The previous coefficients are represented as:



Filter Implementation and Analysis

B
A

1; %Numerator
[1 0.9]; %Denominator

and results in a highpass filter.
To apply this filter to your data, use
y = filter(B,A,x);

filter gives you as many output samples as there are input samples, that is, the length
of y is the same as the length of x. If the first element of a is not 1, filter divides the
coefficients by a(1) before implementing the difference equation.
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The filter Function

1-6

filter is implemented as the transposed direct-form II structure, where n-1 is the filter
order. This is a canonical form that has the minimum number of delay elements.

xlm]

bin b3 b2 Hli

:-J. - ... :'J- EH— :'J- :.'lm]

Ipo) zalm) zplm

—ain —al3) —al2]

At sample m, filter computes the difference equations

y(m) =bD)x(m) +2z (m -1
b(2)x(m) + zg(m 1) —a(2)y(m)

z1(m)

2,_9(m)=b(n-1Dx(m) + 2z, ;(m -1 -an-1)y(m)
2p_1(m) = b(n)x(m) —a(n)y(m)

In its most basic form, filter initializes the delay outputs 2i(1),i = 1, ..., n-1 to 0. This is
equivalent to assuming both past inputs and outputs are zero. Set the initial delay outputs
using a fourth input parameter to filter, or access the final delay outputs using a
second output parameter:

[y,zf] = filter(b,a,x,zi)

Access to initial and final conditions is useful for filtering data in sections, especially if
memory limitations are a consideration. Suppose you have collected data in two segments
of 5000 points each:

x1
X2

randn(5000,1); % Generate two random data sequences.
randn(5000,1);

Perhaps the first sequence, x1, corresponds to the first 10 minutes of data and the
second, X2, to an additional 10 minutes. The whole sequence is x = [x1;x2]. If there is
not sufficient memory to hold the combined sequence, filter the subsequences x1 and x2
one at a time. To ensure continuity of the filtered sequences, use the final conditions from
x1 as initial conditions to filter x2:



The filter Function

[yl,zf] = filter(b,a,x1);
y2 = filter(b,a,x2,zf);

The filtic function generates initial conditions for filter. filtic computes the delay
vector to make the behavior of the filter reflect past inputs and outputs that you specify.
To obtain the same output delay values zf as above using filtic, use

zf = filtic(b,a,flipud(yl),flipud(x1));

This can be useful when filtering short data sequences, as appropriate initial conditions
help reduce transient startup effects.
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Multirate Filter Bank Implementation

1-8

The upfirdn function alters the sampling rate of a signal by an integer ratio P/Q. It
computes the result of a cascade of three systems that performs the following tasks:
» Upsampling (zero insertion) by integer factor p

* Filtering by FIR filter h

* Downsampling by integer factor q

. | P X |Q L— w

For example, to change the sample rate of a signal from 44.1 kHz to 48 kHz, we first find
the smallest integer conversion ratio p/g. Set

d = gcd(48000,44100);
p = 48000/d;
q = 44100/d;

In this example, p = 160 and q = 147. Sample rate conversion is then accomplished by
typing

y = upfirdn(x,h,p,q)

This cascade of operations is implemented in an efficient manner using polyphase
filtering techniques, and it is a central concept of multirate filtering. Note that the quality
of the resampling result relies on the quality of the FIR filter h.

Filter banks may be implemented using upfirdn by allowing the filter h to be a matrix,
with one FIR filter per column. A signal vector is passed independently through each FIR
filter, resulting in a matrix of output signals.

Other functions that perform multirate filtering (with fixed filter) include resample,
interp, and decimate.
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Frequency Domain Filter Implementation

Duality between the time domain and the frequency domain makes it possible to perform
any operation in either domain. Usually one domain or the other is more convenient for a
particular operation, but you can always accomplish a given operation in either domain.

To implement general IIR filtering in the frequency domain, multiply the discrete Fourier
transform (DFT) of the input sequence with the quotient of the DFT of the filter:

n
y

length(x);
ifft(fft(x).*fft(b,n)./fft(a,n));

This computes results that are identical to filter, but with different startup transients
(edge effects). For long sequences, this computation is very inefficient because of the
large zero-padded FFT operations on the filter coefficients, and because the FFT
algorithm becomes less efficient as the number of points n increases.

For FIR filters, however, it is possible to break longer sequences into shorter,
computationally efficient FFT lengths. The function

y = fftfilt(b,x)

uses the overlap add method to filter a long sequence with multiple medium-length FFTs.
Its output is equivalent to filter(b,1,x).

1-9
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Anti-Causal, Zero-Phase Filter Implementation

1-10

In the case of FIR filters, it is possible to design linear phase filters that, when applied to
data (using filter or conv), simply delay the output by a fixed number of samples. For
IIR filters, however, the phase distortion is usually highly nonlinear. The filtfilt
function uses the information in the signal at points before and after the current point, in
essence "looking into the future," to eliminate phase distortion.

To see how filtfilt does this, recall that if the Z-transform of a real sequence *'#/ is

X1z} then the Z-transform of the time-reversed sequence *' =" is X(1/2! Consider the
following processing scheme:

Xiz)—aw H(z) ] T L gl ) el TS L e xiH(1H)

X1 (=) X1/ H1/z) X(1=H =1 H )

. . .7
When 2 = ! thatis 2=¢" the output reduces to Xie™) H{e™) Given all the

samples of the sequence '/, a doubly filtered version of * that has zero-phase
distortion is possible.

For example, a 1-second duration signal sampled at 100 Hz, composed of two sinusoidal
components at 3 Hz and 40 Hz, is

= 100;
0:1/fs:1;

fs
t
X = sin(2*pi*t*3)+.25*sin(2*pi*t*40);

Now create a 10-point averaging FIR filter. Filter x using both filter and filtfilt for
comparison:
b = ones(1,10)/10;

y = filtfilt(b,1,x);
yy = filter(b,1,x);

plot(t,x,t,y,t,yy)
legend('Original', 'Noncausal filtering', 'Normal filtering')



Anti-Causal, Zero-Phase Filter Implementation

1.5 T T T T T T T T T
Original
Moncausal filtering

Marmal filtering 4

Both filtered versions eliminate the 40 Hz sinusoid evident in the original, solid line. The
plot also shows how filter and filtfilt differ; the dashed (filtfilt) line is in
phase with the original 3 Hz sinusoid, while the dotted (filter) line is delayed by about
five samples. Also, the amplitude of the dashed line is smaller due to the magnitude
squared effects of filtfilt.

filtfilt reduces filter startup transients by carefully choosing initial conditions, and by
prepending onto the input sequence a short, reflected piece of the input sequence. For
best results, make sure the sequence you are filtering has length at least three times the
filter order and tapers to zero on both edges.
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See Also
conv | filter | filtfilt
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Impulse Response

The impulse response of a digital filter is the output arising from the unit impulse
sequence defined as

T I, n=10,
ARl =2 ——=
" {E}. 0.

You can generate an impulse sequence a number of ways; one straightforward way is
imp = [1; zeros(49,1)];
The impulse response of the simple filter with # =1 and ¢ = [1-09] i hln) = 09"
which decays exponentially.

b
a

1;
[1 -0.9];

h filter(b,a,imp);

stem(0:49,h)
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A simple way to display the impulse response is with the Filter Visualization Tool,
fvtool.

fvtool(b,a)
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T-, on the toolbar, select Analysis > Impulse

Response from the menu, or type the following code to obtain the exponential decay of
the single-pole system.

fvtool(b,a, 'Analysis', 'impulse')
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Amplitude
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Frequency Response

Frequency Response

In this section...

“Digital Domain” on page 1-17
“Analog Domain” on page 1-24

Digital Domain

freqz uses an FFT-based algorithm to calculate the Z-transform frequency response of a
digital filter. Specifically, the statement

[h,w] = freqz(b,a,p)
returns the p-point complex frequency response, H(e'), of the digital filter.

B(1)+b(2)e /P + ...+ b(n + e IO

H(e'?) = : .
a)+a@)e 7? +...+ alm+ De /o™

In its simplest form, freqz accepts the filter coefficient vectors b and a, and an integer p
specifying the number of points at which to calculate the frequency response. freqz
returns the complex frequency response in vector h, and the actual frequency points in
vector w in rad/s.

freqz can accept other parameters, such as a sampling frequency or a vector of arbitrary
frequency points. The example below finds the 256-point frequency response for a 12th-
order Chebyshev Type I filter. The call to freqz specifies a sampling frequency fs of

1000 Hz:
[b,a] = chebyl1(12,0.5,200/500);
[h,f] = freqz(b,a,256,1000);

Because the parameter list includes a sampling frequency, freqz returns a vector f that
contains the 256 frequency points between 0 and fs/2 used in the frequency response
calculation.

Note This toolbox uses the convention that unit frequency is the Nyquist frequency,
defined as half the sampling frequency. The cutoff frequency parameter for all basic filter
design functions is normalized by the Nyquist frequency. For a system with a 1000 Hz
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sampling frequency, for example, 300 Hz is 300/500 = 0.6. To convert normalized
frequency to angular frequency around the unit circle, multiply by . To convert
normalized frequency back to hertz, multiply by half the sample frequency.

If you call freqz with no output arguments, it plots both magnitude versus frequency and
phase versus frequency. For example, a ninth-order Butterworth lowpass filter with a
cutoff frequency of 400 Hz, based on a 2000 Hz sampling frequency, is

[b,a] = butter(9,400/1000);

To calculate the 256-point complex frequency response for this filter, and plot the
magnitude and phase with freqz, use

freqz(b,a,256,2000)

B Figure 1 =@ = |

File Edit View Insert Tools Desktop Window Help E

UEde | | AR RL-2(0E ad

_SDD 1 1 1 1 1 1 1
1] 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

MNormalized Frequency (< rad/sample)

Phase (degrees)
I

_1DDD 1 1 1 1 1 1 1
o 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.2 1

MNormalized Frequency (= rad/sample)

fregz can also accept a vector of arbitrary frequency points for use in the frequency
response calculation. For example,
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w
h

linspace(0,pi);
fregz(b,a,w);

calculates the complex frequency response at the frequency points in w for the filter
defined by vectors b and a. The frequency points can range from 0 to 2m. To specify a
frequency vector that ranges from zero to your sampling frequency, include both the
frequency vector and the sampling frequency value in the parameter list.

These examples show how to compute and display digital frequency responses.
Frequency Response from Transfer Function

Compute and display the magnitude response of the third-order IIR lowpass filter
described by the following transfer function:

Hiz) = 005634(1 +z71)(1 — 1.0166z"' +z7%)
= 0683711 — 1446127 + 0795772

Express the numerator and denominator as polynomial convolutions. Find the frequency
response at 2001 points spanning the complete unit circle.

b0 = 0.05634;

bl = [1 1];

b2 = [1 -1.0166 1];

al = [1 -0.683];

a2 = [1 -1.4461 0.7957];
b bO*conv(bl,b2);

a conv(al,a2);

[h,w] = freqz(b,a, 'whole',2001);
Plot the magnitude response expressed in decibels.

plot(w/pi,20*1ogl0(abs(h)))

ax = gca;

ax.YLim = [-100 20];

ax.XTick = 0:.5:2;

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Magnitude (dB)"')
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Frequency Response of an FIR Bandpass Filter

Design an FIR bandpass filter with passband between 0.357 gpq 0-8x rad/sample and 3

dB of ripple. The first stopband goes from 0 to O.1x rad/sample and has an attenuation of

40 dB. The second stopband goes from 0.9 rad/sample to the Nyquist frequency and has
an attenuation of 30 dB. Compute the frequency response. Plot its magnitude in both

linear units and decibels. Highlight the passband.

sfl = 0.1;
pfl = 0.35;
pf2 = 0.8;
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sf2 = 0.9;
pb = linspace(pfl,pf2,1e3)*pi;

bp = designfilt('bandpassfir’,
'StopbandAttenuationl', 40, 'StopbandFrequencyl’',sfl,...
'PassbandFrequencyl',pfl, 'PassbandRipple’, 3, 'PassbandFrequency2',pf2,
'StopbandFrequency2',sf2, 'StopbandAttenuation2',30);

freqz(bp,1024);

[h,w] =
= freqz(bp,pb);

hpb

subplot(2,1,1)
plot(w/pi,abs(h),pb/pi,abs(hpb),"'.-")

axis([0 1 -1 2])
legend('Response', 'Passband', 'Location', 'South")
ylabel('Magnitude")

subplot(2,1,2)

plot(w/pi,db(h),pb/pi,db(hpb),"'.-")

axis([0 1 -60 10])

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Magnitude (dB)"')
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Magnitude Response of a Highpass Filter

Design a 3rd-order highpass Butterworth filter having a normalized 3-dB frequency of

0.5 rad/sample. Compute its frequency response. Express the magnitude response in
decibels and plot it.

[b,al] = butter(3,0.5,"'high");
[h,w] = freqz(b,a);
dB = mag2db(abs(h));

plot(w/pi,dB)
xlabel('\omega / \pi')
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ylabel('Magnitude (dB)")
ylim([-82 5])
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én A o R
o o _ o

&
=]

=80 i I I I
0.1 0.2 0.3 0.4 0.5 0.6 0.7

L/ JII Fll

Repeat the computation using fvtool.

fvtool(b,a)
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Analog Domain

fregs evaluates frequency response for an analog filter defined by two input coefficient
vectors, b and a. Its operation is similar to that of freqz; you can specify a number of
frequency points to use, supply a vector of arbitrary frequency points, and plot the
magnitude and phase response of the filter. This example shows how to compute and
display analog frequency responses.
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Comparison of Analog IIR Lowpass Filters

Design a bth-order analog Butterworth lowpass filter with a cutoff frequency of 2 GHz.

Multiply by 2 o convert the frequency to radians per second. Compute the frequency
response of the filter at 4096 points.

n 5;

f = 2e9;

[zb,pb,kb] = butter(n,2*pi*f,'s");
[bb,ab] zp2tf(zb,pb,kb);

[hb,wb] freqs(bb,ab,4096);

Design a bth-order Chebyshev Type I filter with the same edge frequency and 3 dB of
passband ripple. Compute its frequency response.

[z1,pl,k1l] = chebyl(n,3,2*pi*f,'s");
[bl,al] = zp2tf(zl,pl,kl);
[h1,wl] = freqs(bl,al,4096);

Design a bth-order Chebyshev Type II filter with the same edge frequency and 30 dB of
stopband attenuation. Compute its frequency response.

[z2,p2,k2] = cheby2(n,30,2*pi*f,'s");
[b2,a2] = zp2tf(z2,p2,k2);
[h2,w2] = freqs(b2,a2,4096);

Design a Sth-order elliptic filter with the same edge frequency, 3 dB of passband ripple,
and 30 dB of stopband attenuation. Compute its frequency response.

[ze,pe,ke] = ellip(n,3,30,2*¥pi*f,'s");
[be,ae] zp2tf(ze,pe,ke);
[he,we] freqs(be,ae,4096);

Plot the attenuation in decibels. Express the frequency in gigahertz. Compare the filters.

plot(wb/(2e9*pi),mag2db(abs(hb)))
hold on
plot(wl/(2e9*pi),mag2db(abs(hl)))
plot(w2/(2e9*pi),mag2db(abs(h2)))
plot(we/(2e9*pi),mag2db(abs(he)))
axis([0 4 -40 5])

grid

xlabel('Frequency (GHz)")
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ylabel('Attenuation (dB)")
legend('butter"', 'chebyl', 'cheby2','ellip")
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The Butterworth and Chebyshev Type II filters have flat passbands and wide transition
bands. The Chebyshev Type I and elliptic filters roll off faster but have passband ripple.
The frequency input to the Chebyshev Type II design function sets the beginning of the
stopband rather than the end of the passband.
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Phase Response

MATLAB® functions are available to extract the phase response of a filter. Given a
frequency response, the function abs returns the magnitude and angle returns the

phase angle in radians. To view the magnitude and phase of a Butterworth filter using
fvtool:

d = designfilt('lowpassiir','FilterOrder',9,

'HalfPowerFrequency',400, 'SampleRate',2000) ;
fvtool(d, 'Analysis', 'freq"')

Magnitude Response (dB) and Phase Response
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You can also click the Magnitude and Phase Response button on the toolbar or select
Analysis > Magnitude and Phase Response to display the plot.
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The unwrap function is also useful in frequency analysis. unwrap unwraps the phase to
make it continuous across 360° phase discontinuities by adding multiples of £360°, as
needed. To see how unwrap is useful, design a 25th-order lowpass FIR filter:

h = firl(25,0.4);
Obtain the frequency response with freqz and plot the phase in degrees:
[H,f] = freqz(h,1,512,2);

plot(f,angle(H)*180/pi)
grid

ZDD T T T T T T T T T

sl | | \ |
TN M

AVRYER L
AR AR AR

_2 DD i i i i i i i i i

It is difficult to distinguish the 360° jumps (an artifact of the arctangent function inside
angle) from the 180° jumps that signify zeros in the frequency response.
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unwrap eliminates the 360° jumps:

plot(f,unwrap(angle(H))*180/pi)
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Alternatively, you can use phasez to see the unwrapped phase:

phasez(h,1)
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Phase Response
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See Also

abs | angle | freqz | fvtool | phasez | unwrap

1-30



Delay

Delay

The group delay of a filter is a measure of the average time delay of the filter as a
function of frequency. It is defined as the negative first derivative of a filter's phase
response. If the complex frequency response of a filter is H(e/*), then the group delay is

where 6(w) is the phase, or argument of H(e/*). Compute group delay with
[gd,w] = grpdelay(b,a,n)

which returns the n-point group delay, 7,(w), of the digital filter specified by b and a,
evaluated at the frequencies in vector w.

The phase delay of a filter is the negative of phase divided by frequency:

6@

%@h—w

To plot both the group and phase delays of a system on the same FVTool graph, type
[z,p,k] = butter(10,200/1000);

fvtool(zp2sos(z,p,k), 'Analysis', 'grpdelay’,
'OverlayedAnalysis', 'phasedelay', 'Legend', 'on')
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Zero-Pole Analysis

The zplane function plots poles and zeros of a linear system. For example, a simple filter

with a zero at -1/2 and a complex pole pair at 0.9¢770% gng 0.9e/203 4

zer
pol

-0.5;
0.9*exp(j*2*pi*[-0.3 0.3]1");

To view the pole-zero plot for this filter you can use zplane. Supply column vector
arguments when the system is in pole-zero form.

zplane(zer,pol)

0.8 T i

0.6 : ' 7

0.2 F ' |

Imaginary Part

Real Part
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For access to additional tools, use fvtool. First convert the poles and zeros to transfer
function form, then call fvtool.
[b,a]

zp2tf(zer,pol,h1);
fvtool(b,a)
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Click the Pole/Zero Plot toolbar button, select Analysis > Pole/Zero Plot from the
menu, or type the following code to see the plot.

fvtool(b,a, 'Analysis', 'polezero')
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To use zplane for a system in transfer function form, supply row vector arguments. In

this case, zplane finds the roots of the numerator and denominator using the roots
function and plots the resulting zeros and poles.

zplane(b,a)
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See Linear System Models for details on zero-pole and transfer function representation of
systems.
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Discrete-Time System Models

Discrete-Time System Models

The discrete-time system models are representational schemes for digital filters. The
MATLAB technical computing environment supports several discrete-time system models,
which are described in the following sections:

* “Transfer Function” on page 1-37

» “Zero-Pole-Gain” on page 1-37

» “State Space” on page 1-38

» “Partial Fraction Expansion (Residue Form)” on page 1-39

* “Second-Order Sections (SOS)” on page 1-40

* “Lattice Structure” on page 1-41

* “Convolution Matrix” on page 1-43

Transfer Function

The transfer function is a basic z-domain representation of a digital filter, expressing the
filter as a ratio of two polynomials. It is the principal discrete-time model for this toolbox.
The transfer function model description for the z-transform of a digital filter's difference
equation is

-1 -n
Y(2) = b)+b(2)z " +...+b(n+1)z X(2)

aD+a2z+. +am+ 1z ™

Here, the constants b(i) and a(i) are the filter coefficients, and the order of the filter is the
maximum of n and m. In the MATLAB environment, you store these coefficients in two
vectors (row vectors by convention), one row vector for the numerator and one for the
denominator. See “Filters and Transfer Functions” on page 1-3 for more details on the
transfer function form.

Zero-Pole-Gain

The factored or zero-pole-gain form of a transfer function is

Hz)= 92 _p 2= qD)z—g2)..(z—qn))
p)  (z-pD)(z - p2)..(z- pn))
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1-38

By convention, polynomial coefficients are stored in row vectors and polynomial roots in
column vectors. In zero-pole-gain form, therefore, the zero and pole locations for the
numerator and denominator of a transfer function reside in column vectors. The factored
transfer function gain k is a MATLAB scalar.

The poly and roots functions convert between polynomial and zero-pole-gain
representations. For example, a simple IIR filter is

b [2 3 4];
a [13 3 1];

The zeros and poles of this filter are

g = roots(b)
p = roots(a)
% Gain factor

k = b(1l)/a(l)
Returning to the original polynomials,

bb
aa

k*poly(q)
poly(p)

Note that b and a in this case represent the transfer function:

2+3z71+422 2:%243z+4

H(z)= 3

1+82 1432242 22+322+32+1

Forb = [2 3 4], the roots function misses the zero for z equal to 0. In fact, it misses
poles and zeros for z equal to 0 whenever the input transfer function has more poles than
zeros, or vice versa. This is acceptable in most cases. To circumvent the problem,
however, simply append zeros to make the vectors the same length before using the
roots function; for example, b = [b 0].

State Space

It is always possible to represent a digital filter, or a system of difference equations, as a
set of first-order difference equations. In matrix or state-space form, you can write the
equations as

x(n+1)= Ax(n)+ Bu(n)
y(n) =Cx(n)+ Du(n)
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where u is the input, x is the state vector, and y is the output. For single-channel systems,
A is an m-by-m matrix where m is the order of the filter, B is a column vector, C is a row
vector, and D is a scalar. State-space notation is especially convenient for multichannel
systems where input u and output y become vectors, and B, C, and D become matrices.

State-space representation extends easily to the MATLAB environment. A, B, C, and D are
rectangular arrays; MATLAB functions treat them as individual variables.

Taking the Z-transform of the state-space equations and combining them shows the
equivalence of state-space and transfer function forms:

Y(z) = H2)U(z), where H(z) = C(zI ~A)'B+D

Don't be concerned if you are not familiar with the state-space representation of linear
systems. Some of the filter design algorithms use state-space form internally but do not
require any knowledge of state-space concepts to use them successfully. If your
applications use state-space based signal processing extensively, however, see the Control
System Toolbox™ product for a comprehensive library of state-space tools.

Partial Fraction Expansion (Residue Form)

Each transfer function also has a corresponding partial fraction expansion or residue
form representation, given by

b2 _ rd) ..+ LH@(D YRz 4.+ k(m —n+ 1)z
a(z) 1-p1zt 1- p(n)z~!

provided H(z) has no repeated poles. Here, n is the degree of the denominator polynomial
of the rational transfer function b(z)/a(z). If r is a pole of multiplicity s,, then H(z) has
terms of the form:

r(j) + r(j+1) N r(j+s. -1
1-p(zt A-p(HzH% " aA-p(jz >

The Signal Processing Toolbox residuez function in converts transfer functions to and
from the partial fraction expansion form. The “z” on the end of residuez stands for z-
domain, or discrete domain. residuez returns the poles in a column vector p, the
residues corresponding to the poles in a column vector r, and any improper part of the
original transfer function in a row vector k. residuez determines that two poles are the
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same if the magnitude of their difference is smaller than 0.1 percent of either of the poles'
magnitudes.

Partial fraction expansion arises in signal processing as one method of finding the inverse
Z-transform of a transfer function. For example, the partial fraction expansion of

—4+8271

Hz)= ——
1+6271 +8272

is

[-4 8];
[16 8];
r,p,kl = residuez(b,a)

b
a
[
which corresponds to

-12 8

H(z)= T+ T
1+4z" 1+2z

To find the inverse Z-transform of H(z), find the sum of the inverse Z-transforms of the
two addends of H(z), giving the causal impulse response:

h(n)=-12(-4)" +8(-2)", n=0,1,2,...

To verify this in the MATLAB environment, type

imp = [10 00 0];

resptf = filter(b,a,imp)

respres = filter(r(1),[1 -p(1)],imp)+...
filter(r(2),[1 -p(2)],imp)

Second-Order Sections (SOS)

Any transfer function H(z) has a second-order sections representation

L L -1 -2
H(Z)=HHk(Z)=HbOk+blkz +b2k2 5
k=1

1 _
k=1Cp T Q32 ~ t Qg2
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where L is the number of second-order sections that describe the system. The MATLAB
environment represents the second-order section form of a discrete-time system as an L-
by-6 array sos. Each row of sos contains a single second-order section, where the row
elements are the three numerator and three denominator coefficients that describe the
second-order section.

bor b1 bar apr ap ag

b b b a a a
508 = _02 .12 .22 .02 _12 .22

bor, bir, bar, aor, @r agr

There are many ways to represent a filter in second-order section form. Through careful
pairing of the pole and zero pairs, ordering of the sections in the cascade, and
multiplicative scaling of the sections, it is possible to reduce quantization noise gain and
avoid overflow in some fixed-point filter implementations. The functions zp2sos and
s5250s, described in “Linear System Transformations” on page 1-47, perform pole-zero
pairing, section scaling, and section ordering.

Note All Signal Processing Toolbox second-order section transformations apply only to
digital filters.

Lattice Structure

For a discrete Nth order all-pole or all-zero filter described by the polynomial coefficients
a(n),n=1, 2, ..., N+1, there are N corresponding lattice structure coefficients k(n),
n=1,2,.., N. The parameters k(n) are also called the reflection coefficients of the filter.
Given these reflection coefficients, you can implement a discrete filter as shown below.
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FIR and IIR Lattice Filter structure diagrams

For a general pole-zero IIR filter described by polynomial coefficients a and b, there are
both lattice coefficients k(n) for the denominator a and ladder coefficients v(n) for the
numerator b. The lattice/ladder filter may be implemented as

o g {7+

vl 1l vl wli

Km)

ARMA output

Diagram of lattice/ladder filter

The toolbox function tf2latc accepts an FIR or IIR filter in polynomial form and returns
the corresponding reflection coefficients. An example FIR filter in polynomial form is

b =1[1.0000 0.6149 ©0.9899 0.0000 0.0031 -0.0082];

This filter's lattice (reflection coefficient) representation is
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k = tf2latc(b)

For IIR filters, the magnitude of the reflection coefficients provides an easy stability
check. If all the reflection coefficients corresponding to a polynomial have magnitude less
than 1, all of that polynomial's roots are inside the unit circle. For example, consider an
IIR filter with numerator polynomial b from above and denominator polynomial:

a=[11/2 1/3];

The filter's lattice representation is

[k,v] = tf2latc(b,a);

Because abs (k) < 1 for all reflection coefficients in k, the filter is stable.

The function latc2tf calculates the polynomial coefficients for a filter from its lattice
(reflection) coefficients. Given the reflection coefficient vector k, the corresponding
polynomial form is

b = latc2tf(k);

The lattice or lattice/ladder coefficients can be used to implement the filter using the
function latcfilt.

Convolution Matrix

In signal processing, convolving two vectors or matrices is equivalent to filtering one of
the input operands by the other. This relationship permits the representation of a digital
filter as a convolution matrix.

Given any vector, the toolbox function convmtx generates a matrix whose inner product
with another vector is equivalent to the convolution of the two vectors. The generated
matrix represents a digital filter that you can apply to any vector of appropriate length;
the inner dimension of the operands must agree to compute the inner product.

The convolution matrix for a vector b, representing the numerator coefficients for a
digital filter, is

b=1[12 3];
X = randn(3,1);
C = convmtx(b',3);

Two equivalent ways to convolve b with x are as follows.
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C*x;
conv(b,x);

y2
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Continuous-Time System Models

The continuous-time system models are representational schemes for analog filters. Many
of the discrete-time system models described earlier are also appropriate for the
representation of continuous-time systems:

» State-space form

» Partial fraction expansion

* Transfer function

* Zero-pole-gain form

It is possible to represent any system of linear time-invariant differential equations as a

set of first-order differential equations. In matrix or state-space form, you can express the
equations as

x =Ax+ Bu
y=Cx+Du

where u is a vector of nu inputs, x is an nx-element state vector, and y is a vector of ny
outputs. In the MATLAB environment, A, B, C, and D are stored in separate rectangular
arrays.

An equivalent representation of the state-space system is the Laplace transform transfer
function description

Y(s)= H(s)U(s)
where
H(s)=C(sI-A)'B+D

For single-input, single-output systems, this form is given by

_b(e) _ D" +H2s" T+ +b(n+1)

H(s) = 3
as) q)s™ +a@2)s™ 1 +.. . +am+1)

Given the coefficients of a Laplace transform transfer function, residue determines the
partial fraction expansion of the system. See the description of residue for details.
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The factored zero-pole-gain form is

s) —h (s—z())(s—2(2))...(s—z(n))

H(s) = =
ps)  (s— pD)s— p(2)...(s—pm))

As in the discrete-time case, the MATLAB environment stores polynomial coefficients in
row vectors in descending powers of s. It stores polynomial roots, or zeros and poles, in
column vectors.
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Linear System Transformations

A number of Signal Processing Toolbox functions are provided to convert between the
various linear system models. You can use the following chart to find an appropriate
transfer function: find the row of the model to convert from on the left side of the chart
and the column of the model to convert to on the top of the chart and read the function
name(s) at the intersection of the row and column. Note that some cells of this table are
empty.

To - Transfer |State-|Zero- Partial Lattice |Second- Convolution

Function |[Space [Pole- Gain |[Fraction Filter Order Matrix
From | Sections
Transfer tf2ss [tf2zp residuez |tf2latc |none convmtx
Function roots
State-Space |ss2tf ss2zp none none $52S0S none
Zero-Pole- |zp2tf Zp2ss none none Zp2s0s none
Gain poly
Partial residuez |none |none none none none
Fraction
Lattice latc2tf |none |none none none none
Filter
SOS sos2tf S0S2S [S052zp none none none

S

Note Converting from one filter structure or model to another may produce a result with
different characteristics than the original. This is due to the computer's finite-precision
arithmetic and the variations in the conversion's round-off computations.

Many of the toolbox filter design functions use these functions internally. For example, the
zp2ss function converts the poles and zeros of an analog prototype into the state-space
form required for creation of a Butterworth, Chebyshey, or elliptic filter. Once in state-
space form, the filter design function performs any required frequency transformation,
that is, it transforms the initial lowpass design into a bandpass, highpass, or bandstop
filter, or a lowpass filter with the desired cutoff frequency.
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Note All Signal Processing Toolbox second-order section transformations apply only to
digital filters.
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Discrete Fourier Transform

The discrete Fourier transform, or DFT, is the primary tool of digital signal processing.
The foundation of the product is the fast Fourier transform (FFT), a method for computing
the DFT with reduced execution time. Many of the toolbox functions (including Z-domain
frequency response, spectrum and cepstrum analysis, and some filter design and
implementation functions) incorporate the FFT.

The MATLAB® environment provides the functions fft and ifft to compute the discrete
Fourier transform and its inverse, respectively. For the input sequence x and its
transformed version X (the discrete-time Fourier transform at equally spaced frequencies
around the unit circle), the two functions implement the relationships

N—1I
X(k+1)=_ xin+ 1)Wis
=l

and

N-1
XiHn+4+ | ] = T Xik + 1 :ngkr.'_

|
N'=

In these equations, the series subscripts begin with 1 instead of 0 because of the MATLAB
vector indexing scheme, and

Wy = e~ 2=/N,

Note The MATLAB convention is to use a negative j for the fft function. This is an
engineering convention; physics and pure mathematics typically use a positive j.

fft, with a single input argument, x, computes the DFT of the input vector or matrix. If x
is a vector, fft computes the DFT of the vector; if x is a rectangular array, fft computes
the DFT of each array column.

For example, create a time vector and signal:

t
X

0:1/100:10-1/100;

Time vector
sin(2*pi*15*t) + sin(2*pi*40*t); S

ignal

o° o°
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The DFT of the signal, and the magnitude and phase of the transformed sequence, are
then

y = fft(x); % Compute DFT of x
m = abs(y); % Magnitude
p = unwrap(angle(y)); % Phase

To plot the magnitude and phase in degrees, type the following commands:
f = (0:length(y)-1)*100/length(y); % Frequency vector

subplot(2,1,1)

plot(f,m)
title('Magnitude')

ax = gca;

ax.XTick = [15 40 60 85];

subplot(2,1,2)
plot(f,p*180/pi)
title('Phase"')

ax = gca;

ax.XTick = [15 40 60 85];



Discrete Fourier Transform
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A second argument to fft specifies a number of points n for the transform, representing
DFT length:

n = 512;

y = fft(x,n);

m = abs(y);

p = unwrap(angle(y));

f = (0:1length(y)-1)*100/1length(y);
subplot(2,1,1)

plot(f,m)

title('Magnitude')

ax = gca;

ax.XTick = [15 40 60 85];
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subplot(2,1,2)
plot(f,p*180/pi)
title('Phase")

ax = gca;

ax.XTick = [15 40 60 85];

Magnitude
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In this case, fft pads the input sequence with zeros if it is shorter than n, or truncates
the sequence if it is longer than n. If n is not specified, it defaults to the length of the
input sequence. Execution time for fft depends on the length, n, of the DFT it performs;
see the fft reference page for details about the algorithm.

Note The resulting FFT amplitude is A*n/2, where A is the original amplitude and n is
the number of FFT points. This is true only if the number of FFT points is greater than or
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equal to the number of data samples. If the number of FFT points is less, the FFT
amplitude is lower than the original amplitude by the above amount.

The inverse discrete Fourier transform function ifft also accepts an input sequence and,
optionally, the number of desired points for the transform. Try the example below; the
original sequence x and the reconstructed sequence are identical (within rounding error).

t =0:1/255:1;

X = sin(2*pi*120*t);

y = real(ifft(fft(x)));

figure

plot(th'Y)

E }C1D-1EI T T T T T T T T

4 - -
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This toolbox also includes functions for the two-dimensional FFT and its inverse, fft2
and ifft2. These functions are useful for two-dimensional signal or image processing.
The goertzel function, which is another algorithm to compute the DFT, also is included in
the toolbox. This function is efficient for computing the DFT of a portion of a long signal.

It is sometimes convenient to rearrange the output of the fft or fft2 function so the
zero frequency component is at the center of the sequence. The function fftshift
moves the zero frequency component to the center of a vector or matrix.

See Also
fft | fft2 | fftshift | goertzel | ifft | ifft2
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» “Filter Requirements and Specification” on page 2-2

» “IIR Filter Design” on page 2-5

* “FIR Filter Design” on page 2-19

» “Special Topics in IIR Filter Design” on page 2-42

» “Filtering Data With Signal Processing Toolbox Software” on page 2-51
» “Selected Bibliography” on page 2-70
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Filter Requirements and Specification

2-2

Filter design is the process of creating the filter coefficients to meet specific filtering
requirements. Filter implementation involves choosing and applying a particular filter
structure to those coefficients. Only after both design and implementation have been
performed can data be filtered. The following chapter describes filter design and
implementation in Signal Processing Toolbox™ software.

The goal of filter design is to perform frequency dependent alteration of a data sequence.
A possible requirement might be to remove noise above 200 Hz from a data sequence
sampled at 1000 Hz. A more rigorous specification might call for a specific amount of
passband ripple, stopband attenuation, or transition width. A very precise specification
could ask to achieve the performance goals with the minimum filter order, or it could call
for an arbitrary magnitude shape, or it might require an FIR filter. Filter design methods
differ primarily in how performance is specified.

To design a filter, the Signal Processing Toolbox software offers two approaches. The first
approach uses the designfilt function. As an example, design and implement a 5th-
order lowpass Butterworth filter with a 3-dB frequency of 200 Hz. Assume a sample rate
of 1 kHz. Apply the filter to input data.

Fs 1000;

fc 200;

time = 0:1/Fs:1;

X = Cc0oS(2*pi*6O*time)+sin(2*pi*120*time)+randn(size(time));

d = designfilt('lowpassiir','FilterOrder"',5, ...
'"HalfPowerFrequency', fc, 'DesignMethod’, 'butter’,
'SampleRate',Fs);

yd = filter(d,x);

The other approach implements the filter using a function such as butter or firpm. All
of these "classic" filter design functions operate with normalized frequencies. Convert
frequency specifications in Hz to normalized frequency to use these functions. The Signal
Processing Toolbox software defines normalized frequency to be in the closed interval
[0,1], with 1 denoting i rad/sample. For example, to specify a normalized frequency of /2
rad/sample, enter 0.5.

To convert from Hz to normalized frequency, multiply the frequency in Hz by two and
divide by the sampling frequency. For example, design a Sth-order lowpass Butterworth
filter with a 3-dB frequency of 200 Hz using butter.
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Wn = fc/(Fs/2);

[b,a] = butter(5,Wn, 'low');
yb = filter(b,a,x);

Plot the two filtered signals.

plot(time,yd, time,yb)
legend('designfilt’', 'butter')

designfilt
butter

o 0.1 0.2 03 04
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See Also
butter | designfilt | filter
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lIR Filter Design

In this section...

“IIR vs. FIR Filters” on page 2-5

“Classical IIR Filters” on page 2-5

“Other IIR Filters” on page 2-5

“IIR Filter Method Summary” on page 2-6

“Classical IIR Filter Design Using Analog Prototyping” on page 2-7
“Comparison of Classical IIR Filter Types” on page 2-10

IIR vs. FIR Filters

The primary advantage of IIR filters over FIR filters is that they typically meet a given set
of specifications with a much lower filter order than a corresponding FIR filter. Although
IIR filters have nonlinear phase, data processing within MATLAB software is commonly
performed “offline,” that is, the entire data sequence is available prior to filtering. This
allows for a noncausal, zero-phase filtering approach (via the filtfilt function), which
eliminates the nonlinear phase distortion of an IIR filter.

Classical IIR Filters

The classical IIR filters, Butterworth, Chebyshev Types I and II, elliptic, and Bessel, all
approximate the ideal “brick wall” filter in different ways.

This toolbox provides functions to create all these types of classical IIR filters in both the
analog and digital domains (except Bessel, for which only the analog case is supported),
and in lowpass, highpass, bandpass, and bandstop configurations. For most filter types,
you can also find the lowest filter order that fits a given filter specification in terms of
passband and stopband attenuation, and transition width(s).

Other IR Filters

The direct filter design function yulewalk finds a filter with magnitude response
approximating a specified frequency-response function. This is one way to create a
multiband bandpass filter.

2-5



2 Filter Design and Implementation

2-6

You can also use the parametric modeling or system identification functions to design IIR
filters. These functions are discussed in “Parametric Modeling” on page 7-26.

The generalized Butterworth design function maxflat is discussed in the section
“Generalized Butterworth Filter Design” on page 2-17.

lIR Filter Method Summary

The following table summarizes the various filter methods in the toolbox and lists the
functions available to implement these methods.
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Toolbox Filters Methods and Available Functions

Filter Method

Description

Filter Functions

Analog
Prototyping

Using the poles and zeros of a
classical lowpass prototype filter
in the continuous (Laplace)
domain, obtain a digital filter
through frequency transformation
and filter discretization.

Complete design functions:
besself, butter, chebyl, cheby2, ellip

Order estimation functions:
buttord, cheblord, cheb2ord, ellipord

Lowpass analog prototype functions:
besselap, buttap, cheblap, cheb2ap,
ellipap

Frequency transformation functions:
1p2bp, Lp2bs, Lp2hp, Lp21lp

Filter discretization functions:
bilinear, impinvar

Direct Design Design digital filter directly in the |yulewalk
discrete time-domain by
approximating a piecewise linear
magnitude response.
Generalized Design lowpass Butterworth maxflat
Butterworth filters with more zeros than poles.
Design
Parametric Find a digital filter that Time-domain modeling functions:
Modeling approximates a prescribed time or|lpc, prony, stmcb

frequency domain response. (See
System Identification Toolbox™
documentation for an extensive
collection of parametric modeling
tools.)

Frequency-domain modeling functions:
invfreqs, invfreqz

Classical IIR Filter Design Using Analog Prototyping

The principal IIR digital filter design technique this toolbox provides is based on the
conversion of classical lowpass analog filters to their digital equivalents. The following
sections describe how to design filters and summarize the characteristics of the
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supported filter types. See “Special Topics in IIR Filter Design” on page 2-42 for detailed
steps on the filter design process.

Complete Classical IIR Filter Design

You can easily create a filter of any order with a lowpass, highpass, bandpass, or bandstop
configuration using the filter design functions.

Filter Design Functions

Filter Type Design Function

Bessel (analog only) [b,a] = besself(n,Wn,options)
[z,p,k] = besself(n,Wn,options)

[A,B,C,D] = besself(n,Wn,options)
Butterworth [b,a] = butter(n,Wn,options)

[z,p,k] = butter(n,Wn,options)

[A,B,C,D] = butter(n,Wn,options)
Chebyshev Type I [b,a] = chebyl(n,Rp,Wn,options)

[z,p,k] = chebyl(n,Rp,Wn,options)

[A,B,C,D] = chebyl(n,Rp,Wn,options)
Chebyshev Type II [b,a] = cheby2(n,Rs,Wn,options)

[z,p,k] = cheby2(n,Rs,Wn,options)

[A,B,C,D] = cheby2(n,Rs,Wn,options)
Elliptic [b,a] = ellip(n,Rp,Rs,Wn,options)

[z,p,k] = ellip(n,Rp,Rs,Wn,options)
[A,B,C,D] = ellip(n,Rp,Rs,Wn,options)

By default, each of these functions returns a lowpass filter; you need to specify only the
cutoff frequency that you want, Wn, in normalized units such that the Nyquist frequency is
1 Hz). For a highpass filter, append 'high' to the function's parameter list. For a
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bandpass or bandstop filter, specify Wn as a two-element vector containing the passband
edge frequencies. Append 'stop' for the bandstop configuration.

Here are some example digital filters:

[b,a] = butter(5,0.4); % Lowpass Butterworth

[b,a] = chebyl(4,1,[0.4 0.7]); % Bandpass Chebyshev Type I
[b,a] = cheby2(6,60,0.8, 'high'); % Highpass Chebyshev Type II
[b,a] = ellip(3,1,60,[0.4 0.7], " 'stop'); % Bandstop elliptic

To design an analog filter, perhaps for simulation, use a trailing 's' and specify cutoff
frequencies in rad/s:

[b,a]l] = butter(5,0.4,'s"'); % Analog Butterworth filter

All filter design functions return a filter in the transfer function, zero-pole-gain, or state-
space linear system model representation, depending on how many output arguments are
present. In general, you should avoid using the transfer function form because numerical
problems caused by roundoff errors can occur. Instead, use the zero-pole-gain form which
you can convert to a second-order section (SOS) form using zp2sos and then use the SOS
form to analyze or implement your filter.

Note All classical IIR lowpass filters are ill-conditioned for extremely low cutoff
frequencies. Therefore, instead of designing a lowpass IIR filter with a very narrow
passband, it can be better to design a wider passband and decimate the input signal.

Designing IIR Filters to Frequency Domain Specifications

This toolbox provides order selection functions that calculate the minimum filter order
that meets a given set of requirements.

Filter Type Order Estimation Function
Butterworth [n,Wn] = buttord(Wp,Ws,Rp,Rs)
Chebyshev Type I [n,Wn] = cheblord(Wp,Ws,Rp,Rs)
Chebyshev Type II [n,Wn] = cheb2ord(Wp,Ws,Rp,Rs)
Elliptic [n,Wn] = ellipord(Wp,Ws,Rp,Rs)

These are useful in conjunction with the filter design functions. Suppose you want a
bandpass filter with a passband from 1000 to 2000 Hz, stopbands starting 500 Hz away
on either side, a 10 kHz sampling frequency, at most 1 dB of passband ripple, and at least
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60 dB of stopband attenuation. You can meet these specifications by using the butter
function as follows.

[n,Wn] = buttord([1000 2000]/5000, [500 2500]/5000,1,60)
[b,a] = butter(n,Wn);

n =
12
Wn =
0.1951 0.4080

An elliptic filter that meets the same requirements is given by

[n,Wn] = ellipord([1000 2000]/5000, [500 2500]/5000,1,60)
[b,a] = ellip(n,1,60,Wn);

n:
5

Wn =

0.2000 0.4000

These functions also work with the other standard band configurations, as well as for
analog filters.

Comparison of Classical IIR Filter Types

The toolbox provides five different types of classical IIR filters, each optimal in some way.
This section shows the basic analog prototype form for each and summarizes major
characteristics.

Butterworth Filter

The Butterworth filter provides the best Taylor series approximation to the ideal lowpass
filter response at analog frequencies Q = 0 and Q = «; for any order N, the magnitude
squared response has 2N - 1 zero derivatives at these locations (maximally flat at Q = 0
and Q = »). Response is monotonic overall, decreasing smoothly from Q = 0 to Q = =,

|H(jo)|=1/V2 atQ = 1.
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Chebyshev Type I Filter

The Chebyshev Type I filter minimizes the absolute difference between the ideal and
actual frequency response over the entire passband by incorporating an equal ripple of
Rp dB in the passband. Stopband response is maximally flat. The transition from passband

to stopband is more rapid than for the Butterworth filter. |H(jQ)|=108?/20 at 0 = 1.
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Chebyshev Type Il Filter

The Chebyshev Type II filter minimizes the absolute difference between the ideal and

actual frequency response over the entire stopband by incorporating an equal ripple of
Rs dB in the stopband. Passband response is maximally flat.

The stopband does not approach zero as quickly as the type I filter (and does not
approach zero at all for even-valued filter order n). The absence of ripple in the passband,

however, is often an important advantage. |H(jQ)|=10"85/20 at 0 = 1.
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Elliptic Filter

Elliptic filters are equiripple in both the passband and stopband. They generally meet
filter requirements with the lowest order of any supported filter type. Given a filter
order n, passband ripple Rp in decibels, and stopband ripple Rs in decibels, elliptic filters

minimize transition width. |[H(jQ)|=10"8?"20 at q = 1.
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Bessel Filter

Analog Bessel lowpass filters have maximally flat group delay at zero frequency and
retain nearly constant group delay across the entire passband. Filtered signals therefore
maintain their waveshapes in the passband frequency range. Frequency mapped and
digital Bessel filters, however, do not have this maximally flat property; this toolbox
supports only the analog case for the complete Bessel filter design function.

Bessel filters generally require a higher filter order than other filters for satisfactory

stopband attenuation. |H(jQ)|< 1//2 at Q = 1 and decreases as filter order n increases.
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Note The lowpass filters shown above were created with the analog prototype functions
besselap, buttap, cheblap, cheb2ap, and ellipap. These functions find the zeros,
poles, and gain of an nth-order analog filter of the appropriate type with a cutoff
frequency of 1 rad/s. The complete filter design functions (besself, butter, chebyl,
cheby?2, and ellip) call the prototyping functions as a first step in the design process.
See “Special Topics in IIR Filter Design” on page 2-42 for details.

To create similar plots, use n = 5 and, as needed, Rp = 0.5 and Rs = 20. For example, to
create the elliptic filter plot:
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[z,p,k] = ellipap(5,0.5,20);

w = logspace(-1,1,1000);

h = fregs(k*poly(z),poly(p),w);
semilogx(w,abs(h)), grid
xlabel('Frequency (rad/s)")
ylabel('Magnitude")

Direct IIR Filter Design

This toolbox uses the term direct methods to describe techniques for IIR design that find
a filter based on specifications in the discrete domain. Unlike the analog prototyping
method, direct design methods are not constrained to the standard lowpass, highpass,
bandpass, or bandstop configurations. Rather, these functions design filters with an
arbitrary, perhaps multiband, frequency response. This section discusses the yulewalk
function, which is intended specifically for filter design; “Parametric Modeling” on page 7-
26 discusses other methods that may also be considered direct, such as Prony's method,
Linear Prediction, the Steiglitz-McBride method, and inverse frequency design.

The yulewalk function designs recursive IIR digital filters by fitting a specified
frequency response. yulewalk's name reflects its method for finding the filter's
denominator coefficients: it finds the inverse FFT of the ideal specified magnitude-
squared response and solves the modified Yule-Walker equations using the resulting
autocorrelation function samples. The statement

[b,a] = yulewalk(n,f,m)

returns row vectors b and a containing the n+1 numerator and denominator coefficients
of the nth-order IIR filter whose frequency-magnitude characteristics approximate those
given in vectors f and m. f is a vector of frequency points ranging from 0 to 1, where 1
represents the Nyquist frequency. m is a vector containing the specified magnitude
response at the points in f. f and m can describe any piecewise linear shape magnitude
response, including a multiband response. The FIR counterpart of this function is fir2,
which also designs a filter based on an arbitrary piecewise linear magnitude response.
See “FIR Filter Design” on page 2-19 for details.

Note that yulewalk does not accept phase information, and no statements are made
about the optimality of the resulting filter.

Design a multiband filter with yulewalk and plot the specified and actual frequency
response:

0 1 1 0 0 1 1 0 0];
.10.20.30.40.50.60.70.81];

m [0
f [0 0



lIR Filter Design

[b,al yulewalk(10,f,m);
[h,w] freqz(b,a, 128)
plot(f,m,w/pi,abs(h))

1.2 T T

0.8} |
| \

0.2} /| \ |
I | | ||

Generalized Butterworth Filter Design

The toolbox function maxflat enables you to design generalized Butterworth filters, that
is, Butterworth filters with differing numbers of zeros and poles. This is desirable in some
implementations where poles are more expensive computationally than zeros. maxflat is
just like the butter function, except that it you can specify two orders (one for the
numerator and one for the denominator) instead of just one. These filters are maximally
flat. This means that the resulting filter is optimal for any numerator and denominator
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orders, with the maximum number of derivatives at 0 and the Nyquist frequency w =
both set to 0.

For example, when the two orders are the same, maxflat is the same as butter:
[b,a] = maxflat(3,3,0.25)
b =
0.0317 0.0951 0.0951 0.0317
T 1.0000 -1.4590 0.9104 -0.1978

[b,a] = butter(3,0.25)

0.0317 0.0951 0.0951 0.0317

1.0000 -1.4590 0.9104 -0.1978

However, maxflat is more versatile because it allows you to design a filter with more
zeros than poles:

[b,a] = maxflat(3,1,0.25)
b —
0.0950 0.2849 0.2849 0.0950

a =
1.0000 -0.2402

The third input to maxflat is the half-power frequency, a frequency between 0 and 1

with a magnitude response of 1/ V2.

You can also design linear phase filters that have the maximally flat property using the
‘sym' option:

maxflat(4, 'sym',0.3)

ans =
0.0331 0.2500 0.4337 0.2500 0.0331

For complete details of the maxflat algorithm, see Selesnick and Burrus [2].
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In this section...

“FIR vs. IIR Filters” on page 2-19
“FIR Filter Summary” on page 2-20
“Linear Phase Filters” on page 2-20

“Windowing Method” on page 2-21

“Multiband FIR Filter Design with Transition Bands” on page 2-25
“Constrained Least Squares FIR Filter Design” on page 2-31
“Arbitrary-Response Filter Design” on page 2-36

FIR vs. IIR Filters

Digital filters with finite-duration impulse response (all-zero, or FIR filters) have both
advantages and disadvantages compared to infinite-duration impulse response (IIR)
filters.

FIR filters have the following primary advantages:

* They can have exactly linear phase.

* They are always stable.

* The design methods are generally linear.

* They can be realized efficiently in hardware.

» The filter startup transients have finite duration.

The primary disadvantage of FIR filters is that they often require a much higher filter
order than IIR filters to achieve a given level of performance. Correspondingly, the delay
of these filters is often much greater than for an equal performance IIR filter.
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FIR Filter Summary

FIR Filters

Filter Design Description Filter Functions

Method

Windowing Apply window to truncated inverse Fourier firl, fir2,
transform of specified "brick wall" filter kaiserord

Multiband with Equiripple or least squares approach over firls, firpm,

Transition Bands |sub-bands of the frequency range firpmord

Constrained Least

Minimize squared integral error over entire

fircls, firclsl

transition

Squares frequency range subject to maximum error
constraints

Arbitrary Response |Arbitrary responses, including nonlinear cfirpm
phase and complex filters

Raised Cosine Lowpass response with smooth, sinusoidal rcosdesign

Linear Phase Filters

Except for cfirpm, all of the FIR filter design functions design linear phase filters only.
The filter coefficients, or “taps,” of such filters obey either an even or odd symmetry
relation. Depending on this symmetry, and on whether the order n of the filter is even or
odd, a linear phase filter (stored in length n+1 vector b) has certain inherent restrictions

on its frequency response.

Linear Filter |[Symmetry of Coefficients Response Response

Phase Filter [Order H(f),f = 0 |H(f),f =1

Type (Nyquist)

Type I Even even: No restriction |No restriction
bk)=bn+2-k), k=1,.,n+1

Type II Odd even: No restriction [H(1) = 0
bk)=bn+2-k), k=1,.,n+1
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Linear Filter |[Symmetry of Coefficients Response Response

Phase Filter [Order H(f),f = 0 |H(f),f =1

Type (Nyquist)

Type III Even odd: HO) =0 H(1) =0
bk)=-bn+2-k), k=1,.,n+1

Type IV Odd odd: HO) =0 No restriction
bk)=-bn+2-k), k=1,.,n+1

The phase delay and group delay of linear phase FIR filters are equal and constant over
the frequency band. For an order n linear phase FIR filter, the group delay is n/2, and the
filtered signal is simply delayed by n/2 time steps (and the magnitude of its Fourier
transform is scaled by the filter's magnitude response). This property preserves the wave
shape of signals in the passband; that is, there is no phase distortion.

The functions firl, fir2, firls, firpm, fircls, and fircls1 all design type I and II
linear phase FIR filters by default. rcosdesign designs only type I filters. Both firls
and firpm design type III and IV linear phase FIR filters given a 'hilbert' or
'differentiator' flag. cfirpm can design any type of linear phase filter, and
nonlinear phase filters as well.

Note Because the frequency response of a type II filter is zero at the Nyquist frequency
(“high” frequency), firl does not design type II highpass and bandstop filters. For odd-
valued n in these cases, firl adds 1 to the order and returns a type I filter.

Windowing Method

Consider the ideal, or “brick wall,” digital lowpass filter with a cutoff frequency of w,
rad/s. This filter has magnitude 1 at all frequencies with magnitude less than w,, and
magnitude 0 at frequencies with magnitude between w, and 1. Its impulse response
sequence h(n) is

h(l’l) :LJ‘” H(a))elmdw: L o e-/w"dw _ Sin a)on
2w d-m 2T - ™
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This filter is not implementable since its impulse response is infinite and noncausal. To
create a finite-duration impulse response, truncate it by applying a window. By retaining
the central section of impulse response in this truncation, you obtain a linear phase FIR
filter. For example, a length 51 filter with a lowpass cutoff frequency w, of 0.4 i rad/s is

b = 0.4*%sinc(0.4%(-25:25));

The window applied here is a simple rectangular window. By Parseval’s theorem, this is
the length 51 filter that best approximates the ideal lowpass filter, in the integrated least
squares sense. The following command displays the filter's frequency response in FVTool:

fvtool(b,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this
by right-clicking on the axis label and selecting Magnitude Squared from the menu.

Magnitude Response (squared)

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9
Mormalized Frequency ( = rad/sample)

Ringing and ripples occur in the response, especially near the band edge. This “Gibbs
effect” does not vanish as the filter length increases, but a nonrectangular window
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FIR Filter Design

reduces its magnitude. Multiplication by a window in the time domain causes a

convolution or smoothing in the frequency domain. Apply a length 51 Hamming window
to the filter and display the result using FVTool:

b 0.4*sinc(0.4%(-25:25));
b b.*hamming(51)';
fvtool(b,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this
by right-clicking on the axis label and selecting Magnitude Squared from the menu.

Magnitude Response {squared)

o]
T
-

0 0.1 0.2 0.3 0.4 0.5

i i i
06 07 08 09
Mormalized Frequency ( =« rad/sample)

Using a Hamming window greatly reduces the ringing. This improvement is at the
expense of transition width (the windowed version takes longer to ramp from passband to

stopband) and optimality (the windowed version does not minimize the integrated
squared error).

The functions firl and fir2 are based on this windowing process. Given a filter order
and description of an ideal filter, these functions return a windowed inverse Fourier
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transform of that ideal filter. Both use a Hamming window by default, but they accept any
window function. See “Windows” on page 7-2 for an overview of windows and their
properties.

Standard Band FIR Filter Design: firl

firl implements the classical method of windowed linear phase FIR digital filter design.
It resembles the IIR filter design functions in that it is formulated to design filters in
standard band configurations: lowpass, bandpass, highpass, and bandstop.

The statements

n = 50;
Wn = 0.4;
b = firl(n,Wn);

create row vector b containing the coefficients of the order n Hamming-windowed filter.
This is a lowpass, linear phase FIR filter with cutoff frequency Wn. Wn is a number
between 0 and 1, where 1 corresponds to the Nyquist frequency, half the sampling
frequency. (Unlike other methods, here Wn corresponds to the 6 dB point.) For a highpass
filter, simply append 'high' to the function's parameter list. For a bandpass or bandstop
filter, specify Wn as a two-element vector containing the passband edge frequencies.
Append 'stop' for the bandstop configuration.

b = firl(n,Wn,window) uses the window specified in column vector window for the
design. The vector window must be n+1 elements long. If you do not specify a window,
firl applies a Hamming window.

Kaiser Window Order Estimation

The kaiserord function estimates the filter order, cutoff frequency, and Kaiser window
beta parameter needed to meet a given set of specifications. Given a vector of frequency
band edges and a corresponding vector of magnitudes, as well as maximum allowable
ripple, kaiserord returns appropriate input parameters for the firl function.

Multiband FIR Filter Design: fir2
The fir2 function also designs windowed FIR filters, but with an arbitrarily shaped
piecewise linear frequency response. This is in contrast to firl, which only designs

filters in standard lowpass, highpass, bandpass, and bandstop configurations.

The commands
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n = 50;

f=100 .4 .51];
m=1[1 1 0 0];
b = fir2(n,f,m);

return row vector b containing the n+1 coefficients of the order n FIR filter whose
frequency-magnitude characteristics match those given by vectors f and m. f is a vector
of frequency points ranging from 0 to 1, where 1 represents the Nyquist frequency. m is a
vector containing the specified magnitude response at the points specified in f. (The IIR
counterpart of this function is yulewalk, which also designs filters based on arbitrary
piecewise linear magnitude responses. See “IIR Filter Design” on page 2-5 for details.)

Multiband FIR Filter Design with Transition Bands

The firls and firpm functions provide a more general means of specifying the ideal
specified filter than the firl and fir2 functions. These functions design Hilbert
transformers, differentiators, and other filters with odd symmetric coefficients (type III
and type IV linear phase). They also let you include transition or “don't care” regions in
which the error is not minimized, and perform band dependent weighting of the
minimization.

The firls function is an extension of the firl and fir2 functions in that it minimizes
the integral of the square of the error between the specified frequency response and the
actual frequency response.

The firpm function implements the Parks-McClellan algorithm, which uses the Remez
exchange algorithm and Chebyshev approximation theory to design filters with optimal
fits between the specified and actual frequency responses. The filters are optimal in the
sense that they minimize the maximum error between the specified frequency response
and the actual frequency response; they are sometimes called minimax filters. Filters
designed in this way exhibit an equiripple behavior in their frequency response, and
hence are also known as equiripple filters. The Parks-McClellan FIR filter design
algorithm is perhaps the most popular and widely used FIR filter design methodology.

The syntax for firls and firpm is the same; the only difference is their minimization
schemes. The next example shows how filters designed with firls and firpm reflect
these different schemes.

Basic Configurations

The default mode of operation of firls and firpm is to design type I or type II linear
phase filters, depending on whether the order you want is even or odd, respectively. A
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lowpass example with approximate amplitude 1 from 0 to 0.4 Hz, and approximate
amplitude 0 from 0.5 to 1.0 Hz is

n = 20; % Filter order
f=1000.40.51]; % Frequency band edges
a=1[1 1 0 0]; % Amplitudes

b = firpm(n,f,a);

From 0.4 to 0.5 Hz, firpm performs no error minimization; this is a transition band or
“don't care” region. A transition band minimizes the error more in the bands that you do
care about, at the expense of a slower transition rate. In this way, these types of filters
have an inherent trade-off similar to FIR design by windowing.

To compare least squares to equiripple filter design, use firls to create a similar filter.
Type

bb = firls(n,f,a);
and compare their frequency responses using FVTool:
fvtool(b,1,bb,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this
by right-clicking on the axis label and selecting Magnitude Squared from the menu.
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The filter designed with firpm exhibits equiripple behavior. Also note that the firls
filter has a better response over most of the passband and stopband, but at the band
edges (f = 0.4 and f = 0.5), the response is further away from the ideal than the firpm
filter. This shows that the firpm filter's maximum error over the passband and stopband

is smaller and, in fact, it is the smallest possible for this band edge configuration and
filter length.

Think of frequency bands as lines over short frequency intervals. firpmand firls use
this scheme to represent any piecewise linear frequency-response function with any
transition bands. firls and firpm design lowpass, highpass, bandpass, and bandstop
filters; a bandpass example is

f

[6 0.3 0.4 0.7 0.8 1];
a

[0 0 1 1 0 0];

% Band edges in pairs
% Bandpass filter amplitude

Technically, these f and a vectors define five bands:
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» Two stopbands, from 0.0 to 0.3 and from 0.8 to 1.0
* A passband from 0.4 to 0.7
* Two transition bands, from 0.3 to 0.4 and from 0.7 to 0.8

Example highpass and bandstop filters are

f=1000.7 0.8 11; % Band edges in pairs
a=1[0 0 1 11; % Highpass filter amplitude
f=1000.3 0.4 0.5 0.8 1]; % Band edges in pairs
a=1[11 0 0 1 1]; % Bandstop filter amplitude

An example multiband bandpass filter is

f
a

[0 0.1 0.150.25 0.3 0.4 0.45 0.55 0.6 0.7 0.75 0.85 0.9 1];
[1 1 © 0 1 1 o© 0 1 1 © 0 1 11;

Another possibility is a filter that has as a transition region the line connecting the
passband with the stopband; this can help control “runaway” magnitude response in wide
transition regions:

[0 0.4 0.42 0.48 0.5 1];
[110.80.200]; % Passband, linear transition,
% stopband

f
a

The Weight Vector

Both firls and firpm allow you to place more or less emphasis on minimizing the error
in certain frequency bands relative to others. To do this, specify a weight vector following
the frequency and amplitude vectors. An example lowpass equiripple filter with 10 times
less ripple in the stopband than the passband is

20;

[0 0.4 0.5 1];
[1 1 0 0];
[1 10];
firpm(n,f,a,w);

Filter order
Frequency band edges
Amplitudes

Weight vector

o® o o o°

T QY 3>
numunnn

A legal weight vector is always half the length of the f and a vectors; there must be
exactly one weight per band.

Anti-Symmetric Filters / Hilbert Transformers

When called with a trailing 'h' or 'Hilbert' option, firpmand firls design FIR
filters with odd symmetry, that is, type III (for even order) or type IV (for odd order) linear
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phase filters. An ideal Hilbert transformer has this anti-symmetry property and an
amplitude of 1 across the entire frequency range. Try the following approximate Hilbert
transformers and plot them using FVTool:

b = firpm(21,[0.05 1],[1 1],'h"); % Highpass Hilbert
bb = firpm(20,[0.05 0.95],[1 1],'h"); % Bandpass Hilbert
fvtool(b,1,bb,1)

Magnitude Response (dB)
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You can find the delayed Hilbert transform of a signal x by passing it through these
filters.

fs = 1000;

t (0:1/fs:2)";

X sin(2*pi*300*t);
xh = filter(bb,1,x);

Sampling frequency

Two second time vector

300 Hz sine wave example signal
Hilbert transform of x

o® o° o° o°

The analytic signal corresponding to x is the complex signal that has x as its real part and
the Hilbert transform of x as its imaginary part. For this FIR method (an alternative to the
hilbert function), you must delay x by half the filter order to create the analytic signal:
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xd
Xa

[zeros(10,1); x(1l:length(x)-10)1; % Delay 10 samples
xd + j*xh; % Analytic signal

This method does not work directly for filters of odd order, which require a noninteger
delay. In this case, the hilbert function, described in “Hilbert Transform” on page 7-
77, estimates the analytic signal. Alternatively, use the resample function to delay the
signal by a noninteger number of samples.

Differentiators

Differentiation of a signal in the time domain is equivalent to multiplication of the signal's
Fourier transform by an imaginary ramp function. That is, to differentiate a signal, pass it
through a filter that has a response H(w) = jw. Approximate the ideal differentiator (with
a delay) using firpmor firls witha 'd' or 'differentiator' option:

b = firpm(21,[0 1],[0 pi],'d");

For a type III filter, the differentiation band should stop short of the Nyquist frequency,
and the amplitude vector must reflect that change to ensure the correct slope:

bb = firpm(20,[0 0.9],[0 0.9%pi], 'd');

In the 'd' mode, firpm weights the error by 1/w in nonzero amplitude bands to minimize
the maximum relative error. firls weights the error by (1/w)? in nonzero amplitude
bands in the 'd' mode.

The following plots show the magnitude responses for the differentiators above.

fvtool(b,1,bb,1)
legend('0dd order', 'Even order', 'Location', 'best')
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Constrained Least Squares FIR Filter Design

The Constrained Least Squares (CLS) FIR filter design functions implement a technique
that enables you to design FIR filters without explicitly defining the transition bands for
the magnitude response. The ability to omit the specification of transition bands is useful
in several situations. For example, it may not be clear where a rigidly defined transition
band should appear if noise and signal information appear together in the same frequency
band. Similarly, it may make sense to omit the specification of transition bands if they
appear only to control the results of Gibbs phenomena that appear in the filter's response.
See Selesnick, Lang, and Burrus [2] for discussion of this method.

Instead of defining passbands, stopbands, and transition regions, the CLS method accepts
a cutoff frequency (for the highpass, lowpass, bandpass, or bandstop cases), or passband
and stopband edges (for multiband cases), for the response you specify. In this way, the
CLS method defines transition regions implicitly, rather than explicitly.
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The key feature of the CLS method is that it enables you to define upper and lower
thresholds that contain the maximum allowable ripple in the magnitude response. Given
this constraint, the technique applies the least square error minimization technique over
the frequency range of the filter's response, instead of over specific bands. The error
minimization includes any areas of discontinuity in the ideal, "brick wall" response. An
additional benefit is that the technique enables you to specify arbitrarily small peaks
resulting from the Gibbs phenomenon.

There are two toolbox functions that implement this design technique.

Description Function
Constrained least square multiband FIR filter design fircls
Constrained least square filter design for lowpass and highpass linear firclsl
phase filters

For details on the calling syntax for these functions, see their reference descriptions in
the Function Reference.

Basic Lowpass and Highpass CLS Filter Design

The most basic of the CLS design functions, fircls1l, uses this technique to design
lowpass and highpass FIR filters. As an example, consider designing a filter with order 61
impulse response and cutoff frequency of 0.3 (normalized). Further, define the upper and
lower bounds that constrain the design process as:

* Maximum passband deviation from 1 (passband ripple) of 0.02.
* Maximum stopband deviation from 0 (stopband ripple) of 0.008.

_m_(\_ _m T =002 Y N & =0008
SEVAVI. v & v s

To approach this design problem using fircls1, use the following commands:

n = 61;

wo = 0.3;
dp = 0.02;
ds = 0.008;

h = firclsl(n,wo,dp,ds);
fvtool(h,1)
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Note that the y-axis shown below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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Multiband CLS Filter Design

fircls uses the same technique to design FIR filters with a specified piecewise constant
magnitude response. In this case, you can specify a vector of band edges and a
corresponding vector of band amplitudes. In addition, you can specify the maximum

amount of ripple for each band.
For example, assume the specifications for a filter call for:

From 0 to 0.3 (normalized): amplitude 0, upper bound 0.005, lower bound -0.005
From 0.3 to 0.5: amplitude 0.5, upper bound 0.51, lower bound 0.49

From 0.5 to 0.7: amplitude 0, upper bound 0.03, lower bound -0.03

From 0.7 to 0.9: amplitude 1, upper bound 1.02, lower bound 0.98
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* From 0.9 to 1: amplitude 0, upper bound 0.05, lower bound -0.05

Design a CLS filter with impulse response order 129 that meets these specifications:

n = 129;

f=1000.30.50.70.91];
a=1[00.5010];

up = [0.005 0.51 0.03 1.02 0.05];
lo = [-0.005 0.49 -0.03 0.98 -0.05];

h = fircls(n,f,a,up,l0);
fvtool(h,1)

Note that the y-axis shown below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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Weighted CLS Filter Design

Weighted CLS filter design lets you design lowpass or highpass FIR filters with relative
weighting of the error minimization in each band. The fircls1l function enables you to
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specify the passhand and stopband edges for the least squares weighting function, as well
as a constant k that specifies the ratio of the stopband to passband weighting.

For example, consider specifications that call for an FIR filter with impulse response
order of 55 and cutoff frequency of 0.3 (normalized). Also assume maximum allowable
passband ripple of 0.02 and maximum allowable stopband ripple of 0.004. In addition, add
weighting requirements:

» Passband edge for the weight function of 0.28 (normalized)

* Stopband edge for the weight function of 0.32

* Weight error minimization 10 times as much in the stopband as in the passband

To approach this using firclsl, type

n = 55;

wo = 0.3;
dp = 0.02;
ds = 0.004;
wp = 0.28;
ws = 0.32;

k = 10;
h = firclsl(n,wo,dp,ds,wp,ws,K);
fvtool(h,1)

Note that the y-axis shown below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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Magnitude Response (squared)
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Arbitrary-Response Filter Design

The cfirpm filter design function provides a tool for designing FIR filters with arbitrary
complex responses. It differs from the other filter design functions in how the frequency
response of the filter is specified: it accepts the name of a function which returns the

filter response calculated over a grid of frequencies. This capability makes cfirpm a
highly versatile and powerful technique for filter design.

This design technique may be used to produce nonlinear-phase FIR filters, asymmetric

frequency-response filters (with complex coefficients), or more symmetric filters with
custom frequency responses.

The design algorithm optimizes the Chebyshev (or minimax) error using an extended
Remez-exchange algorithm for an initial estimate. If this exchange method fails to obtain

the optimal filter, the algorithm switches to an ascent-descent algorithm that takes over to
finish the convergence to the optimal solution.
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Multiband Filter Design

Consider a multiband filter with the following special frequency-domain characteristics.

Band Amplitude Optimization Weighting
[-1-0.5] [51] 1

[-0.4 +0.3] [2 2] 10

[+0.4 +0.8] [2 1] 5

A linear-phase multiband filter may be designed using the predefined frequency-response
function multiband, as follows:

b =cfirpm(38, [-1 -0.5 -0.4 0.3 0.4 0.8], ...
{'multiband', [512 2 2 11}, [1 10 5]);

For the specific case of a multiband filter, we can use a shorthand filter design notation
similar to the syntax for firpm:

b =cfirpm(38,[-1 -0.5 -0.4 0.3 0.4 0.8],
[512221]1, [110 5]);

As with firpm, a vector of band edges is passed to cfirpm. This vector defines the
frequency bands over which optimization is performed; note that there are two transition
bands, from -0.5 to -0.4 and from 0.3 to 0.4.

In either case, the frequency response is obtained and plotted using linear scale in
FVTool:

fvtool(b,1)

Note that the range of data shown below is (-pi,pi).
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Magnitude Response (dB)
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The filter response for this multiband filter is complex, which is expected because of the
asymmetry in the frequency domain. The impulse response, which you can select from the

FVTool toolbar, is shown below.
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Amplitude

Impulse Response
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Filter Design with Reduced Delay

Consider the design of a 62-tap lowpass filter with a half-Nyquist cutoff. If we specify a
negative offset value to the Lowpass filter design function, the group delay offset for the
design is significantly less than that obtained for a standard linear-phase design. This
filter design may be computed as follows:

b = cfirpm(61,[0 0.5 0.55 1],{'lowpass',-16});

The resulting magnitude response is

fvtool(b,1)

The y-axis is in Magnitude Squared, which you can set by right-clicking on the axis label
and selecting Magnitude Squared from the menu.
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Magnitude Response (squared)
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The group delay of the filter reveals that the offset has been reduced from N/2 to N/2-16
(i.e., from 30.5 to 14.5). Now, however, the group delay is no longer flat in the passband
region. To create this plot, click the Group Delay Response button on the toolbar.
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If we compare this nonlinear-phase filter to a linear-phase filter that has exactly 14.5
samples of group delay, the resulting filter is of order 2*¥14.5, or 29. Using

b =cfirpm(29,[0 0.5 0.55 1], 'lowpass'), the passband and stopband ripple is
much greater for the order 29 filter. These comparisons can assist you in deciding which
filter is more appropriate for a specific application.
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Special Topics in lIR Filter Design

In this section...

“Classic IIR Filter Design” on page 2-42
“Analog Prototype Design” on page 2-42
“Frequency Transformation” on page 2-43
“Filter Discretization” on page 2-45

Classic IIR Filter Design

The classic IIR filter design technique includes the following steps.

1 Find an analog lowpass filter with cutoff frequency of 1 and translate this prototype
filter to the specified band configuration
Transform the filter to the digital domain.

Discretize the filter.

The toolbox provides functions for each of these steps.

Design Task Available functions

Analog lowpass prototype buttap, cheblap, besselap, ellipap, cheb2ap
Frequency transformation 1p21lp, Lp2hp, 1p2bp, 1p2bs

Discretization bilinear, impinvar

Alternatively, the butter, chebyl, cheb2ord, ellip, and besself functions perform
all steps of the filter design and the buttord, cheblord, cheb2ord, and ellipord
functions provide minimum order computation for IIR filters. These functions are
sufficient for many design problems, and the lower level functions are generally not
needed. But if you do have an application where you need to transform the band edges of
an analog filter, or discretize a rational transfer function, this section describes the tools
with which to do so.

Analog Prototype Design

This toolbox provides a number of functions to create lowpass analog prototype filters
with cutoff frequency of 1, the first step in the classical approach to IIR filter design.
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The table below summarizes the analog prototype design functions for each supported
filter type; plots for each type are shown in “IIR Filter Design” on page 2-5.

Filter Type Analog Prototype Function
Bessel [z,p,k] = besselap(n)
Butterworth [z,p,k] = buttap(n)
Chebyshev Type I [z,p,k] = cheblap(n,Rp)
Chebyshev Type II [z,p,k] = cheb2ap(n,Rs)
Elliptic [z,p,k] = ellipap(n,Rp,Rs)

Frequency Transformation

The second step in the analog prototyping design technique is the frequency
transformation of a lowpass prototype. The toolbox provides a set of functions to
transform analog lowpass prototypes (with cutoff frequency of 1 rad/s) into bandpass,
highpass, bandstop, and lowpass filters with the specified cutoff frequency.

Frequency Transformation

Transformation Function

Lowpass to lowpass

s'=s/a,

[numt,dent] = 1p2lp (num,den,Wo)
[At,Bt,Ct,Dt]

1p2lp (A,B,C,D,Wo)

Lowpass to highpass

[numt,dent] 1p2hp (num,den,Wo)

[At,Bt,Ct,Dt] = lp2hp (A,B,C,D,Wo)

Lowpass to bandpass

B, s/ay

S,_&(s/wo)2+1

[numt,dent] 1p2bp (num,den,Wo,Bw)

[At,Bt,Ct,Dt]

1p2bp (A,B,C,D,Wo,Bw)

Lowpass to bandstop

_By_slay

S

@ (s/ wy)?+1

[numt,dent] 1p2bs (num,den,Wo,Bw)

[At,Bt,Ct,Dt] lp2bs( A,B,C,D,Wo,Bw)
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2-44

As shown, all of the frequency transformation functions can accept two linear system
models: transfer function and state-space form. For the bandpass and bandstop cases

@) = o0,
and
B, =wy—ay
where w; is the lower band edge and w, is the upper band edge.

The frequency transformation functions perform frequency variable substitution. In the
case of Lp2bp and 1p2bs, this is a second-order substitution, so the output filter is twice
the order of the input. For 1p21p and 1p2hp, the output filter is the same order as the
input.

To begin designing an order 10 bandpass Chebyshev Type I filter with a value of 3 dB for
passband ripple, enter

[z,p,k] = cheblap(10,3);

Outputs z, p, and k contain the zeros, poles, and gain of a lowpass analog filter with
cutoff frequency Q. equal to 1 rad/s. Use the function to transform this lowpass prototype
to a bandpass analog filter with band edges Q; = /5 and Q, = m. First, convert the filter
to state-space form so the 1p2bp function can accept it:

[A,B,C,D] = zp2ss(z,p,k); % Convert to state-space form.

Now, find the bandwidth and center frequency, and call 1p2bp:

ul = 0.1*%2%pi;

u2 = 0.5%2%pi; % In radians per second
Bw = u2-ul;

Wo = sqrt(ul*u2);

[At,Bt,Ct,Dt] = 1p2bp(A,B,C,D,Wo,Bw);
Finally, calculate the frequency response and plot its magnitude:

[b,a] = ss2tf(At,Bt,Ct,Dt);

w = linspace(0.01,1,500)*2*pi;
h = freqs(b,a,w);
semilogy(w/2/pi,abs(h))

Convert to TF form
Generate frequency vector
Compute frequency response
Plot log magnitude vs. freq

o® o o o°
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Filter Discretization
The third step in the analog prototyping technique is the transformation of the filter to

the discrete-time domain. The toolbox provides two methods for this: the impulse
invariant and bilinear transformations. The filter design functions butter, chebyl,
cheby?2, and ellip use the bilinear transformation for discretization in this step.
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Analog to Digital Transformation Function

Transformation

Impulse invariance [numd,dend] = impinvar (num,den,fs)
Bilinear transform [zd,pd,kd] = bilinear (z,p,k,fs,Fp)

[numd,dend] = bilinear (num,den,fs,Fp)

[Ad,Bd,Cd,Dd] = bilinear (At,Bt,Ct,Dt,fs,Fp)

Impulse Invariance

The toolbox function impinvar creates a digital filter whose impulse response is the
samples of the continuous impulse response of an analog filter. This function works only
on filters in transfer function form. For best results, the analog filter should have
negligible frequency content above half the sampling frequency, because such high-
frequency content is aliased into lower bands upon sampling. Impulse invariance works
for some lowpass and bandpass filters, but is not appropriate for highpass and bandstop
filters.

Design a Chebyshev Type I filter and plot its frequency and phase response using FVTool:

[bz,az] = impinvar(b,a,?2);
fvtool(bz,az)

Click the Magnitude and Phase Response toolbar button.




Special Topics in lIR Filter Design

Magnitude (dB)
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Impulse invariance retains the cutoff frequencies of 0.1 Hz and 0.5 Hz.

Bilinear Transformation

The bilinear transformation is a nonlinear mapping of the continuous domain to the
discrete domain; it maps the s-plane into the z-plane by

H(z)= H(s)

z-1

S=R——

z+1

Bilinear transformation maps the jQ-axis of the continuous domain to the unit circle of the

discrete domain according to

o=2tan"! (9)
k
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The toolbox function bilinear implements this operation, where the frequency warping
constant k is equal to twice the sampling frequency (2*fs) by default, and equal to

2nf, / tan(n o/ 15 ) if you give bilinear a trailing argument that represents a “match”
frequency Fp. If a match frequency Fp (in hertz) is present, bilinear maps the
frequency Q = 2mf, (in rad/s) to the same frequency in the discrete domain, normalized to
the sampling rate: w = 2mf,/f; (in rad/sample).

The bilinear function can perform this transformation on three different linear system
representations: zero-pole-gain, transfer function, and state-space form. Try calling
bilinear with the state-space matrices that describe the Chebyshev Type I filter from
the previous section, using a sampling frequency of 2 Hz, and retaining the lower band
edge of 0.1 Hz:

[Ad,Bd,Cd,Dd] = bilinear(At,Bt,Ct,Dt,2,0.1);
The frequency response of the resulting digital filter is

[bz,az] = ss2tf(Ad,Bd,Cd,Dd); % Convert to TF
fvtool(bz,az)

Click the Magnitude and Phase Response toolbar button.
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Magnitude Response (dB) and Phase Response
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The lower band edge is at 0.1 Hz as expected. Notice, however, that the upper band edge
is slightly less than 0.5 Hz, although in the analog domain it was exactly 0.5 Hz. This
illustrates the nonlinear nature of the bilinear transformation. To counteract this
nonlinearity, it is necessary to create analog domain filters with “prewarped” band edges,
which map to the correct locations upon bilinear transformation. Here the prewarped
frequencies ul and u2 generate Bw and Wo for the 1p2bp function:

fs = 2; %

ul = 2*¥fs*tan(0.1*(2*pi/fs)/2); % Lower band edge (rad/s)
u2 = 2*¥fs*tan(0.5*(2*pi/fs)/2); % Upper band edge (rad/s)
Bw = u2 - ul; % Bandwidth

Wo = sqrt(ul*u2); % Center frequency

[At,Bt,Ct,Dt] = lp2bp(A,B,C,D,Wo,Bw);

Sampling frequency (hertz)

A digital bandpass filter with correct band edges 0.1 and 0.5 times the Nyquist frequency

1S

[Ad,Bd,Cd,Dd] = bilinear(At,Bt,Ct,Dt,fs);
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The example bandpass filters from the last two sections could also be created in one
statement using the complete IIR design function chebyl. For instance, an analog version
of the example Chebyshev filter is

[b,a]l = chebyl(5,3,[0.1 0.5]1*2*pi,'s");

Note that the band edges are in rad/s for analog filters, whereas for the digital case,
frequency is normalized:

[bz,az] = chebyl(5,3,[0.1 0.5]);

All of the complete design functions call bilinear internally. They prewarp the band
edges as needed to obtain the correct digital filter.
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Filtering Data With Signal Processing Toolbox Software
Lowpass FIR Filter - Window Method

This example shows how to design and implement an FIR filter using two command line
functions, firl and designfilt, and the interactive Filter Designer app.

Create a signal to use in the examples. The signal is a 100 Hz sine wave in additive

N(0.1/4) \hite Gaussian noise. Set the random number generator to the default state
for reproducible results.

rng default

Fs = 1000;
t linspace(0,1,Fs);
X CoS(2*pi*100*t)+0.5*randn(size(t));

The filter design is an FIR lowpass filter with order equal to 20 and a cutoff frequency of
150 Hz. Use a Kaiser window with length one sample greater than the filter order and

/=3 See kaiser for details on the Kaiser window.

Use firl to design the filter. Tirl requires normalized frequencies in the interval [0,1],

where 1 corresponds to # rad/sample. To use firl, you must convert all frequency
specifications to normalized frequencies.

Design the filter and view the filter's magnitude response.

fc 150;
Wn (2/Fs)*fc;
b = firl(20,Wn, 'low',kaiser(21,3));

fvtool(b,1,'Fs',Fs)
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Apply the filter to the signal and plot the result for the first ten periods of the 100 Hz
sinusoid.

y = filter(b,1,x);

plot(t,x,t,y)
xlim([0 0.1])

xlabel('Time (s)")

ylabel('Amplitude")
legend('Original Signal', 'Filtered Data')
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Amplitude
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Design the same filter using designfilt. Set the filter response to ' lowpassfir' and

input the specifications as Name, Value pairs. With designfilt, you can specify your
filter design in Hz.

Fs
Hd

1000;
designfilt('lowpassfir', 'FilterOrder',20, 'CutoffFrequency',150,
'DesignMethod', 'window', 'Window', {@kaiser, 3}, 'SampleRate',Fs);

Filter the data and plot the result.
yl = filter(Hd,x);

plot(t,x,t,yl)
xlim([0 0.1])
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xLlabel('Time (s)"')
ylabel('Amplitude")
legend('Original Signal', 'Filtered Data')
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Lowpass FIR Filter with Filter Designer

This example shows how to design and implement a lowpass FIR filter using the window
method with the interactive Filter Designer app.

» Start the app by entering filterDesigner at the command line.
* Set the Response Type to Lowpass.
* Set the Design Method to FIR and select the Window method.
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* Under Filter Order, select Specify order. Set the order to 20.
* Under Frequency Specifications, set Units to Hz, Fs to 1000, and Fc to 150.

f ™y
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* Click Design Filter.

* Select File > Export... to export your FIR filter to the MATLAB® workspace as
coefficients or a filter object. In this example, export the filter as an object. Specify the
variable name as Hd.
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i N
|4 Export = %
— Export To
Workspace -
— Export Az
Objects =

— “ariable Hames

Dizcrete Fiter:  |Hd

|:| Owerwrite Wariables

[Expnrt] [C.Ins.e] [ Help ]

* Click Export.

+ Filter the input signal in the command window with the exported filter object. Plot the
result for the first ten periods of the 100 Hz sinusoid.

y2 = filter(Hd,x);

plot(t,x,t,y2)
x1im([0® 0.1])

xlabel('Time (s)')

ylabel('Amplitude")
legend('Original Signal', 'Filtered Data')
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* Select File > Generate MATLAB Code > Filter Design Function to generate a
MATLAB function to create a filter object using your specifications.
You can also use the interactive tool filterBuilder to design your filter.

Bandpass Filters - Minimum-Order FIR and IIR Systems

This example shows how to design a bandpass filter and filter data with minimum-order
FIR equiripple and IIR Butterworth filters. You can model many real-world signals as a
superposition of oscillating components, a low-frequency trend, and additive noise. For
example, economic data often contain oscillations, which represent cycles superimposed
on a slowly varying upward or downward trend. In addition, there is an additive noise
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component, which is a combination of measurement error and the inherent random
fluctuations in the process.

In these examples, assume you sample some process every day for one year. Assume the
process has oscillations on approximately one-week and one-month scales. In addition,

there is a low-frequency upward trend in the data and additive N{0.1/4) white Gaussian

noise.

Create the signal as a superposition of two sine waves with frequencies of 1/7 and 1/30

cycles/day. Add a low-frequency increasing trend term and N(0.1/4) white Gaussian
noise. Reset the random number generator for reproducible results. The data is sampled
at 1 sample/day. Plot the resulting signal and the power spectral density (PSD) estimate.

rng default

Fs = 1;
n = 1:365;

X = CO0S(2*pi*(1/7)*n)+cos(2*pi*(1/30)*n-pi/4);
trend = 3*sin(2*pi*(1/1480)*n);

y = x+trend+0.5*randn(size(n));
[pxx,f] = periodogram(y,[],[],Fs);

subplot(2,1,1)
plot(n,y)
xlim([1 365])
xlabel('Days")
grid

subplot(2,1,2)
plot(f,10*1ogl0O(pxx))
xlabel('Cycles/day")
ylabel('dB")

grid
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The low-frequency trend appears in the power spectral density estimate as increased low-
frequency power. The low-frequency power appears approximately 10 dB above the
oscillation at 1/30 cycles/day. Use this information in the specifications for the filter
stopbands.

Design minimum-order FIR equiripple and IIR Butterworth filters with the following
specifications: passband from [1/40,1/4] cycles/day and stopbands from [0,1/60] and
[1/4,1/2] cycles/day. Set both stopband attenuations to 10 dB and the passband ripple

tolerance to 1 dB.

Hd1l = designfilt('bandpassfir’,
'StopbandFrequencyl’

,1/60, 'PassbandFrequencyl’

,1/40,

'PassbandFrequency2',1/4 ,'StopbandFrequency2',1/2 , ...

'StopbandAttenuationl’

,10, 'PassbandRipple’', 1,
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'StopbandAttenuation2',10, 'DesignMethod', 'equiripple', 'SampleRate',Fs);
Hd2 = designfilt('bandpassiir’, .

'StopbandFrequencyl',1/60, 'PassbandFrequencyl',1/40,

'PassbandFrequency2',1/4 ,'StopbandFrequency2',1/2 ,

'StopbandAttenuationl', 10, 'PassbandRipple’',1,

'StopbandAttenuation2',10, 'DesignMethod', 'butter', 'SampleRate',Fs);

Compare the order of the FIR and IIR filters and the unwrapped phase responses.
fprintf('The order of the FIR filter is %d\n',filtord(Hd1l))

The order of the FIR filter is 78

fprintf('The order of the IIR filter is %d\n',filtord(Hd2))

The order of the IIR filter is 8

[phifir,w] = phasez(Hd1,[]1,1);
[phiiir,w] = phasez(Hd2,[]1,1);
figure

plot(w,unwrap(phifir))

hold on

plot(w,unwrap(phiiir))

hold off

xlabel('Cycles/Day")

ylabel('Radians')

legend('FIR Equiripple Filter','IIR Butterworth Filter')
grid
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The IIR filter has a much lower order that the FIR filter. However, the FIR filter has a
linear phase response over the passhand, while the IIR filter does not. The FIR filter
delays all frequencies in the filter passband equally, while the IIR filter does not.

Additionally, the rate of change of the phase per unit of frequency is greater in the FIR
filter than in the IIR filter.

Design a lowpass FIR equiripple filter for comparison. The lowpass filter specifications
are: passband [0,1/4] cycles/day, stopband attenuation equal to 10 dB, and the passband
ripple tolerance set to 1 dB.

Hdlow = designfilt('lowpassfir',
'PassbandFrequency',1/4, 'StopbandFrequency',1/2,
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'PassbandRipple’', 1, 'StopbandAttenuation', 10,
'DesignMethod’', 'equiripple’', 'SampleRate',1);

Filter the data with the bandpass and lowpass filters.

yfir = filter(Hdl,y);
yiir = filter(Hd2,y);
ylow = filter(Hdlow,y);

Plot the PSD estimate of the bandpass IIR filter output. You can replace yiir with yfir
in the following code to view the PSD estimate of the FIR bandpass filter output.

[pxx,f] = periodogram(yiir,[]1,[1,Fs);
plot(f,10*1ogl0O(pxx))
xlabel('Cycles/day")

ylabel('dB")
grid
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The PSD estimate shows the bandpass filter attenuates the low-frequency trend and high-
frequency noise.

Plot the first 120 days of FIR and IIR filter output.

plot(n,yfir,n,yiir)

axis([1 120 -2.8 2.8])
xlabel('Days"')
legend('FIR bandpass filter output',

'"Location'

, 'SouthEast')

'IIR bandpass filter output',
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The increased phase delay in the FIR filter is evident in the filter output.

Plot the lowpass FIR filter output superimposed on the superposition of the 7-day and 30-
day cycles for comparison.

plot(n,x,n,ylow)
xlim([1 365])

xlabel('Days"')
legend('7-day and 30-day cycles', 'FIR lowpass filter output', ...

'"Location', 'NorthWest"')
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You can see in the preceding plot that the low-frequency trend is evident in the lowpass
filter output. While the lowpass filter preserves the 7-day and 30-day cycles, the bandpass
filters perform better in this example because the bandpass filters also remove the low-
frequency trend.

Zero-Phase Filtering
This example shows how to perform zero-phase filtering.

Repeat the signal generation and lowpass filter design with firl and designfilt. You
do not have to execute the following code if you already have these variables in your
workspace.
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rng default

Fs = 1000;
t linspace(0,1,Fs);
CoS(2*pi*100*t)+0.5*randn(size(t));

X

% Using firl

fc = 150;
Wn = (2/Fs)*fc;
b = firl(20,Wn, 'low',kaiser(21,3));

% Using designfilt
Hd = designfilt('lowpassfir', 'FilterOrder',20, 'CutoffFrequency', 150,
'DesignMethod', 'window', 'Window', {@kaiser,3}, 'SampleRate',Fs);

Filter the data using filter. Plot the first 100 points of the filter output along with a
superimposed sinusoid with the same amplitude and initial phase as the input signal.

yout = filter(Hd,x);
xin = cos(2*pi*100*t);

plot(t,xin,t,yout)
xlim([0 0.1])

xlabel('Time (s)')

ylabel('Amplitude")

legend('Input Sine Wave', 'Filtered Data')
grid
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Looking at the initial 0.01 seconds of the filtered data, you see that the output is delayed
with respect to the input. The delay appears to be approximately 0.01 seconds, which is

almost 1/2 the length of the FIR filter in samples | 10 * 0001}

This delay is due to the filter's phase response. The FIR filter in these examples is a type I
linear-phase filter. The group delay of the filter is 10 samples.

Plot the group delay using fvtool.

fvtool(Hd, 'Analysis', 'grpdelay')
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Group delay (in samples)
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In many applications, phase distortion is acceptable. This is particularly true when phase
response is linear. In other applications, it is desirable to have a filter with a zero-phase
response. A zero-phase response is not technically possibly in a noncausal filter. However,
you can implement zero-phase filtering using a causal filter with filtfilt.

Filter the input signal using filtfilt. Plot the responses to compare the filter outputs
obtained with filter and filtfilt.

yzp = filtfilt(Hd,x);
plot(t,xin,t,yout,t,yzp)

x1im([0 0.1])
xlabel('Time (s)')



Filtering Data With Signal Processing Toolbox Software

Amplitude

ylabel('Amplitude")
legend('100-Hz Sine Wave', 'Filtered Signal', 'Zero-phase Filtering',
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In the preceding figure, you can see that the output of filtfilt does not exhibit the
delay due to the phase response of the FIR filter.
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Process Flow Diagram and Filter Design Methodology

3-2

In this section...

“Exploring the Process Flow Diagram” on page 3-2
“Selecting a Response” on page 3-4

“Selecting a Specification” on page 3-4

“Selecting an Algorithm” on page 3-5

“Customizing the Algorithm” on page 3-7

“Designing the Filter” on page 3-7

“Design Analysis” on page 3-8

“Realize or Apply the Filter to Input Data” on page 3-9

Note You must minimally have the Signal Processing Toolbox installed to use fdesign
and design. Some of the features described below may be unavailable if your installation
does not additionally include the DSP System Toolbox™ license. The DSP System Toolbox
significantly expands the functionality available for the specification, design, and analysis
of filters. You can verify the presence of both toolboxes by typing ver at the command
prompt.

Exploring the Process Flow Diagram

The process flow diagram shown in the following figure lists the steps and shows the
order of the filter design process.
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help dfit/fiter

__________________________

Fepumseepueseesnnrneenwweel
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The first four steps of the filter design process relate to the filter Specifications Object,
while the last two steps involve the filter Implementation Object. Both of these objects are
discussed in more detail in the following sections. Step 5 - the design of the filter, is the
transition step from the filter Specifications Object to the Implementation object. The
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analysis and verification step is completely optional. It provides methods for the filter
designer to ensure that the filter complies with all design criteria. Depending on the
results of this verification, you can loop back to steps 3 and 4, to either choose a different
algorithm, or to customize the current one. You may also wish to go back to steps 3 or 4
after you filter the input data with the designed filter (step 7), and find that you wish to
tweak the filter or change it further.

The diagram shows the help command for each step. Enter the help line at the MATLAB
command prompt to receive instructions and further documentation links for the
particular step. Not all of the steps have to be executed explicitly. For example, you could
go from step 1 directly to step 5, and the interim three steps are done for you by the
software.

The following are the details for each of the steps shown above.

Selecting a Response
If you type:
help fdesign/responses

at the MATLAB command prompt, you see a list of all available filter responses. The
responses marked with an asterisk require the DSP System Toolbox.

You must select a response to initiate the filter. In this example, a bandpass filter
Specifications Object is created by typing the following:

d = fdesign.bandpass

Selecting a Specification

A specification is an array of design parameters for a given filter. The specification is a
property of the Specifications Object.

Note A specification is not the same as the Specifications Object. A Specifications Object
contains a specification as one of its properties.

When you select a filter response, there are a number of different specifications available.
Each one contains a different combination of design parameters. After you create a filter
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Specifications Object, you can query the available specifications for that response.
Specifications marked with an asterisk require the DSP System Toolbox.

d = fdesign.bandpass;
set(d, 'specification')

ans =

'"Fstl,Fpl,Fp2,Fst2,Astl,Ap,Ast2’
'N,F3dB1,F3dB2'
'N,F3dB1,F3dB2,Ap'

"N, F3dB1,F3dB2,Ast'
'N,F3dB1,F3dB2,Astl,Ap,Ast2’
'N,F3dB1,F3dB2,BwWp"'
'N,F3dB1,F3dB2,BWst"
"N,Fcl,Fc2'

'N,Fpl,Fp2,Ap'
"N,Fpl,Fp2,Astl,Ap,Ast2’
"N,Fstl,Fpl,Fp2,Fst2’
"N,Fstl,Fpl,Fp2,Fst2,Ap’'
'N,Fstl,Fst2,Ast"
'Nb,Na,Fstl,Fpl,Fp2,Fst2'

d = fdesign.arbmag;
set(d, 'specification')

ans =

The set command can be used to select one of the available specifications as follows:

d = fdesign.lowpass;
set(d, 'specification', 'N,Fc")

If you do not perform this step explicitly, fdesign returns the default specification for the
response you chose in “Select a Response” on page 4-2, and provides default values for
all design parameters included in the specification.

Selecting an Algorithm

The availability of algorithms depends the chosen filter response, the design parameters,
and the availability of the DSP System Toolbox. In other words, for the same lowpass
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filter, changing the specification also changes the available algorithms. In the following
example, for a lowpass filter and a specification of 'N, Fc', only one algorithm is
available—window.

set (d, 'specification', 'N,Fc')
designmethods (d) %step3: get available algorithms

Design Methods for class fdesign.lowpass (N,Fc):

window

However, for a specification of 'Fp,Fst,Ap,Ast’, a number of algorithms are available.
If the user has only the Signal Processing Toolbox installed, the following algorithms are
available:

set(d, 'specification', 'Fp,Fst,Ap,Ast"')
designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter
chebyl
cheby?
ellip
equiripple
kaiserwin

If the user additionally has the DSP System Toolbox installed, the number of available
algorithms for this response and specification increases:

set(d, 'specification', 'Fp,Fst,Ap,Ast"')
designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter
chebyl
cheby?2
ellip
equiripple
ifir
kaiserwin
multistage
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The user chooses a particular algorithm and implements the filter with the design
function.

Hd=design(d, 'butter');

The preceding code actually creates the filter. If you do not perform this step explicitly,
design automatically selects the optimum algorithm for the chosen response and
specification.

Customizing the Algorithm

The customization options available for any given algorithm depend not only on the
algorithm itself, selected in “Selecting an Algorithm” on page 3-5, but also on the
specification selected in “Selecting a Specification” on page 3-4. To explore all the
available options, type the following at the MATLAB command prompt:

help(d, 'algorithm-name")

where d is the Filter Specification Object, and algorithm-name is the name of the
algorithm in single quotes, such as 'butter' or 'chebyl’.

The application of these customization options takes place while “Designing the Filter” on
page 3-7, because these options are the properties of the filter Implementation Object,
not the Specification Object.

If you do not perform this step explicitly, the optimum algorithm structure is selected.

Designing the Filter

To create a filter, use the design command:
Hd = design(d);

where d is the Specifications Object. This code creates a filter without specifying the
algorithm. When the algorithm is not specified, the software selects the best available
one.

To apply the algorithm chosen in “Selecting an Algorithm” on page 3-5, use the same
design command, but specify the Butterworth algorithm as follows:

Hd = design(d, 'butter');

To obtain help and see all the available options, type:
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help fdesign/design

This help command describes not only the options for the design command itself, but
also options that pertain to the method or the algorithm. If you are customizing the
algorithm, you apply these options in this step. In the following example, you design a
bandpass filter, and then modify the filter structure:

Hd

design(d, 'butter', 'FilterStructure', 'df2sos")
Hd =
FilterStructure: 'Direct-Form II, Second-Order Sections'
Arithmetic: 'double'
sosMatrix: [13x6 double]
ScaleValues: [14x1 double]

OptimizeScaleValues: true
PersistentMemory: false

The filter design step, just like the first task of choosing a response, must be performed

explicitly. The filter is created only when design is called.

Design Analysis

After the filter is designed you may wish to analyze it to determine if the filter satisfies the
design criteria. Filter analysis is broken into three main sections:

* Frequency domain analysis — Includes the magnitude response, group delay, and pole-
zero plots.

* Time domain analysis — Includes impulse and step response
* Implementation analysis — Includes quantization noise and cost

To display help for analysis of a discrete-time filter, type:
>> help dfilt/analysis

To display help for analysis of a farrow filter, type:

>> help farrow/functions

To analyze your filter, you must explicitly perform this step.
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Realize or Apply the Filter to Input Data

After the filter is designed and optimized, it can be used to filter actual input data. The
basic filter command takes input data X, filters it through the Filter Object, and produces
output y:

>> y = filter (FilterObj, x)

This step is never automatically performed for you. To filter your data, you must explicitly
execute this step. To understand how the filtering commands work, type:

>> help dfilt/filter

Note If you have Simulink®, you have the option of exporting this filter to a Simulink
block using the realizemdl command. To get help on this command, type:

>> help realizemdl

3-9
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* “Filter Builder Design Process” on page 4-2

* “Designing a FIR Filter Using filterBuilder” on page 4-10

* “Compensate for Delay and Distortion Introduced by Filters” on page 4-13
* “Comparison of Analog IIR Lowpass Filters” on page 4-20

* “Frequency Response of a Lowpass Bessel Filter” on page 4-22

» “Speaker Crossover Filters” on page 4-24



4 Designing a Filter in the Filter Builder GUI

Filter Builder Design Process

4-2

In this section...

“Introduction to Filter Builder” on page 4-2

“Design a Filter Using Filter Builder” on page 4-2
“Select a Response” on page 4-2

“Select a Specification” on page 4-5

“Select an Algorithm” on page 4-5

“Customize the Algorithm” on page 4-6

“Analyze the Design” on page 4-8

“Realize or Apply the Filter to Input Data” on page 4-8

Introduction to Filter Builder

The filterBuilder function provides a graphical interface to the fdesign object-
oriented filter design paradigm and is intended to reduce development time during the
filter design process. filterBuilder uses a specification-centered approach to find the
best algorithm for the desired response.

Note filterBuilder requires the Signal Processing Toolbox. The DSP System Toolbox
product greatly expands the functionality of filterBuilder. Many of the features
described or displayed on this page are only available if the DSP System Toolbox is
installed. You may verify your installation by typing ver at the command prompt.

Design a Filter Using Filter Builder

The basic workflow in using filterBuilder is to choose the constraints and
specifications of the filter, and to use those constraints as a starting point in the design.
Postponing the choice of algorithm for the filter allows the best design method to be
determined automatically, based on the desired performance criteria. The following are
the details of each of the steps for designing a filter with filterBuilder.

Select a Response

When you open the filterBuilder tool by typing:
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filterBuilder

at the MATLAB command prompt, the Response Selection dialog box appears, listing all
possible filter responses available in DSP System Toolbox.

i ™
u Response Selection L == éj

Select a fiter response:

Lowpass -
Highpass

Bandpass

Bandstop

Differentiator

Hilbert Transformer

Arbitrary Response

Pulse Shaping

OK l [ Cancel

Note This step cannot be skipped because it is not automatically completed for you by
the software. You must select a response to initiate the filter design process.

After you choose a response, say bandpass, you start the design of the Specifications
Object, and the Bandpass Design dialog box appears. This dialog box contains a Main
pane, a Data Types pane, and a Code Generation pane. The specifications of your filter
are generally set in the Main pane of the dialog box.

The Data Types pane provides settings for precision and data types, and the Code
Generation pane contains options for various implementations of the completed filter
design.

For the initial design of your filter, you mostly use the Main pane.
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Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: IFIR v]

Order mode: l Minimum - ]

Frequency specifications

Frequency units: lNormaiized (0to 1) V]

Stopband frequency 1: .35 Passband frequency 1: .45

Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB

Stopband attenuation 1: 60 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: | Equiripple

» Design options

Filter implementation

Structure: | Direct-form FIR

The Bandpass Design dialog box contains all the parameters necessary to determine the
specifications of a bandpass filter. The parameters listed in the Main pane depend upon
the type of filter you are designing. However, no matter what type of filter you have
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chosen in the Response Selection dialog box, the filter design dialog box contains the
Main, Data Types, and Code Generation panes.

Select a Specification

To choose the specification for the bandpass filter, you can begin by selecting an Impulse
Response, Order Mode, and Filter Type in the Filter Specifications frame of the
Main Pane. You can further specify the response of your filter by setting frequency and
magnitude specifications in the appropriate frames on the Main Pane.

Note Frequency, Magnitude, and Algorithm specifications are interdependent and
might change based on your Filter Specifications selections. When choosing
specifications for your filter, select your Filter Specifications first and work your way
down the dialog box. This approach ensures that the best settings for dependent
specifications display as available in the dialog box.

Select an Algorithm

The algorithms available for your filter depend upon the filter response and design
parameters you have selected in the previous steps. For example, in the case of a
bandpass filter, if the impulse response selected is IIR and the Order Mode field is set to
Minimum, the design methods available are Butterworth, Chebyshev type I or II, or
Elliptic. If the Order Mode field is set to Specify, the design method available is IIR
least p-norm.
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Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: ’I[R v]

Order mode: l Minimum - ]

Frequency specifications

Frequency units: lNormaiized (0to 1) V]

Stopband frequency 1: .35 Passband frequency 1: .45

Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB

Stopband attenuation 1: 60 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: |Butterworth

» Design options

Filter implementation

Structure: | Direct-form I SOS

Customize the Algorithm

By expanding the Design options section of the Algorithm frame, you can further
customize the algorithm specified. The options available depend upon the algorithm and
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settings that have already been selected in the dialog box. In the case of a bandpass IIR
filter using the Butterworth method, design options such as Match Exactly are
available, as shown in the following figure.

© ™
G L e

Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: [I[R 'l

Order mode: [Minimum - l

Frequency specifications

Frequency units: [Normaiized (0 to 1) ']

Stopband frequency 1: .35 Passband frequency 1: .45

Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB

Stopband attenuation 1: &0 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: [Buﬂemorth

¥ Design options

Match exactly: [Stopband

Filter implementation

Structure: [Direct—form 11505
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Analyze the Design

To analyze the filter response, click the View Filter Response button. The Filter
Visualization Tool opens displaying the magnitude plot of the filter response.

u Filter Visualization Tool - Figure 1: Magnitude Response (dB) l =N X
File Edit Analysis Insert View Debug Desktop Window Help A x
D&R|LK|OTNNN\ 4| & <« &0 EE =] ]

EI R # 2 0 Bkl 0
Figure 1: Magnitude Response (dB)
Magnitude Response (dB)

50 / \

100 / | \ ]

150} / \‘\ .

Magnitude (dB)

200/ L.

0 0.1 0.2 03 04 0.5 068 07 08 08
Normalized Frequency ( =« rad/sample)

Realize or Apply the Filter to Input Data

When you have achieved the desired filter response through design iterations and
analysis using the Filter Visualization Tool, apply the filter to the input data. Again, this
step is never automatically performed for you by the software. To filter your data, you
must explicitly execute this step. In the Bandpass Design dialog box, click OK and the
Signal Processing Toolbox software creates the filter coefficients and exports it to the
MATLAB workspace.
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The filter is then ready to be used to filter actual input data. The basic filter command
takes input data x, filters it through the Filter Object, and produces output y:

y = filter(Hbs,x)
To understand how the filtering command works, type:

help dfilt/filter

Tip If you have Simulink, you have the option of exporting this filter to a Simulink block
using the realizemdl command. To get help on this command, type:

help realizemdl
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Designing a FIR Filter Using filterBuilder

4-10

FIR Filter Design

Example 4.1. Example - Using Filter Builder to Design an FIR Filter

To design a lowpass finite impulse response (FIR) filter using filterBuilder:

1 Open the Filter Builder GUI by typing the following at the MATLAB prompt:
filterBuilder

The Response Selection dialog box appears. In this dialog box, you can select from
a list of filter response types. Select Lowpass in the list box.

=) Response Selectio o ] |

Select a fiter responze:

Bandpazs

Bandstop

Iyoqui=t

Halfhand

Differentistar

Hilbert Transformer
Arbitrary Response
Cazcaded Integrator-Comb
CIC Compensator
Inverse-sinc Lowpass

S [

2  Hit the OK button. The Lowpass Design dialog box opens. Here you can specify the
writable parameters of the Lowpass filter object. The components of the Main frame
of this dialog box are described in the section titled Lowpass Filter Design Dialog Box
— Main Pane. In the dialog box, make the following changes:

* Enter a Fpass value of 0.55.

* Enter a Fstop value of 0.65.



Designing a FIR Filter Using filterBuilder

«): Lowpass Design x|

Lowpass Design
’7 Dezign a lowpasz filker.

Save varable az IHIp Wiew Filker Besponze |

HET | Data Types I Code Generation I

— Filter zpecification

Impulze rezponze:; |F|F| j
Order mode; IM inimum j Drder: I
Filker bpe: ISingIe-rate j

— Frequency specification

Frequency unitz: IanmaIized [Otol] j |put Fs; |2
Fpazs: |.55 Fatop: I.EE

— Magnitude specification

t agnitude unitz: II:IB j
Apag |1 Agtop: IBD
— tulgorithm
Dresign method: IEquirippIe ;I
Skucture: IDilect-fnlm FIR ;I

¥ [Desigh options

Denzity factar: I'I 5
[ Minimum phase

Finirmurm order: I.l’-‘n.n_l,J |
Stopband shape: IFIat LI
Stopband decay: ID

0k I Cancel | Help | Apply

Click Apply, and the following message appears at the MATLAB prompt:

The variable 'Hlp' has been exported to the command window.

To check your design, click View Filter Response. The Filter Visualization tool
appears, showing a plot of the magnitude response of the filter.
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You can change the design and click Apply, followed by View Filter Response, as
many times as needed until your design specifications are met.
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Compensate for Delay and Distortion Introduced by Filters

Compensate for Delay and Distortion Introduced by
Filters

Filtering a signal introduces a delay. This means that the output signal is shifted in time
with respect to the input.

When the shift is constant, you can correct for the delay by shifting the signal in time.

Sometimes the filter delays some frequency components more than others. This
phenomenon is called phase distortion. To compensate for this effect, you can perform
zero-phase filtering using the filtfilt function.

Take an electrocardiogram reading sampled at 500 Hz for 1 s. Add random noise. Reset
the random number generator for reproducible results

Fs = 500;
N = 500;

rng default

xn
tn

ecg(N)+0.1*randn([1 NJ]);
(0:N-1)/Fs;

Remove some of the noise using a filter that stops frequencies above 75 Hz. Use
designfilt to design an FIR filter of order 70.

Nfir = 70;
Fst = 75;

firf = designfilt('lowpassfir','FilterOrder',Nfir,
'CutoffFrequency',Fst, 'SampleRate',Fs);

Filter the signal and plot it. The result is smoother than the original, but lags behind it.
xf = filter(firf,xn);

plot(tn,xn,tn,xf)

title 'Electrocardiogram'

xlabel 'Time (s)'
legend('Original', 'FIR Filtered')
grid
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Electrocardiogram
15 T T T T T T T T T
Criginal
FIR Filtered
1T |'| 7
.'|||
[
0.5 F Il | -
Il]un| | H|
i ar |
]i‘ .I I-’I l | || | H " ijl 'v h {
o B L | | WL IT
i Y d I\| i [ i|'||1 li
|
|
os| | -
|I
|f
_1 i i i i i i i i i
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1
Time (s)

Use grpdelay to check that the delay caused by the filter equals half the filter order.

grpdelay(firf,N,Fs)
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Group delay

35.5 T

354 7

£ B

Group delay (in samples)
&

E
o~

50 100 150 200
Frequency (Hz)

-

delay

mean(grpdelay(firf))

delay = 35

Line up the data. Shift the filtered signal by removing its first delay samples. Remove the
last delay samples of the original and of the time vector.

tt = tn(l:end-delay);
sn = xn(1l:end-delay);
sf = xf;

sf(l:delay) = [];

Plot the signals and verify that they are aligned.
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plot(tt,sn,tt,sf)

title 'Electrocardiogram'

xLlabel('Time (s)')

legend('Original Signal', 'Filtered Shifted Signal')

grid
Electrocardiogram
'1 ; 5 T T T T T T T T T
Original Signal
Filtered Shifted Signal
1k
0.5
051 \ Jl
_1 i i i i i i i i i
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9
Time (s)

Repeat the computation using a 7th-order IIR filter.
Niir = 7;

iir = designfilt('lowpassiir', 'FilterOrder',6Niir,
'HalfPowerFrequency',Fst, 'SampleRate',Fs);

4-16



Compensate for Delay and Distortion Introduced by Filters

Filter the signal. The filtered signal is cleaner than the original, but lags in time with
respect to it. It is also distorted due to the nonlinear phase of the filter.

xfilter = filter(iir,xn);
plot(tn,xn,tn,xfilter)

title 'Electrocardiogram'
xlabel 'Time (s)'
legend('Original', 'Filtered"')
axis([0.25 0.55 -1 1.51])

grid

Electrocardiogram
E 5 T T T T T

Criginal
Filtered

0.25 0.3 0.45 0.5 0.55
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A look at the group delay introduced by the filter shows that the delay is frequency-
dependent.

grpdelay(iir,N,Fs)

Group delay
10 T T T T
."..“'
[
9 | I|I T
8 [ .
1
W x
%_ ir ! I|I T
£ \
c °f / |
- / \
T‘E 51 . I".. 7
g=) | !
(=) R
4 - -
E \\_
] N\
3t \ 1
AN
\\"‘-\.,\_\_
2r s i
1 C i i i i - __
0 50 100 150 200
Frequency (Hz)

Filter the signal using filtfilt. The delay and distortion have been effectively removed.

Use filtfilt when it is critical to keep the phase information of a signal intact.
xfiltfilt = filtfilt(iir,xn);

plot(tn,xn)
hold on

plot(tn,xfilter)
plot(tn,xfiltfilt)
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title 'Electrocardiogram'

xlabel 'Time (s)'

legend('Original’, ' "' 'filter' "', """ "filtfilt'"'")
axis([0.25 0.55 -1 1.5])

grid
Electrocardiogram
1.5 T T T T T
Original
filter
"II filtfilt’
1k _

) II||I .-‘1{ ,."f \l I f N II J‘-'L_ f
Vil Y \| e
f ’ EI l'.lll;‘."h -'I l|lll I" | | | !
} \/ II';\ |IL| I|II I
05+ \1: J||II ,-"II i
\W/
|
_3.25 0.3 0.35 0.4 0.45 0.5 0.55

Time (s)
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Comparison of Analog IIR Lowpass Filters

4-20

Design a 5th-order analog Butterworth lowpass filter with a cutoff frequency of 2 GHz.

Multiply by 27 to convert the frequency to radians per second. Compute the frequency
response of the filter at 4096 points.

n 5;

f = 2e9;

[zb,pb,kb] = butter(n,2*pi*f,'s");
[bb,ab] zp2tf(zb,pb,kb);

[hb,wb] freqs(bb,ab,4096);

Design a Sth-order Chebyshev Type I filter with the same edge frequency and 3 dB of
passband ripple. Compute its frequency response.

[z1,pl,k1l] = chebyl(n,3,2*pi*f,'s");
[bl,al] = zp2tf(zl,pl,kl);
[h1,wl] = freqs(bl,al,4096);

Design a Sth-order Chebyshev Type II filter with the same edge frequency and 30 dB of
stopband attenuation. Compute its frequency response.

[z2,p2,k2] = cheby2(n,30,2*pi*f,'s");
[b2,a2] = zp2tf(z2,p2,k2);
[h2,w2] = freqs(b2,a2,4096);

Design a Sth-order elliptic filter with the same edge frequency, 3 dB of passband ripple,
and 30 dB of stopband attenuation. Compute its frequency response.

[ze,pe,ke] = ellip(n,3,30,2*¥pi*f,'s");
[be,ae] zp2tf(ze,pe,ke);
[he,we] freqs(be,ae,4096);

Plot the attenuation in decibels. Express the frequency in gigahertz. Compare the filters.

plot(wb/(2e9*pi),mag2db(abs(hb)))
hold on
plot(wl/(2e9*pi),mag2db(abs(hl)))
plot(w2/(2e9*pi),mag2db(abs(h2)))
plot(we/(2e9*pi),mag2db(abs(he)))
axis ([0 4 -40 5])

grid



Comparison of Analog IIR Lowpass Filters

Attenuation {dB)

xlabel('Frequency (GHz)"')
ylabel('Attenuation (dB)")
legend('butter', 'chebyl', 'cheby2','ellip")
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Frequency (GHz)

The Butterworth and Chebyshev Type II filters have flat passbands and wide transition
bands. The Chebyshev Type I and elliptic filters roll off faster but have passband ripple.
The frequency input to the Chebyshev Type II design function sets the beginning of the
stopband rather than the end of the passband.
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Frequency Response of a Lowpass Bessel Filter

Design a bth-order analog lowpass Bessel filter with approximately constant group delay

up to 10 rad/s. Plot the magnitude and phase responses of the filter using freqgs.

[b,a] = besself(5,10000);
freqs(b,a)
'||:||:I T T rrrern T '_"—'—I__'__'_\'_I
T
[ak]
=]
=
I=
[y ]
m
=
107° ' '
102 10° 104 10°
Frequency (rad/s)
200 T T
@ 100 [ :
E’ ‘
2 I ~. i
@ T e
n . ]
E 100 b 'm\} 1
-200 . .
102 10° 104 10°

Frequency (rad/s)

Compute the group delay response of the filter as the derivative of the unwrapped phase
response. Plot the group delay to verify that it is approximately constant up to the cutoff

frequency.
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Frequency Response of a Lowpass Bessel Filter

[h,w] = fregs(b,a,1000);
grpdel = diff(unwrap(angle(h)))./diff(w);

clf
semilogx(w(2:end),grpdel)
xlabel('Frequency (rad/s)")

ylabel('Group delay (s)"')

%104

Group delay (s)
r . = .
L 3 o -

i
[ ]
T

/

104

10?
Frequency (rad/s)
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Speaker Crossover Filters

This example shows how to devise a simple model of a digital three-way loudspeaker. The
system splits the audio input into low-, mid-, and high-frequency bands that correspond
respectively to the woofer, the midrange driver, and the tweeter. Typical values for the

normalized crossover frequencies that delimit the bands are 0.136x rad/sample and
0.317x rad/sample.

Create lowpass, bandpass, and highpass filters to generate the low-frequency, mid-
frequency, and high-frequency bands. Specify the frequencies.

lo
hi

0.136;
0.317;

Use a 6th-order Chebyshev Type I design for each filter. Specify a passband ripple of 1
dB, larger than the value for real speakers. The cheby1 function doubles the order of
bandpass designs. Make all filters have the same order by halving the order of the
bandpass filter. Return the zeros, poles, and gain of each filter.

ord = 6;

rip = 1;

[zw,pw, kw] = chebyl(ord,rip,l0);
[zm,pm,km] = chebyl(ord/2,rip,[lo hi]);
[zt,pt,kt] = chebyl(ord,rip,hi, 'high");

Visualize the zeros and poles of the filters.
zplane([zw zm zt], [pw pm pt])

1lg = legend('Woofer', 'Midrange', 'Tweeter');
1g.Box = 'off';
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Imaginary Part

ir ) ’ . Woofer
) ' Midrange

P
L

L

Tweeter
06 b

0.4 | R b4 :
X

Real Part

Woofer: The zeros at == — | suppress high frequencies. The poles enhance the

magnitude response between 0 and the lower crossover frequency.

Midrange: The zeros at = = 0ang z=1 suppress high and low frequencies. The poles
enhance the magnitude response between the lower and higher crossover frequencies.

Tweeter: The zeros at = = | suppress low frequencies. The poles enhance the

magnitude response between the higher crossover frequency and .

Plot the magnitude responses on the unit circle to see the effect of the different poles and
zeros. Use linear units. Represent the filters as second-order sections.
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sw = zp2sos(zw, pw, kw) ;
sm = zp2sos(zm,pm,km);
st = zp2sos(zt,pt,kt);
nf = 1024;

[hw, fw] = freqz(sw,nf, 'whole');
hm = fregz(sm,nf, 'whole');
ht freqz(st,nf, 'whole');

plot3(cos(fw),sin(fw), [abs(hw) abs(hm) abs(ht)])
xlabel('Real"')

ylabel('Imaginary")

view(75,30)

grid

Imaginary
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Plot the magnitude responses in dB using fvtool.

hfvt fvtool(sw,sm,st);
legend (hfvt, 'Woofer', 'Mid-range', 'Tweeter"')

Magnitude Response (dB)
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Load an audio file containing a fragment of Handel's "Hallelujah Chorus" sampled at 8192
Hz. Split the signal into three frequency bands by filtering. Plot the bands.

load

yw
ym
yt

handel

sosfilt(sw,y);
sosfilt(sm,y);
sosfilt(st,y);

% To hear,

To hear,
To hear,
To hear,

o® o° of

type soundsc(y,Fs)
type soundsc(yw,Fs)

type soundsc(ym,Fs)
type soundsc(yt,Fs)
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plot((0:length(y)-1)/Fs,[yw ym yt])
xlabel('Time (s)')

—G_E i i i i i i i i
o 1 2 3 4 o i} T a 9

Time (s)

% To hear all the frequency ranges, type soundsc(yw+ym+yt,Fs)
References
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Hall, 1996.
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5 Filter Designer: A Filter Design and Analysis App

Filter Design Methods

The Filter Designer app is a user interface for designing and analyzing filters quickly.
The app enables you to design digital FIR or IIR filters by setting filter specifications, by
importing filters from your MATLAB workspace, or by adding, moving or deleting poles
and zeros. It also provides tools for analyzing filters, such as magnitude and phase

response and pole-zero plots.

The Filter Designer app gives you access to the following Signal Processing Toolbox

filter design methods.
Design Method Function
Butterworth butter
Chebyshev Type I chebyl
Chebyshev Type II cheby?2
Elliptic ellip
Maximally Flat maxflat
Equiripple firpm
Least-squares firls
Constrained least-squares fircls
Complex equiripple cfirpm
Window firl

When using the window method, all Signal Processing Toolbox window functions are
available, and you can specify a user-defined window by entering its function name and

input parameter.

Advanced Filter Design Methods

The following advanced filter design methods are available if you have DSP System

Toolbox software.

Design Method

Function

Constrained equiripple FIR

firceqrip
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Design Method Function
Constrained-band equiripple FIR fircband
Generalized remez FIR firgr
Equripple halfband FIR firhalfband
Least P-norm optimal FIR firlpnorm
Equiripple Nyquist FIR firnyquist
Interpolated FIR ifir

IIR comb notching or peaking iircomb
Allpass filter (given group delay) iirgrpdelay
Least P-norm optimal IIR iirlpnorm
Constrained least P-norm IIR iirlpnormc
Second-order IIR notch iirnotch
Second-order IIR peaking (resonator) iirpeak
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Using the Filter Designer App

There are different ways that you can design filters using the Filter Designer app. For
example:

* You can first choose a response type, such as bandpass, and then choose from the
available FIR or IIR filter design methods.

* You can specify the filter by its type alone, along with certain frequency- or time-
domain specifications such as passband frequencies and stopband frequencies. The

filter you design is then computed using the default filter design method and filter
order.



Analyzing Filter Responses

Analyzing Filter Responses

Once you have designed your filter, you can display the filter coefficients and detailed
filter information, export the coefficients to the MATLAB workspace, create a C header
file containing the coefficients, and analyze different filter responses in the app or in a
separate Filter Visualization Tool (fvtool). The following filter responses are available:

Magnitude response (freqz)
Phase response (phasez)

Group delay (grpdelay)

Phase delay (phasedelay)
Impulse response (impz)

Step response (stepz)

Pole-zero plots (zplane)
Zero-phase response (zerophase)
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Filter Designer App Panels

The Filter Designer app has sidebar buttons that display particular panels in the lower
half. The panels are:

* Design Filter. See “Choosing a Filter Design Method” on page 5-10 for more
information. You use this panel to
* Design filters from scratch.
* Modify existing filters designed with the app.
* Analyze filters.
* Import filter. You use this panel to
+ Import previously saved filters or filter coefficients that you have stored in the
MATLAB workspace.
* Analyze imported filters.

* Pole/Zero Editor. See “Editing the Filter Using the Pole/Zero Editor” on page 5-15.
You use this panel to add, delete, and move poles and zeros in your filter design.

If you also have DSP System Toolbox product installed, additional panels are available:

* Set quantization parameters — Use this panel to quantize double-precision filters that
you design with Filter Designer, quantize double-precision filters that you import into
the app, and analyze quantized filters.

» Transform filter — Use this panel to change a filter from one response type to another.

* Multirate filter design — Use this panel to create a multirate filter from your existing
FIR design, create CIC filters, and linear and hold interpolators.

If you have Simulink installed, this panel is available:

* Realize Model — Use this panel to create a Simulink block containing the filter
structure.



Getting Help

Getting Help

At any time, you can right-click or click the What's this? button, E to get information.
You can also use the Help menu to see complete Help information.
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Getting Started with Filter Designer

To open the Filter Designer app, type
filterDesigner

at the MATLAB command prompt.

The Filter Designer app opens with the Design Filter panel displayed.



Getting Started with Filter Designer

f ™y

File Edit Analysis Targets View Window Help
DEESE @ idDEONE &0 Bkl W

— Fitter Specifications

rCurrent Fitter Infermation

Mag. (dB)

Structure: Direct-Form FIR
Crder: 50

Stable: Yes

Source: Designed

[ Store Filter ...

[ Fitter Manager ...

—Response Type — __FitterOrder——___ __Frequency Specifications — Magnitude Specifications
© | Lowpass | ) Specify order: |10 Units: |Hz | Unitz: | dB
() Highpass

@ Minimum arder Fs: 48000
() Bandpass Apass |1

(") Bandstop — Options. Fpass 9600

Astop |80

Differentiator | Density Factor: |20 Fstop 12000
|- Design Method

IR | Butterwaorth

@ FIR |Equiripple

De=ign Fitter

Note that when you open Filter Designer, Design Filter is not enabled. You must make
a change to the default filter design in order to enable Design Filter. This is true each
time you want to change the filter design. Changes to radio button items or drop down
menu items such as those under Response Type or Filter Order enable Design Filter
immediately. Changes to specifications in text boxes such as Fs, Fpass, and Fstop require
you to click outside the text box to enable Design Filter.
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Choosing a Response Type
You can choose from several response types:

* Lowpass

* Raised cosine

* Highpass

* Bandpass

* Bandstop

* Differentiator

¢ Multiband

* Hilbert transformer
* Arbitrary magnitude

Additional response types are available if you have DSP System Toolbox software
installed.

Note Not all filter design methods are available for all response types. Once you choose
your response type, this may restrict the filter design methods available to you. Filter
design methods that are not available for a selected response type are removed from the
Design Method region of the app.

Choosing a Filter Design Method

You can use the default filter design method for the response type that you've selected, or
you can select a filter design method from the available FIR and IIR methods listed in the

app.

To select the Remez algorithm to compute FIR filter coefficients, select the FIR radio
button and choose Equiripple from the list of methods.

Setting the Filter Design Specifications
Viewing Filter Specifications

The filter design specifications that you can set vary according to response type and
design method. The display region illustrates filter specifications when you select
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Analysis > Filter Specifications or when you click the Filter Specifications toolbar
button.

You can also view the filter specifications on the Magnitude plot of a designed filter by
selecting View > Specification Mask.

Filter Order

You have two mutually exclusive options for determining the filter order when you design
an equiripple filter:

* Specify order: You enter the filter order in a text box.
* Minimum order: The filter design method determines the minimum order filter.

Note that filter order specification options depend on the filter design method you choose.
Some filter methods may not have both options available.

Options

The available options depend on the selected filter design method. Only the FIR
Equiripple and FIR Window design methods have settable options. For FIR Equiripple, the
option is a Density Factor. See firpm for more information. For FIR Window the options
are Scale Passhand, Window selection, and for the following windows, a settable
parameter:

Window Parameter

Chebyshev (chebwin) Sidelobe attenuation
Gaussian (gausswin) Alpha

Kaiser (kaiser) Beta

Taylor (taylorwin) Nbar and Sidelobe level
Tukey (tukeywin) Alpha

User Defined Function Name, Parameter

You can view the window in the Window Visualization Tool (wvtool) by clicking the View
button.

Bandpass Filter Frequency Specifications

For a bandpass filter, you can set
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* Units of frequency:

* Hz
+ kHz
e MHz
* Normalized (0 to 1)
* Sampling frequency
* Passband frequencies
» Stopband frequencies
You specify the passband with two frequencies. The first frequency determines the lower

edge of the passband, and the second frequency determines the upper edge of the
passband.

Similarly, you specify the stopband with two frequencies. The first frequency determines
the upper edge of the first stopband, and the second frequency determines the lower
edge of the second stopband.

Bandpass Filter Magnitude Specifications

For a bandpass filter, you can specify the following magnitude response characteristics:

* Units for the magnitude response (dB or linear)
» Passband ripple
* Stopband attenuation

Computing the Filter Coefficients

Now that you've specified the filter design, click the Design Filter button to compute the
filter coefficients.

Note The Design Filter button is disabled once you've computed the coefficients for
your filter design. This button is enabled again once you make any changes to the filter
specifications.
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Analyzing the Filter
Displaying Filter Responses

You can view the following filter response characteristics in the display region or in a
separate window.

* Magnitude response

* Phase response

* Magnitude and Phase responses

* Group delay response

* Phase delay response

* Impulse response

* Step response

* Pole-zero plot

» Zero-phase response — available from the y-axis context menu in a Magnitude or
Magnitude and Phase response plot.

Note If you have DSP System Toolbox product installed, two other analyses are available:
magnitude response estimate and round-off noise power. These two analyses are the only
ones that use filter internals.

For descriptions of the above responses and their associated toolbar buttons and other
Filter Designer toolbar buttons, see fvtool.

You can display two responses in the same plot by selecting Analysis > Overlay Analysis
and selecting an available response. A second y-axis is added to the right side of the
response plot. (Note that not all responses can be overlaid on each other.)

You can also display the filter coefficients and detailed filter information in this region.

For all the analysis methods, except zero-phase response, you can access them from the
Analysis menu, the Analysis Parameters dialog box from the context menu, or by using
the toolbar buttons. For zero-phase, right-click the y-axis of the plot and select Zero-
phase from the context menu.

You can overlay the filter specifications on the Magnitude plot by selecting View >
Specification Mask.
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Using Data Tips

You can click the response to add plot data tips that display information about particular
points on the response.

For information on using data tips, see “Display Data Values Interactively” (MATLAB).
Drawing Spectral Masks

To add spectral masks or rejection area lines to your magnitude plot, click View > User-
defined Spectral Mask.

The mask is defined by a frequency vector and a magnitude vector. These vectors must be
the same length.
* Enable Mask — Select to turn on the mask display.

* Normalized Frequency — Select to normalize the frequency between 0 and 1 across
the displayed frequency range.

+ Frequency Vector — Enter a vector of x-axis frequency values.

* Magnitude Units — Select the desired magnitude units. These units should match
the units used in the magnitude plot.

* Magnitude Vector — Enter a vector of y-axis magnitude values.
Changing the Sampling Frequency

To change the sampling frequency of your filter, right-click any filter response plot and
select Sampling Frequency from the context menu.

To change the filter name, type the new name in Filter name. (In fvtool, if you have
multiple filters, select the desired filter and then enter the new name.)

To change the sampling frequency, select the desired unit from Units and enter the
sampling frequency in Fs. (For each filter in fvtool, you can specify a different sampling
frequency or you can apply the sampling frequency to all filters.)

To save the displayed parameters as the default values to use when Filter Designer or
FVTool is opened, click Save as Default.

To restore the default values, click Restore Original Defaults.
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Displaying the Response in FVTool

To display the filter response characteristics in a separate window, select View > Filter
Visualization Tool (available if any analysis, except the filter specifications, is in the
display region) or click the Full View Analysis button. This starts the Filter Visualization
Tool (fvtool).

Note If Filter Specifications are shown in the display region, clicking the Full View
Analysis toolbar button launches a MATLAB figure window instead of FVTool. The
associated menu item is Print to Figure, which is enabled only if the filter specifications
are displayed.

You can use this tool to annotate your design, view other filter characteristics, and print
your filter response. You can link Filter Designer and FVTool so that changes made in
Filter Designer are immediately reflected in FVTool. See fvtool for more information.

Editing the Filter Using the Pole/Zero Editor
Displaying the Pole-Zero Plot

You can edit a designed or imported filter's coefficients by moving, deleting, or adding
poles and/or zeros using the Pole/Zero Editor panel.

Note You cannot generate MATLAB code (File > Generate MATLAB code) if your filter
was designed or edited with the Pole/Zero Editor.

You cannot move quantized poles and zeros. You can only move the reference poles and
Zeros.

Click the Pole/Zero Editor button in the sidebar or select Edit > Pole/Zero Editor to
display the Pole/Zero Editor panel.

Poles are shown using x symbols and zeros are shown using o symbols.
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Changing the Pole-Zero Plot

Plot mode buttons are located to the left of the pole/zero plot. Select one of the buttons to
change the mode of the pole/zero plot. The Pole/Zero Editor has these buttons from left to
right: Move Pole/Zero, Add Pole, Add Zero, and Delete Pole/Zero.

The following plot parameters and controls are located to the left of the pole/zero plot and
below the plot mode buttons.

* Filter gain — factor to compensate for the filter's pole(s) and zero(s) gains

* Coordinates — units (Polar or Rectangular) of the selected pole or zero

* Magnitude — if polar coordinates is selected, magnitude of the selected pole or zero

* Angle — if polar coordinates is selected, angle of selected pole(s) or zero(s)

* Real — if rectangular coordinates is selected, real component of selected pole(s) or
zero(s)

+ Imaginary — if rectangular coordinates is selected, imaginary component of selected
pole or zero

* Section — for multisection filters, number of the current section

* Conjugate — creates a corresponding conjugate pole or zero or automatically selects
the conjugate pole or zero if it already exists.

* Auto update — immediately updates the displayed magnitude response when poles or
zeros are added, moved, or deleted.

The Edit > Pole/Zero Editor has items for selecting multiple poles/zeros, for inverting
and mirroring poles/zeros, and for deleting, scaling and rotating poles/zeros.

*  When you select a pole or zero from a conjugate pair, the Conjugate check box and
the conjugate are automatically selected.

Converting the Filter Structure
Converting to a New Structure

You can use Edit > Convert Structure to convert the current filter to a new structure.
All filters can be converted to the following representations:

e Direct-form I
¢ Direct-form II
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* Direct-form I transposed
* Direct-form II transposed
* Lattice ARMA

Note If you have DSP System Toolbox product installed, you will see additional
structures in the Convert structure dialog box.

In addition, the following conversions are available for particular classes of filters:

* Minimum phase FIR filters can be converted to Lattice minimum phase
* Maximum phase FIR filters can be converted to Lattice maximum phase
» Allpass filters can be converted to Lattice allpass

+ [IR filters can be converted to Lattice ARMA

Note Converting from one filter structure to another may produce a result with different
characteristics than the original. This is due to the computer's finite-precision arithmetic
and the variations in the conversion's round-off computations.

For example:

* Select Edit > Convert Structure to open the Convert structure dialog box.
* Select Direct-form I in the list of filter structures.

Converting to Second-Order Sections

You can use Edit > Convert to Second-Order Sections to store the converted filter
structure as a collection of second-order sections rather than as a monolithic higher-order
structure.

Note The following options are also used for Edit > Reorder and Scale Second-Order
Sections, which you use to modify an SOS filter structure.

The following Scale options are available when converting a direct-form II structure only:

* None (default)
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e L-2(L?norm)
* L-infinity (L” norm)

The Direction (Up or Down) determines the ordering of the second-order sections. The
optimal ordering changes depending on the Scale option selected.

For example:

* Select Edit > Convert to Second-Order Sections to open the Convert to SOS dialog
box.

* Select L-infinity from the Scale menu for L” norm scaling.

» Leave Up as the Direction option.

Note To convert from second-order sections back to a single section, use Edit > Convert
to Single Section.

Exporting a Filter Design
Exporting Coefficients or Objects to the Workspace

You can save the filter either as filter coefficients variables or as a filter object variable.
To save the filter to the MATLAB workspace:

1 Select File > Export. The Export dialog box appears.

2 Select Workspace from the Export To menu.

3 Select Coefficients from the Export As menu to save the filter coefficients or
select Objects to save the filter in a filter object.

4  For coefficients, assign variable names using the Numerator (for FIR filters) or
Numerator and Denominator (for IIR filters), or SOS Matrix and Scale Values
(for IIR filters in second-order section form) text boxes in the Variable Names region.

For objects, assign the variable name in the Discrete Filter text box. If you have
variables with the same names in your workspace and you want to overwrite them,
select the Overwrite Variables check box.

5 Click the Export button.
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Exporting Coefficients to an ASCII File
To save filter coefficients to a text file,

Select File > Export. The Export dialog box appears.
Select Coefficients File (ASCII) from the Export To menu.

3 Click the Export button. The Export Filter Coefficients to .FCF File dialog box
appears.

4 Choose or enter a filename and click the Save button.

The coefficients are saved in the text file that you specified, and the MATLAB Editor
opens to display the file. The text file also contains comments with the MATLAB version
number, the Signal Processing Toolbox version number, and filter information.

Exporting Coefficients or Objects to a MAT-File

To save filter coefficients or a filter object as variables in a MAT-file:

Select File > Export. The Export dialog box appears.
Select MAT - file from the Export To menu.

Select Coefficients from the Export As menu to save the filter coefficients or
select Objects to save the filter in a filter object.

4 For coefficients, assign variable names using the Numerator (for FIR filters) or
Numerator and Denominator (for IIR filters), or SOS Matrix and Scale Values
(for IIR filters in second-order section form) text boxes in the Variable Names region.

For objects, assign the variable name in the Discrete Filter (or Quantized Filter)
text box. If you have variables with the same names in your workspace and you want
to overwrite them, select the Overwrite Variables check box.

Click the Export button. The Export to a MAT-File dialog box appears.
Choose or enter a filename and click the Save button.

Exporting to a Simulink Model

If you have the Simulink product installed, you can export a Simulink block of your filter
design and insert it into a new or existing Simulink model.

You can export a filter designed using any filter design method available in Filter
Designer.
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Note If you have the DSP System Toolbox and Fixed-Point Designer™ installed, you can
export a CIC filter to a Simulink model.

After designing your filter, click the Realize Model sidebar button or select File >
Export to Simulink Model. The Realize Model panel is displayed.

Specify the name to use for your block in Block name.

To insert the block into the current (most recently selected) Simulink model, set the
Destination to Current. To inset the block into a new model, select New. To insert
the block into a user-defined subsystem, select User defined.

If you want to overwrite a block previously created from this panel, check Overwrite
generated "Filter' block.

If you select the Build model using basic elements check box, your filter is
created as a subsystem (Simulink) block, which uses separate sub-elements. In this
mode, the following optimization(s) are available:

* Optimize for zero gains — Removes zero-valued gain paths from the filter
structure.

* Optimize for unity gains — Substitutes a wire (short circuit) for gains
equal to 1 in the filter structure.

* Optimize for negative gains — Substitutes a wire (short circuit) for gains
equal to -1 and changes corresponding additions to subtractions in the filter
structure.

* Optimize delay chains — Substitutes delay chains composed of n unit delays
with a single delay of n.

* Optimize for unity scale values — Removes multiplications for scale
values equal to 1 from the filter structure.

The following illustration shows the effects of some of the optimizations:
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Note The Build model using basic elements check box is enabled only when you
have a DSP System Toolbox license and your filter can be designed using a Biquad
Filter block or a Discrete FIR Filter block. For more information, see the Filter
Realization Wizard topic in the DSP System Toolbox documentation.

Set the Input processing parameter to specify whether the generated filter
performs sample- or frame-based processing on the input. Depending on the type of
filter you design, one or both of the following options may be available:

* Columns as channels (frame based) — When you select this option, the
block treats each column of the input as a separate channel.
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* Elements as channels (sample based) — When you select this option, the
block treats each element of the input as a separate channel.

7  Click the Realize Model button to create the filter block. When the Build model
using basic elements check box is selected, Filter Designer implements the filter
as a subsystem block using Sum, Gain, and Delay blocks.

If you double-click the Simulink Filter block, the filter structure is displayed.

Generating a C Header File

You may want to include filter information in an external C program. To create a C header
file with variables that contain filter parameter data, follow this procedure:
1 Select Targets > Generate C Header. The Generate C Header dialog box appears.

2 Enter the variable names to be used in the C header file. The particular filter
structure determines the variables that are created in the file.

Filter Structure Variable Parameter

Direct-form I Numerator, Numerator length, Denominator,

Denominator length
Direct-form II

Direct-form I
transposed

Direct-form II

transposed

Lattice ARMA Lattice coeff., Lattice coeff. length, Ladder coeff.,
Ladder coeff. length

Lattice MA Lattice coeff., Lattice coeff. length, and Number of

sections (inactive if filter has only one section)

Direct-form FIR Direct- |Numerator, Numerator length, and Number of
form FIR transposed |sections (inactive if filter has only one section)

Length variables contain the total number of coefficients of that type.

Note Variable names cannot be C language reserved words, such as “for.”
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3 Select Export Suggested to use the suggested data type or select Export As and
select the desired data type from the pull-down.

Note If you do not have DSP System Toolbox software installed, selecting any data
type other than double-precision floating point results in a filter that does not exactly
match the one you designed in the Filter Designer. This is due to rounding and
truncating differences.

4 Click Generate to save the file and leave the dialog box open for additional C header
file definitions. To close the dialog box, click Close.

Generating MATLAB Code

You can generate MATLAB code that constructs the filter you designed in Filter
Designer from the command line. Select File > Generate MATLAB Code > Filter
Design Function and specify the filename in the Generate MATLAB code dialog box.

Note You cannot generate MATLAB code (File > Generate MATLAB Code > Filter
Design Function) if your filter was designed or edited with the Pole/Zero Editor.

The following is generated MATLAB code for the default lowpass filter in Filter
Designer.

function Hd = ExFilter

%SEXFILTER Returns a discrete-time filter object.

MATLAB Code

Generated by MATLAB(R) 7.11 and the Signal Processing Toolbox 6.14.

Generated on: 17-Feb-2010 14:15:37

0° 0° o° P o° o°

o°

Equiripple Lowpass filter designed using the FIRPM function.

o°

All frequency values are in Hz.
Fs = 48000; % Sampling Frequency

Fpass
Fstop

9600;
12000;

Passband Frequency
Stopband Frequency

%
%
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Dpass = 0.057501127785; % Passband Ripple
Dstop = 0.0001; % Stopband Attenuation
dens = 20; % Density Factor

% Calculate the order from the parameters using FIRPMORD.
[N, Fo, Ao, W] = firpmord([Fpass, Fstopl/(Fs/2), [1 0], [Dpass, Dstopl);

% Calculate the coefficients using the FIRPM function.
b = firpm(N, Fo, Ao, W, {dens});

Hd = dfilt.dffir(b);

% [EOF]

Managing Filters in the Current Session

You can store filters designed in the current Filter Designer session for cascading
together, exporting to FVTool or for recalling later in the same or future Filter Designer
sessions.

You store and access saved filters with the Store Filter and Filter Manager buttons,
respectively, in the Current Filter Information pane.

Store Filter — Displays the Store Filter dialog box in which you specify the filter name to
use when storing the filter in the Filter Manager. The default name is the type of the filter.

Filter Manager — Opens the Filter Manager.

The current filter is listed below the listbox. To change the current filter, highlight the
desired filter. If you select Edit current filter, Filter Designer displays the currently
selected filter specifications. If you make any changes to the specifications, the stored
filter is updated immediately.

To cascade two or more filters, highlight the desired filters and press Cascade. A new
cascaded filter is added to the Filter Manager.

To change the name of a stored filter, press Rename. The Rename filter dialog box is
displayed.

To remove a stored filter from the Filter Manager, press Delete.

To export one or more filters to FVTool, highlight the filter(s) and press FVTool.
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Saving and Opening Filter Design Sessions

You can save your filter design session as a MAT-file and return to the same session
another time.

Select the Save Session button to save your session as a MAT-file. The first time you save
a session, a Save Filter Design Session browser opens, prompting you for a session name.

The . fda extension is added automatically to all filter design sessions you save.

Note You can also use File > Save Session and File > Save Session As to save a
session.

You can load existing sessions into Filter Designer by selecting the Open Session
button or File > Open Session . A Load Filter Design Session browser opens that allows
you to select from your previously saved filter design sessions.
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Importing a Filter Design

In this section...

“Import Filter Panel” on page 5-26
“Filter Structures” on page 5-27

Import Filter Panel

The Import Filter panel allows you to import a filter. You can access this region by clicking
the Import Filter button in the sidebar.

— Filter Coefficient

Filker Structure: Sampling Frequency:

| Direct form I transposed x| Mumerator [[0.028 0.0530.071 0.0530.028] Clear | Units' [Momalzed (0t 1] 7|
I Import as second-order-sections  D'enominator: |11 000 -2.026 2,148 -1.159 0.279) Clear | Fs: [Fs

Import Filker |

The imported filter can be in any of the representations listed in the Filter Structure
pull-down menu. You can import a filter as second-order sections by selecting the check
box.

Specify the filter coefficients in Numerator and Denominator, either by entering them
explicitly or by referring to variables in the MATLAB workspace.

Select the frequency units from the following options in the Units menu, and for any
frequency unit other than Normalized, specify the value or MATLAB workspace variable
of the sampling frequency in the Fs field.

To import the filter, click the Import Filter button. The display region is automatically
updated when the new filter has been imported.

You can edit the imported filter using the Pole/Zero Editor panel.
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Filter Structures

The available filter structures are:
* Direct Form, which includes direct-form I, direct-form II, direct-form I transposed,
direct-form II transposed, and direct-form FIR

» Lattice, which includes lattice allpass, lattice MA min phase, lattice MA max phase,
and lattice ARMA

* Discrete-time Filter (dfilt object)

The structure that you choose determines the type of coefficients that you need to specify
in the text fields to the right.

Direct-form

For direct-form I, direct-form II, direct-form I transposed, and direct-form II transposed,
specify the filter by its transfer function representation

)= B +b2)z 1 +53)z2 +.. . bm+1)z™
a)+a@2zt+aB)Z 3 +. an+1)z™"

* The Numerator field specifies a variable name or value for the numerator coefficient
vector b, which contains m+1 coefficients in descending powers of z.

* The Denominator field specifies a variable name or value for the denominator
coefficient vector a, which contains n+1 coefficients in descending powers of z. For
FIR filters, the Denominator is 1.

Filters in transfer function form can be produced by all of the Signal Processing Toolbox
filter design functions (such as firl, fir2, firpm, butter, yulewalk). See “Transfer
Function” on page 1-37 for more information.

Importing as second-order sections

For all direct-form structures, except direct-form FIR, you can import the filter in its
second-order section representation:

L -1 -2
H(Z)=GH bOk +b1kz +b2k2

1 2
k=10pp T Q12 = + Qg2
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The Gain field specifies a variable name or a value for the gain G, and the SOS Matrix
field specifies a variable name or a value for the L-by-6 SOS matrix

bor b1 boy 1 aj; ag
bog big bag 1 ajg agy
SOS = . .

bor, bir, bor, 1 ay agp

whose rows contain the numerator and denominator coefficients by, and a;, of the second-
order sections of H(z).

Filters in second-order section form can be produced by functions such as tf2sos,
zZp2s0s, ss2s0s, and sosfilt. See “Second-Order Sections (SOS)” on page 1-40 for
more information.

Lattice

For lattice allpass, lattice minimum and maximum phase, and lattice ARMA filters, specify
the filter by its lattice representation:

» For lattice allpass, the Lattice coeff field specifies the lattice (reflection) coefficients,
k(1) to k(N), where N is the filter order.

* For lattice MA (minimum or maximum phase), the Lattice coeff field specifies the
lattice (reflection) coefficients, k(1) to k(N), where N is the filter order.

» For lattice ARMA, the Lattice coeff field specifies the lattice (reflection) coefficients,
k(1) to k(N), and the Ladder coeff field specifies the ladder coefficients, v(1) to
v (N+1), where N is the filter order.

Filters in lattice form can be produced by tf2latc. See “Lattice Structure” on page 1-41
for more information.

Discrete-time Filter (dfilt object)

For Discrete-time filter, specify the name of the dfilt object. See dfilt for more
information.
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FIR Bandpass Filter with Asymmetric Attenuation

Use the Filter Designer app to create a 50th-order equiripple FIR bandpass filter to be
used with signals sampled at 1 kHz.

Specify that the passband spans frequencies of 200-300 Hz and that the transition region
on either side has a width of 50 Hz.

Fstopl = 150;
Fpassl = 200;
Fpass2 = 300;
Fstop2 = 350;

Specify weights for the optimization fit:

» 3 for the low-frequency stopband
* 1 for the passband
* 100 for the high-frequency stopband

Open the Filter Designer app.

Wstopl = 3;
Wpass = 1;
Wstop2 = 100;
filterDesigner

Use the app to design the rest of the filter. To specify the frequency constraints and
magnitude specifications, use the variables you created.

Set Response Type to Bandpass.

Set Design Method to FIR. From the drop-down list, select Equiripple.
Under Filter Order, specify the order as N.

Under Frequency Specifications, specify Fs as Fs.

Click Design Filter.

ua A W N -
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See Also

Apps
Filter Designer
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Arbitrary Magnitude Filter

5-32

Design an FIR filter with the following piecewise frequency response:
* A sinusoid between 0 and 0.19m rad/sample.

F1 = 0:0.01:0.19;
Al = 0.5+sin(2*pi*7.5*F1)/4;

* A piecewise linear section between 0.2 rad/sample and 0.78mx rad/sample.

F2 [0.2 0.38 0.4 0.55 0.562 0.585 0.6 0.781;
A2 [0.52.311 -0.2 -0.211];

* A quadratic section between 0.79m rad/sample and the Nyquist frequency.

F3

9:0.01:1;
A3 +

0.7
0.2+18*(1-F3)."2;

Specify a filter order of 50. Consolidate the frequency and amplitude vectors. To give all
bands equal weights during the optimization fit, specify a weight vector of all ones. Open
the Filter Designer app.

N = 50;

FregVect = [F1 F2 F3];
AmplVect = [Al A2 A3];
WghtVect = ones(1,N/2);
filterDesigner

Use the app to design the filter.

1 Under Response Type, select the button next to Differentiator. From the drop-
down list, choose Arbitrary Magnitude.
Set Design Method to FIR. From the drop-down list, select Least-squares.
Under Filter Order, specify the order as the variable N.
Under Frequency and Magnitude Specifications, specify the variables you
created:
* Freq. vector — FregVect.
* Mag. vector — AmplVect.
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* Weight vector — WghtVect.
5 Click Design Filter.

Right-click the y-axis of the plot and select Magnitude to express the magnitude
response in linear units.
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See Also

Apps
Filter Designer

Functions
designfilt
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Statistical Signal Processing

The following chapter discusses statistical signal processing tools and applications,
including correlations, covariance, and spectral estimation.

“Correlation and Covariance” on page 6-2
“Spectral Analysis” on page 6-5
“Nonparametric Methods” on page 6-9
“Parametric Methods” on page 6-34
“Selected Bibliography” on page 6-47
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Correlation and Covariance

6-2

In this section...

“Background Information” on page 6-2
“Using xcorr and xcov Functions” on page 6-3
“Bias and Normalization” on page 6-3
“Multiple Channels” on page 6-4

Background Information

The cross-correlation sequence for two wide-sense stationary random process, x(n) and
y(n) is

Ry (m) = Elx(n+m)y (n)},

where the asterisk denotes the complex conjugate and the expectation is over the
ensemble of realizations that constitute the random processes.

Note that cross-correlation is not commutative, but a Hermitian (conjugate) symmetry
property holds such that:

Ry (m)= Ry, (-m).
The cross-covariance between x(n) and y(n) is:
Cyy(m) = E{(x(n+m)— 1) (¥(n) — 1, )} = ny(m)—uxuy*.

For zero-mean wide-sense stationary random processes, the cross-correlation and cross-
covariance are equivalent.

In practice, you must estimate these sequences, because it is possible to access only a
finite segment of the infinite-length random processes. Further, it is often necessary to
estimate ensemble moments based on time averages because only a single realization of
the random processes are available. A common estimate based on N samples of x(n) and
y(n) is the deterministic cross-correlation sequence (also called the time-ambiguity
function)
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N-m-1 N
n 2 x(n+m)y (n), m=0,
ny(m) = n=0

R, (-m), m < 0.
where we assume for this discussion that x(n) and y(n) are indexed from 0 to N - 1, and

R,y (m) from -(N - 1) to N - 1.

Using xcorr and xcov Functions

The functions xcorr and xcov estimate the cross-correlation and cross-covariance
sequences of random processes. They also handle autocorrelation and autocovariance as
special cases. The xcorr function evaluates the sum shown above with an efficient FFT-
based algorithm, given inputs x(n) and y(n) stored in length N vectors x and y. Its
operation is equivalent to convolution with one of the two subsequences reversed in time.

For example:

X [11111];
y = X;
Xyc = xcorr(x,y)

Notice that the resulting sequence length is one less than twice the length of the input
sequence. Thus, the Nth element is the correlation at lag 0. Also notice the triangular
pulse of the output that results when convolving two square pulses.

The xcov function estimates autocovariance and cross-covariance sequences. This

function has the same options and evaluates the same sum as xcorr, but first removes
the means of x and y.

Bias and Normalization

An estimate of a quantity is biased if its expected value is not equal to the quantity it
estimates. The expected value of the output of xcorr is

E{R,,(m)} =(N —|m|)Ry,(m).

6-3
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xcorr provides the unbiased estimate, dividing by N - |m| when you specify an
"unbiased' flag after the input sequences.

xcorr(x,y, 'unbiased")

Although this estimate is unbiased, the end points (near -(N - 1) and N - 1) suffer from
large variance because xcorr computes them using only a few data points. A possible
trade-off is to simply divide by N using the 'biased’ flag:

xcorr(x,y, 'biased")

With this scheme, only the sample of the correlation at zero lag (the Nth output element)
is unbiased. This estimate is often more desirable than the unbiased one because it avoids
random large variations at the end points of the correlation sequence.

xcorr provides one other normalization scheme. The syntax

xcorr(x,y, 'coeff')

divides the output by norm(x)*norm(y) so that, for autocorrelations, the sample at zero
lagis 1.

Multiple Channels

For a multichannel signal, xcorr and xcov estimate the autocorrelation and cross-
correlation and covariance sequences for all of the channels at once. If S is an M-by-N
signal matrix representing N channels in its columns, xcorr(S) returns a (2M - 1)-by-N?
matrix with the autocorrelations and cross-correlations of the channels of S in its N2
columns. If S is a three-channel signal

S = [s1 s2 s3]
then the result of xcorr(S) is organized as

R = [Rslsl Rs1s2 Rs1ls3 Rs2sl Rs2s2 Rs2s3 Rs3sl Rs3s2 Rs3s3]

Two related functions, cov and corrcoef, are available in the standard MATLAB
environment. They estimate covariance and normalized covariance respectively between
the different channels at lag 0 and arrange them in a square matrix.
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Spectral Analysis

In this section...

“Background Information” on page 6-5
“Spectral Estimation Method” on page 6-6

Background Information

The goal of spectral estimation is to describe the distribution (over frequency) of the
power contained in a signal, based on a finite set of data. Estimation of power spectra is
useful in a variety of applications, including the detection of signals buried in wideband
noise.

The power spectral density (PSD) of a stationary random process x(n) is mathematically
related to the autocorrelation sequence by the discrete-time Fourier transform. In terms
of normalized frequency, this is given by

1 < _;
P = R Jom
> () o Y. R.(me

m=—oo

This can be written as a function of physical frequency f (e.g., in hertz) by using the
relation w = 2mf/ f,, where f; is the sampling frequency:

P.(f)= fl Y Ry (me 2L,

S m=—oo

The correlation sequence can be derived from the PSD by use of the inverse discrete-time
Fourier transform:

£./2

V4
Ry (m) = [ Py(@e’do= [ P, (pe/>mf/hdf.
- ~£.12

The average power of the sequence x(n) over the entire Nyquist interval is represented by

6-5
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T f./2
R0 = [ P @do= [ P(pdf.
- —f,/2

The average power of a signal over a particular frequency band [w;, w,], 0 = w; < w, = 1@,
can be found by integrating the PSD over that band:

D Wy -,
P[a,“wz] = jwl Pxx (a))da) = .[—0)21 Pxx(w) do.

You can see from the above expression that P,,(w) represents the power content of a
signal in an infinitesimal frequency band, which is why it is called the power spectral
density.

The units of the PSD are power (e.g., watts) per unit of frequency. In the case of P,,(w),
this is watts/radian/sample or simply watts/radian. In the case of P,,(f), the units are
watts/hertz. Integration of the PSD with respect to frequency yields units of watts, as
expected for the average power .

For real-valued signals, the PSD is symmetric about DC, and thus P,,(w) for 0 = w = is
sufficient to completely characterize the PSD. However, to obtain the average power over
the entire Nyquist interval, it is necessary to introduce the concept of the one-sided PSD.

The one-sided PSD is given by

0, -1 <w<0,

P . =
one-sided(®) {2Pxx(w), 0<w<n.

The average power of a signal over the frequency band, [w;,w,] with 0 < w; = w, = @, can
be computed using the one-sided PSD as

D @,
P[wl,wz] = Ja) P, esided(@da.
1

Spectral Estimation Method

The various methods of spectrum estimation available in the toolbox are categorized as
follows:
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* Nonparametric methods
* Parametric methods
* Subspace methods

Nonparametric methods are those in which the PSD is estimated directly from the signal
itself. The simplest such method is the periodogram. Other nonparametric techniques
such as Welch's method [8], the multitaper method (MTM) reduce the variance of the
periodogram.

Parametric methods are those in which the PSD is estimated from a signal that is
assumed to be output of a linear system driven by white noise. Examples are the Yule-
Walker autoregressive (AR) method and the Burg method. These methods estimate the
PSD by first estimating the parameters (coefficients) of the linear system that
hypothetically generates the signal. They tend to produce better results than classical
nonparametric methods when the data length of the available signal is relatively short.
Parametric methods also produce smoother estimates of the PSD than nonparametric
methods, but are subject to error from model misspecification.

Subspace methods, also known as high-resolution methods or super-resolution methods,
generate frequency component estimates for a signal based on an eigenanalysis or
eigendecomposition of the autocorrelation matrix. Examples are the multiple signal
classification (MUSIC) method or the eigenvector (EV) method. These methods are best
suited for line spectra — that is, spectra of sinusoidal signals — and are effective in the
detection of sinusoids buried in noise, especially when the signal to noise ratios are low.
The subspace methods do not yield true PSD estimates: they do not preserve process
power between the time and frequency domains, and the autocorrelation sequence cannot
be recovered by taking the inverse Fourier transform of the frequency estimate.

All three categories of methods are listed in the table below with the corresponding
toolbox function names. More information about each function is on the corresponding
function reference page. See “Parametric Modeling” on page 7-26 for details about 1pc
and other parametric estimation functions.
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Spectral Estimation Methods/Functions

Method

Description

Functions

Periodogram

Power spectral density estimate

periodogram

Welch

Averaged periodograms of
overlapped, windowed signal
sections

pwelch, cpsd, tfestimate,
mscohere

Multitaper

Spectral estimate from

combination of multiple
orthogonal windows (or
“tapers”)

pmtm

Yule-Walker AR

Autoregressive (AR) spectral
estimate of a time-series from
its estimated autocorrelation
function

pyulear

Burg

Autoregressive (AR) spectral
estimation of a time-series by
minimization of linear
prediction errors

pburg

Covariance

Autoregressive (AR) spectral
estimation of a time-series by
minimization of the forward
prediction errors

pcov

Modified Covariance

Autoregressive (AR) spectral
estimation of a time-series by
minimization of the forward and
backward prediction errors

pmcov

MUSIC

Multiple signal classification

pmusic

Eigenvector

Pseudospectrum estimate

peig
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Nonparametric Methods

The following sections discuss the periodogram on page 6-9, modified periodogram on
page 6-18, Welch on page 6-21, and multitaper on page 6-25 methods of
nonparametric estimation, along with the related CPSD function on page 6-28, transfer
function estimate on page 6-29, and coherence function on page 6-31.

Periodogram

In general terms, one way of estimating the PSD of a process is to simply find the
discrete-time Fourier transform of the samples of the process (usually done on a grid with
an FFT) and appropriately scale the magnitude squared of the result. This estimate is
called the periodogram.

The periodogram estimate of the PSD of a signal Kl of length L is

-1

— §lafn .F
P.f) S xplmle
LP\ oy

where Fs is the sampling frequency.

In practice, the actual computation of Pulf) can be performed only at a finite number of
frequency points, and usually employs an FFT. Most implementations of the periodogram

method compute the N -point PSD estimate at the frequencies

kF,

i=—, k=0.1.....N—-1L
h=7

In some cases, the computation of the periodogram via an FFT algorithm is more efficient
if the number of frequencies is a power of two. Therefore it is not uncommon to pad the
input signal with zeros to extend its length to a power of two.

As an example of the periodogram, consider the following 1001-element signal xn, which
consists of two sinusoids plus noise:

fs = 1000; % Sampling frequency
t = (0:fs)/fs; % One second worth of samples

6-9
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[12]; % Sinusoid amplitudes (row vector)
f o

[150;140]; s Sinusoid frequencies (column vector)
xn = A*sin(2*pi*f*t) + 0.l*randn(size(t));

% The three last lines are equivalent to

% XN = sin(2*pi*150*t) + 2*sin(2*pi*140*t) + 0.1*randn(size(t));

The periodogram estimate of the PSD can be computed using periodogram. In this case,
the data vector is multiplied by a Hamming window to produce a modified periodogram.

[Pxx,F] = periodogram(xn,hamming(length(xn)),length(xn),fs);
plot(F,10*10ogl0(Pxx))

xlabel('Hz")

ylabel('dB")

title('Modified Periodogram Power Spectral Density Estimate')

Modified Periodogram Power Spectral Density Estimate

0 50 100 150 200 250 300 350 400 450 500
Hz
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Algorithm

Periodogram computes and scales the output of the FFT to produce the power vs.
frequency plot as follows.

1 [f the input signal is real-valued, the magnitude of the resulting FFT is symmetric
with respect to zero frequency (DC). For an even-length FFT, only the first (1 +
nfft/2) points are unique. Determine the number of unique values and keep only
those unique points.

2 Take the squared magnitudes of the unique FFT values. Scale the squared

HFN)

magnitudes (except for DC) by 2 , where N is the length of signal prior to any

zero padding. Scale the DC value by !/ FsV)
3 Create a frequency vector from the number of unique points, the nfft and the
sampling frequency.

4  Plot the resulting magnitude squared FFT against the frequency.

Performance of the Periodogram

The following sections discuss the performance of the periodogram with regard to the
issues of leakage, resolution, bias, and variance.

Spectral Leakage

Consider the PSD of a finite-length (length ) signal *#'*/_ It is frequently useful to

xpin)

interpret as the result of multiplying an infinite signal, '/, by a finite-length

rectangular window, &'/
xpin) = xin)wgln).

Because multiplication in the time domain corresponds to convolution in the frequency
domain, the expected value of the periodogram in the frequency domain is

EP, =1 /J{T:Rinz”'“‘f—f'i.-"F_T:I

L I_ —F,/2 Lsin’(z( f — )/F,)

Polfdf,
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showing that the expected value of the periodogram is the convolution of the true PSD
with the square of the Dirichlet kernel.

The effect of the convolution is best understood for sinusoidal data. Suppose that *'®/ is

composed of a sum of M complex sinusoids:

N

) Jung
xin) = E A ¥
k=1

Its spectrum is

N

Xlimw) = E Ay — ang),
k=1

which for a finite-length sequence becomes

N
i
/ tZa”lk:’)Ie—m@ Wela — &) de.

- = k=]

The preceding equation is equal to

N

Xlm) = E A Welawr — oy ).
k=1

So in the spectrum of the finite-length signal, the Dirac deltas have been replaced by

Weim — ay)

terms of the form , which corresponds to the frequency response of a

rectangular window centered on the frequency “.

The frequency response of a rectangular window has the shape of a periodic sinc:

= 32;
[h,w] = fregz(rectwin(L)/L,1);
= diric(w,L);

plot(w/pi,20*loglO(abs(h)))

6-12
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hold on

plot(w/pi,20*loglO(abs(y)),

hold off
ylim([-40,0])

)

legend('Frequency Response', 'Periodic Sinc')

xlabel('\omega / \pi')

101

— — — Perindic Sinc

Frequency Response

0.5

[ JII il

0.6

The plot displays a mainlobe and several sidelobes, the largest of which is approximately
13.5 dB below the mainlobe peak. These lobes account for the effect known as spectral
leakage. While the infinite-length signal has its power concentrated exactly at the discrete

frequency points J&, the windowed (or truncated) signal has a continuum of power

"leaked" around the discrete frequency points I,

6-13
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Because the frequency response of a short rectangular window is a much poorer
approximation to the Dirac delta function than that of a longer window, spectral leakage
is especially evident when data records are short. Consider the following sequence of 100

samples:

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.l*randn(size(t));

pe riodog ram(xn, rectwin(length(xn)), 1024, fs)

Periodogram Power Spectral Density Estimate
D T T T T T T T T T

R
=
T

ﬂ”‘ |

|
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W Wy

i
el
=

A
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Fowerffrequency (dB/Hz)

i

tn

=
T

_? D i i i i i i i i i
0 50 100 1500 200 250 300 350 400 450 500

Frequency (Hz)
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It is important to note that the effect of spectral leakage is contingent solely on the length
of the data record. It is not a consequence of the fact that the periodogram is computed at
a finite number of frequency samples.

Resolution

Resolution refers to the ability to discriminate spectral features, and is a key concept on
the analysis of spectral estimator performance.

In order to resolve two sinusoids that are relatively close together in frequency, it is
necessary for the difference between the two frequencies to be greater than the width of
the mainlobe of the leaked spectra for either one of these sinusoids. The mainlobe width
is defined to be the width of the mainlobe at the point where the power is half the peak

mainlobe power (i.e., 3 dB width). This width is approximately equal to L

In other words, for two sinusoids of frequencies It ana f ﬁ, the resolvability condition
requires that

.. F
H—-h= T

In the example above, where two sinusoids are separated by only 10 Hz, the data record
must be greater than 100 samples to allow resolution of two distinct sinusoids by a
periodogram.

Consider a case where this criterion is not met, as for the sequence of 67 samples below:

fs = 1000; % Sampling frequency
t = (0:fs/15)/fs; % 67 samples
A=1[12]; % Sinusoid amplitudes
f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));
periodogram(xn, rectwin(length(xn)), 1024, fs)
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Periodogram Power Spectral Density Estimate
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The above discussion about resolution did not consider the effects of noise since the
signal-to-noise ratio (SNR) has been relatively high thus far. When the SNR is low, true
spectral features are much harder to distinguish, and noise artifacts appear in spectral
estimates based on the periodogram. The example below illustrates this:

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*¥sin(2*pi*f*t) + 2*randn(size(t));
periodogram(xn, rectwin(length(xn)), 1024, fs)
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Fowerffrequency (dB/Hz)

Periodogram Power Spectral Density Estimate
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Bias of the Periodogram

The periodogram is a biased estimator of the PSD. Its expected value was previously
shown to be

E{P,f)} N “"12'-ff?flf—f-_.-'-“.v-'p (fdf.
S F,. -F, QL:S'l]'IE'L:?I'Lf —f/F,) -

The periodogram is asymptotically unbiased, which is evident from the earlier observation
that as the data record length tends to infinity, the frequency response of the rectangular
window more closely approximates the Dirac delta function. However, in some cases the
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periodogram is a poor estimator of the PSD even when the data record is long. This is due
to the variance of the periodogram, as explained below.

Variance of the Periodogram

The variance of the periodogram can be shown to be

PLIfl, 0<f<F,2,

Var(P.(f)) =
wiPulf {21*31:}'], f=0.F/2,

which indicates that the variance does not tend to zero as the data length L tends to
infinity. In statistical terms, the periodogram is not a consistent estimator of the PSD.
Nevertheless, the periodogram can be a useful tool for spectral estimation in situations
where the SNR is high, and especially if the data record is long.

The Modified Periodogram

The modified periodogram windows the time-domain signal prior to computing the DFT in
order to smooth the edges of the signal. This has the effect of reducing the height of the
sidelobes or spectral leakage. This phenomenon gives rise to the interpretation of
sidelobes as spurious frequencies introduced into the signal by the abrupt truncation that
occurs when a rectangular window is used. For nonrectangular windows, the end points
of the truncated signal are attenuated smoothly, and hence the spurious frequencies
introduced are much less severe. On the other hand, nonrectangular windows also
broaden the mainlobe, which results in a reduction of resolution.

The periodogram allows you to compute a modified periodogram by specifying the
window to be used on the data. For example, compare a default rectangular window and a
Hamming window. Specify the same number of DFT points in both cases.

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

nfft = 1024;

xn = A*¥sin(2*pi*f*t) + 0.1*randn(size(t));
periodogram(xn, rectwin(length(xn)),nfft,fs)
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periodogram(xn,hamming(length(xn)),nfft,fs)
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You can verify that although the sidelobes are much less evident in the Hamming-
windowed periodogram, the two main peaks are wider. In fact, the 3 dB width of the
mainlobe corresponding to a Hamming window is approximately twice that of a
rectangular window. Hence, for a fixed data length, the PSD resolution attainable with a
Hamming window is approximately half that attainable with a rectangular window. The
competing interests of mainlobe width and sidelobe height can be resolved to some extent
by using variable windows such as the Kaiser window.

Nonrectangular windowing affects the average power of a signal because some of the
time samples are attenuated when multiplied by the window. To compensate for this,
periodogram and pwelch normalize the window to have an average power of unity. This
ensures that the measured average power is generally independent of window choice. If
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the frequency components are not well resolved by the PSD estimators, the window
choice does affect the average power.

The modified periodogram estimate of the PSD is

ﬁj.{.: JII-: = x’.ijr _.'
' F.LU

where U is the window normalization constant:

L=

For large values of L, U tends to become independent of window length. The addition of U
as a normalization constant ensures that the modified periodogram is asymptotically
unbiased.

Welch's Method

An improved estimator of the PSD is the one proposed by Welch. The method consists of
dividing the time series data into (possibly overlapping) segments, computing a modified
periodogram of each segment, and then averaging the PSD estimates. The result is
Welch's PSD estimate. The toolbox function pwelch implements Welch's method.

The averaging of modified periodograms tends to decrease the variance of the estimate
relative to a single periodogram estimate of the entire data record. Although overlap
between segments introduces redundant information, this effect is diminished by the use
of a nonrectangular window, which reduces the importance or weight given to the end
samples of segments (the samples that overlap).

However, as mentioned above, the combined use of short data records and
nonrectangular windows results in reduced resolution of the estimator. In summary, there
is a tradeoff between variance reduction and resolution. One can manipulate the
parameters in Welch's method to obtain improved estimates relative to the periodogram,
especially when the SNR is low. This is illustrated in the following example.

Consider a signal consisting of 301 samples:

fs = 1000;
t = (0:0.3*%fs)/fs;

Sampling frequency
301 samples

%
%
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[2 8];
[150;140];

inusoid amplitudes (row vector)
inusoid frequencies (column vector)

—+ >

% S
% S

= A*sin(2*pi*f*t) + 5*randn(size(t));
periodogram(xn, rectwin(length(xn)), 1024, fs)

Periodogram Power Spectral Density Estimate
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We can obtain Welch's spectral estimate for 3 segments with 50% overlap using a
rectangular window.

pwelch(xn, rectwin(150),50,512,fs)
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In the periodogram above, noise and the leakage make one of the sinusoids essentially
indistinguishable from the artificial peaks. In contrast, although the PSD produced by
Welch's method has wider peaks, you can still distinguish the two sinusoids, which stand
out from the "noise floor."

However, if we try to reduce the variance further, the loss of resolution causes one of the
sinusoids to be lost altogether.

pwelch(xn, rectwin(100),75,512,fs)
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Welch Power Spectral Density Estimate
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Bias and Normalization in Welch's Method

Welch's method yields a biased estimator of the PSD. The expected value of the PSD
estimate is:

E{Pye1en (/) = 1 \W(f - £ Pl F)df,

F./2
FSLU-[

~F./2

where L is the length of the data segments, U is the same normalization constant present
in the definition of the modified periodogram, and W(f) is the Fourier transform of the
window function. As is the case for all periodograms, Welch's estimator is asymptotically
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unbiased. For a fixed length data record, the bias of Welch's estimate is larger than that
of the periodogram because the length of the segments is less than the length of the
entire data sample.

The variance of Welch's estimator is difficult to compute because it depends on both the
window used and the amount of overlap between segments. Basically, the variance is
inversely proportional to the number of segments whose modified periodograms are being
averaged.

Multitaper Method

The periodogram can be interpreted as filtering a length L signal, Xpin) through a filter
bank (a set of filters in parallel) of L FIR bandpass filters. The 3 dB bandwidth of each of

these bandpass filters can be shown to be approximately equal to I/ L The magnitude
response of each one of these bandpass filters resembles that of a rectangular window.
The periodogram can thus be viewed as a computation of the power of each filtered signal
(i.e., the output of each bandpass filter) that uses just one sample of each filtered signal

and assumes that the PSD of *2'"/ is constant over the bandwidth of each bandpass filter.

As the length of the signal increases, the bandwidth of each bandpass filter decreases,
making it a more selective filter, and improving the approximation of constant PSD over
the bandwidth of the filter. This provides another interpretation of why the PSD estimate
of the periodogram improves as the length of the signal increases. However, there are two
factors apparent from this standpoint that compromise the accuracy of the periodogram
estimate. First, the rectangular window yields a poor bandpass filter. Second, the
computation of the power at the output of each bandpass filter relies on a single sample
of the output signal, producing a very crude approximation.

Welch's method can be given a similar interpretation in terms of a filter bank. In Welch's
implementation, several samples are used to compute the output power, resulting in
reduced variance of the estimate. On the other hand, the bandwidth of each bandpass
filter is larger than that corresponding to the periodogram method, which results in a loss
of resolution. The filter bank model thus provides a new interpretation of the compromise
between variance and resolution.

Thompson's multitaper method (MTM) builds on these results to provide an improved

PSD estimate. Instead of using bandpass filters that are essentially rectangular windows
(as in the periodogram method), the MTM method uses a bank of optimal bandpass filters
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to compute the estimate. These optimal FIR filters are derived from a set of sequences
known as discrete prolate spheroidal sequences (DPSSs, also known as Slepian
sequences).

In addition, the MTM method provides a time-bandwidth parameter with which to balance

the variance and resolution. This parameter is given by the time-bandwidth product, NW
and it is directly related to the number of tapers used to compute the spectrum. There are

always INW -1 tapers used to form the estimate. This means that, as NW increases,
there are more estimates of the power spectrum, and the variance of the estimate

decreases. However, the bandwidth of each taper is also proportional to NW 50 as NW
increases, each estimate exhibits more spectral leakage (i.e., wider peaks) and the overall

spectral estimate is more biased. For each data set, there is usually a value for NW that
allows an optimal trade-off between bias and variance.

The Signal Processing Toolbox™ function that implements the MTM method is pmtm. Use
pmtm to compute the PSD of a signal.

fs = 1000; % Sampling frequency

t = (0:fs)/fs; % One second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

Xxn = A*sin(2*pi*f*t) + 0.1*randn(size(t));
pmtm(xn,4,[],fs)
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By lowering the time-bandwidth product, you can increase the resolution at the expense

of larger variance.

pmtm(xn,1.5,[1,fs)
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This method is more computationally expensive than Welch's method due to the cost of
computing the discrete prolate spheroidal sequences. For long data series (10,000 points
or more), it is useful to compute the DPSSs once and save them in a MAT-file. dpsssave,
dpssload, dpssdir, and dpssclear are provided to keep a database of saved DPSSs in
the MAT-file dpss.mat.

Cross-Spectral Density Function

The PSD is a special case of the cross spectral density (CPSD) function, defined between
two signals x(n) and y(n) as
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ny(m)=2_1n Z ny(m)e_jmm.

m=—oo

As is the case for the correlation and covariance sequences, the toolbox estimates the
PSD and CPSD because signal lengths are finite.

To estimate the cross-spectral density of two equal length signals x and y using Welch's
method, the cpsd function forms the periodogram as the product of the FFT of x and the
conjugate of the FFT of y. Unlike the real-valued PSD, the CPSD is a complex function.
cpsd handles the sectioning and windowing of x and y in the same way as the pwelch
function:

Sxy = cpsd(x,y,nwin,noverlap,nfft,fs)

Transfer Function Estimate

One application of Welch's method is nonparametric system identification. Assume that H
is a linear, time invariant system, and x(n) and y(n) are the input to and output of H,
respectively. Then the power spectrum of x(n) is related to the CPSD of x(n) and y(n) by

]

wlw) = Hiwm|P lw).

An estimate of the transfer function between x(n) and y(n) is

~
a0 Polw)
Hiw) == .

P la)

This method estimates both magnitude and phase information. The tfestimate function
uses Welch's method to compute the CPSD and power spectrum, and then forms their
quotient for the transfer function estimate. Use tfestimate the same way that you use
the cpsd function.

Generate a signal consisting of two sinusoids embedded in white Gaussian noise.

rng('default")

fs = 1000; % Sampling frequency
t = (0:fs)/fs; % One second worth of samples
A=1[12]; % Sinusoid amplitudes
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f = [150;140]; % Sinusoid frequencies
xn = A*¥sin(2*pi*f*t) + 0.1*randn(size(t));

Filter the signal xn with an FIR moving-average filter. Compute the actual magnitude
response and the estimated response.

h = ones(1,10)/10; % Moving-average filter
yn = filter(h,1,xn);

[HEST,f] = tfestimate(xn,yn, 256,128,256, fs);
H = freqz(h,1,f,fs);

Plot the results.

subplot(2,1,1)

plot(f,abs(H))

title('Actual Transfer Function Magnitude')
yl = ylim;

grid

subplot(2,1,2)

plot(f,abs(HEST))

title('Transfer Function Magnitude Estimate')
xlabel('Frequency (Hz)"')

ylim(yl)

grid
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Coherence Function

The magnitude-squared coherence between two signals x(n) and y(n) is

P_la)|?
O ) = Ll

'”’ PP, (w)

This quotient is a real number between 0 and 1 that measures the correlation between

x(n) and y(n) at the frequency .
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The mscohere function takes sequences xn and yn, computes their power spectra and
CPSD, and returns the quotient of the magnitude squared of the CPSD and the product of
the power spectra. Its options and operation are similar to the cpsd and tfestimate
functions.

Generate a signal consisting of two sinusoids embedded in white Gaussian noise. The
signal is sampled at 1 kHz for 1 second.

rng('default')

fs = 1000;

t = (0:fs)/fs;

A=1[12]; % Sinusoid amplitudes
f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.l*randn(size(t));

Filter the signal xn with an FIR moving-average filter. Compute and plot the coherence
function of xn and the filter output yn as a function of frequency.

h = ones(1,10)/10;
yn = filter(h,1,xn);

mscohere(xn,yn, 256,128,256, fs)
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If the input sequence length, window length, and number of overlapping data points in a
window are such that mscohere operates on only a single record, the function returns all
ones. This is because the coherence function for linearly dependent data is one.
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Parametric methods can yield higher resolutions than nonparametric methods in cases
when the signal length is short. These methods use a different approach to spectral
estimation; instead of trying to estimate the PSD directly from the data, they model the
data as the output of a linear system driven by white noise, and then attempt to estimate
the parameters of that linear system.

The most commonly used linear system model is the all-pole model, a filter with all of its
zeroes at the origin in the z-plane. The output of such a filter for white noise input is an
autoregressive (AR) process. For this reason, these methods are sometimes referred to as
AR methods of spectral estimation.

The AR methods tend to adequately describe spectra of data that is “peaky,” that is, data
whose PSD is large at certain frequencies. The data in many practical applications (such
as speech) tends to have “peaky spectra” so that AR models are often useful. In addition,
the AR models lead to a system of linear equations which is relatively simple to solve.

Signal Processing Toolbox AR methods for spectral estimation include:

* Yule-Walker AR method (autocorrelation method) on page 6-36
* Burg method on page 6-38

* Covariance method on page 6-42

* Modified covariance method on page 6-42

All AR methods yield a PSD estimate given by

1 e
Fs D . 2
1- de(k)e—]Qn'kf/Fs
k=1

P(f)=

The different AR methods estimate the parameters slightly differently, yielding different
PSD estimates. The following table provides a summary of the different AR methods.
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AR Methods
Burg Covariance Modified Yule-Walker
Covariance
Characteristics |Does not apply Does not apply Does not apply Applies window to
window to data window to data window to data data
Minimizes the Minimizes the Minimizes the Minimizes the
forward and forward prediction |forward and forward prediction
backward error in the least |backward error in the least
prediction errors |squares sense prediction errors |squares sense
in the least in the least
squares sense, squares sense (also called
with the AR “Autocorrelation
coefficients method”)
constrained to
satisfy the L-D
recursion
Advantages High resolution for | Better resolution |High resolution for |Performs as well
short data records |than Y-W for short |short data records |as other methods
data records (more for large data
accurate records
estimates)
Always produces a |Able to extract Able to extract Always produces a
stable model frequencies from |frequencies from |stable model
data consisting of |data consisting of
p Or more pure p Or more pure
sinusoids sinusoids
Does not suffer
spectral line-
splitting
Disadvantages Peak locations May produce May produce Performs relatively

highly dependent
on initial phase

unstable models

unstable models

poorly for short
data records
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Burg Covariance Modified Yule-Walker
Covariance

May suffer Frequency bias for |Peak locations Frequency bias for

spectral line- estimates of slightly dependent |estimates of

splitting for sinusoids in noise |on initial phase sinusoids in noise

sinusoids in noise,
or when order is

very large
Frequency bias for Minor frequency
estimates of bias for estimates
sinusoids in noise of sinusoids in
noise
Conditions for Order must be less |Order must be less | Because of the
Nonsingularity than or equal to than or equal to biased estimate,
half the input 2/3 the input the
frame size frame size autocorrelation

matrix is
guaranteed to
positive-definite,
hence nonsingular

Yule-Walker AR Method

The Yule-Walker AR method of spectral estimation computes the AR parameters by solving
the following linear system, which give the Yule-Walker equations in matrix form:

r0 @ .. rp-p)e®) (r@

o fo e | *P =T

r(p-1) r(p-2) ... r(0) ' ’
a(p) r(p)

In practice, the biased estimate of the autocorrelation is used for the unknown true
autocorrelation.The Yule-Walker AR method produces the same results as a maximum
entropy estimator. For more information, see page 155 of item [2] in the “Selected
Bibliography” on page 6-47.

The use of a biased estimate of the autocorrelation function ensures that the
autocorrelation matrix above is positive definite. Hence, the matrix is invertible and a
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solution is guaranteed to exist. Moreover, the AR parameters thus computed always result
in a stable all-pole model. The Yule-Walker equations can be solved efficiently via
Levinson’s algorithm, which takes advantage of the Hermitian Toeplitz structure of the
autocorrelation matrix.

The toolbox function pyulear implements the Yule-Walker AR method. For example,

compare the spectrum of a speech signal using Welch's method and the Yule-Walker AR
method:

load mtlb
[Pxx,F] = pwelch(mtlb,hamming(256),128,1024,Fs);
plot(F,10*10ogl0(Pxx))

T — ~=loi x|

File Edit Wiew Insert Tools Desktop Window Help
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YWelch Power Spectral Density Estimate
-20 T T T T
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| i i i
0.s 1 15 2 248 3 348
Frequency (kHz)

]

order = 14;
[Pxx,F] = pyulear(mtlb,order,1024,fs);
plot(F,10*10ogl0(Pxx))
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The Yule-Walker AR spectrum is smoother than the periodogram because of the simple
underlying all-pole model.

Burg Method

The Burg method for AR spectral estimation is based on minimizing the forward and
backward prediction errors while satisfying the Levinson-Durbin recursion (see

Marple [3], Chapter 7, and Proakis [6], Section 12.3.3). In contrast to other AR estimation
methods, the Burg method avoids calculating the autocorrelation function, and instead
estimates the reflection coefficients directly.

The primary advantages of the Burg method are resolving closely spaced sinusoids in
signals with low noise levels, and estimating short data records, in which case the AR
power spectral density estimates are very close to the true values. In addition, the Burg
method ensures a stable AR model and is computationally efficient.

The accuracy of the Burg method is lower for high-order models, long data records, and
high signal-to-noise ratios (which can cause line splitting, or the generation of extraneous
peaks in the spectrum estimate). The spectral density estimate computed by the Burg
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method is also susceptible to frequency shifts (relative to the true frequency) resulting
from the initial phase of noisy sinusoidal signals. This effect is magnified when analyzing
short data sequences.

The toolbox function pburg implements the Burg method. Compare the spectrum of the
speech signal generated by both the Burg method and the Yule-Walker AR method. They
are very similar for large signal lengths:

load mtlb

order = 14;

[Pburg,F] = pburg(mtlb(1:512),0order,1024,fs);
plot(F,10*1ogl0(Pburg))

rgwes -ioix
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[Pxx,F] = pyulear(mtlb(1:512),0RDER,1024,fs);
plot(F,10*1ogl0(Pxx))
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Compare the spectrum of a noisy signal computed using the Burg method and the Welch

method:

fs = 1000; % Sampling frequency

t = (0:fs)/fs; % One second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));
pwelch(xn,hamming(256),128,1024,fs)
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pburg(xn, 14,1024, fs)
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Note that, as the model order for the Burg method is reduced, a frequency shift due to
the initial phase of the sinusoids will become apparent.

Covariance and Modified Covariance Methods

The covariance method for AR spectral estimation is based on minimizing the forward
prediction error. The modified covariance method is based on minimizing the forward and
backward prediction errors. The toolbox functions pcov and pmcov implement the
respective methods.

Compare the spectrum of the speech signal generated by both the covariance method and
the modified covariance method. They are nearly identical, even for a short signal length:

load mtlb
pcov(mtlb(1l:64),14,1024,fs)



Parametric Methods

T e —— ~=loi x|

File Edit Wiew Insert Tools Desktop Window Help N
DeEE KRaMme | 08| 5O

Covariance Power Spectral Density Estimate
'30 T T T T T T T

Powerfrequency (dB/Hz)

| i i i i
0.s 1 15 2 248 3 348
Frequency (kHz)

-90 | i
0

pmcov(mtlb(1:64),14,1024,fs)
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MUSIC and Eigenvector Analysis Methods

The pmusic function and peig functions provide two related spectral analysis methods:

* pmusic provides the multiple signal classification (MUSIC) method developed by
Schmidt

* peig provides the eigenvector (EV) method developed by Johnson

Both of these methods are frequency estimator techniques based on eigenanalysis of the
autocorrelation matrix. This type of spectral analysis categorizes the information in a
correlation or data matrix, assigning information to either a signal subspace or a noise
subspace.

Eigenanalysis Overview

Consider a number of complex sinusoids embedded in white noise. You can write the
autocorrelation matrix R for this system as the sum of the signal autocorrelation matrix
(S) and the noise autocorrelation matrix (W):
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R =S + W. There is a close relationship between the eigenvectors of the signal
autocorrelation matrix and the signal and noise subspaces. The eigenvectors v of S span
the same signal subspace as the signal vectors. If the system contains M complex
sinusoids and the order of the autocorrelation matrix is p, eigenvectors vy, through v,,,
span the noise subspace of the autocorrelation matrix.

Frequency Estimator Functions

To generate their frequency estimates, eigenanalysis methods calculate functions of the
vectors in the signal and noise subspaces. Both the MUSIC and EV techniques choose a
function that goes to infinity (denominator goes to zero) at one of the sinusoidal
frequencies in the input signal. Using digital technology, the resulting estimate has sharp
peaks at the frequencies of interest; this means that there might not be infinity values in
the vectors.

The MUSIC estimate is given by the formula
___ 1

M 9’

3 et

k=p+1

Pyusie(H =

where the v, are the eigenvectors of the noise subspace and e(f) is a vector of complex
sinusoids:

Here v represents the eigenvectors of the input signal's correlation matrix; vy is the kth
eigenvector. H is the conjugate transpose operator. The eigenvectors used in the sum
correspond to the smallest eigenvalues and span the noise subspace (p is the size of the
signal subspace).

The expression e(f)"v, is equivalent to a Fourier transform (the vector e(f) consists of
complex exponentials). This form is useful for numeric computation because the FFT can
be computed for each v, and then the squared magnitudes can be summed.

The EV method weights the summation by the eigenvalues of the correlation matrix:
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k=p+1

Pay(f) =

The pmusic and peig functions in this toolbox interpret their first input either as a signal
matrix or as a correlation matrix (if the 'corr' input flag is set). In the former case, the
singular value decomposition of the signal matrix is used to determine the signal and
noise subspaces. In the latter case, the eigenvalue decomposition of the correlation
matrix is used to determine the signal and noise subspaces.
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Windows
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In this section...

“Why Use Windows?” on page 7-2

“Basic Shapes” on page 7-3

“Available Window Functions” on page 7-2
“Graphical User Interface Tools” on page 7-3

Why Use Windows?

In both digital filter design and spectral estimation, the choice of a windowing function
can play an important role in determining the quality of overall results. The main role of
the window is to damp out the effects of the Gibbs phenomenon that results from

truncation of an infinite series.

Available Window Functions

Window Function
Bartlett-Hann window barthannwin
Bartlett window bartlett
Blackman window blackman
Blackman-Harris window blackmanharris
Bohman window bohmanwin
Chebyshev window chebwin

Flat Top window flattopwin
Gaussian window gausswin
Hamming window hamming
Hann window hann

Kaiser window kaiser
Nuttall's Blackman-Harris window nuttallwin
Parzen (de la Vallée-Poussin) window parzenwin
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Window Function
Rectangular window rectwin
Tapered cosine window tukeywin
Triangular window triang

Graphical User Interface Tools

Two graphical user interface tools are provided for working with windows in the Signal
Processing Toolbox product:

* Window Designer app
*  Window Visualization Tool (wvtool)

Refer to the reference pages for detailed information.

Basic Shapes

The basic window is the rectangular window, a vector of ones of the appropriate length. A
rectangular window of length 50 is

50;
rectwin(n);

n
w

This toolbox stores windows in column vectors by convention, so an equivalent expression
is

w = ones(50,1);
To use the Window Designer app to create this window, type
windowDesigner

The app opens with a default Hamming window. To visualize the rectangular window, set
Type = Rectangular and Length = 50 in the Current Window Information panel and
then press Apply.

The Bartlett (or triangular) window is the convolution of two rectangular windows. The
functions bartlett and triang compute similar triangular windows, with three
important differences. The bartlett function always returns a window with two zeros on
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the ends of the sequence, so that for n odd, the center section of bartlett(n+2) is
equivalent to triang(n):

Bartlett = bartlett(7);
isequal(Bartlett(2:end-1),triang(5))

ans =
1

For n even, bartlett is still the convolution of two rectangular sequences. There is no
standard definition for the triangular window for n even; the slopes of the line segments
of the triang result are slightly steeper than those of bartlett in this case:

w = bartlett(8);
[w(2:7) triang(6)]

You can see the difference between odd and even Bartlett windows in Window Designer.



Windows

| File View Tools Window Help

-]

Dar O a<«idBEw

rWindow Viewer

Time domain - Frequency domaln
1 — Barliatt_8
Bartlatt_7
0
03
2
@ = .
b=
2 0.6 §
[=%
g E
0.4 = -100
0.2 =150
0 =200
2 4 6 8 10 12 14 16 0 50 100 150 200
Time (ms}) Frequency (Hz)
Leakage Factor: 0.28 % Relative sidelobe attenuation: -25.2 dB Mainlobe width (-3dB). 93.334 H=z
Window List —Current Window Information
Select windows to display: Name: Bartiett_8 | -
Bartlett 7 -
Bartlett 8 [ Add a new window ] Type Bartlett ~
[ Copy window ] Length:
[ Save to workspace ] Farameter? I:l
[ Delete ]

The final difference between the Bartlett and triangular windows is evident in the Fourier
transforms of these functions. The Fourier transform of a Bartlett window is negative for
n even. The Fourier transform of a triangular window, however, is always nonnegative.

7-5



7 Special Topics

The following figure, which plots the zero-phase responses of 8-point Bartlett and
Triangular windows, illustrates the difference.

zerophase(bartlett(8))

hold on

zerophase(triang(8))
legend('Bartlett', 'Triangular')
axis([0.3 1 -0.2 0.5])

Eile Edit Niew Inset Tools Desktop Window Help
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See Also

This difference can be important when choosing a window for some spectral estimation
techniques, such as the Blackman-Tukey method. Blackman-Tukey forms the spectral
estimate by calculating the Fourier transform of the autocorrelation sequence. The
resulting estimate might be negative at some frequencies if the window's Fourier
transform is negative.

See Also

Apps
Window Designer

Functions
bartlett | rectwin | triang | wvtool
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Getting Started with Window Designer

Typing windowDesigner at the command line opens the Window Designer app for

designing and analyzing spectral windows. The app opens with a default 64-point
Hamming window.

Note A related tool, wwtool, is available for displaying, annotating, or printing windows.




Getting Started with Window Designer

= . . F T
Window Designer .;l =
File View Tools Window Help o
D&k T a< dd|E)w
~Window Viewer l
Time domain . Frequency domaln
1
20 i
048 0
g
@ =
= =20
2 0.6 §
E € 0
= g
04 =
=60
02
-B0
a -100
20 40 60 80 100 120 0 50 100 150 200
Time (ms}) Frequency (Hz)
Leakage Factor: 0.04 % Relative sidelobe attenuation: -42.4 dB Mainlobe width (-3dB). 10.254 H=z
Window List —Current Window Information
Select windows to display: Name: windaw_1 | -
window 1 -
| Add anew window | Type: Hamming -
WATLAB code:
[ Copy window ] Length:
Parameter: I:I
[ Save o workspace ] Parameter2: I:l
[ Delste ] | i
< Apply
The app has three panels:
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Window Viewer displays the time domain and frequency domain representations of the
selected window(s). The currently active window is shown in bold. Three window
measurements are shown below the plots.

* Leakage factor — ratio of power in the sidelobes to the total window power

* Relative sidelobe attenuation — difference in height from the mainlobe peak to the
highest sidelobe peak

* Mainlobe width (-3dB) — width of the mainlobe at 3 dB below the mainlobe peak
Window List lists the windows available for display in the Window Viewer. Highlight
one or more windows to display them. The Window List buttons are:

* Add a new window — Adds a default Hamming window with length 64 and
symmetric sampling. You can change the information for this window by applying
changes made in the Current Window Information panel.

* Copy window — Copies the selected window(s).

* Save to workspace — Saves the selected window(s) as vector(s) to the MATLAB
workspace. The name of the window is used as the vector name.

* Delete — Removes the selected window(s) from the window list.

Current Window Information displays information about the currently active window.
The active window name is shown in the Name field. To make another window active,
select its name from the Name menu.

Window Parameters

Each window is defined by the parameters in the Current Window Information panel. You
can change the current window's characteristics by changing its parameters and clicking
Apply. The parameters of the current window are

Name — Name of the window. The name is used for the legend in the Window Viewer,
in the Window List, and for the vector saved to the workspace. You can either select a
name from the menu or type the desired name in the edit box.

Type — Algorithm for the window. Select the type from the menu. All Signal
Processing Toolbox windows are available.

MATLAB code — Any valid MATLAB expression that returns a vector defining the
window if Type = User Defined.

Length — Number of samples.
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Parameter — Additional parameter for windows that require it, such as Chebyshey,
which requires you to specify the sidelobe attenuation. Note that the title “Parameter”
changes to the appropriate parameter name.

Sampling — Type of sampling to use for generalized cosine windows (Hamming,
Hann, and Blackman) — Periodic or Symmetric. Periodic computes a length n+1
window and returns the first n points, and Symmet ric computes and returns the n
points specified in Length.

Window Designer Menus

In addition to the usual menu items, Window Designercontains these menu commands:

File menu:

Export — Exports window coefficient vectors to the MATLAB workspace, a text file, or
a MATile.

In the Window List in, highlight the window(s) you want to export and then select
File > Export. For exporting to the workspace or a MAT-file, specify the variable name
for each set of window coefficients. To overwrite variables in the workspace, select the
Overwrite variables check box.

Full View Analysis — Copies the windows shown in both plots to a separate wvtool
figure window. This is useful for printing and annotating. This option is also available
with the Full View Analysis toolbar button.

View menu:

Time domain — Select to show the time domain plot in the Window Viewer panel.

Frequency domain — Select to show the frequency domain plot in the Window
Viewer panel.

Legend — Toggles the window name legend on and off. This option is also available
with the Legend toolbar button.

Analysis Parameters — Controls the response plot parameters, including number of
points, range, x- and y-axis units, sampling frequency, and normalized magnitude.

You can also access the Analysis Parameters by right-clicking the x-axis label of a plot
in the Window Viewer panel. The x-axis units for the time domain plot depend on the
selected Sampling Frequency units.
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Frequency Domain Time Domain
Hz S
kHz ms
MHz Bs
GHz ns
Tools menu:

* Zoom In — Zooms in along both x- and y-axes.

* Zoom X — Zooms in along the x-axis only. Drag the mouse in the x direction to select
the zoom area.

* Zoom Y — Zooms in along the y-axis only. Drag the mouse in the y direction to select
the zoom area.

¢ Full View — Returns to full view.

See Also

Functions
window | wvtool



Generalized Cosine Windows

Generalized Cosine Windows

Blackman, flat top, Hamming, Hann, and rectangular windows are all special cases of the
generalized cosine window. These windows are combinations of sinusoidal sequences
with frequencies that are multiples of 2m/(N - 1), where N is the window length. One
special case is the Blackman window:

N = 128;

A =0.42;

B =20.5;

C =0.08;

ind = (0:N-1)'*2*pi/(N-1);

w = A - B*cos(ind) + C*cos(2*ind);

Changing the values of the constants A, B, and C in the previous expression generates
different generalized cosine windows like the Hamming and Hann windows. Adding
additional cosine terms of higher frequency generates the flat top window. The concept
behind these windows is that by summing the individual terms to form the window, the
low frequency peaks in the frequency domain combine in such a way as to decrease
sidelobe height. This has the side effect of increasing the mainlobe width.

The Hamming and Hann windows are two-term generalized cosine windows, given by
A =0.54,B = 0.46 for the Hamming and A = 0.5, B = 0.5 for the Hann.

Note that the definition of the generalized cosine window shown in the earlier MATLAB
code yields zeros at samples 1 and n forA=0.5and B =0.5.

This Window Designer screen shot compares Blackman, Hamming, Hann, and Flat Top
windows.
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- —
Window Designer L —.

File View Tools Window Help

D&k D a< ddEw

rWindow Viewer
: Time domain - Frequency domaln
_Hamng
0.8 o Blackman
—— Hann
. — Flatiap
0.6 @ o I ’F
@ =2 . i
2 3 4l !
—E_ 04 2 .
=
< = -100 i | t
02 = I I
. 1
0 150 I
-0.2 =200
20 40 60 80 100 120 0 50 100 150 200
Time (ms) Frequency (Hz)
Leakage Factor: 0.04 % Relative sidelobe attenuation: -42.4 dB Mainlobe width (-3dB). 10.254 H=z
Window List —Current Window Information
Select windows to display: Name: Hamming | -
| Add anew window | Type: Hamming -
MATLAB code:
[ Copy window ] Length:
Parameter: I:I
[ Save o workspace ] Parameter2: I:l
[ Delete ]
< Apply

7-14



See Also

See Also

Apps
Window Designer

Functions
blackman | flattopwin | hamming | hann | wvtool
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The Kaiser window is an approximation to the prolate spheroidal window, for which the
ratio of the mainlobe energy to the sidelobe energy is maximized. For a Kaiser window of
a particular length, the parameter  controls the sidelobe height. For a given §, the
sidelobe height is fixed with respect to window length. The statement kaiser(n,beta)
computes a length n Kaiser window with parameter beta.

Examples of Kaiser windows with length 50 and 8 parameters of 1, 4, and 9 are shown in
this example.



Kaiser Window

File View Tools Window Help o
D&k T a< dd|E)w
rWindow Viewer
Time domain F
50
1
0
03
2
@ = .
b=
2 0.6 §
g =
0.4 E -100
0.2 =150
0 =200
20 40 60 80 100 0 50 100 150 200
Time (ms}) Frequency (Hz)
Leakage Factor: 0 % Relative sidelobe attenuation: 55.9 dB Mainlobe width (-3dB). 16.958 H=z
Window List —Current Window Information
Select windows to display: Name: Kaiserd | -
Kaiser - ) -
Kaiserd [ Add a new window ] Type: Kaiger -
Kaiser] WATLAB code:
[ Copy window ] Length:
Beta: o
[ Save o workspace ] Parameter2: I:l
[ Delete ]
< Apply

To create these Kaiser windows using the MATLAB command line, type the following:

n = 50;
wl = kaiser(n,1);
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w2 kaiser(n,4);

w3 kaiser(n,9);

[Wl,f] freqz(wl/sum(wl),1,512,2);

[W2,f] freqz(w2/sum(w2),1,512,2);

[W3,f] freqz(w3/sum(w3),1,512,2);
plot(f,20*loglO(abs([W1 W2 W3])))

grid

legend('\beta = 1', '\beta = 4',"'\beta = 9")
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As B increases, the sidelobe height decreases and the mainlobe width increases. This
screen shot shows how the sidelobe height stays the same for a fixed  parameter as the
length is varied.
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File View Tools Window Help k]
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Window List —Current Window Information
Select windows to display: Name: Kaisersg | -
_ [CAddanew window | | | Tyee Kaiser _
WATLAB code:
[ Copy window ] Length:
Beta: I:I
[ Save to workspace ] Parameterz: I:l
[ Delete )
-

To create these Kaiser windows using the MATLAB command line, type the following:

wl = kaiser(50,4);
w2 kaiser(20,4);
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w3 = kaiser(101,4);

[W1,f] = freqz(wl/sum(wl),1,512,2);
[W2,f] = freqz(w2/sum(w2),1,512,2);
[W3,f] = freqz(w3/sum(w3),1,512,2);

plot(f,20*1ogl0(abs([W1 W2 W3])))
grid
legend('length = 50", 'length = 20', 'length = 101")
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Kaiser Windows in FIR Design

There are two design formulas that can help you design FIR filters to meet a set of filter
specifications using a Kaiser window. To achieve a sidelobe height of -a dB, the 8 (beta)
parameter is

0.1102(ex— 8.7), a > 50,
f=14 0.5842(a— 21" 4+ 0.7886la—21). 50=a =21,
0, a = 21,

For a transition width of 4 rad/sample, use the length

_ _u—8§
2.285Am
Filters designed using these heuristics will meet the specifications approximately, but you
should verify this. To design a lowpass filter with cutoff frequency 0.5% rad/sample,

transition width 0.2 rad/sample, and 40 dB of attenuation in the stopband, try

[n,wn,beta] = kaiserord([0.4 0.6]*pi,[1 0],[0.01 0.01],2*pi);
h = firl(n,wn,kaiser(n+1,beta), 'noscale');

The kaiserord function estimates the filter order, cutoff frequency, and Kaiser window
beta parameter needed to meet a given set of frequency domain specifications.

The ripple in the passband is roughly the same as the ripple in the stopband. As you can
see from the frequency response, this filter nearly meets the specifications:

fvtool(h,1)
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See Also

Apps
Window Designer

Functions
freqz | kaiser | kaiserord | wvtool
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Chebyshev Window

The Chebyshev window minimizes the mainlobe width, given a particular sidelobe height.
It is characterized by an equiripple behavior. Its sidelobes all have the same height.

Generate and display a 50-point Chebyshev window with a sidelobe attenuation of 40 dB.

w = chebwin(50,40);
wvtool(w)
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As shown in the time-domain plot, the Chebyshev window has large spikes at its outer
samples.




See Also

See Also

Apps
Window Designer

Functions
chebwin | wvtool
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In this section...

“What is Parametric Modeling” on page 7-26

“Available Parametric Modeling Functions” on page 7-26
“Time-Domain Based Modeling” on page 7-27
“Frequency-Domain Based Modeling” on page 7-30

What is Parametric Modeling

Parametric modeling techniques find the parameters for a mathematical model describing
a signal, system, or process. These techniques use known information about the system to
determine the model. Applications for parametric modeling include speech and music
synthesis, data compression, high-resolution spectral estimation, communications,
manufacturing, and simulation.

Available Parametric Modeling Functions

The toolbox parametric modeling functions operate with the rational transfer function
model. Given appropriate information about an unknown system (impulse or frequency
response data, or input and output sequences), these functions find the coefficients of a
linear system that models the system.

One important application of the parametric modeling functions is in the design of filters
that have a prescribed time or frequency response.

Here is a summary of the parametric modeling functions in this toolbox.

Domain Functions Description

Time arburg Generate all-pole filter coefficients that model an
input data sequence using the Levinson-Durbin
algorithm.

arcov Generate all-pole filter coefficients that model an
input data sequence by minimizing the forward
prediction error.




Parametric Modeling

Domain Functions Description

armcov Generate all-pole filter coefficients that model an
input data sequence by minimizing the forward
and backward prediction errors.

aryule Generate all-pole filter coefficients that model an
input data sequence using an estimate of the
autocorrelation function.

lpc, levinson Linear Predictive Coding. Generate all-pole
recursive filter whose impulse response matches a
given sequence.

prony Generate IIR filter whose impulse response
matches a given sequence.
stmch Find IIR filter whose output, given a specified
input sequence, matches a given output sequence.
Frequency invfreqz, Generate digital or analog filter coefficients given
invfreqgs complex frequency response data.

Time-Domain Based Modeling

The 1pc, prony, and stmcb functions find the coefficients of a digital rational transfer
function that approximates a given time-domain impulse response. The algorithms differ
in complexity and accuracy of the resulting model.

Linear Prediction

Linear prediction modeling assumes that each output sample of a signal, x(k), is a linear
combination of the past n outputs (that is, it can be linearly predicted from these
outputs), and that the coefficients are constant from sample to sample:

k) = —a@xk -1l —aBxk-2y- . —an+ Lixk-n)
An nth-order all-pole model of a signal x is
a = lpc(x,n)

To illustrate 1pc, create a sample signal that is the impulse response of an all-pole filter
with additive white noise:

x = impz(1,[1 0.1 0.1 0.1 0.1],10) + randn(10,1)/10;
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The coefficients for a fourth-order all-pole filter that models the system are
a = lpc(x,4)

1lpc first calls xcorr to find a biased estimate of the correlation function of x, and then
uses the Levinson-Durbin recursion, implemented in the levinson function, to find the
model coefficients a. The Levinson-Durbin recursion is a fast algorithm for solving a
system of symmetric Toeplitz linear equations. Lpc's entire algorithm for n = 4 is

r = xcorr(x);
r(l:length(x)-1
a = n(r

) = [1; % Remove corr. at negative lags
levinso ,4)

You could form the linear prediction coefficients with other assumptions by passing a
different correlation estimate to Levinson, such as the biased correlation estimate:

r = xcorr(x, 'biased');
r(l:length(x)-1) = []; % Remove corr. at negative lags
a = levinson(r,4)

Prony's Method (ARMA Modeling)

The prony function models a signal using a specified number of poles and zeros. Given a
sequence X and numerator and denominator orders n and m, respectively, the statement

[b,al = prony(x,n,m)

finds the numerator and denominator coefficients of an IIR filter whose impulse response
approximates the sequence x.

The prony function implements the method described in [4] Parks and Burrus

(pgs. 226-228). This method uses a variation of the covariance method of AR modeling to
find the denominator coefficients a, and then finds the numerator coefficients b for which
the resulting filter's impulse response matches exactly the first n + 1 samples of x. The
filter is not necessarily stable, but it can potentially recover the coefficients exactly if the
data sequence is truly an autoregressive moving-average (ARMA) process of the correct
order.

Note The functions prony and stmcb (described next) are more accurately described as
ARX models in system identification terminology. ARMA modeling assumes noise only at
the inputs, while ARX assumes an external input. prony and stmcb know the input
signal: it is an impulse for prony and is arbitrary for stmcb.
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A model for the test sequence x (from the earlier 1pc example) using a third-order IIR
filter is

[b,al = prony(x,3,3)

The impz command shows how well this filter's impulse response matches the original
sequence:

format long
[x impz(b,a,10)]

Notice that the first four samples match exactly. For an example of exact recovery,
recover the coefficients of a Butterworth filter from its impulse response:

[b,a] = butter(4,.2);
h = impz(b,a,26);
[bb,aa] = prony(h,4,4);

Try this example; you'll see that bb and aa match the original filter coefficients to within
a tolerance of 1013,

Steiglitz-McBride Method (ARMA Modeling)

The stmcb function determines the coefficients for the system b(z)/a(z) given an
approximate impulse response X, as well as the desired number of zeros and poles. This
function identifies an unknown system based on both input and output sequences that
describe the system's behavior, or just the impulse response of the system. In its default
mode, stmcb works like prony.

[b,a] = stmcb(x,3,3)
stmcb also finds systems that match given input and output sequences:

y = filter(1,[1 1],x)

; % Create an output signal.
[b,a] = stmcb(y,x,0,1)

In this example, stmcb correctly identifies the system used to create y from x.

The Steiglitz-McBride method is a fast iterative algorithm that solves for the numerator
and denominator coefficients simultaneously in an attempt to minimize the signal error
between the filter output and the given output signal. This algorithm usually converges
rapidly, but might not converge if the model order is too large. As for prony, stmcb's
resulting filter is not necessarily stable due to its exact modeling approach.
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stmcb provides control over several important algorithmic parameters; modify these
parameters if you are having trouble modeling the data. To change the number of
iterations from the default of five and provide an initial estimate for the denominator
coefficients:

n 10; % Number of iterations
a lpc(x,3); % Initial estimates for denominator
[b,a]l] = stmcb(x,3,3,n,a);

The function uses an all-pole model created with prony as an initial estimate when you
do not provide one of your own.

To compare the functions 1pc, prony, and stmch, compute the signal error in each case:

al = lpc(x,3);

[b2,a2] = prony(x,3,3);

[b3,a3] = stmcb(x,3,3);

[x-impz(1,al,10) x-impz(b2,a2,10) x-impz(b3,a3,10)]

In comparing modeling capabilities for a given order IIR model, the last result shows that
for this example, stmch performs best, followed by prony, then 1pc. This relative
performance is typical of the modeling functions.

Frequency-Domain Based Modeling

The invfregs and invfreqz functions implement the inverse operations of freqs and
freqz; they find an analog or digital transfer function of a specified order that matches a
given complex frequency response. Though the following examples demonstrate
invfreqz, the discussion also applies to invfreqs.

To recover the original filter coefficients from the frequency response of a simple digital
filter:

[b,a] = butter(4,0.4) % Design Butterworth lowpass
[h,w] = freqz(b,a,64); % Compute frequency response
[b4,ad4] = invfreqz(h,w,4,4) % Model: n =4, m=4

The vector of frequencies w has the units in rad/sample, and the frequencies need not be
equally spaced. invfreqz finds a filter of any order to fit the frequency data; a third-
order example is

[b4,ad4] = invfreqz(h,w,3,3) % Find third-order IIR
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Both invfreqs and invfreqz design filters with real coefficients; for a data point at
positive frequency f, the functions fit the frequency response at both f and - f.

By default invfreqz uses an equation error method to identify the best model from the
data. This finds b and a in

min Y with)|hik)Awiky) - Blew(h))|?

ba

k=1

by creating a system of linear equations and solving them with the MATLAB \ operator.
Here A(w(k)) and B(w(k)) are the Fourier transforms of the polynomials a and b
respectively at the frequency w(k), and n is the number of frequency points (the length of
h and w). wt(k) weights the error relative to the error at different frequencies. The syntax

invfreqz(h,w,n,m,wt)

includes a weighting vector. In this mode, the filter resulting from invfreqz is not
guaranteed to be stable.

invfreqz provides a superior (“output-error”) algorithm that solves the direct problem
of minimizing the weighted sum of the squared error between the actual frequency
response points and the desired response

n
2
min Y wt[k;‘h[!z;—m‘
R

Aok

To use this algorithm, specify a parameter for the iteration count after the weight vector
parameter:

wt = ones(size(w)); % Create unity weighting vector
[b30,a30] = invfreqz(h,w,3,3,wt,30) % 30 iterations

The resulting filter is always stable.

Graphically compare the results of the first and second algorithms to the original
Butterworth filter with FVTool (and select the Magnitude and Phase Responses):

fvtool(b,a,b4,a4,b30,a30)
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To verify the superiority of the fit numerically, type

sum(abs (h-freqz(b4,a4,w)).”2)
sum(abs (h-freqz(b30,a30,w))."2)

Total error,
Total error,

o
“©
o

“©
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Resampling

In this section...

“Available Resampling Functions” on page 7-33
“resample Function” on page 7-33

“decimate and interp Functions” on page 7-35
“upfirdn Function” on page 7-35

“spline Function” on page 7-35

Available Resampling Functions

The toolbox provides a number of functions that resample a signal at a higher or lower

rate.

Operation Function
Apply FIR filter with resampling |upfirdn
Cubic spline interpolation spline
Decimation decimate
Interpolation interp
Other 1-D interpolation interpl
Resample at new rate resample

resample Function

The resample function changes the sampling rate for a sequence to any rate that is a
ratio of two integers. The basic syntax for resample is

y = resample(x,p,q)

where the function resamples the sequence x at p/q times the original sampling rate. The
length of the result y is p/q times the length of x.

One resampling application is the conversion of digitized audio signals from one sampling
rate to another, such as from 48 kHz (the digital audio tape standard) to 44.1 kHz (the
compact disc standard).
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The example file contains a length 4001 vector of speech sampled at 7418 Hz:
clear

load mtlb

whos

Name Size Bytes C(lass Attributes

Fs 1x1 8 double
mtlb 4001x1 32008 double

Fs
Fs =
7418

To play this speech signal on a workstation that can only play sound at 8192 Hz, use the
rat function to find integers p and q that yield the correct resampling factor:

[p,q] = rat(8192/Fs,0.0001)

Since p/gq*Fs = 8192.05 Hz, the tolerance of 0.0001 is acceptable; to resample the
signal at very close to 8192 Hz:

y = resample(mtlb,p,q);

resample applies a lowpass filter to the input sequence to prevent aliasing during
resampling. It designs this filter using the firls function with a Kaiser window. The
syntax

resample(x,p,q,l,beta)

controls the filter's length and the beta parameter of the Kaiser window. Alternatively, use
the function intfilt to design an interpolation filter b and use it with

resample(x,p,q,b)



Resampling

decimate and interp Functions

The decimate and interp functions do the same thing as resample withp=1and q =
1, respectively. These functions provide different anti-alias filtering options, and they
incur a slight signal delay due to filtering. The interp function is significantly less
efficient than the resample function with q = 1.

upfirdn Function
The toolbox also contains a function, upfirdn, that applies an FIR filter to an input

sequence and outputs the filtered sequence at a sample rate different than its original.
See “Multirate Filter Bank Implementation” on page 1-8.

spline Function
The standard MATLAB environment contains a function, spline, that works with

irregularly spaced data. The MATLAB function interpl performs interpolation, or table
lookup, using various methods including linear and cubic interpolation.
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What Is a Cepstrum?

Cepstrum analysis is a nonlinear signal processing technique with a variety of
applications in areas such as speech and image processing.

The complex cepstrum of a sequence x is calculated by finding the complex natural
logarithm of the Fourier transform of x, then the inverse Fourier transform of the
resulting sequence:

o
X= 1 [ log X gl _rl’-"-""'- ey,
2ad_q

The toolbox function cceps performs this operation, estimating the complex cepstrum for
an input sequence. It returns a real sequence the same size as the input sequence.

Try using cceps in an echo detection application. First, create a 45 Hz sine wave sampled
at 100 Hz. Add an echo of the signal, with half the amplitude, 0.2 seconds after the
beginning of the signal.

t =0:0.01:1.27;
sl = sin(2*pi*45*t);
s2 sl + 0.5%[zeros(1,20) s1(1:108)1;

Compute and plot the complex cepstrum of the new signal.

C = cceps(s2);
plot(t,c)



Cepstrum Analysis
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The complex cepstrum shows a peak at 0.2 seconds, indicating the echo.

The real cepstrum of a signal x, sometimes called simply the cepstrum, is calculated by
determining the natural logarithm of magnitude of the Fourier transform of x, then
obtaining the inverse Fourier transform of the resulting sequence:

-

Cp = L / log | X(ef™) e dp,

i -

The toolbox function rceps performs this operation, returning the real cepstrum for a
sequence. The returned sequence is a real-valued vector the same size as the input
vector.
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The rceps function also returns a unique minimum-phase sequence that has the same
real cepstrum as the input. To obtain both the real cepstrum and the minimum-phase
reconstruction for a sequence, use [y,ym] = rceps(x), where y is the real cepstrum
and ym is the minimum phase reconstruction of x. The following example shows that one
output of rceps is a unique minimum-phase sequence with the same real cepstrum as Xx.

y = [415]; % Non-minimum phase sequence
[xhat,yhat] = rceps(y);

xhat2 = rceps(yhat);

[xhat' xhat2']

ans = 3x2

1.6225 1.6225
0.3400 0.3400
0.3400 0.3400

Inverse Complex Cepstrum

To invert the complex cepstrum, use the icceps function. Inversion is complicated by the
fact that the cceps function performs a data-dependent phase modification so that the
unwrapped phase of its input is continuous at zero frequency. The phase modification is
equivalent to an integer delay. This delay term is returned by cceps if you ask for a
second output:

x = 1:10;
[xhat,delay] = cceps(x)

xhat = 1Ix10

2.2428 -0.0420 -0.0210 0.0045 0.0366 0.0788 0.1386 0.2327

delay =1

To invert the complex cepstrum, use icceps with the original delay parameter:

icc icceps(xhat,?2)
icc = 1x10

2.0000 3.0000 4.0000 5.0000 6.0000 7.0000 8.0000 9.0000

10.(



See Also

As shown in the above example, with any modification of the complex cepstrum, the

original delay term may no longer be valid. You will not be able to invert the complex
cepstrum exactly.

See Also

cceps | icceps | rceps
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FFT-Based Time-Frequency Analysis
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The Signal Processing Toolbox™ product provides functions that return the time-
dependent Fourier transform for a sequence, or displays this information as a
spectrogram. The time-dependent Fourier transform is the discrete-time Fourier
transform for a sequence, computed using a sliding window. This form of the Fourier
transform, also known as the short-time Fourier transform (STFT), has numerous
applications in speech, sonar, and radar processing. The spectrogram of a sequence is the
magnitude of the time-dependent Fourier transform versus time.

To display the spectrogram of a signal, you can use the pspectrum function. For
example, generate two seconds of a signal sampled at 10 kHz. Specify the instantaneous
frequency of the signal as a triangular function of time. To compute the spectrogram,
divide the signal into segments of duration 0.0256 second and specify 86% segment-to-
segment overlap. The leakage measures the ability of the sliding window to detect a weak
tone from noise in the presence of a neighboring strong tone. Specify a leakage of 0.875.

fs = 10000;
t =0:1/fs:2;
X = vco(sawtooth(2*pi*t,0.75),[0.1 0.4]*fs,fs);

pspectrum(x,fs, 'spectrogram',
'TimeResolution',0.0256, 'Overlap',86, 'Leakage',0.875)



FFT-Based Time-Frequency Analysis
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The persistence spectrum of a signal is a time-frequency view that shows the percentage
of the time that a given frequency is present in a signal. The persistence spectrum is a
histogram in power-frequency space. The longer a particular frequency persists in a
signal as the signal evolves, the higher its time percentage and thus the brighter or
"hotter" its color in the display.

Compute and display the persistence spectrum of the signal. Specify a time resolution of
0.01 second, 50% overlap between adjoining segments, and a leakage of 0.5.

pspectrum(x, fs, 'persistence’,
'TimeResolution',0.01, 'Overlap',50, 'Leakage',0.5)
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Fower Spectrum (dB)
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See Also

Apps
Signal Analyzer

Functions
fsst|ifsst | pspectrum|spectrogram| tfridge | xspectrogram

Density( %}



See Also

Related Examples

. “Practical Introduction to Time-Frequency Analysis”
. “Detect Closely Spaced Sinusoids” on page 14-33
. “Hilbert Transform and Instantaneous Frequency” on page 14-26
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Cross-Spectrogram of Complex Signals
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Generate two signals, each sampled at 3 kHz for 1 second. The first signal is a quadratic
chirp whose frequency increases from 300 Hz to 1300 Hz during the measurement. The
chirp is embedded in white Gaussian noise. The second signal, also embedded in white
noise, is a chirp with sinusoidally varying frequency content.

fs = 3000;

t =0:1/fs:1-1/fs;

x1 = chirp(t,300,t(end),1300, 'quadratic')+randn(size(t))/100;
X2 = exp(2j*pi*100*cos(2*pi*2*t))+randn(size(t))/100;

Compute and plot the cross-spectrogram of the two signals. Divide the signals into 256-
sample segments with 255 samples of overlap between adjoining segments. Use a Kaiser
window with shape factor 8 = 30 to window the segments. Use the default number of DFT
points. Center the cross-spectrogram at zero frequency.

nwin = 256;

xspectrogram(x1l,x2,kaiser(nwin,30),nwin-1,[],fs, 'centered"', 'yaxis"')



Cross-Spectrogram of Complex Signals
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Compute the power spectrum instead of the power spectral density. Set to zero the values
smaller than -40 dB. Center the plot at the Nyquist frequency.

xspectrogram(x1l,x2,kaiser(nwin,30),nwin-1,[1,fs,

'"power', 'MinThreshold', -40, 'yaxis')
title('Cross-Spectrogram of Quadratic Chirp and Complex Chirp')

7-45



7 Special Topics

Cross-Spectrogram of Quadratic Chirp and Complex Chirp
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The thresholding further highlights the regions of common frequency.

See Also

spectrogram | xspectrogram
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Find Interference Using Persistence Spectrum

Visualize an interference narrowband signal embedded within a broadband signal.

Generate a chirp sampled at 1 kHz for 500 seconds. The frequency of the chirp increases
from 180 Hz to 220 Hz during the measurement.

fs = 1000;
t (0:1/fs:500)"';
X chirp(t,180,t(end),220) + 0.15*randn(size(t));

The signal also contains a 210 Hz sinusoid. The sinusoid has an amplitude of 0.05 and is
present only for 1/6 of the total signal duration.

idx = floor(length(x)/6);
x(1l:idx) = x(1l:idx) + 0.05*cos(2*pi*t(1:idx)*210);

Save the signal as a MATLAB® timetable.
S = timetable(seconds(t),x);

Open Signal Analyzer and drag the timetable from the Workspace browser to a display.
Click the Time-Frequency button to add a spectrogram view. On the Spectrogram tab,
under Time Resolution, select Specify and enter a time resolution of 1 second. Set the
Frequency Limits to 100 Hz and 290 Hz. Both signal components are visible.
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Go back to the Display tab. Click the Time button to remove the time view and click the
Spectrum button to add a power spectrum view. The frequency range continues to be
from 100 Hz to 290 Hz. The weak sinusoid is obscured by the chirp.
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Click the Spectrum V¥ button to change the Spectrum view to a Persistence
Spectrum view. On the Persistence Spectrum tab, under Time Resolution, select
Specify and enter a time resolution of 1 second. Specify zero overlap between adjoining
segments. Set the Power Limits to -50 dB and 0 dB and the Density Limits to 0.1 and 4.
Now both signal components are clearly visible.
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On the Display tab, under Share, click Generate Script ¥ and select Persistence
Spectrum Script. The script appears in the MATLAB Editor.

% Compute persistence spectrum

enerated by MATLAB(R) 9.3 and Signal Processing Toolbox 7.5.
enerated on: 15-Jul-2017 18:43:37

% Parameters

timeLimits = seconds([0 500]); %
frequencyLimits = [100 290]; % Hz
timeResolution = 1; % seconds
overlapPercent = 0;

seconds

% Index into signal time region of interest
S x ROI = S(:,'x");
S x ROI = S x ROI(timerange(timeLimits(1),timeLimits(2)),1);



See Also

% Compute spectral estimate
% Run the function call below without output arguments to plot the results
[P,F,PWR] = pspectrum(S x ROI,

'persistence’,

'FrequencyLimits', frequencyLimits,

'TimeResolution',timeResolution,

'OverlapPercent',overlapPercent);

See Also

Apps
Signal Analyzer

Functions
pspectrum
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Find and Track Ridges Using Reassigned Spectrogram

Load a datafile containing an echolocation pulse emitted by a big brown bat (Eptesicus
fuscus) and measured with a sampling interval of 7 microseconds. Create a MATLAB®
timetable using the signal and the time information.

load batsignal

t = (0:length(batsignal)-1)*DT;
sg = timetable(seconds(t) ', batsignal);

Open Signal Analyzer and drag the timetable from the Workspace browser to the Signal
table. Click Display Grid V¥ to create two side-by-side displays. Select each display and
click the Time-Frequency button to add a spectrogram view.

Drag the timetable to both displays.

DI ECTTII | .
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Find and Track Ridges Using Reassigned Spectrogram

Select the Spectrogram tab. On the display at right, check Reassign. For each display:

* Set the time resolution to 280 microseconds and specify 85% overlap between
adjoining segments.

* Use the Leakage slider to increase the leakage until the RBW is about 4.5 kHz.
* Set the power limits to -45 dB and -20 dB.

Fier Signals

6 s || e csrincos
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The reassigned spectrogram clearly shows three time-frequency ridges. To track the
ridges, select the display at right. On the Display tab, click Generate Script and select
Spectrogram Script. The script appears in the Editor.

% Compute spectrogram

% Generated by MATLAB(R) 9.3 and Signal Processing Toolbox 7.5.
% Generated on: 13-Jul-2017 19:32:31
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% Parameters
timeLimits = seconds([3.805177e-06 0.002796805]); % seconds
frequencyLimits = [0 71428.57]; % Hz

leakage = 0.9;

timeResolution = 0.00028; % seconds

overlapPercent = 85;
reassignfFlag = true;

% Index into signal time region of interest
sg _batsignal ROI sg(:, 'batsignal');
sg _batsignal ROI sg batsignal ROI(timerange(timeLimits(1l),timeLimits(2)),1);

% Compute spectral estimate
% Run the function call below without output arguments to plot the results
[P,F,T] = pspectrum(sg batsignal ROI,

'spectrogram',

'FrequencyLimits', frequencyLimits,

'Leakage', leakage,

'TimeResolution',timeResolution,

'OverlapPercent',overlapPercent,

'Reassign', reassignFlag);

Run the script. Plot the reassigned spectrogram.

mesh(seconds(T),F,P)
xlabel('Time")
ylabel('Frequency")
axis tight

view(2)

colormap pink
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Use the tfridge function to track the ridges.
[fridge,~,lridge] = tfridge(P,F,0.01, 'NumRidges',3, 'NumFrequencyBins',10);
hold on

plot3(seconds(T),fridge,P(lridge),': "', 'linewidth',3)
hold off
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Frequency
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Thanks to Curtis Condon, Ken White, and Al Feng of the Beckman Center at the
University of Illinois for the bat data and permission to use it in this example.

See Also

Apps
Signal Analyzer

Functions
pspectrum
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Extract Regions of Interest from Whale Song

Load a file that contains audio data from a Pacific blue whale, sampled at 4 kHz. The file
is from the library of animal vocalizations maintained by the Cornell University
Bioacoustics Research Program. The time scale in the data is compressed by a factor of
10 to raise the pitch and make the calls more audible. Convert the signal to a MATLAB®
timetable.

whaleFile = fullfile(matlabroot, 'examples', 'matlab', 'bluewhale.au');
[w,fs] = audioread(whaleFile);

whale = timetable(seconds((0:length(w)-1)"'/fs),w);
% To hear, type soundsc(w,fs)

Open Signal Analyzer and drag the timetable to a display. Four features stand out from
the noise. The first is known as a trill, and the other three are known as moans.
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On the Display tab, click Spectrum to open a spectrum view and click Panner to
activate the panner. Use the panner to create a zoom window with a width of about 2
seconds. Drag the zoom window so that it is centered on the trill. The spectrum shows a
noticeable peak at around 900 Hz.
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Extract the three moans to compare their spectra:

1  Center the panner zoom window on the first moan. The spectrum has eight clearly
defined peaks, located very close to multiples of 170 Hz. Click Extract Signals ¥ and
select Between Time Limits.

2  Click Panner to hide the panner. Press the space bar to see the full signal. Click
Zoom in X and zoom in on a 2-second interval of the time view centered on the
second moan. The spectrum again has peaks at multiples of 170 Hz. Click Extract
Signals ¥ and select Between Time Limits.

3  Press the space bar to see the full signal. Click Data Cursors ¥ and select Two. Place
the time-domain cursors in a 2-second interval around the third moan. Again, there
are peaks at multiples of 170 Hz. Click Extract Signals ¥ and select Between Time
Cursors.
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Pomer Spectum (48)

Frequency (42)

Remove the original signal from the display by clearing the check box next to its name in
the Signal table. Display the three regions of interest you just extracted. Their spectra lie
approximately on top of each other. Move the frequency-domain cursors to the locations
of the first and third spectral peaks. Asterisks in cursor labels indicate interpolated signal
values.
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Apps
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Median Filtering

The function medfiltl implements one-dimensional median filtering, a nonlinear
technique that applies a sliding window to a sequence. The median filter replaces the
center value in the window with the median value of all the points within the window [5].
In computing this median, medfiltl assumes zeros beyond the input points.

When the number of elements n in the window is even, medfilt1 sorts the numbers,
then takes the average of the n/2 and n/2 + 1 elements.

Two simple examples with fourth- and third-order median filters are

medfiltl([4 3 52 8 9 1],4)
ans =

1.500 3.500 3.50
medfiltl([4 3 52 8
ans =

3 4 3 5 8 8 1

4.000 6.500 5.000 4.500

0
9 1],3)

See the medfilt2 function in the Image Processing Toolbox™ for information on two-
dimensional median filtering.
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Communications Applications

In this section...

“Modulation” on page 7-63
“Demodulation” on page 7-64
“Voltage Controlled Oscillator” on page 7-67

Modulation

Modulation varies the amplitude, phase, or frequency of a carrier signal with reference to
a message signal. The modulate function modulates a message signal with a specified
modulation method.

The basic syntax for the modulate function is
y = modulate(x, fc,fs, 'method',opt)
where:

* X is the message signal.

» fc is the carrier frequency.

+ fs is the sampling frequency.

* method is a flag for the desired modulation method.

* opt is any additional argument that the method requires. (Not all modulation methods
require an option argument.)

The table below summarizes the modulation methods provided; see the documentation for
modulate, demod, and vco for complete details on each.

Method Description

amdsb-sc or am Amplitude modulation, double sideband, suppressed carrier
amdsb-tc Amplitude modulation, double sideband, transmitted carrier
amssb Amplitude modulation, single sideband

fm Frequency modulation

pm Phase modulation
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Method Description

ppm Pulse position modulation

pwm Pulse width modulation

gam Quadrature amplitude modulation

If the input x is an array rather than a vector, modulate modulates each column of the

array.

To obtain the time vector that modulate uses to compute the modulated signal, specify a

second output parameter:

[y,t] = modulate(x,fc,fs, 'method',opt)

Demodulation

The demod function performs demodulation, that is, it obtains the original message signal
from the modulated signal:

The syntax for demod is

x = demod(y, fc,fs, 'method',opt)

demod uses any of the methods shown for modulate, but the syntax for quadrature
amplitude demodulation requires two output parameters:

[X1,X2] = demod(y,fc,fs, 'gam')

If the input y is an array, demod demodulates all columns.

Try modulating and demodulating a signal. A 50 Hz sine wave sampled at 1000 Hz is

t
X

(0:1/1000:2);
sin(2*pi*50*t);

With a carrier frequency of 200 Hz, the modulated and demodulated versions of this

signal are

y
z

modulate(x,200,1000, 'am');
demod(y,200,1000, 'am');

To plot portions of the original, modulated, and demodulated signal:
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figure; plot(t(1:150),x(1:150)); title('Original Signal');
figure; plot(t(1:150),y(1:150)); title('Modulated Signal');
figure; plot(t(1:150),z(1:150)); title('Demodulated Signal');
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Note The demodulated signal is attenuated because demodulation includes two steps:
multiplication and lowpass filtering. The multiplication produces a component with
frequency centered at 0 Hz and a component with frequency at twice the carrier
frequency. The filtering removes the higher frequency component of the signal, producing
the attenuated result.

Voltage Controlled Oscillator

The voltage controlled oscillator function vco creates a signal that oscillates at a
frequency determined by the input vector. The basic syntax for vco is

y = vco(x,fc,fs)

where fc is the carrier frequency and fs is the sampling frequency.
To scale the frequency modulation range, use

y = vco(x, [Fmin Fmax],fs)

In this case, vco scales the frequency modulation range so values of x on the interval
[-1 1] map to oscillations of frequency on [Fmin Fmax].

If the input x is an array, vco produces an array whose columns oscillate according to the
columns of x.

See “FFT-Based Time-Frequency Analysis” on page 7-40 for an example using the vco
function.
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Deconvolution
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Deconvolution, or polynomial division, is the inverse operation of convolution.
Deconvolution is useful in recovering the input to a known filter, given the filtered output.
This method is very sensitive to noise in the coefficients, however, so use caution in
applying it.

The syntax for deconv is
[q,r] = deconv(b,a)

where b is the polynomial dividend, a is the divisor, q is the quotient, and r is the
remainder.

To try deconv, first convolve two simple vectors a and b .

a=1[123];
b =1[456];
c = conv(a,b)

C
4 13 28 27 18

Now use deconv to deconvolve b from c:
[q,r] = deconv(c,a)
q =

r =



Chirp Z-Transform

Chirp Z-Transform

The chirp Z-transform (CZT) is useful in evaluating the Z-transform along contours other
than the unit circle. The chirp Z-transform is also more efficient than the DFT algorithm
for the computation of prime-length transforms, and it is useful in computing a subset of
the DFT for a sequence. The chirp Z-transform, or CZT, computes the Z-transform along
spiral contours in the z-plane for an input sequence. Unlike the DFT, the CZT is not
constrained to operate along the unit circle, but can evaluate the Z-transform along

contours described by % = AW £ =0 .M =1 yhore A is the complex starting
point, W is a complex scalar describing the complex ratio between points on the contour,
and M is the length of the transform.

One possible spiral is

A = 0.8*exp(lj*pi/6);
W = 0.995%exp(-1j*pi*.05);
M = 91;

z = A¥(W."(-(0:M-1)));
zplane([],z.")
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czt(x,M,W,A) computes the Z-transform of x on these points.

An interesting and useful spiral set is m evenly spaced samples around the unit circle,

parameterized by A =1 and W = €xXp(—Jx/M} The 7-transform on this contour is
simply the DFT, obtained by czt:

M
m

64;
0:M-1;

X = sin(2*pi*m/15);
fft(x);
czt(x,M,exp(-2j*pi/M),1);
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See Also

stem(m,abs (FFT))
hold on
stem(m,abs(CZT), '*")
hold off
legend('fft', 'czt")

30 T T T T T

20

107

70

czt may be faster than the fft function for computing the DFT of sequences with certain

odd lengths, particularly long prime-length sequences.

See Also
czt| fft
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Discrete Cosine Transform

The discrete cosine transform (DCT) is closely related to the discrete Fourier transform
(DFT). The DFT is actually one step in the computation of the DCT for a sequence. The
DCT, however, has better energy compaction than the DFT, with just a few of the
transform coefficients representing the majority of the energy in the sequence. This
property of the DCT makes it useful in applications such as data communications and
signal coding.

DCT Variants
The DCT has four standard variants. For a signal x of length N, and with O1e the
Kronecker delta, the transforms are defined by:

e DCT-1:

N
ZJ.IH ! cos % _(n—1)ik—1)]
n=1 v |+t’?f1+¢f'."~, I+ 8y + Oy W —1 !

EIM[

— N
vkl = \‘%Z J.'IZHI;

cos |::%|:2n: — k=11

=1 W+ 8y V2 /
+ DCT3:
. 3 - oy | i .
vkl = ‘I‘F; m.r.;.mcm: lnﬁ n—112k—1))
* DCT4:
— N ‘
vik) = %Z xin) Lm|—|2n:—l. Ek—lilju

The Signal Processing Toolbox function dct computes the unitary DCT of an input array.
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Inverse DCT Variants

All variants of the DCT are unitary (or, equivalently, orthogonal): To find their inverses,
switch k and n in each definition. In particular, DCT-1 and DCT-4 are their own inverses,
and DCT-2 and DCT-3 are inverses of each other:

e Inverse of DCT-1:

N

9 . .
"iz.‘f”&i . ] —— _l —cos [ —Z (k- 1)n—1)|
VNS VI4dy+8n/ 1+, +8,y V-1 4

* Inverse of DCT-2:

— N
|2 Z . | . .y L
= vikl————cos | —{k—1}{2n -1} |

Illl'. N,ﬂ::l '|,'I +l:’.i*|_ w2N 4

e Inverse of DCT-3:

N
Z _vik:_;cm: (Z(2k—1)(n—1))
T+o,  \2N

g

* Inverse of DCT-4:
i
P Y eoe | & M — 1% — 10|
A.r.l.t.—,Ilr_-ﬁz_x-.ﬁ..mzxtm.ﬂ 1)(2n I',J'

The function idct computes the inverse DCT for an input sequence, reconstructing a
signal from a complete or partial set of DCT coefficients.

Signal Reconstruction Using DCT

Because of the energy compaction property of the DCT, you can reconstruct a signal from
only a fraction of its DCT coefficients. For example, generate a 25 Hz sinusoidal sequence
sampled at 1000 Hz.

t
X

0:1/1000:1;
sin(2*pi*25*t);
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Compute the DCT of this sequence and reconstruct the signal using only those
components with value greater than 0.1. Determine how many coefficients out of the
original 1000 satisfy the requirement.

y = dct(x);

y2 = find(abs(y) < 0.1);
y(y2) = zeros(size(y2));
z = idct(y);

howmany = length(find(y))
64

howmany

Plot the original and reconstructed sequences.

subplot(2,1,1)

plot(t,x)

ax = axis;
title('Original Signal')

subplot(2,1,2)

plot(t,z)

axis(ax)

title('Reconstructed Signal')
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Original Signal
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Reconstructed Signal
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o
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i
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One measure of the accuracy of the reconstruction is the norm of the difference between
the original and reconstructed signals, divided by the norm of the original signal.
Compute this estimate and express it as a percentage.

norm(x-z)/norm(x)*100

ans = 1.,9437

The reconstructed signal retains approximately 98% of the energy in the original signal.

See Also
dct | idct
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Related Examples
. “DCT for Speech Signal Compression” on page 14-55
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Hilbert Transform

The Hilbert transform facilitates the formation of the analytic signal. The analytic signal is
useful in the area of communications, particularly in bandpass signal processing. The
toolbox function hilbert computes the Hilbert transform for a real input sequence x and
returns a complex result of the same length, y = hilbert(x), where the real part of y
is the original real data and the imaginary part is the actual Hilbert transform. y is
sometimes called the analytic signal, in reference to the continuous-time analytic signal. A
key property of the discrete-time analytic signal is that its Z-transform is 0 on the lower
half of the unit circle. Many applications of the analytic signal are related to this property;
for example, the analytic signal is useful in avoiding aliasing effects for bandpass
sampling operations. The magnitude of the analytic signal is the complex envelope of the
original signal.

The Hilbert transform is related to the actual data by a 90-degree phase shift; sines
become cosines and vice versa. To plot a portion of data and its Hilbert transform, use

t
X

y

0:1/1024:1;
sin(2*pi*60*t);
hilbert(x);

plot(t(1:50),real(y(1:50)))

hold on

plot(t(1:50),imag(y(1:50)))

hold off

axis([0 0.05 -1.1 2])

legend('Real Part','Imaginary Part')
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Real Part
Imaginary Part

0.5

S NS

0.015 0.02 0025 003 0035 004 0045 0.05

-1 .

0 0.005 0.01
The analytic signal is useful in calculating instantaneous attributes of a time series, the

attributes of the series at any point in time. The procedure requires that the signal be

monocomponent.

See Also
hilbert

Related Examples
“Analytic Signal for Cosine” on page 14-7
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See Also

“Envelope Extraction” on page 14-11
“Analytic Signal and Hilbert Transform” on page 14-20
“Hilbert Transform and Instantaneous Frequency” on page 14-26
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Walsh-Hadamard Transform

7-80

The Walsh-Hadamard transform is a non-sinusoidal, orthogonal transformation technique
that decomposes a signal into a set of basis functions. These basis functions are Walsh
functions, which are rectangular or square waves with values of +1 or -1. Walsh-
Hadamard transforms are also known as Hadamard (see the hadamard function in the
MATLAB software), Walsh, or Walsh-Fourier transforms.

The first eight Walsh functions have these values:

Index Walsh Function Values

11111111

1111-1-1-141

11-1-1-1-111

11-1-111-1-1

1-1-111-1-11

1-1-11-11141

1-11-1-11-11

N OO W N - O

1-11-11-1141

The Walsh-Hadamard transform returns sequency values. Sequency is a more generalized
notion of frequency and is defined as one half of the average number of zero-crossings per
unit time interval. Each Walsh function has a unique sequency value. You can use the
returned sequency values to estimate the signal frequencies in the original signal.

Three different ordering schemes are used to store Walsh functions: sequency, Hadamard,
and dyadic. Sequency ordering, which is used in signal processing applications, has the
Walsh functions in the order shown in the table above. Hadamard ordering, which is used
in controls applications, arranges them as 0, 4, 6, 2, 3, 7, 5, 1. Dyadic or gray code
ordering, which is used in mathematics, arranges them as 0, 1, 3, 2, 6, 7, 5, 4.

The Walsh-Hadamard transform is used in a number of applications, such as image
processing, speech processing, filtering, and power spectrum analysis. It is very useful for
reducing bandwidth storage requirements and spread-spectrum analysis. Like the FFT,
the Walsh-Hadamard transform has a fast version, the fast Walsh-Hadamard transform
(fwht). Compared to the FFT, the FWHT requires less storage space and is faster to
calculate because it uses only real additions and subtractions, while the FFT requires



See Also

complex values. The FWHT is able to represent signals with sharp discontinuities more
accurately using fewer coefficients than the FFT. Both the FWHT and the inverse FWHT
(ifwht) are symmetric and thus, use identical calculation processes. The FWHT and
IFWHT for a signal x(t) of length N are defined as:

1N—1

= 2 WAL(n, i),

N-1
x; = z ¥, WAL(n,1),
=0

where i = 0,1, ..., N - 1 and WAL(n,i) are Walsh functions. Similar to the Cooley-Tukey
algorithm for the FFT, the N elements are decomposed into two sets of N/2 elements,
which are then combined using a butterfly structure to form the FWHT. For images,
where the input is typically a 2-D signal, the FWHT coefficients are calculated by first
evaluating across the rows and then evaluating down the columns.

For the following simple signal, the resulting FWHT shows that x was created using
Walsh functions with sequency values of 0, 1, 3, and 6, which are the nonzero indices of
the transformed x. The inverse FWHT recreates the original signal.

x=[422002 -20]
y = fwht(x)
X =

4 2 2 0 0 2 2 0
y =

1 1 0 1 0 0 1 0
x1 = ifwht(y)
x1l =

4 2 2 0 0 2 2 0
See Also
fwht | ifwht
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Related Examples

. “Walsh-Hadamard Transform for Spectral Analysis and Compression of ECG Signals”
on page 7-83
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Walsh-Hadamard Transform for Spectral Analysis and Compression of ECG Signals

Walsh-Hadamard Transform for Spectral Analysis and
Compression of ECG Signals

Use an electrocardiogram (ECG) signal to illustrate working with the Walsh-Hadamard
transform. ECG signals typically are very large and need to be stored for analysis and
retrieval at a future time. Walsh-Hadamard transforms are particularly well-suited to this
application because they provide compression and thus require less storage space. They
also provide rapid signal reconstruction.

Start with an ECG signal. Replicate it to create a longer signal and insert some additional
random noise.

xe = ecg(512);
Xr repmat(xe,1,8);
X = xr + 0.1.*randn(1,length(xr));

Transform the signal using the fast Walsh-Hadamard transform. Plot the original signal
and the transformed signal.

y = fwht(x);

subplot(2,1,1)

plot(x)

xlabel('Sample index')
ylabel('Amplitude")
title('ECG Signal')

subplot(2,1,2)
plot(abs(y))
xlabel('Sequency index')
ylabel('Magnitude")
title('WHT Coefficients')
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7-84

ECG Signal
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The plot shows that most of the signal energy is in the lower sequency values, below
approximately 1100. Store only the first 1024 coefficients (out of 4096). Try to
reconstruct the signal accurately from only these stored coefficients.

y(1025:1ength(x)) = 0;
xHat = ifwht(y);

figure

plot(x)

hold on

plot(xHat)

xlabel('Sample Index')

ylabel('ECG Signal Amplitude')
legend('Original', 'Reconstructed')



See Also

ECG Signal Amplitude
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The reproduced signal is very close to the original but has been compressed to a quarter
of the size. Storing more coefficients is a tradeoff between increased resolution and
increased noise, while storing fewer coefficients can cause loss of peaks.

See Also
fwht | ifwht
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Eliminate Outliers Using Hampel Identifier

7-86

This example shows a naive implementation of the procedure used by hampel to detect
and remove outliers. The actual function is much faster.

Generate a random signal, x, containing 24 samples. Reset the random number generator
for reproducible results.

rng default

x = 24;
x = randn(1,1x);

Generate an observation window around each element of x. Take k = 2 neighbors at

either side of the sample. The moving window that results has a length of 2x2+1=5
samples.

k = 2;

iLo
iHi

Truncate the window so that the function computes medians of smaller segments as it
reaches the signal edges.

iLo(iLo<l) = 1;
iHi(iHi>1x) = 1x;

Record the median of each surrounding window. Find the median of the absolute
deviation of each element with respect to the window median.

for ] = 1:1x
= x(iLo(j):iHi(j));
med] = median(w);
mmed(j) = medj;
mmad(j) = median(abs(w-medj));
end

Scale the median absolute deviation with

1~ am26
Vv2erf11/2)



Eliminate Outliers Using Hampel Identifier

to obtain an estimate of the standard deviation of a normal distribution.
sd = mmad/(erfinv(1/2)*sqrt(2));

Find the samples that differ from the median by more than nd = 2 standard deviations.
Replace each of those outliers by the value of the median of its surrounding window. This
is the essence of the Hampel algorithm.

nd = 2;
ki = abs(x-mmed) > nd*sd;
yu = Xx;

yu(ki) = mmed(ki);

Use the hampel function to compute the filtered signal and annotate the outliers. Overlay
the filtered values computed in this example.

hampel(x, k,nd)
hold on

plot(yu, 'o', 'HandleVisibility"', 'off")
hold off
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See Also
hampel
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* “SPTool: An Interactive Signal Processing Environment” on page 8-2
* “Opening SPTool” on page 8-4

* “Getting Context-Sensitive Help” on page 8-6

» “Signal Browser” on page 8-7
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* “Spectrum Viewer” on page 8-12
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SPTool: An Interactive Signal Processing Environment

8-2

In this section...

“SPTool Overview” on page 8-2

“SPTool Data Structures” on page 8-2

SPTool Overview

SPTool is an interactive GUI for digital signal processing used to

* Analyze signals

* Design filters

* Analyze (view) filters
 Filter signals

* Analyze signal spectra

You can accomplish these tasks using four GUIs that you access from within SPTool:
» The “Signal Browser” on page 8-7 is for analyzing signals. You can also play signals

using your computer's audio hardware.

+ Filter Designer is available for designing or editing FIR and IIR digital filters. Most
Signal Processing Toolbox filter design methods available at the command line are also
available in Filter Designer.

» The “Filter Visualization Tool” on page 8-10 (FVTool) is for analyzing filter
characteristics.

* The “Spectrum Viewer” on page 8-12 is for spectral analysis. You can use Signal
Processing Toolbox spectral estimation methods to estimate the power spectral density
of a signal.

SPTool Data Structures

You can use SPTool to analyze signals, filters, or spectra that you create at the MATLAB
command line.

You can bring signals, filters, or spectra from the MATLAB workspace into the SPTool
workspace using File > Import. For more information, see “Importing Filters and



SPTool: An Interactive Signal Processing Environment

Spectra” on page 8-30. Signals, filters, or spectra that you create in (or import into) the
SPTool workspace exist as MATLAB structures. See the MATLAB documentation for more
information on MATLAB structures.

When you use File > Export to save signals, filters, and spectra that you create or modify
in SPTool, these are also saved as MATLAB structures. For more information on
exporting, see “Exporting Signals, Filters, and Spectra” on page 8-26.
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Opening SPTool

To open SPTool, type

sptool
B SPTool: startup.spt E=H =R
File Edit Window | Help | »
Signals Filters Spectra
chirp [vector] PZlp [imported] chirpse [auto]
train [wector] FIRbp [de=ign] trainze [auto]

[ View |

( View | View |
[ Hew ] [ Create ]
[ Edi I Update ]
[ Apply ]

When you first open SPTool, it contains a collection of default signals, filters, and spectra.

To specify your own preferences for what signals, filters, and spectra to see when SPTool
opens see “Setting Preferences” on page 8-41.

You can access these three GUIs from SPTool by selecting a signal, filter, or spectrum and
clicking the appropriate View button:

» Signal Browser on page 8-7
 Filter Visualization Tool on page 8-10
* Spectrum Viewer on page 8-12

8-4



Opening SPTool

You can access Filter Designer by clicking New to create a new filter or Edit to edit a
selected filter. Clicking Apply applies a selected filter to a selected signal.

Create opens the Spectrum Viewer and creates the power spectral density of the selected
signal. Update opens the Spectrum Viewer for the selected spectrum.
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Getting Context-Sensitive Help

8-6

To find information on a particular feature or setting of the “Signal Browser” on page 8-
7:

* In any Measurements panel, right-click anywhere on the panel and select What's
this?.
In any dialog box where you see the \.) icon in the lower left corner, right-click on

any parameter and select What's this?.

To find information on a particular region of Filter Designer or “Spectrum Viewer” on
page 8-12:

Click What's this? ﬂ
2 Click on the region of the GUI you want information on.

You can also use Help > What's This? to launch context-sensitive help.



Signal Browser

Signal Browser

In this section...

“Overview of the Signal Browser” on page 8-7

“Opening the Signal Browser” on page 8-7

Overview of the Signal Browser

You can use the Signal Browser to display and analyze signals listed in the Signals list
box in SPTool.

Using the Signal Browser, you can:

* Analyze and compare vector or array (matrix) signals.
e Zoom in on portions of signal data.

* Measure a variety of characteristics of signal data.

* Compare multiple signals.

* Play portions of signal data on audio hardware.

* Print signal plots.

Opening the Signal Browser

To open the Signal Browser from SPTool:

1  Select one or more signals in the Signals list in SPTool.
2 Click View under the Signals list.
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8-8

n Signal Browser
File Tools View Help

aelaw s B EEER $E S

Ampltude

Time (secs)

The Signal Browser has the following components:

* A display region for analyzing signals

* A panels section on the right side of the scope window, which shows statistics and
information about your signals

* A toolbar with buttons for convenient access to frequently used functions

Icon Description

= Print the current scope window.

) Play an audio signal. The function soundsc is used
to play the signal.

== Show multiple displays of signals.

@ v G Zoom the signal in and out.

[Z] Scale the axes.




Signal Browser

Icon Description
= Toggle the legends on and off.
Toggle the Cursor Measurements panel. This panel

allows you to see screen cursors and get
measurements of time and amplitude values at the
Cursors.

e Toggle the Signal Statistics, Bilevel Measurements,
z b and Peak Finder panels, which display various
measurements about the selected signal.

For more information on the Signal Browser, see the sptool function reference page.

8-9



8 spwola Signal Processing GUI Suite

Filter Visualization Tool

8-10

In this section...

“Connection between FVTool and SPTool” on page 8-10
“Opening the Filter Visualization Tool” on page 8-10

“Analysis Parameters” on page 8-11

Connection between FVTool and SPTool

You can use the Filter Visualization Tool to analyze response characteristics of the
selected filter(s). See fvtool for detailed information about FVTool.

If you start FVTool by clicking the SPTool Filter View button, that FVTool is linked to
SPTool. Any changes made in SPTool to the filter are immediately reflected in FVTool. The
FVTool title bar includes "SPTool" to indicate the link.

If you start an FVTool by clicking the New button or by selecting File > New from within
FVTool, that FVTool is a standalone version and is not linked to SPTool.

Note Every time you click the Filter View button a new, linked FVTool starts. This allows
you to view multiple analyses simultaneously.

Opening the Filter Visualization Tool

You open FVTool from SPTool as follows.

1 Select one or more filters in the Filters list in SPTool.
2 Click the View button under the Filters list.

When you first open FVTool, it displays the selected filter's magnitude plot.




Filter Visualization Tool

) Figure 1: Filter Visualization Tool - Magnitude Response (dB)

File Edit Analysis Insert Yiew ‘Window Help
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Analysis Parameters

In the plot area of any filter response plot, right-click and select Analysis Parameters to
display details about the displayed plot. See “Analysis Parameters” in the Filter Designer
online help for more information.

You can change any parameter in a linked FVTool, except the sampling frequency. You can
only change the sampling frequency using the SPTool Edit > Sampling Frequency or
the SPTool Filters Edit button.
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Spectrum Viewer

8-12

In this section...

“Spectrum Viewer Overview” on page 8-12

“Opening the Spectrum Viewer” on page 8-12

Spectrum Viewer Overview

You can use the Spectrum Viewer for estimating and analyzing a signal's power spectral
density (PSD). You can use the PSD estimates to understand a signal's frequency content.

The Spectrum Viewer provides the following functionality.

* Analyze and compare spectral density plots.
* Use different spectral estimation methods to create spectra:

* Burg (pburg)

* Covariance (pcov)

o FFT (fft)

* Modified covariance (pmcov)

¢ MTM (multitaper method) (pmtm)
* MUSIC (pmusic)

*  Welch (pwelch)

* Yule-Walker AR (pyulear)

* Modify power spectral density parameters such as FFT length, window type, and
sample frequency.

» Print spectral plots.

Opening the Spectrum Viewer

To open the Spectrum Viewer and create a PSD estimate from SPTool:

1 Select a signal from the Signal list box in SPTool.
2 Click Create in the Spectra list.



Spectrum Viewer

3  Click Apply in the Spectrum Viewer.

To open the Spectrum Viewer with a PSD estimate already listed in SPTool:
1  Select a PSD estimate from the Spectra list box in SPTool.
2 Click View in the Spectra list.

For example:

1 Select mtlb in the default Signals list in SPTool.
2 C(Click Create in SPTool to open the Spectrum Viewer.
3 Click Apply in the Spectrum Viewer to plot the spectrum.

=

File Options Markers Window Help

SR|INXI swme Tt #| AN
Signal: mth
4001 k-1 real FFT Spectrum Estimate
Fs <7418 20 T T T T T T T
Parameters 10/l ‘ i
Method [ 3| [ |
N1ﬂ|1024 0 ‘ T
A0k } 4
20k | 4
1]l o
a0k 4
A0 - ‘
_50 1 1 1 1 ‘I 1 1
0 500 1000 1500 2000 2500 3000 3500
Frequency
I'""‘"“"“’“ :I' Marker 1 * 1228 748 Marker 2 % |2470.252 ax 1231.5039
| | ¥ -21.523543 — ¥ -2418231 dy: -2 5346826

The Spectrum Viewer has the following components:

* A signal identification region that provides information about the signal whose power
spectral density estimate is displayed

* A Parameters region for modifying the PSD parameters

* A display region for analyzing spectra and an Options menu for modifying display
characteristics

* Spectrum management controls
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* Inherit from menu to inherit PSD specifications from another PSD object listed in
the menu

* Revert button to revert to the named PSD's original specifications
* Apply button for creating or updating PSD estimates
» A toolbar with buttons for convenient access to frequently used functions

Icon Description

= Print and print preview

R DS SRSV Zoom the signal in and out

i Select one of several loaded signals

= Set the display color and line style of a signal

™M Toggle the markers on and off
= IF W | F Y] Set marker types
E Turn on the What's This help
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Filtering and Analysis of Noise

In this section...

“Overview” on page 8-15

“Importing a Signal into SPTool” on page 8-15
“Designing a Filter” on page 8-17

“Applying a Filter to a Signal” on page 8-19

“Analyzing a Signal” on page 8-21

“Spectral Analysis in the Spectrum Viewer” on page 8-23

Overview

The following sections provide an example of using the GUI-based interactive tools to:

* Design and implement an FIR bandpass digital filter
* Apply the filter to a noisy signal
* Analyze signals and their spectra

The steps include:

1 “Importing a Signal into SPTool” on page 8-15
Designing a bandpass filter using Filter Designer on page 8-17

3 Applying the filter to the original noise signal to create a bandlimited noise signal on
page 8-19

4 Comparing the time domain information of the original and filtered signals using the
Signal Browser on page 8-21

5 Comparing the spectra of both signals using the Spectrum Viewer on page 8-23

Importing a Signal into SPTool

To import a signal into SPTool from the workspace or disk, the signal must be either:

* A special MATLAB signal structure, such as that saved from a previous SPTool session
* A signal created as a variable (vector or matrix) in the MATLAB workspace
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8-16

For this example, create a new signal at the command line and then import it as a
structure into SPTool:

1

Create a random signal in the MATLAB workspace by typing

X = randn(5000,1);
If SPTool is not already open, open SPTool by typing

sptool

The SPTool window is displayed.
Select File > Import. The Import to SPTool dialog opens.

x

Source — "Workspace Contents — r o Import As: ISignaI = I—
% From ‘Workspace <ho selection:
" From Disk

- I [ at
FAT-file: Meme: [ =
Browse... |
Sarmpling Frequency
= n>| K
— Mame
Ok I Cancel | Help | I sig1

The variable x is displayed in the Workspace Contents list. (If it is not, select the
From Workspace radio button to display the contents of the workspace.)

Select the signal and import it into the Data field:

a  Select the signal variable x in the Workspace Contents list.

b  Make sure that Signal is selected in the Import As pull-down menu.
Click on the arrow to the left of the Data field or type x in the Data field.
Type 5000 in the Sampling Frequency field.

a n

e Name the signal by typing noise in the Name field.
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f  Click OK.

The signal noise[vector] appears and is selected in SPTool's Signals list.

Note You can import filters on page 8-30 and spectra on page 8-32 into SPTool in much
the same way as you import signals. See “Importing Filters and Spectra” on page 8-30
for specific details.

You can also import signals from MAT-files on your disk, rather than from the workspace.
See “Loading Variables from the Disk” on page 8-34 for more information.

Type help sptool for information about importing from the command line.

Designing a Filter

You can import an existing filter into SPTool, or you can design and edit a new filter using
Filter Designer.

In this example, you

1 Open a default filter in Filter Designer.
2 Specify an equiripple bandpass FIR filter.

Opening Filter Designer

To open Filter Designer, click New in SPTool. Filter Designer opens with a default
filter named filtl.

Specifying the Bandpass Filter
Design an equiripple bandpass FIR filter with the following characteristics:

* Sampling frequency of 5000 Hz

* Stopband frequency ranges of [0 500] Hz and [1500 2500] Hz
» Passband frequency range of [750 1250] Hz

* Ripple in the passband of 0.01 dB

* Stopband attenuation of 75 dB

To modify the filter in Filter Designer to meet these specifications, you need to
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Select Bandpass from the Response Type list.
Verify that FIR Equiripple is selected as the Design Method.

Verify that Minimum order is selected as the Filter Order and that the Density
Factor is set to 20.

4 Under Frequency Specifications, set the sampling frequency (Fs) and the passband
(Fpass1, Fpass2) and stopband (Fstop1, Fstop2) edges:

Units Hz
Fs 5000
Fstopl 500
Fpassl 750
Fpass2 1250
Fstop2 1500

5 Under Magnitude Specifications, set the stopband attenuation (Astopl, Astop2)
and the maximum passband ripple (Apass):

Units dB
Astopl 75
Apass 0.01
Astop?2 75

6 Click Design Filter to design the new filter. When the new filter is designed, the
magnitude response of the filter is displayed.
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/) Filter Design & Analysis Tool - (filt1)
File Edit Analysis Targets VYiew Window Help

= =]

FEHER 2L OX DM INHNEA <D Bl K

— Current Filter Information

Structure:  Direct-Farm FIR

Order: 78 g

Stakle: Yes L

Source: Designed E
g
= -

— Maghitude Response (dB)

0 0.5 1 1.8 =
Frequency (kHz)
— Responze Type _Filter Order — Freguency Specifications — Magnitude Specifications
 |Lowpazs - Unit=: IHz vl Unit=: IdE vl
" Highpass
£ Minimurm order Fs: 000
{+ Bandpaszs Astop F’S
™ Bandstop __ Options Fatopl: EDD
Apass I.D1
 |pitterentistor = Density Factor: ED
Fpass1: JT'SD
| Design Method Astop? Fs
"‘.'aa COR  [Butterwortn -1 e |
5]
* FIR IEquinppIE - l Fstop2: J1500

FE

Desian Fifter |

|Designing Filter ... Done

The resulting filter is an order-78 bandpass equiripple filter.

Applying a Filter to a Signal

When you apply a filter to a signal, you create a new signal in SPTool representing the
filtered signal.

To apply the filter filt1 you just created to the signal noise,

1 In SPTool, select the signal noise[vector] from the Signals list and select the
filter (named filtl[design]) from the Filters list.
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8-20

<} SPTool: startup_spt M=l E3
File Edit ‘Window Help
Signals Filters Spectra
mtlb [wector] | |LSIp [design] - -
chirp [vectar] _I FZlp [imparted] _I chirpze [auto]
train [wector FleE desiin trainge [auta]
Wiew I Yiew I Wiew
MHew I Create
Edit | Update
Apply |
Click Apply under the Filters list.
I
Input Signal hoise
Fitter I(irt1
AR (nirect-Form FIR ]
Output Sighal Isig'l
QK | Cancel |
Leave the Algorithm as Direct-Form FIR.

Note You can apply one of two filtering algorithms to FIR filters. The default
algorithm is specific to the filter structure, which is shown in the Filter Designer
Current Filter Info frame. Alternately for FIR filters, FFT based FIR (fftfilt)

uses the algorithm described in fftfilt.

For IIR filters, the alternate algorithm is a zero-phase IIR that uses the algorithm

described in filtfilt.
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Enter blnoise as the Output Signal name.
Click OK to close the Apply Filter dialog box.

The filter is applied to the selected signal, and the filtered signal blnoise[vector]
is listed in the Signals list in SPTool.

Analyzing a Signal

You can analyze and print signals using the Signal Browser. You can also play the signals
if your computer has audio output capabilities.

For example, compare the signal noise on page 8-15 to the filtered signal blnoise

on page 8-19:

1 Shift+click on the noise and blnoise signals in the Signals list of SPTool to select
both signals.

2 Click View under the Signals list.
The Signal Browser is activated, and both signals are displayed in the display region.
(The names of both signals are shown above the display region.) Initially, the original
noise signal covers up the bandlimited blnoise signal.

3

Push the selection button ﬂ on the toolbar to select the blnoise signal.

The display area is updated. Now you can see the blnoise signal superimposed on
top of the noise signal. The signals are displayed in different colors in both the
display region and the panner. You can change the color of the selected signal using
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8-22

+ | Signal Browser M=l E3
File Markers ‘window Help

& & ||t | B ap

T T 4 e

noise, blnoise

4 T T T T T T | T T T

"0 01 02 03 0.4 05 06 07 08 0g
Time
L TR I :
E
Z L
Marker 1 # [ 0.3332 Marker 2 * | 06566 dw: 0.3334
v 0051656 — — p 0782 dy: -0 63555

Playing a Signal

When you click Play in the Signal Browser toolbar, ﬂ the active signal is played on the
computer's audio hardware.

1 To hear a portion of the active (selected) signal

a  Use the vertical markers on page 8-39to select a portion of the signal you want
to play. Vertical markers are enabled by the U and ﬂ buttons.
b  Click Play.
2 To hear the other signal
a  Select the signal using the selection button on the toolbar. You can also select the
signal directly in the display region.
b  Click Play again.
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Printing a Signal

You can print from the Signal Browser using the Print button, @

You can use the line display buttons to maximize the visual contrast between the signals
by setting the line color for noise on page 8-15 to gray and the line color for blnoise on
page 8-15 to white. Do this before printing two signals together.

Note You can follow the same rules to print spectra, but you can't print filter responses
directly from SPTool.

Use the Signal Browser region in the Preferences dialog box in SPTool to suppress
printing of both the panner and the marker settings.

To print both signals, click Print in the Signal Browser toolbar.

Spectral Analysis in the Spectrum Viewer

You can analyze the frequency content of a signal using the Spectrum Viewer, which
estimates and displays a signal's power spectral density.

For example, to analyze and compare the spectra of noise and blnoise:

1 Create a power spectral density (PSD) object on page 8-23, spectl, that is
associated with the signal noise, and a second PSD object, spect2, that is associated
with the signal blnoise.

Open the Spectrum Viewer to analyze both of these spectra on page 8-23.
Print both spectra on page 8-23.

Creating a PSD Object From a Signal

1 Click on SPTool, or select Window > SPTool in any active open GUI. SPTool is now
the active window.
Select the noise[vector] on page 8-15 signal in the Signals list of SPTool.

Click Create in the Spectra list.

The Spectrum Viewer is activated, and a PSD (spectl) corresponding to the noise
signal is created in the Spectra list. The PSD is not computed or displayed yet.
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8-24

Click Apply in the Spectrum Viewer to compute and display the PSD estimate
spectl using the default parameters.

The PSD of the noise signal is displayed in the display region. The identifying
information for the PSD's associated signal (noise) is displayed above the
Parameters region.

The PSD estimate spectl is within 2 or 3 dB of 0, so the noise has a fairly "flat"
power spectral density.

Follow steps 1 through 4 for the bandlimited noise signal blnoise on page 8-19 to
create a second PSD estimate spect2.

The PSD estimate spect? is flat between 750 and 1250 Hz and has 75 dB less power
in the stopband regions of filtl.

Opening the Spectrum Viewer with Two Spectra

1

Reactivate SPTool again, as in step 1 above.
Shift+click on spectl and spect2 in the Spectra list to select them both.

Click View in the Spectra list to reactivate the Spectrum Viewer and display both
spectra together.

¢ Spectrum Viewes
File Opbore Makers Window Help
[BR[DIX T e me =01 =e s &Y R
Signal nose —
5000-bys1 real PSD
Fs = 5000 -0 T r . :
Faameters — A A i e e S o T TN [ s e
Method [y/elch = -0 - \ E
hae | 1024 |
Nuwind [ 255 60+ [ \ 4
|
Wirdow | haning 'l ! \
80 | | ]
|
Overap [0 IIl \
-0} ; \ -
i . Jd WA _—
\ Ve LAV A% -\;r\.l,. TARTAYOAATAY
120 1 1 1 1
i} S00 1000 1500 2000 2500
Freguency
[inhert from =l Marker 1 [ 834 3609 Marker 2 * [ 16650391 die 83007813
| o 1w -33.8209 — — y-34454 dy: -0.60451
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Printing the Spectra

Before printing the two spectra together, use the color and line style selection button,

To print both spectra:

1
Click Print Preview @ in the toolbar on the Spectrum Viewer.

2  From the Spectrum Viewer Print Preview window, drag the legend out of the display
region so that it doesn't obscure part of the plot.

3  Click Print in the Spectrum Viewer Print Preview window.
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Exporting Signals, Filters, and Spectra

8-26

In this section...

“Opening the Export Dialog Box” on page 8-26
“Exporting a Filter to the MATLAB Workspace” on page 8-27

Opening the Export Dialog Box

To save the filter Tilt1 you just created in this example, open the Export dialog box with
filtl preselected:

1 Select filtl in the SPTool Filters list.
2 Select File > Export.

The Export dialog box opens with filt1 preselected.
~imi

~ Export List

Signal: mtlb [vector] ;I
Sigmal: chirp [wector] : .
Zigmal: train [vector] [~ Export fiters as TF ohjects
Filter: LSlp [desigml

Filter: PZlp [imported]

Filter: FIPbp [design] .

DUFiltl [desicm] Export to disk... |
Spectrum: mtlhse [autao]
Spectrum: chirpse [autc Export to workspace I

Spectrum: trainse [autc

Cancel I

Help I

Kl | _>l;I

Shiowe: IAII - I
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Exporting a Filter to the MATLAB Workspace

To export the filter filt1l to the MATLAB workspace:

1 Select filtl from the Export List and deselect all other items using Ctrl+click.
2 Click Export to Workspace.
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Accessing Filter Parameters

In this section...

“Accessing Filter Parameters in a Saved Filter” on page 8-28

“Accessing Parameters in a Saved Spectrum” on page 8-29

Accessing Filter Parameters in a Saved Filter

The MATLAB structures created by SPTool have several associated fields, many of which
are also MATLAB structures. See the MATLAB documentation for general information
about MATLAB structures.

For example, after exporting on page 8-27 a filter filt1 to the MATLAB workspace, type
filtl

to display the fields of the MATLAB filter structure. The tf field of the structure contains
information that describes the filter.

The tf Field: Accessing Filter Coefficients

The tf field is a structure containing the transfer function representation of the filter. Use
this field to obtain the filter coefficients;

« filtl.tf.num contains the numerator coefficients.
« filtl.tf.den contains the denominator coefficients.

The vectors contained in these structures represent polynomials in descending powers of
z. The numerator and denominator polynomials are used to specify the transfer function

_B@) _HD+b@z "+ +b(nb+ D"
AR o) +a@z + +ama + Dz

H(z)

where:

* b is a vector containing the coefficients from the tf.num field.
* ais avector containing the coefficients from the tf.den field.
* mis the numerator order.
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* nisthe denominator order.

You can change the filter representation from the default transfer function to another
form by using the tf2ss or tf2zp functions.

Note The FDAspecs field of your filter contains internal information about Filter
Designer and should not be changed.

Accessing Parameters in a Saved Spectrum

The following structure fields describe the spectra saved by SPTool.

Field Description

P The spectral power vector.

f The spectral frequency vector.

confid A structure containing the confidence intervals data

¢ The confid. level field contains the chosen confidence
level.

e The confid.Pc field contains the spectral power data for
the confidence intervals.

* The confid.enable field contains a 1 if confidence levels
are enabled for the power spectral density.

signalLabel The name of the signal from which the power spectral density
was generated.

Fs The associated signal's sample rate.

You can access the information in these fields as you do with every MATLAB structure.

For example, if you export an SPTool PSD estimate spectl to the workspace, type
spectl.P

to obtain the vector of associated power values.
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Importing Filters and Spectra

8-30

In this section...

“Similarities to Other Procedures” on page 8-30
“Importing Filters” on page 8-30

“Importing Spectra” on page 8-32

Similarities to Other Procedures

The procedures are very similar to those explained in

* “Importing a Signal into SPTool” on page 8-15 for loading variables from the
workspace

* “Loading Variables from the Disk” on page 8-34 for loading variables from your disk

Importing Filters

When you import filters, first select the appropriate filter form from the Form list. SPTool
does not currently support the import of filter objects.

-} Import to SPTool il
Source — “orkspace Contents — r Import As: Im—

%' From "Workspace
" From Disk

& T -file Mame: _>|
% |

Browse,.. |

S tal
Zeroz, Poles, Gain

I 2nd Order Sections

Sampling Frequency
== | K

— Mame

oK | ] Heln | [fir
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For every filter you specify a variable name or a value for the filter's sampling frequency
in the Sampling Frequency field. Each filter form requires different variables.

Transfer Function

For Transfer Function, you specify the filter by its transfer function representation:

B b +b@)z +- 4 bm+ Dz

H(z)= =
‘ Al2) g+ a2zt + +an+1)z™"

* The Numerator field specifies a variable name or value for the numerator coefficient
vector b, which contains m+1 coefficients in descending powers of z.

* The Denominator field specifies a variable name or value for the denominator
coefficient vector a, which contains n+1 coefficients in descending powers of z.

State Space
For State Space, you specify the filter by its state-space representation:
x=Ax+ Bu

y=Cx+Du

The A-Matrix, B-Matrix, C-Matrix, and D-Matrix fields specify a variable name or a
value for each matrix in this system.

Zeros, Poles, Gain

For Zeros, Poles, Gain, you specify the filter by its zero-pole-gain representation:

_Z(2) _ k (z—-2DNz-2(2))---(z2—2z(m))

H(z)=
P(2) (z— p(D)z - p(2))---(z— p(n))

* The Zeros field specifies a variable name or value for the zeros vector z, which
contains the locations of m zeros.

* The Poles field specifies a variable name or value for the zeros vector p, which
contains the locations of n poles.

* The Gain field specifies a variable name or value for the gain k.
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8-32

Second Order Sections

For 2nd Order Sections you specify the filter by its second-order section
representation:

ﬁ bop +bip 2 +bgpz 2

2

L
H(z) =[] Hp(2) = = —
k=1 kel L+agz ' +ag?

The SOS Matrix field specifies a variable name or a value for the L-by-6 SOS matrix

bo1 b1 bey 1 ayp ag
b bo 1 a0 a
sos=| 2 %z Pz 1 iz dz

bor, bir bar 1 a1 agp

whose rows contain the numerator and denominator coefficients b;, and a;, of the second-
order sections of H(2).

Note If you import a filter that was not created in SPTool, you can only edit that filter
using the Pole/Zero Editor.

Importing Spectra
When you import a power spectral density (PSD), you specify:

* Avariable name or a value for the PSD vector in the PSD field
* Avariable name or a value for the frequency vector in the Freq. Vector field

The PSD values in the PSD vector correspond to the frequencies contained in the Freq.
Vector vector; the two vectors must have the same length.
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-} Import to SPTool
Source File Cantents

r Impart As: ISpectrum vl—

I PSD
I Freq. Weckar

' From Workspace
om0
MAT file Marme:

Browze. . |

L1

— Mame

0K, | Cancel Help I spect]
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Loading Variables from the Disk

8-34

To import variables representing signals, filters, or spectra from a MAT-file on your disk;
1 Select the From Disk radio button and do either of the following:
* Type the name of the file you want to import into the MAT-file Name field and

press either the Tab or the Enter key on your keyboard.

* Select Browse, and then find and select the file you want to import using Select
> File to Open. Click OK to close that dialog.

In either case, all variables in the MAT-file you selected are displayed in the File
Contents list.

2 Select the variables to be imported into SPTool.

You can now import one or more variables from the File Contents list into SPTool, as
long as these variables are scalars, vectors, or matrices.
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Saving and Loading Sessions

In this section...

“SPTool Sessions” on page 8-35
“Filter Formats” on page 8-35

SPTool Sessions

When you start SPTool, the default startup.spt session is loaded. To save your work in
the startup SPTool session, use File > Save Session or to specify a session name, use
File > Save Session As.

To recall a previously saved session, use File > Open Session.

Filter Formats

When you start SPTool or open a session, the current filter design format preference is
compared to the filter formats in the session. See “Setting Preferences” on page 8-41.

» If the formats match, the session opens.

+ If the filter preference is FDATool, but the session contains Filter Designer filters, this
warning displays:

-) Convert filters to use FDATool? ] e

Filters in this zezsion were created with Filter Degigner and are not
compatible with FDAT ool.

Select "Convert" if you want to zet FDAT ool az the preferred filker design
tool and permanently corwert all filters in this zezsion to an FOAT ool
farmat.

Mate: Canverting ta an FDAT ool format cannat be undohe.

Select "Do not uze FDAT ool to continue uzing Filker Designer.

Mate: Filter Designer will be removed in a future releaze.

Convert Do not use FOATool
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Click Convert to convert the filters to FDATool format. Click Don't Use FDATool to
leave the filters in Filter Designer format and change the preference to Use Filter
Designer.

+ [If the filter preference is Use Filter Designer, but the session contains FDATool
filters, this warning displays:

] ) Design filters using -10] =l
Filters in thiz session were created with FDAT ool and are not compatible

] with Filter Degigner. Switching to Filker Designer will delete all filkers

. it thiz sezsion,

| Do vou want to use Filter Dezsigner and delete your current filkers?
Mate: Filter Dezsigner will be remaoved in a future release.

Yesl an

Click Yes to remove the current filters. Click No to leave the filters in FDATool.
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Selecting Signals, Filters, and Spectra

All signals, filters, or spectra listed in SPTool exist as special MATLAB structures. You can
bring data representing signals, filters, or spectra into SPTool from the MATLAB
workspace. In general, you can select one or several items in a given list box. An item is
selected when it is highlighted.

The Signals list shows all vector and array signals in the current SPTool session.
The Filters list shows all designed and imported filters in the current SPTool session.
The Spectra list shows all spectra in the current SPTool session.

You can select a single data object in a list, a range of data objects in a list, or multiple
separate data objects in a list. You can also have data objects simultaneously selected in

different lists:
* To select a single item, click it. All other items in that list box become deselected.

* To add or remove a range of items, Shift+click on the items at the top and bottom of
the section of the list that you want to add. You can also drag your mouse pointer to
select these items.

» To add a single data object to a selection or remove a single data object from a
multiple selection, Ctrl+click on the object.
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Editing Signals, Filters, or Spectra

8-38

You can edit selected items in SPTool by

1 Selecting the names of the signals, filters, or spectra you want to edit.
2 Selecting the appropriate Edit menu item:

* Duplicate to copy an item in an SPTool list

* Clear to delete an item in an SPTool list

* Name to rename an item in an SPTool list

* Sampling Frequency to modify the sampling frequency associated with either a
signal (and its associated spectra) or filter in an SPTool list

The pull-down menu next to each menu item shows the names of all selected items.

You can also edit the following signal characteristics by right-clicking in the display
region of the Signal Browser, the Filter Visualization Tool, or the Spectrum Viewer:

* The signal name
* The sampling frequency
* The line style properties

Note If you modify the sampling frequency associated with a signal's spectrum using the
right-click menu on the Spectrum Viewer display region, the sampling frequency of the
associated signal is automatically updated.
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Making Signal Measurements with Markers

You can use the markers on the Signal Browser on page 8-7 or the Spectrum Viewer on
page 8-7 to make measurements on either of the following:

* Asignal in the Signal Browser

* A power spectral density plotted in the Spectrum Viewer

The following marker buttons are included

BT S

Icon Description

Toggle markers on/off

Vertical markers

Horizontal markers

Vertical markers with tracking

Vertical markers with tracking and slope

=) ]| = | =) s

Display peaks (local maxima)

You can find peaks in a signal from the command line with
findpeaks

l? Display valleys (local minima)

To make a measurement:

1  Select a line to measure (or play, if you are in the Signal Browser).
2 Select one of the marker buttons to apply a marker to the displayed signal.

3  Position a marker in the main display area by grabbing it with your mouse and
dragging:
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a Select a marker setting. If you choose the Vertical, Track, or Slope buttons, you
can drag a marker to the right or left. If you choose the Horizontal button, you
can drag a marker up or down.

b Move the mouse over the marker (1 or 2) that you want to drag.

The hand cursor with the marker number inside it ¥17 is displayed when your
mouse passes over a marker.

¢ Drag the marker to where you want it on the signal
As you drag a marker, the bottom of the Signal Browser shows the current position of
both markers. Depending on which marker setting you select, some or all of the

following fields are displayed — x1, y1, x2, y2, dx, dy, m. These fields are also
displayed when you print from the Signal Browser, unless you suppress them.

You can also position a marker by typing its x1 and x2 or y1 and y2 values in the region
at the bottom.
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Setting Preferences

In this section...

“Overview of Setting Preferences” on page 8-41

“Summary of Settable Preferences” on page 8-42

Overview of Setting Preferences

Use File > Preferences to customize displays and certain parameters for SPTool and its
four component GUISs. If you change any preferences, a dialog box displays when you
close SPTool asking if you want to save those changes. If you click Yes, the new settings
are saved on disk and are used when you restart SPTool from the MATLAB workspace.

Note You can set MATLAB preferences that affect the Filter Visualization Tool only from
within FVTool by selecting File > Preferences. You can set FVTool-specific preferences
using Analysis > Analysis Parameters.

When you first select Preferences, the Preferences dialog box opens with Markers

selected by default.
-} Preferences for SPTool |i |
— Markers
Colos Marker I:Dlorl RIGED
Signal Browser
Spectm Yiewer Marker Stle I o j
Filter Designer ;
Default Session Marker S|ze| g
plug-ingz
Imitial Type I track j
Help... | Facton Settings Eevert Fanel ok Cancel |
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8-42

Change any marker settings, if desired. To change settings for another category, click its
name in the category list to display its settings. Most of the fields are self-explanatory.
Details of the Filter Design options are described below.

Summary of Settable Preferences

In the Preferences regions, you can

Select colors and markers for all displays.
Select colors and line styles for displayed signals.

Configure labels, and enable/disable markers, panner, and zoom in the Signal Browser
on page 8-7.

Configure display parameters, and enable/disable markers and zoom in the Spectrum
Viewer on page 8-12.

Enable/disable use of a default session file.
Export filters for use with Control System Toolbox software.
Enable/disable search for plug-ins at startup.
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Supported Functions

Code generation from MATLAB is a restricted subset of the MATLAB language that
provides optimizations for:

* Generating efficient, production-quality C/C++ code and MEX files for deployment in
desktop and embedded applications. For embedded targets, the subset restricts
MATLAB semantics to meet the memory and data type requirements of the target
environments.

Depending on which feature you wish to use, there are additional required products. For
a comprehensive list, see “Installing Prerequisite Products” (MATLAB Coder).

Code generation from MATLAB supports Signal Processing Toolbox functions listed in the
table. To generate C code, you must have the MATLAB Coder™ software. If you have the
Fixed-Point Designer software, you can use fiaccel to generate MEX code for fixed-
point applications.

To follow the examples in this documentation:

* To generate C/C++ code and MEX files with codegen, install the MATLAB Coder
software, the Signal Processing Toolbox, and a C compiler. For the Windows®
platform, MATLAB supplies a default C compiler. Run mex -setup at the MATLAB
command prompt to set up the C compiler.

* Change to a folder where you have write permission.

Note Many Signal Processing Toolbox functions require constant inputs in generated
code. To specify a constant input for codegen, use coder.Constant.

An asterisk (*) indicates that the reference page has usage notes and limitations for C/C+
+ code generation.

alignsignals

barthannwin*

bartlett*

besselap*

bitrevorder

9-2




Supported Functions

blackman*

blackmanharris*

bohmanwin*

buttap*

butter*

buttord*

cconv

cfirpm*

cheblap*

cheb2ap*

cheblord*

cheb2ord*

chebwin*

cheby1*

cheby2*

convmtx

corrmtx

db2pow

dct*

downsample

dpss*

ellip*

ellipap*

ellipord*

emd

envelope*

filtfilt*

finddelay

findpeaks
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firlx

fir2*

fircls*

firclsl*

firls*

firpm*

firpmord*

flattopwin*

freqz*

gausswin*

hamming*

hann*

hilbert

idct*

intfilt*

kaiser

kaiserord

levinson*

maxflat*

nuttallwin*

parzenwin*

peak2peak

peak2rms

pow2db

rcosdesign*

rectwin*

resample*

rms

sgolay
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sgolayfilt

sinc

sosfilt

taylorwin*

triang*

tukeywin*

upfirdn*

upsample*

xcorr*

Xxcorr2

Xcov

yulewalk*

zp2tf*
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Specifying Inputs in Code Generation from MATLAB

9-6

In this section...

“Defining Input Size and Type” on page 9-6
“Inputs must be Constants” on page 9-7

Defining Input Size and Type

When you use Signal Processing Toolbox functions for code generation, you must define
the size and type of the function inputs. One way to do this is with the -args compilation
option. The size and type of inputs must be defined because C is a statically typed
language. . To illustrate the need to define input size and type, consider the simplest call
to xcorr requiring two input arguments. The following demonstrates the differences in
the use of xcorr in MATLAB and in Code Generation from MATLAB.

Cross correlate two white noise vectors in MATLAB:

X = randn(512,1); %real valued white noise
y = randn(512,1); %real valued white noise
[C,lags] = xcorr(x,y);

X _circ = randn(256,1)+1j*randn(256,1); %circular white noise
y circ = randn(256,1)+1j*randn(256,1); %circular white noise
[C1,lagsl] = xcorr(x _circ,y circ);

xcorr does not require the size and type of the input arguments. xcorr obtains this
information at runtime. Contrast this behavior with a MEX-file created with codegen.
Create the file myxcorr.min a folder where you have read and write permission. Ensure
that this folder is in the MATLAB search path. Copy and paste the following two lines of
code into myxcorr.m and save the file. The compiler tag %s#codegen must be included in
the file.

function [C,Lags]l=myxcorr(x,y) %#codegen
[C,Lags]=xcorr(x,y);

Enter the following command at the MATLAB command prompt:
codegen myxcorr -args {zeros(512,1),zeros(512,1)} -o myxcorr

Run the MEX-file:
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X = randn(512,1); %real valued white noise
y = randn(512,1); %real valued white noise
[C,Lags] = myxcorr(x,y);

Define two new inputs x1 and y1 by transposing x and y.

x1
yl

x'; %x1 is 1x512
y'; %yl is 1x512

Attempt to rerun the MEX-file with the tranposed inputs.

[C,Lags] = myxcorr(xl,yl); %Errors

The preceding program errors with the message ?7?? MATLAB expression 'x' 1is

not of the correct size: expected [512x1] found [1x512].

The error results because the inputs are specified to be 512x1 real-valued column vectors
at compilation. For complex-valued inputs, you must specify that the input is complex
valued. For example:

codegen myxcorr -o ComplexXcorr ...
-args {complex(zeros(512,1)),complex(zeros(512,1))}

Run the MEX-file at the MATLAB command prompt with complex-valued inputs of the
correct size:

X_Circ randn(512,1)+1j*randn(512,1); %circular white noise
y circ randn(512,1)+1j*randn(512,1); %circular white noise
[C,Lags] = ComplexXcorr(x_circ,y circ);

Attempting to run ComplexXcorr with real valued inputs results in the error: ???
MATLAB expression 'x' is not of the correct complexness.

Inputs must be Constants

For a number of supported Signal Processing Toolbox functions, the inputs or a subset of
the inputs must be specified as constants at compilation time. Functions with this
behavior are noted in the right column of the table “Supported Functions” on page 9-2.
Use coder.Type with the -args compilation option, or enter the constants directly in
the source code.

Specifying inputs as constants at compilation time results in significant advantages in the
speed and efficiency of the generated code. For example, storing filter coefficients or
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window function values as vectors in the C source code improves performance by
avoiding costly computation at runtime. Because a primary purpose of Code Generation
from MATLAB is to generate optimized C code for desktop and embedded systems,
emphasis is placed on providing the user with computational savings at runtime whenever
possible.

To illustrate the constant input requirement with butter, create the file
myLowpassFilter.min a folder where you have read and write permission. Ensure that
this folder is in the MATLAB search path. Copy and paste the following lines of code into
myLowpassFilter.m and save the file.

function output = myLowpassFilter(input,N,Wn) %#codegen
[B,A] = butter(N,Wn, 'low');
output = filter(B,A,input);

If you have the MATLAB Coder software, enter the following command at the MATLAB
command prompt:

codegen myLowpassFilter -o myLowpassFilter ...
-args {zeros(512,1),coder.newtype('constant',5),coder.newtype('constant',0.1)} -report

Once the program compiles successfully, the following message appears in the command
window: Code generation successful: View report.

Click on View report. Click on the C code tab on the top left and open the target
source file myLowpassFilter.c.

Note that the numerator and denominator filter coefficients are included in the source
code.

static real T dvO[6]
static real T dvl1[6]

{ 5.9795780369978346E-5, 0.00029897890184989173,
{ 1.0, -3.9845431196123373, 6.4348670902758709,

Run the MEX-file without entering the constants:
output = myLowpassFilter(randn(512,1));

If you attempt to run the MEX-file by inputting the constants, you receive the error ???
Error using ==> myLowpassFilter 1 input required for entry-point
'myLowpassFilter'.

You may also enter the constants in the MATLAB source code directly. Edit the
myLowPassFilter.m file and replace the MATLAB code with the lines:

9-8
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function output = myLowpassFilter(input) S#codegen

[B,A] = butter(5,0.1, 'low');

output = filter(B,A,input);

Enter the following command at the MATLAB command prompt:

codegen myLowpassFilter -args {zeros(512,1)} -o myLowpassFilter
Run the MEX-file by entering the following at the MATLAB command prompt:
output = mylLowpassFilter(randn(512,1));

See “Apply Window to Input Signal” on page 9-10 ,“Apply Lowpass Filter to Input Signal”
on page 9-12, and “Zero Phase Filtering” on page 9-14 for additional examples of the
constant input requirement.

9-9
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Code Generation Examples

In this section...

“Apply Window to Input Signal” on page 9-10

“Apply Lowpass Filter to Input Signal” on page 9-12

“Cross Correlate or Autocorrelate Input Data” on page 9-12
“freqz With No Output Arguments” on page 9-13

“Zero Phase Filtering” on page 9-14

Apply Window to Input Signal

In this example, apply a Hamming window to an input data vector of size 512x1.
Create a file called window data.m by typing

>>edit window data

at the MATLAB command prompt.

Copy and paste the code provided into the editor and save the file.

function output data=window data(input data,N) S%#codegen
Win=hamming(N);

output data=input data.*Win;

Use codegen to generate a MEX-file window data.m.

codegen window data -args {zeros(512,1),coder.newtype('constant',512)} -o window data

The -args option defines the input specifications for the MEX -file. input dataisa
512x1 real valued vector. Because the input to hamming must be a constant,
coder.newtype is used to specify the window length. In a conventional MATLAB
program, you can read the input data length at runtime and construct a Hamming window
of the corresponding length.

Alternatively, edit the code for window_data.m as follows:
function output data=window data(input data) S#codegen

Win=hamming(512);
output data=input data.*Win;

9-10
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The preceding code specifies the length of the Hamming window in the source code as
opposed to using coder.newtype. Use codegen to generate a MEX-file and C code:

codegen window data -args {zeros(512,1)} -o window data -report

The - report flag generates a compilation report. If the codegen operation is successful,
you obtain: Code generation successful: View report.

Click on View report to view the Code Generation Report.

Select the C- code tab and select window data.c as the Target Source File.

[& Code Generation Report = B %

MATLAB code  Callstack = Ccode File: window_data.c (h:\mfiles\c data\window data.c)

Target Source Files
€] 1t_nonfinite.n

’Ej window data.c

) window data.h

1 window_data_apic

Z) window data apih

€] window data initislize.c
] window data initialize.h
£ window data mex.c

= dow data terminate.c

void window_data(const real T input_data[512], real T output_d

{

int32 T i:
) window data terminateh 29 static real T dv0[512] = { 0.080000000000000016, 0.0800347
2] window data typesh For (i = 0; i < 512; i+4) { 3
cutput_data[i] = input_data[i] * dvo[i]:

Summary All Messages (0) Target Build Log
C source code generated on: 18-Oct-2010 10:24:42

Coding target: C MEX Function
Number of errors: [
Number of warnings: o

Provide Feedback

‘We value your feedback. Please take a few minutes to answer this short survey regarding the Code
Generation Report.

=>Take Survey

Note from the location bar that the C source code is in the codegen/mex/

<FUNCTION NAME> folder. Running codegen creates this folder and places the C source
code, C header files, and MEX files in the folder. Each function that you create produces a
codegen/mex/<FUNCTION NAME> folder.

Scroll through the C code to see that the values of the Hamming window are included
directly in the C source code.

Run the MEX-file on a white noise input:

9-11
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9-12

% Window white noise input
output data=window data(randn(512,1));

Apply Lowpass Filter to Input Signal

Assuming a sampling frequency of 20 kHz, create a fourth-order Butterworth filter with a
3-dB frequency of 2.5 kHz. Use the Butterworth filter to lowpass filter a 10000x1 input
data vector.

Create a file called ButterFilt.m. Copy and paste the following code into the file.
function output data=ButterFilt(input data) %#codegen
[b,al=butter(4,0.25);

output data=filter(b,a,input data);

Run the codegen command to obtain the C source code ButterFilt. c and MEX file:
codegen ButterFilt -args {zeros(10000,1)} -o ButterFilt -report

The C source code includes the five numerator and denominator coefficients of the fourth-
order Butterworth filter as constants.

static real T dvO[5]
static real T dvl[5]

{ 0.010209480791203124, 0.040837923164812495, 0.061256884747218
{ 1.0, -1.9684277869385174, 1.7358607092088851, -0.724470829507.:

Apply the filter using the MEX-file:

Fs=20000;

%Create 10000x1 input signal

t=0:(1/Fs):0.5-(1/Fs);

input data=(cos(2*pi*1000*t)+sin(2*pi*500*t)+0.2*randn(size(t)))"';
%Filter data

output data=ButterFilt(input data);

Cross Correlate or Autocorrelate Input Data

Estimate the cross correlation or autocorrelation of two real-valued input vectors to lag
50. Output the estimate at the nonnegative lags.

Create a file called myxcorr.m. Copy and paste the following code into the file:

function [C,Lags]zmyxcorr(xly) %#COdegen
[c,lags]=xcorr(x,y,50, 'coeff");
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C=c(51:end);
Lags=lags(51:end);

Run the codegen command at the MATLAB command prompt:
codegen myxcorr -args {zeros(512,1), zeros(512,1)} -o myxcorr -report

Use the MEX-file to compute and plot the autocorrelation of a white noise input:

rng (0, 'twister')

%White noise input

input data=randn(512,1);

%Compute autocorrelation with MEX-file
[C,Lags]=myxcorr(input data,input data);

% Plot the result

stem(Lags,C); axis([-0.5 51 -1.1 1.11])
xlabel('Lags'); ylabel('Autocorrelation Function');

B Figure 1 = &8 =

File Edit View Insert Tools Desktop Window Help o

DSH kRN EL- |20 D

1
0.8

0 @éd)w(b ? 9 . f w?éﬁ’@é@@m

Autocorrelation Function

1 1 . 1 . . L L L L L
0 5 10 15 20 25 30 35 40 45 50
Lags

freqz With No Output Arguments

In Code Generation from MATLAB, freqz with no output arguments behaves differently
than in the standard MATLAB language. In standard MATLAB, freqz with no output
arguments produces a plot of the magnitude and phase response of the input filter. The
plot is produced regardless of whether the call to freqz terminates in a semicolon or not.
No frequency response or phase vectors are returned.

fregz with no output arguments and no terminating semicolon:

9-13
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B =1[0.050.9 0.05]; %Numerator coefficients
freqz(B,1) %no semicolon. Plot is produced

freqz with no output arguments and terminating in a semicolon:

B =1[0.050.9 0.05]; %Numerator coefficients
freqz(B,1); %semicolon. Plot is produced

The behavior shown in the preceding examples differs from the expected behavior of a
MEX-file using freqz with code generation support. To illustrate this difference create a
program called myfreqz.m.

Copy and paste the following code into the file:

function myfreqz(B,A) S#codegen
freqz(B,A)

Run the following command at the MATLAB command prompt:
codegen myfreqz -args {zeros(1,3), zeros(1l,1)} -o myfreqz

Calling the MEX-file writes a 512x1 complex-valued vector to the workspace and displays
the output. The vector is the frequency response. No plot is produced.

myfreqz([0.05 0.9 0.05],1);
Change the code in myfreqz.m by adding a terminating semicolon:

function myfreqz(B,A) S%#codegen
freqz(B,A);

Run the following command at the MATLAB command prompt:
codegen myfreqz -args {zeros(1,3), zeros(l,1)} -o myfreqz

Calling the MEX-file produces a plot of the magnitude and phase response of the filter.
The output of the complex-valued frequency response is suppressed.

myfreqz([0.05 0.9 0.05],1);

Zero Phase Filtering

Design a lowpass Butterworth filter with a 1 kHz 3-dB frequency to implement zero phase
filtering on data with a sampling frequency of 20 kHz.

9-14
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[B,A] = butter(20,0.314, 'low"');
Create the program myZerophaseFilt.m.

function output = myZerophaseFilt(input) %#codegen
B=1le-3 *[
.0000
.0001
.0010
.0060
.0254
.0814
.2035
.4071
.6615
.8820
.9702
.8820
.6615
.4071
.2035
.0814
.0254
.0060
.0010
.0001
.0000];
A=[1.0000
-7.4340
28.2476
-71.6333
134.6222
-197.9575
235.1628
-230.2286
188.0901
-129.1746
74.8284
-36.5623
15.0197
-5.1525
1.4599
-0.3361
0.0613
-0.0085

[cNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNo]
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0.0009
-0.0001
0.0000];
output = filtfilt(B,A,input);

Run the following command at the MATLAB command prompt:
codegen myZerophaseFilt -args {zeros(1,20001)} -o myZerophaseFilt

Filter input data with myZerophaseFilt:

Fs = 20000;

t =0:(1/Fs):1;

Comp500Hz = cos(2*pi*500*t);

Signal = Comp500Hz+sin(2*pi*4000*t)+0.2*randn(size(t));
FilteredData = myZerophaseFilt(Signal);
plot(t(1:500).*1000,Comp500Hz(1:500));

xlabel('msec'); ylabel('Amplitude');

axis([0 25 -1.8 1.8]); hold on;
plot(t(1:500).*1000,FilteredData(1:500),'r"', 'linewidth',2);
legend('500 Hz component', 'Zero phase lowpass filtered data',...
'Location', 'NorthWest');

=1a1x]

File Edit Wiew Insert Tools Desktop Window Help

D[R9 EL-3|0EaD

500 Hz component
Zero phase lowpass filtered data

Amplitude
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* “Linear and Circular Convolution” on page 10-2

* “Confidence Intervals for Sample Autocorrelation” on page 10-5

* “Residual Analysis with Autocorrelation” on page 10-7

* “Autocorrelation of Moving Average Process” on page 10-17

* “Cross-Correlation of Two Moving Average Processes” on page 10-21
* “Cross-Correlation of Delayed Signal in Noise” on page 10-23

* “Cross-Correlation of Phase-Lagged Sine Wave” on page 10-26
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Linear and Circular Convolution

10-2

This example shows how to establish an equivalence between linear and circular
convolution.

Linear and circular convolution are fundamentally different operations. However, there
are conditions under which linear and circular convolution are equivalent. Establishing
this equivalence has important implications. For two vectors, x and y, the circular
convolution is equal to the inverse discrete Fourier transform (DFT) of the product of the
vectors' DFTs. Knowing the conditions under which linear and circular convolution are
equivalent allows you to use the DFT to efficiently compute linear convolutions.

The linear convolution of an N-point vector, X, and an L-point vector, y, has length N + L -
1.

For the circular convolution of x and y to be equivalent, you must pad the vectors with
zeros to length at least N + L - 1 before you take the DFT. After you invert the product of
the DFTs, retain only the first N + L - 1 elements.

Create two vectors, x and y, and compute the linear convolution of the two vectors.

X [2121];
y = [1 2 3];
clin = conv(x,y);

The output has length 443-1.

Pad both vectors with zeros to length 4+3-1. Obtain the DFT of both vectors, multiply the
DFTs, and obtain the inverse DFT of the product.

xpad [x zeros(1l,6-length(x))];
ypad [y zeros(1,6-length(y))];
ccirc = ifft(fft(xpad).*fft(ypad));

The circular convolution of the zero-padded vectors, xpad and ypad, is equivalent to the
linear convolution of x and y. You retain all the elements of ccirc because the output has
length 4+3-1.

Plot the output of linear convolution and the inverse of the DFT product to show the
equivalence.

subplot(2,1,1)
stem(clin, 'filled"')



Linear and Circular Convolution

ylim([0 111)
title('Linear Convolution of x and y')

subplot(2,1,2)

stem(ccirc, 'filled')

ylim([0 111)

title('Circular Convolution of xpad and ypad')

Linear Convelution of x and y

1or »
]

(s}
T

or ]
]

o
T

Circular Convolution of xpad and ypad

T T
]
L ]
i
o 8.5 &
T T
]
L ]
i
5 5.5 &

Pad the vectors to length 12 and obtain the circular convolution using the inverse DFT of
the product of the DFTs. Retain only the first 4+3-1 elements to produce an equivalent

result to linear convolution.

N = length(x)+length(y)-1;
xpad = [x zeros(1l,12-length(x))];
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ypad = [y zeros(1l,12-1length(y))];
ccirc ifft(fft(xpad).*fft(ypad));
ccirc ccirc(1l:N);

The Signal Processing Toolbox™ software has a function, cconv, that returns the circular
convolution of two vectors. You can obtain the linear convolution of x and y using circular
convolution with the following code.

ccirc2 = cconv(x,y,6);

cconv internally uses the same DFT-based procedure illustrated in the previous example.

10-4
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Confidence Intervals for Sample Autocorrelation

This example shows how to create confidence intervals for the autocorrelation sequence
of a white noise process. Create a realization of a white noise process with length

L = 1000 samples. Compute the sample autocorrelation to lag 20. Plot the sample
autocorrelation along with the approximate 95%-confidence intervals for a white noise
process.

Create the white noise random vector. Set the random number generator to the default
settings for reproducible results. Obtain the normalized sampled autocorrelation to lag
20.

rng default

L = 1000;

X = randn(L,1);
[xc,lags] = xcorr(x,20, 'coeff');

Create the lower and upper 95% confidence bounds for the normal distribution

N0 1/ L) |

, whose standard deviation is /' V'L For a 95%-confidence interval, the

V2 erf1(0.95) = 1.96

critical value is and the confidence interval is

A=0+120
v L
vcrit = sqrt(2)*erfinv(0.95)

vcrit = 1.9600

lconf = -vcrit/sqrt(L);
upconf = vcrit/sqrt(L);

Plot the sample autocorrelation along with the 95%-confidence interval.

stem(lags,xc, 'filled")

hold on

plot(lags, [lconf;upconf]l*ones(size(lags)),'r")

hold off

ylim([lconf-0.03 1.05])

title('Sample Autocorrelation with 95% Confidence Intervals')
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Sample Autocorrelation with 95% Confidence Intervals

1F ] 1

0.9r 7

0.7 7

0.5 7

You see in the above figure that the only autocorrelation value outside of the 95%-
confidence interval occurs at lag 0 as expected for a white noise process. Based on this
result, you can conclude that the data are a realization of a white noise process.
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Residual Analysis with Autocorrelation

This example shows how to use autocorrelation with a confidence interval to analyze the
residuals of a least-squares fit to noisy data. The residuals are the differences between
the fitted model and the data. In a signal-plus-white noise model, if you have a good fit for
the signal, the residuals should be white noise.

Create a noisy data set consisting of a 1st-order polynomial (straight line) in additive
white Gaussian noise. The additive noise is a sequence of uncorrelated random variables
following a N(0,1) distribution. This means that all the random variables have mean zero
and unit variance. Set the random number generator to the default settings for
reproducible results.

X = -3:0.01:3;

rng default

y = 2*x+randn(size(x));
plot(x,y)
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Use polyfit to find the least-squares line for the noisy data. Plot the original data along
with the least-squares fit.

coeffs = polyfit(x,y,1);
yfit = coeffs(2)+coeffs(1l)*x;

plot(x,y)

hold on
plot(x,yfit, 'linewidth"',2)
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Find the residuals. Obtain the autocorrelation sequence of the residuals to lag 50.

residuals
[xc,lags]

y - yfit;
xcorr(residuals, 50, 'coeff');

When you inspect the autocorrelation sequence, you want to determine whether or not
there is evidence of autocorrelation. In other words, you want to determine whether the
sample autocorrelation sequence looks like the autocorrelation sequence of white noise. If
the autocorrelation sequence of the residuals looks like the autocorrelation of a white
noise process, you are confident that none of the signal has escaped your fit and ended up
in the residuals. In this example, use a 99%-confidence interval. To construct the
confidence interval, you need to know the distribution of the sample autocorrelation
values. You also need to find the critical values on the appropriate distribution between
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10-10

which lie 0.99 of the probability. Because the distribution in this case is Gaussian, you can
use complementary inverse error function, erfcinv. The relationship between this
function and the inverse of the Gaussian cumulative distribution function is described on
the reference page for erfcinv.

Find the critical value for the 99%-confidence interval. Use the critical value to construct
the lower and upper confidence bounds.

conf99 = sqrt(2)*erfcinv(2*.01/2);
lconf = -conf99/sqrt(length(x));
upconf = conf99/sqrt(length(x));

Plot the autocorrelation sequence along with the 99%-confidence intervals.
figure

stem(lags,xc, 'filled")

ylim([lconf-0.03 1.05])

hold on

plot(lags,lconf*ones(size(lags)),'r', 'linewidth',2)
plot(lags,upconf*ones(size(lags)),'r', 'linewidth',2)
title('Sample Autocorrelation with 99% Confidence Intervals')
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Sample Autocorrelation with 99% Confidence Intervals

1F . :

50 40 -30 20 -10 0 10 20 30 40 50

Except at zero lag, the sample autocorrelation values lie within the 99%-confidence
bounds for the autocorrelation of a white noise sequence. From this, you can conclude
that the residuals are white noise. More specifically, you cannot reject that the residuals
are a realization of a white noise process.

Create a signal consisting of a sine wave plus noise. The data are sampled at 1 kHz. The
frequency of the sine wave is 100 Hz. Set the random number generator to the default
settings for reproducible results.

Fs = 1000;

t =0:1/Fs:1-1/Fs;

rng default

X = COS(2*pi*100*t)+randn(size(t));
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Use the discrete Fourier transform (DFT) to obtain the least-squares fit to the sine wave
at 100 Hz. The least-squares estimate of the amplitude is 2 / N times the DFT coefficient
corresponding to 100 Hz, where N is the length of the signal. The real part is the
amplitude of a cosine at 100 Hz and the imaginary part is the amplitude of a sine at 100
Hz. The least-squares fit is the sum of the cosine and sine with the correct amplitude. In
this example, DFT bin 101 corresponds to 100 Hz.

xdft = fft(x);
ampest = 2/length(x)*xdft(101);
xfit = real(ampest)*cos(2*pi*100*t)+imag(ampest)*sin(2*pi*100*t);

figure

plot(t,x)

hold on
plot(t,xfit,'linewidth"',2)
axis([0 0.30 -4 4])
xlabel('Seconds')
ylabel('Amplitude")
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Amplitude

o 0.05 0.1 0.15 0.2 0.25 0.3
Seconds

Find the residuals and determine the sample autocorrelation sequence to lag 50.

x-xfit;
xcorr(residuals,50, 'coeff');

residuals
[xc,lags]

Plot the autocorrelation sequence with the 99%-confidence intervals.
figure

stem(lags,xc, 'filled")

ylim([lconf-0.03 1.05])

hold on

plot(lags,lconf*ones(size(lags)),'r', 'linewidth',2)
plot(lags,upconf*ones(size(lags)),'r', 'linewidth"',2)
title('Sample Autocorrelation with 99% Confidence Intervals')
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Sample Autocorrelation with 99% Confidence Intervals

1F . :

50 40 -30 20 -10 0 10 20 30 40 50

Again, you see that except at zero lag, the sample autocorrelation values lie within the
99%-confidence bounds for the autocorrelation of a white noise sequence. From this, you
can conclude that the residuals are white noise. More specifically, you cannot reject that
the residuals are a realization of a white noise process.

Finally, add another sine wave with a frequency of 200 Hz and an amplitude of 3/4. Fit
only the sine wave at 100 Hz and find the sample autocorrelation of the residuals.

X = X+3/4*sin(2*pi*200*t);

xdft = fft(x);

ampest = 2/length(x)*xdft(101);

xfit = real(ampest)*cos(2*pi*100*t)+imag(ampest)*sin(2*pi*100*t);
residuals = x-xfit;

[xc,lags] = xcorr(residuals,50, 'coeff"');



Residual Analysis with Autocorrelation

Plot the sample autocorrelation along with the 99%-confidence intervals.

figure

stem(lags,xc, 'filled"')

ylim([lconf-0.12 1.05])

hold on

plot(lags,lconf*ones(size(lags)),'r', 'linewidth',2)
plot(lags,upconf*ones(size(lags)),'r', 'linewidth"',2)
title('Sample Autocorrelation with 99% Confidence Intervals')

Sample Autocorrelation with 99% Confidence Intervals
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In this case, the autocorrelation values clearly exceed the 99%-confidence bounds for a
white noise autocorrelation at many lags. Here you can reject the hypothesis that the
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residuals are a white noise sequence. The implication is that the model has not accounted
for all the signal and therefore the residuals consist of signal plus noise.
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Autocorrelation of Moving Average Process

This example shows how to introduce autocorrelation into a white noise process by
filtering. When we introduce autocorrelation into a random signal, we manipulate its
frequency content. A moving average filter attenuates the high-frequency components of
the signal, effectively smoothing it.

Create the impulse response for a 3-point moving average filter. Filter an N(0,1) white
noise sequence with the filter. Set the random number generator to the default settings
for reproducible results.

h = 1/3*ones(3,1);
rng default

X = randn(1000,1);
y = filter(h,1,x);

Obtain the biased sample autocorrelation out to 20 lags. Plot the sample autocorrelation
along with the theoretical autocorrelation.

[xc,lags] = xcorr(y,20, 'biased');

Xc = zeros(size(xc));
Xc(19:23) = [1 2 3 2 11/9*var(x);

stem(lags,xc, 'filled")
hold on
stem(lags,Xc,'."', 'linewidth"',2)

1g = legend('Sample autocorrelation', 'Theoretical autocorrelation');

lg.Location = 'NorthEast';
1g.Box = 'off"';
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The sample autocorrelation captures the general form of the theoretical autocorrelation,
even though the two sequences do not agree in detail.

In this case, it is clear that the filter has introduced significant autocorrelation only over
lags [-2,2]. The absolute value of the sequence decays quickly to zero outside of that
range.

To see that the frequency content has been affected, plot Welch estimates of the power
spectral densities of the original and filtered signals.

[pxx,wx] = pwelch(x);
[pyy,wyl = pwelch(y);
figure



Autocorrelation of Moving Average Process

plot(wx/pi,20*1ogl0(pxx),wy/pi,20*1loglO(pyy))
1g = legend('Original sequence','Filtered sequence');
lg.Location = 'SouthWest';

xlabel('Normalized Frequency (\times\pi rad/sample)")
ylabel('Power/frequency (dB/rad/sample)')
title('Welch Power Spectral Density Estimate')

grid
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0
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E L Py y P I|r \l'.
— - r 'il i W -
E BD I.J I|II II I.\_. /II I| r,JII I'.I|II |
[ |I |II II LV I',I‘IJ'I
E -40 r \ { .
g L lln._f\l
=50 ! I.'.-",.' T
- " [t
g l"'-,l |'I
= 60T | [ T
: |/
o -Tor | I,' T
._- |
-B0 T Criginal sequence f IlI 7
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Mormalized Frequency (=« rad/sample)

The white noise has been "colored" by the moving average filter.
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See Also

External Websites
. Ellis, Dan. About Colored Noise. http://www.ee.columbia.edu/~dpwe/noise/
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Cross-Correlation of Two Moving Average Processes

Cross-Correlation of Two Moving Average Processes

This example shows how to find and plot the cross-correlation sequence between two
moving average processes. The example compares the sample cross-correlation with the

theoretical cross-correlation. Filter an V(9 1) white noise input with two different
moving average filters. Plot the sample and theoretical cross-correlation sequences.

Create an V!0 1) white noise sequence. Set the random number generator to the default
settings for reproducible results. Create two moving average filters. One filter has

impulse response @) +3(n — 1) The other filter has impulse response @#) —d(n—1]

rng default

w = randn(100,1);
x = filter([1 1],1,w);
y = filter([1 -1],1,w);

Obtain the sample cross-correlation sequence up to lag 20. Plot the sample cross-
correlation along with the theoretical cross-correlation.

[xc,lags] = xcorr(x,y,20,'biased');

Xc = zeros(size(xc));

Xc(20) = -1;

Xc(22) = 1;

stem(lags,xc, 'filled"')

hold on

stem(lags,Xc,'."', 'linewidth',2)

g = legend('Sample cross-correlation', 'Theoretical cross-correlation');
g.Location '"NorthWest"';

q.FontSize = 9;

g.Box = 'off";
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The theoretical cross-correlation is —! at lag —1, 1 at lag I', and zero at all other lags.

The sample cross-correlation sequence approximates the theoretical cross-correlation.

As expected, there is not perfect agreement between the theoretical cross-correlation and
sample cross-correlation. The sample cross-correlation does accurately represent both the

sign and magnitude of the theoretical cross-correlation sequence values at lag —I and lag
1



Cross-Correlation of Delayed Signal in Noise

Cross-Correlation of Delayed Signal in Noise

This example shows how to use the cross-correlation sequence to detect the time delay in
a noise-corrupted sequence. The output sequence is a delayed version of the input
sequence with additive white Gaussian noise. Create two sequences. One sequence is a

delayed version of the other. The delay is 3 samples. Add N(0.0.37) white noise to the
delayed signal. Use the sample cross-correlation sequence to detect the lag.

Create and plot the signals. Set the random number generator to the default settings for
reproducible results.

rng default

X
y

triang(20);
[zeros(3,1);x]+0.3*randn(length(x)+3,1);

subplot(2,1,1)

stem(x, 'filled")
axis([0 22 -1 2])
title('Input Sequence')

subplot(2,1,2)

stem(y, 'filled")

axis([0 22 -1 2])
title('Output Sequence')
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Obtain the sample cross-correlation sequence and use the maximum absolute value to
estimate the lag. Plot the sample cross-correlation sequence.

[xc,lags] = xcorr(y,x);
[~,I] = max(abs(xc));

figure

stem(lags,xc, 'filled")
legend(sprintf('Maximum at lag %d',lags(I)))
title('Sample Cross-Correlation Sequence')
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Sample Cross-Correlation Sequence
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The maximum cross correlation sequence value occurs at lag 3 as expected.
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Cross-Correlation of Phase-Lagged Sine Wave

10-26

This example shows how to use the cross-correlation sequence to estimate the phase lag
between two sine waves. The theoretical cross-correlation sequence of two sine waves at
the same frequency also oscillates at that frequency. Because the sample cross-correlation
sequence uses fewer and fewer samples at larger lags, the sample cross-correlation
sequence also oscillates at the same frequency, but the amplitude decays as the lag
increases.

Create two sine waves with frequencies of 2= /10 rad/sample. The starting phase of one

sine wave is 0, while the starting phase of the other sine wave is —# radians. Add

N{0,0.257%) white noise to the sine wave with the phase lag of ® radians. Set the random
number generator to the default settings for reproducible results.

rng default

t = 0:99;
X = cos(2*pi*1/10%*t);
y = C0os(2*pi*1/10*t-pi)+0.25*randn(size(t));

Obtain the sample cross-correlation sequence for two periods of the sine wave (10
samples). Plot the cross-correlation sequence and mark the known lag between the two
sine waves (5 samples).

[xc,lags] = xcorr(y,x,20, 'coeff');
stem(lags(21l:end),xc(21:end), " 'filled")

hold on
plot([5 5],[-1 1])

ax = gca;
ax.XTick = 0:5:20;
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You see that the cross-correlation sequence peaks at lag 5 as expected and oscillates with
a period of 10 samples.
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Downsampling — Signal Phases

11-2

This example shows how to use downsample to obtain the phases of a signal.
Downsampling a signal by M can produce M unique phases. For example, if you have a
discrete-time signal, x, with x(0) x(1) x(2) x(3), ..., the M phases of x are x(nM + k) with k
=0,1, .. M-1.

The M signals are referred to as the polyphase components of x.

Create a white noise vector and obtain the 3 polyphase components associated with
downsampling by 3.

Reset the random number generator to the default settings to produce a repeatable
result. Generate a white noise random vector and obtain the 3 polyphase components
associated with downsampling by 3.

rng default

X = randn(36,1);

x0 = downsample(x,3,0);
x1 downsample(x,3,1);
X2 downsample(x,3,2);

The polyphase components have length equal to 1/3 the original signal.

Upsample the polyphase components by 3 using upsample.

y0 = upsample(x0,3,0);
yl = upsample(x1,3,1);
y2 = upsample(x2,3,2);

Plot the result.

subplot(4,1,1)

stem(x, 'Marker', "'none")
title('Original Signal')
ylim([-4 4])

subplot(4,1,2)

stem(y0, 'Marker', 'none")
ylabel('Phase 0')
ylim([-4 4])

subplot(4,1,3)
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Phase 1 Phase 0

Phase 2

stem(yl, 'Marker', 'none")
ylabel('Phase 1')
ylim([-4 4])

subplot(4,1,4)

stem(y2, 'Marker', 'none")
ylabel('Phase 2')
ylim([-4 4])

If you sum the upsampled polyphase components you obtain the original signal.

Original Signal
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Create a discrete-time sinusoid and obtain the 2 polyphase components associated with

downsampling by 2.
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Create a discrete-time sine wave with an angular frequency of 7/ rad/sample. Add a DC
offset of 2 to the sine wave to help with visualization of the polyphase components.
Downsample the sine wave by 2 to obtain the even and odd polyphase components.

n=0:127;

X = 2+cos(pi/4*n);

x0 = downsample(x,2,0);
x1 = downsample(x,2,1);

Upsample the two polyphase components.

upsample(x0,2,0);
upsample(x1,2,1);

y0o
yl

Plot the upsampled polyphase components along with the original signal for comparison.

subplot(3,1,1)
stem(x, 'Marker', "'none")
ylim([0.5 3.5])
title('Original Signal')

subplot(3,1,2)

stem(y0, 'Marker', 'none")
ylim([0.5 3.5])
ylabel('Phase 0')

subplot(3,1,3)

stem(yl, 'Marker', 'none")
ylim([0.5 3.5])
ylabel('Phase 1)
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Phase 0
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If you sum the two upsampled polyphase components (Phase 0 and Phase 1), you obtain
the original sine wave.

See Also

downsample | upsample
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Downsampling — Aliasing

11-6

This example shows how to avoid aliasing when downsampling a signal. If a discrete-time

signal's baseband spectral support is not limited to an interval of width 2m /M radians,
downsampling by A results in aliasing. Aliasing is the distortion that occurs when
overlapping copies of the signal's spectrum are added together. The more the signal's

baseband spectral support exceeds 27 /M radians, the more severe the aliasing.
Demonstrate aliasing in a signal downsampled by two. The signal's baseband spectral
support exceed 7 radians in width.

Create a signal with baseband spectral support equal to %7 /2 radians. Use fir2 to design
the signal. Plot the signal's spectrum.

F = [0 0.2500 0.5000 0.7500 1.0000];
A =1[1.00 0.6667 0.3333 0 0];

Order = 511;

Bl = fir2(Order,F,A);

[Hx,W] = freqz(B1,1,8192, 'whole');
Hx = [Hx(4098:end) ; Hx(1:4097)1;
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
xlim([-pi pi])

grid

title('Magnitude Spectrum')
xlabel('Radians/Sample')
ylabel('Magnitude")
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Magnitude

Magnitude Spectrum
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You see that the signal's baseband spectral support exceeds [-m/2,m/2]

Downsample the signal by a factor of 2 and plot the downsampled signal's spectrum with
the spectrum of the original signal.

y = downsample(B1,2,0);
[Hy,W] = freqz(y,1,8192, 'whole');
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on

plot(omega,abs(Hy), 'r', 'linewidth"',2)

legend('Original Signal', 'Downsampled Signal')

text(-2.5,0.35, '\downarrow aliasing', 'HorizontalAlignment', 'center"')
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text(2.5,0.35, 'aliasing \downarrow', 'HorizontalAlignment', 'center')
hold off

Magnitude Spectrum
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In addition to an amplitude scaling of the spectrum, the superposition of overlapping
spectral replicas causes distortion of the original spectrum for lw| > 7 /2,

Increase the baseband spectral support of the signal to [~ 77 /8. 77/8] and downsample
the signal by 2. Plot the original spectrum along with the spectrum of the downsampled

signal.

F =10 0.2500 0.5000 0.7500 7/8 1.0000];
A=1[1.00 0.7143 0.4286 0.1429 0 0];
Order = 511;
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B2 = fir2(Order,F,A);

[Hx,W] = freqz(B2,1,8192, 'whole');
Hx = [Hx(4098:end) ; Hx(1:4097)1;
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
xlim([-pi pi])

y = downsample(B2,2,0);
[Hy,W] = freqz(y,1,8192, 'whole');
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on
plot(omega,abs(Hy), 'r', 'linewidth"',2)
grid

legend('Original Signal', 'Downsampled Signal')

(
xlabel('Radians/Sample')
ylabel('Magnitude")

hold off
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Magnitude
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The increased spectral width results in more pronounced aliasing in the spectrum of the
downsampled signal because more signal energy is outside [~ 7/2.7/2],

Finally, construct a signal with baseband spectral support limited to [~ /2. 7/2],
Downsample the signal by a factor of 2 and plot the spectrum of the original and
downsampled signals. The downsampled signal is full band, but the shape of the spectrum
is preserved because the spectral copies do not overlap. There is no aliasing.

[0 0.250 0.500 0.7500 17;
[1.0000 0.5000 0 0 0];
r = 511;

fir2(0Order,F,A);

W] = freqz(B3,1,8192, 'whole');

F 3
A 3
Ord
B3
[Hx,
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Hx = [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192): (2*pi)/8192:pi;

plot(omega,abs(Hx))
xlim([-pi pi])

y = downsample(B3,2,0);
[Hy,W] = freqz(y,1,8192, 'whole');
Hy = [Hy(4098:end) ; Hy(1:4097)];

plot(omega,abs(Hx))

hold on

plot(omega,abs(Hy), 'r', 'linewidth"',2)

grid

legend('Original Signal', 'Downsampled Signal')
xlabel('Radians/Sample')

ylabel('Magnitude")

hold off
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You see in the preceding figure that the shape of the spectrum is preserved. The spectrum
of the downsampled signal is a stretched and scaled version of the original signal's
spectrum, but there is no aliasing.

See Also

downsample | fir2 | freqz
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Filtering Before Downsampling

This example shows how to filter before downsampling to mitigate the distortion caused
by aliasing. You can use decimate or resample to filter and downsample with one
function. Alternatively, you can lowpass filter your data and then use downsample. Create

a signal with baseband spectral support greater than # radians. Use decimate to filter
the signal with a 10th-order Chebyshev type I lowpass filter prior to downsampling.

Create the signal and plot the magnitude spectrum.

[0 0.2500 0.5000 0.7500 1.0000];
[1.00 0.6667 0.3333 0 0];
Order = 511;
B = fir2(0Order,F,A);
[Hx W] = freqz(B,1,8192, 'whole');
= [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

> M

plot(omega,abs(Hx))
xlim([-pi pi])

grid

title('Magnitude Spectrum')
xlabel('Radians/Sample')
ylabel('Magnitude")
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Filter the signal with a 10th-order type I Chebyshev lowpass filter and downsample by 2.
Plot the magnitude spectra of the original signal along with the filtered and downsampled
signal.

y = decimate(B,2,10);
[Hy,W] = freqz(y,1,8192, 'whole');
Hy = [Hy(4098:end) ; Hy(1:4097)1];

hold on

plot(omega,abs(Hy),'r', 'linewidth',2)
legend('Original Signal', 'Downsampled Signal')
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The lowpass filter reduces the amount of aliasing distortion outside the interval
|—m/2,7/2]

See Also

decimate | fir2 | freqz
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Upsampling — Imaging Artifacts

11-16

This example shows how to upsample a signal and how upsampling can result in images.
Upsampling a signal contracts the spectrum. For example, upsampling a signal by 2
results in a contraction of the spectrum by a factor of 2. Because the spectrum of a

discrete-time signal is 2x -periodic, contraction can cause replicas of the spectrum

normally outside of the baseband to appear inside the interval |—m.m],

Create a discrete-time signal whose baseband spectral support is =7 x| Plot the
magnitude spectrum.

F [0 0.250 0.500 0.7500 1];

A [1.0000 0.5000 0 0 0];

Order = 511;

B = fir2(0Order,F,A);

[Hx,W] = freqz(B,1,8192, 'whole');

Hx = [Hx(4098:end) ; Hx(1:4097)1;

omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
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Upsample the signal by 2. Plot the spectrum of the upsampled signal.

y = upsample(B,2);
[Hy,W] = freqz(y,1,8192, 'whole');
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on
plot(omega,abs(Hy),'r', 'linewidth"',2)

xlim([-pi pi])
legend('Original Signal', 'Upsampled Signal')
xlabel('Radians/Sample"')

ylabel('Magnitude")
text(-2,0.5, '\leftarrow Imaging', 'HorizontalAlignment', 'center')
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text(2,0.5, 'Imaging \rightarrow', 'HorizontalAlignment', 'center"')
hold off
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Magnitude
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You can see in the preceding figure that the contraction of the spectrum has drawn

subsequent periods of the spectrum into the interval | =%,

See Also
fir2 | freqz | upsample
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Filtering After Upsampling — Interpolation

This example shows how to upsample a signal and apply a lowpass interpolation filter
with interp. Upsampling by L inserts L - 1 zeros between every element of the original
signal. Upsampling can create imaging artifacts. Lowpass filtering following upsampling
can remove these imaging artifacts. In the time domain, lowpass filtering interpolates the
zeros inserted by upsampling.

Create a discrete-time signal whose baseband spectral support is \—m/2,7/2] Plot the
magnitude spectrum.

F = [0 0.250 0.500 0.7500 1];
A = [1.0000 0.5000 0 0 0];
Order = 511;

B = fir2(0Order,F,A);

[Hx,W] = freqz(B,1,8192, 'whole');
Hx = [Hx(4098:end) ; Hx(1:4097)1;
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
xlim([-pi pi])
xlabel('Radians/Sample')
ylabel('Magnitude")
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Upsample the signal and apply a lowpass filter to remove the imaging artifacts. Plot the
magnitude spectrum.

y = interp(B,2);
[Hy,W] = freqz(y,1,8192, 'whole');
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on

plot(omega,abs(Hy), 'r', 'linewidth',2)
legend('Original Signal', 'Upsampled Signal')
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Upsampling still contracts the spectrum, but the imaging artifacts are removed by the

lowpass filter.

See Also

fir2 | freqz | interp
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Simulate a Sample-and-Hold System

This example shows several ways to simulate the output of a sample-and-hold system by
upsampling and filtering a signal.

Construct a sinusoidal signal. Specify a sample rate such that 16 samples correspond to
exactly one signal period. Draw a stem plot of the signal. Overlay a stairstep graph for
sample-and-hold visualization.

fs = 16;
t =0:1/fs:1-1/fs;

X = .9%sin(2*pi*t);
stem(t, x)
hold on

stairs(t,x)
hold off
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Upsample the signal by a factor of four. Plot the result alongside the original signal.
upsample increases the sample rate of the signal by adding zeros between the existing
samples.

ups = 4;

fu
tu

fs*ups;
0:1/fu:l-1/fu;

y = upsample(x,ups);
stem(tu,y,'--x")

hold on
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stairs(t,x)
hold off
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Filter with a moving-average FIR filter to fill in the zeros with sample-and-hold values.

h = ones(ups,1);

z = filter(h,1,y);
stem(tu,z,'--.")
hold on
stairs(t,x)

hold off
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You can obtain the same behavior using the MATLAB® function interpl with nearest-
neighbor interpolation. In that case, you must shift the origin to line up the sequence.

zi = interpl(t,x,tu, 'nearest');

dl = floor(ups/2);
stem(tu(l+dl:end),zi(1l:end-dl),"'--.")
hold on

stairs(t,x)
hold off
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The function resample produces the same result when you set the last input argument to
Zero.

g = resample(x,ups,1,0);
stem(tu(l+dl:end),q(l:end-dl),"'--.")
hold on

stairs(t,x)
hold off
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See Also

resample | upsample
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Changing Signal Sample Rate

11-28

This example shows how to change the sample rate of a signal. The example has two
parts. Part one changes the sample rate of a sinusoidal input from 44.1 kHz to 48 kHz.
This workflow is common in audio processing. The sample rate used on compact discs is
44.1 kHz, while the sample rate used on digital audio tape is 48 kHz. Part two changes
the sample rate of a recorded speech sample from 7418 Hz to 8192 Hz.

Create an input signal consisting of a sum of sine waves sampled at 44.1 kHz. The sine
waves have frequencies of 2, 4, and 8 kHz.

Fs = 44.1e3;
t 0:1/Fs:1-1/Fs;
X COS (2*pi*2000*t)+1/2*sin(2*pi*4000*(t-pi/4))+1/4*cos(2*¥pi*8000*t);

To change the sample rate from 44.1 to 48 kHz, you have to determine a rational number
(ratio of integers), P/Q, such that P/Q times the original sample rate, 44100, is equal to
48000 within some specified tolerance.

To determine these factors, use rat. Input the ratio of the new sample rate, 48000, to the
original sample rate, 44100.

[P,Q] = rat(48e3/Fs);
abs (P/Q*Fs-48000)

ans = 7.2760e-12

You see that P/Q*Fs only differs from the desired sample rate, 48000, on the order of
1 U—]E

Use the numerator and denominator factors obtained with rat as inputs to resample to
output a waveform sampled at 48 kHz.

xnew = resample(x,P,Q);

If your computer can play audio, you can play the two waveforms. Set the volume to a
comfortable level before you play the signals. Execute the play commands separately so
that you can hear the signal with the two different sample rates.

P44 1 = audioplayer(x,44100);
P48 = audioplayer(xnew,48000);
play(P44 1)
play(P48)

0° o° o° o°



Changing Signal Sample Rate

Change the sample rate of a speech sample from 7418 Hz to 8192 Hz. The speech signal
is a recording of a speaker saying "MATLAB®".

Load the speech sample.

load mtlb

Loading the file mt1b.mat brings the speech signal, mt1b, and the sample rate, Fs, into
the MATLAB workspace.

Determine a rational approximation to the ratio of the new sample rate, 8192, to the
original sample rate. Use rat to determine the approximation.

[P,Q] = rat(8192/Fs);

Resample the speech sample at the new sample rate. Plot the two signals.
mtlb new = resample(mtlb,P,Q);

subplot(2,1,1)

plot((0:length(mtlb)-1)/Fs,mtlb)

subplot(2,1,2)
plot((0:length(mtlb new)-1)/(P/Q*Fs),mtlb new)
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If your computer has audio output capability, you can play the two waveforms at their
respective sample rates for comparison. Set the volume on your computer to a
comfortable listening level before playing the sounds. Execute the play commands
separately to compare the speech samples at the different sample rates.

Pmtlb = audioplayer(mtlb,Fs);

Pmtlb new = audioplayer(mtlb _new,8192);
play(Pmtlb)

play(Pmtlb new)

d° o° o o°
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See Also

resample
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12 Spectral Analysis

Power Spectral Density Estimates Using FFT

This example shows how to obtain nonparametric power spectral density (PSD) estimates
equivalent to the periodogram using fft. The examples show you how to properly scale
the output of fft for even-length inputs, for normalized frequency and hertz, and for one-
and two-sided PSD estimates.

Even-Length Input with Sample Rate

Obtain the periodogram for an even-length signal sampled at 1 kHz using both fft and
periodogram. Compare the results.

Create a signal consisting of a 100 Hz sine wave in N(0,1) additive noise. The sampling
frequency is 1 kHz. The signal length is 1000 samples. Use the default settings of the
random number generator for reproducible results.

rng default

Fs = 1000;

t 0:1/Fs:1-1/Fs;

X Cos(2*pi*100*t) + randn(size(t));

Obtain the periodogram using fft. The signal is real-valued and has even length.
Because the signal is real-valued, you only need power estimates for the positive or
negative frequencies. In order to conserve the total power, multiply all frequencies that
occur in both sets -- the positive and negative frequencies -- by a factor of 2. Zero
frequency (DC) and the Nyquist frequency do not occur twice. Plot the result.

N = length(x);

xdft = fft(x);

xdft = xdft(1:N/2+1);

psdx = (1/(Fs*N)) * abs(xdft)."2;
psdx(2:end-1) = 2*psdx(2:end-1);
freq = 0:Fs/length(x):Fs/2;

plot(freq,10*loglO(psdx))

grid on

title('Periodogram Using FFT')
xlabel('Frequency (Hz)"')
ylabel('Power/Frequency (dB/Hz)")
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Periodogram Using FFT
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Compute and plot the periodogram using periodogram. Show that the two results are

identical.

periodogram(x, rectwin(length(x)),length(x),Fs)
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Periodogram Power Spectral Density Estimate
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mxerr = max(psdx'-periodogram(x,rectwin(length(x)),length(x),Fs))

mxerr = 3.4694e-18
Input with Normalized Frequency

Use fft to produce a periodogram for an input using normalized frequency. Create a
signal consisting of a sine wave in N(0,1) additive noise. The sine wave has an angular

frequency of /4 rad/sample. Use the default settings of the random number generator
for reproducible results.
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rng default
n 0:999;
X cos(pi/4*n) + randn(size(n));

Obtain the periodogram using fft. The signal is real-valued and has even length.
Because the signal is real-valued, you only need power estimates for the positive or
negative frequencies. In order to conserve the total power, multiply all frequencies that
occur in both sets -- the positive and negative frequencies -- by a factor of 2. Zero
frequency (DC) and the Nyquist frequency do not occur twice. Plot the result.

N = length(x);
xdft = fft(x);

xdft = xdft(1:N/2+1);

psdx = (1/(2*pi*N)) * abs(xdft).”2;
psdx(2:end-1) = 2*psdx(2:end-1);
freq = 0:(2*pi)/N:pi;

plot(freq/pi,10*loglO(psdx))

grid on

title('Periodogram Using FFT')

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Power/Frequency (dB/rad/sample)')
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Periodogram Using FFT
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Compute and plot the periodogram using periodogram. Show that the two results are
identical.

periodogram(x, rectwin(length(x)),length(x))
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mxerr = max(psdx'-periodogram(x,rectwin(length(x)),length(x)))
mxerr = 1.4211le-14
Complex-Valued Input with Normalized Frequency

Use fft to produce a periodogram for a complex-valued input with normalized frequency.

The signal is a complex exponential with an angular frequency of # /4 rad/sample in
complex-valued N(0,1) noise. Set the random number generator to the default settings for
reproducible results.
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rng default
n 0:999;
X = exp(1lj*pi/4*n) + [1 1j1*randn(2,length(n))/sqrt(2);

Use fft to obtain the periodogram. Because the input is complex-valued, obtain the

periodogram from (=, @] rad/sample. Plot the result.

N = length(x);

xdft = fft(x);
psdx = (1/(2*pi*N)) * abs(xdft).”2;
freq = 0:(2*pi)/N:2*pi-(2*pi)/N;

plot(freq/pi,10*1ogl@(psdx))

grid on

title('Periodogram Using FFT")

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Power/Frequency (dB/rad/sample)"')
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Use periodogram to obtain and plot the periodogram. Compare the PSD estimates.

periodogram(x, rectwin(length(x)),length(x), 'twosided")
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Periodogram Power Spectral Density Estimate
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mxerr = max(psdx'-periodogram(x,rectwin(length(x)),length(x), 'twosided'))

mxerr = 4.4409e-16

See Also

Apps
Signal Analyzer

Functions
fft | periodogram
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Bias and Variability in the Periodogram

Bias and Variability in the Periodogram

This example shows how to reduce bias and variability in the periodogram. Using a
window can reduce the bias in the periodogram, and using windows with averaging can
reduce variability.

Use wide-sense stationary autoregressive (AR) processes to show the effects of bias and
variability in the periodogram. AR processes present a convenient model because their
PSDs have closed-form expressions. Create an AR(2) model of the following form:

vin) —075vin—14+053vin—-2] =e&ln),

where €M/ is a zero mean white noise sequence with some specified variance. In this
example, assume the variance and the sampling period to be 1. To simulate the preceding
AR(2) process, create an all-pole (IIR) filter. View the filter's magnitude response.

B2 = 1;
A2 = [1 -0.75 0.5];
fvtool(B2,A2)
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This process is bandpass. The dynamic range of the PSD is approximately 14.5 dB, as you
can determine with the following code.

[H2,W2] = freqz(B2,A2,1e3,1);
dr2 = max(20*logl@(abs(H2)))-min(20*1ogl0(abs(H2)))

dr2 = 14.4984

By examining the placement of the poles, you see that this AR(2) process is stable. The
two poles are inside the unit circle.

fvtool(B2,A2, 'Analysis', 'polezero')
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Next, create an AR(4) process described by the following equation:
vin) =2.7607vin— 1) +3.8100pn—21 —2.6535v(n—3) +09238yv(n—4) = &(n.

Use the following code to view the magnitude response of this IIR system.

B4 = 1;
A4 = [1 -2.7607 3.8106 -2.6535 0.9238];
fvtool(B4,A4)
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Magnitude Response (dB)
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Examining the placement of the poles, you can see this AR(4) process is also stable. The
four poles are inside the unit circle.

fvtool(B4,A4, 'Analysis', 'polezero')
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The dynamic range of this PSD is approximately 65 dB, much larger than the AR(2)
model.

[H4,W4] = freqz(B4,A4,1e3,1);
drd = max(20*logl@(abs(H4)))-min(20*1ogl0(abs(H4)))

drd = 64.6213

To simulate realizations from these AR(p) processes, use randn and filter. Set the
random number generator to the default settings to produce repeatable results. Plot the
realizations.

rng default
X = randn(le3,1);
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12-16

y2
v4

filter(B2,A2,x);
filter(B4,A4,x);

subplot(2,1,1)
plot(y2)

title('AR(2) Process')

xlabel('Time")

subplot(2,1,2)
plot(y4)

title('AR(4) Process')

xlabel('Time")
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Bias and Variability in the Periodogram

Compute and plot the periodograms of the AR(2) and AR(4) realizations. Compare the
results against the true PSD. Note that periodogram converts the frequencies to
millihertz for plotting.

Fs

=1;
NFFT =

length(y2);

subplot(2,1,1)

periodogram(y2, rectwin(NFFT) ,NFFT,Fs)

hold on

plot(1000*W2,20*1ogl0(abs(H2)),'r', 'linewidth',2)
title('AR(2) PSD and Periodogram')

subplot(2,1,2)

periodogram(y4, rectwin(NFFT) ,NFFT,Fs)

hold on

plot(1000*W4,20*1ogl0(abs(H4)),'r', 'linewidth',2)
title('AR(4) PSD and Periodogram')

text (350,20, '\downarrow Bias')
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AR(2) PSD and Periodogram
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In the case of the AR(2) process, the periodogram estimate follows the shape of the true
PSD but exhibits considerable variability. This is due to the low degrees of freedom. The
pronounced negative deflections (in dB) in the periodogram are explained by taking the
log of a chi-square random variable with two degrees of freedom.

In the case of the AR(4) process, the periodogram follows the shape of the true PSD at
low frequencies but deviates from the PSD in the high frequencies. This is the effect of
the convolution with Fejer's kernel. The large dynamic range of the AR(4) process
compared to the AR(2) process is what makes the bias more pronounced.

Mitigate the bias demonstrated in the AR(4) process by using a taper, or window. In this

example, use a Hamming window to taper the AR(4) realization before obtaining the
periodogram.
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Fowerffrequency (dB/Hz)

figure

periodogram(y4,hamming(length(y4)),NFFT,Fs)

hold on
plot(1000*W4,20*1loglO(abs(H4)), " 'r', 'linewidth',2)
title('AR(4) PSD and Periodogram with Hamming Window')
legend('Periodogram', 'AR(4) PSD')

AR(4) PSD and Periodogram with Hamming Window
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Note that the periodogram estimate now follows the true AR(4) PSD over the entire
Nyquist frequency range. The periodogram estimates still only have two degrees of
freedom so the use of a window does not reduce the variability of periodogram, but it
does address bias.
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Fowerffrequency (dB/Hz)
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In nonparametric spectral estimation, two methods for increasing the degrees of freedom
and reducing the variability of the periodogram are Welch's overlapped segment
averaging and multitaper spectral estimation.

Obtain a multitaper estimate of the AR(4) time series using a time half bandwidth product
of 3.5. Plot the result.

NW = 3.5;

figure

pmtm(y4,NW,NFFT,Fs)

hold on

plot(1000*W4,20*1oglO(abs(H4)),'r', 'linewidth',2)
legend('Multitaper Estimate', 'AR(4) PSD')

Thomson Multitaper Power Spectral Density Estimate

Multitaper Estimate
AR(4) PSD




See Also

The multitaper method produces a PSD estimate with significantly less variability than
the periodogram. Because the multitaper method also uses windows, you see that the bias
of the periodogram is also addressed.

See Also

periodogram | pmtm
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Cross Spectrum and Magnitude-Squared Coherence

12-22

This example shows how to use the cross spectrum to obtain the phase lag between
sinusoidal components in a bivariate time series. The example also uses the magnitude-
squared coherence to identify significant frequency-domain correlation at the sine wave
frequencies.

Create the bivariate time series. The individual series consist of two sine waves with
frequencies of 100 and 200 Hz embedded in additive white Gaussian noise and sampled at
1 kHz. The sine waves in the x-series both have amplitudes equal to 1. The 100 Hz sine
wave in the y-series has amplitude 0.5 and the 200 Hz sine wave in the y-series has
amplitude 0.35. The 100 Hz and 200 Hz sine waves in the y-series are phase-lagged by

/4 radians and #/2 radians respectively. You can think of y-series as the noise-
corrupted output of a linear system with input x. Set the random number generator to the
default settings for reproducible results.

rng default

Fs = 1000;

t =0:1/Fs:1-1/Fs;

X = CO0S(2*pi*100*t) + sin(2*pi*200*t) + 0.5*randn(size(t));

y = 0.5*%cos(2*pi*100*t-pi/4) + 0.35*sin(2*pi*200*t-pi/2) + 0.5*randn(size(t));

Obtain the magnitude-squared coherence estimate for the bivariate time series. The
magnitude-squared coherence enables you to identify significant frequency-domain
correlation between the two time series. Phase estimates in the cross spectrum are only
useful where significant frequency-domain correlation exists.

To prevent obtaining a magnitude-squared coherence estimate that is identically 1 for all
frequencies, you must use an averaged coherence estimator. Both Welch's overlapped
segment averaging (WOSA) and multitaper techniques are appropriate. mscohere
implements a WOSA estimator.

Set the window length to 100 samples. This window length contains 10 periods of the 100
Hz sine wave and 20 periods of the 200 Hz sine wave. Use an overlap of 80 samples with
the default Hamming window. Input the sample rate explicitly to get the output
frequencies in Hz. Plot the magnitude-squared coherence.

[Cxy,F] = mscohere(x,y,hamming(100),80,100,Fs);



Cross Spectrum and Magnitude-Squared Coherence

plot(F,Cxy)

title('Magnitude-Squared Coherence')
xlabel('Frequency (Hz)"')

grid
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You see that the magnitude-squared coherence is greater than 0.8 at 100 and 200 Hz.

Obtain the cross spectrum of x and y using cpsd. Use the same parameters to obtain the
cross spectrum that you used in the coherence estimate. Plot the phase of the cross
spectrum and indicate the frequencies with significant coherence between the two times.
Mark the known phase lags between the sinusoidal components.

[Pxy,F] = cpsd(x,y,hamming(100),80,100,Fs);
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plot(F, -angle(Pxy)/pi)
title('Cross Spectrum Phase')
xlabel('Frequency (Hz)"')
ylabel('Lag (\times\pi rad)")

ax = gca;
ax.XTick = [100 200];
ax.YTick = [-1 -1/2 -1/4 0 1/4 1/2 1];

grid
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You see that, at 100 Hz and 200 Hz, the phase lags estimated from the cross spectrum are

close to the true values.
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In this example, the cross spectrum estimates are spaced at 10007100 = 10HZ v4y, can
return the phase estimates at those frequency bins. Keep in mind that the first frequency
bin corresponds to 0 Hz, or DC.

phile0
phi200

-angle(Pxy(11));
-angle(Pxy(21));

You see that phi100 and phi200 are close to —#/4 and —#/2.

1agl00 = philee/pi
lagle0 = -0.2488
1ag200 = phi200/pi
1ag200 = -0.5086
See Also

cpsd | mscohere | pwelch
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Amplitude Estimation and Zero Padding
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This example shows how to use zero padding to obtain an accurate estimate of the
amplitude of a sinusoidal signal. Frequencies in the discrete Fourier transform (DFT) are

spaced at intervals of Fy/N , where F, is the sample rate and N is the length of the input

time series. Attempting to estimate the amplitude of a sinusoid with a frequency that does
not correspond to a DFT bin can result in an inaccurate estimate. Zero padding the data
before computing the DFT often helps to improve the accuracy of amplitude estimates.

Create a signal consisting of two sine waves. The two sine waves have frequencies of 100
and 202.5 Hz. The sample rate is 1000 Hz and the signal is 1000 samples in length.

Fs = 1e3;
t 0:0.001:1-0.001;
X COS (2*pi*100*t)+sin(2*pi*202.5*t);

Obtain the DFT of the signal. The DFT bins are spaced at 1 Hz. Accordingly, the 100 Hz
sine wave corresponds to a DFT bin, but the 202.5 Hz sine wave does not.

Because the signal is real-valued, use only the positive frequencies from the DFT to
estimate the amplitude. Scale the DFT by the length of the input signal and multiply all
frequencies except 0 and the Nyquist by 2.

Plot the result with the known amplitudes for comparison.

xdft = fft(x);

xdft = xdft(1l:length(x)/2+1);
xdft = xdft/length(x);
xdft(2:end-1) = 2*xdft(2:end-1);
freq = 0:Fs/length(x):Fs/2;

plot(freq,abs(xdft))

hold on

plot(freq,ones(length(x)/2+1,1), 'LineWidth',2)
xlabel('Hz")

ylabel('Amplitude")

hold off
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The amplitude estimate at 100 Hz is accurate because that frequency corresponds to a
DFT bin. However, the amplitude estimate at 202.5 Hz is not accurate because that
frequency does not correspond to a DFT bin.

You can interpolate the DFT by zero padding. Zero padding enables you to obtain more
accurate amplitude estimates of resolvable signal components. On the other hand, zero
padding does not improve the spectral (frequency) resolution of the DFT. The resolution is
determined by the number of samples and the sample rate.

Pad the DFT out to 2000, or twice the original length of x. With this length, the spacing
between DFT bins is £+ 2000 =05 HZ 1 thig case, the energy from the 202.5 Hz sine
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wave falls directly in a DFT bin. Obtain the DFT and plot the amplitude estimates. Use
zero padding out to 2000 samples.

lpad = 2*length(x);

xdft = fft(x,lpad);

xdft = xdft(1l:1lpad/2+1);

xdft = xdft/length(x);
xdft(2:end-1) = 2*xdft(2:end-1);
freq = 0:Fs/lpad:Fs/2;

plot(freq,abs(xdft))

hold on

plot(freq,ones(2*length(x)/2+1,1), 'LineWidth',2)
xlabel('Hz")

ylabel('Amplitude")

hold off
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The use of zero padding enables you to estimate the amplitudes of both frequencies
correctly.
See Also
fft
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Significance Testing for Periodic Component

12-30

This example shows how to assess the significance of a sinusoidal component in white
noise using Fisher's g-statistic. Fisher's g-statistic is the ratio of the largest periodogram
value to the sum of all the periodogram values over 1/2 of the frequency interval, (0,
Fs/2). A detailed description of the g-statistic and exact distribution can be found in the
references.

Create a signal consisting of a 100 Hz sine wave in white Gaussian noise with zero mean
and variance 1. The amplitude of the sine wave is 0.25. The sample rate is 1 kHz. Set the
random number generator to the default settings for reproducible results.

rng default

Fs = 1le3;
t 0:1/Fs:1-1/Fs;
X 0.25*cos(2*pi*100*t)+randn(size(t));

Obtain the periodogram of the signal using periodogram. Exclude 0 and the Nyquist
frequency (Fs/2). Plot the periodogram.

[Pxx,F] = periodogram(x,rectwin(length(x)),length(x),Fs);
Pxx = Pxx(2:length(x)/2);

periodogram(x, rectwin(length(x)),length(x),Fs)
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Find the maximum value of the periodogram. Fisher's g-statistic is the ratio of the
maximum periodogram value to the sum of all periodogram values.

[maxval,index] = max(Pxx);
fisher g = Pxx(index)/sum(Pxx)

fisher g = 0.0381

The maximum periodogram value occurs at 100 Hz, which you can verify by finding the
frequency corresponding to the index of the maximum periodogram value.

F = F(2:end-1);
F(index)

ans = 100
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Use the distributional results detailed in the references to determine the significance
level, pval, of Fisher's g-statistic. The following MATLAB® code implements equation (6)
of [2].

N = length(Pxx);
upper = floor(l/fisher g);
for nn = 1:3
I(nn) = (-1)~(nn-1)*nchoosek(N,nn)*(1l-nn*fisher g)"~(N-1);

end
pval = sum(I)

pval = 2.0163e-06

The p-value is less than 0.00001, which indicates a significant periodic component at 100
Hz. The interpretation of Fisher's g-statistic is complicated by the presence of other
periodicities. See [1] for a modification when multiple periodicities may be present.

References

[1] Percival, Donald B. and Andrew T. Walden. Spectral Analysis for Physical Applications.
Cambridge, UK: Cambridge University Press, 1993.

[2] Wichert, Sofia, Konstantinos Fokianos, and Korbinian Strimmer. "Identifying
Periodically Expressed Transcripts in Microarray Time Series Data." Bioinformatics. Vol.
20, 2004, pp. 5-20.

See Also

nchoosek | periodogram
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Frequency Estimation by Subspace Methods

This example shows how to resolve closely spaced sine waves using subspace methods.
Subspace methods assume a harmonic model consisting of a sum of sine waves, possibly
complex, in additive noise. In a complex-valued harmonic model, the noise is also
complex-valued.

Create a complex-valued signal 24 samples in length. The signal consists of two complex
exponentials (sine waves) with frequencies of 0.50 Hz and 0.52 Hz and additive complex

white Gaussian noise. The noise has zero mean and variance %2°. In a complex white
noise, both the real and imaginary parts have variance equal to 1/2 the overall variance.

n=0:23;

rng default

X = exp(1lj*2*pi*0.5*n)+exp(lj*2*pi*0.52*n)+ ...
0.2/sqrt(2)*(randn(size(n))+1lj*randn(size(n)));

Using periodogram, attempt to resolve the two sine waves.

periodogram(x, rectwin(length(x)),128,1)
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The periodogram shows a broad peak near 1/2 Hz. You cannot resolve the two separate
sine waves because the frequency resolution of the periodogram is 1/ N , where N is the
length of the signal. In this case, 1/ N _is greater than the separation of the two sine

waves. Zero padding does not help to resolve two separate peaks.

Use a subspace method to resolve the two closely spaced peaks. In this example, use the
root-MUSIC method. Estimate the autocorrelation matrix and input the autocorrelation
matrix into pmusic. Specify a model with two sinusoidal components. Plot the result.

[X,R]
[S,F]

corrmtx(x, 14, ‘mod');
pmusic(R,2,[1,1, " 'corr");

plot(F,S, 'linewidth',2)
x1im([0.46 0.60])
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Pseudospectrum

xlabel('Hz")
ylabel('Pseudospectrum')
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The root-MUSIC method is able to separate the two peaks at 0.5 and 0.52 Hz. However,
subspace methods do not produce power estimates like power spectral density estimates.
Subspace methods are most useful for frequency identification and can be sensitive to
model-order misspecification.

See Also

corrmtx | periodogram | pmusic
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Frequency-Domain Linear Regression

This example shows how to use the discrete Fourier transform to construct a linear
regression model for a time series. The time series used in this example is the monthly
number of accidental deaths in the United States from 1973 to 1979. The data are
published in Brockwell and Davis (2006). The original source is the U. S. National Safety
Council.

Enter the data. Copy the exdata matrix into the MATLAB® workspace.

exdata = [
9007 7750 8162 7717 7792 7836
8106 6981 7306 7461 6957 6892
8928 8038 8124 7776 7726 7791
9137 8422 7870 7925 8106 8129
10017 8714 9387 8634 8890 9115
10826 9512 9556 8945 9299 9434
11317 10120 10093 10078 10625 10484
10744 9823 9620 9179 9302 9827
9713 8743 8285 8037 8314 9110
9938 9129 8433 8488 8850 9070
9161 8710 8160 7874 8265 8633
8927 8680 8034 8647 8796 9240];

exdata is a 12-by-6 matrix. Each column of exdata contains 12 months of data. The first
row of each column contains the number of U.S. accidental deaths for January of the
corresponding year. The last row of each column contains the number of U.S. accidental
deaths for December of the corresponding year.

Reshape the data matrix into a 72-by-1 time series and plot the data for the years 1973 to
1978.

ts = reshape(exdata,72,1);
years = linspace(1973,1979,72);

plot(years,ts,'o-"', 'MarkerFaceColor', 'auto")

xlabel('Year")
ylabel('Number of Accidental Deaths')
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A visual inspection of the data indicates that number of accidental deaths varies in a
periodic manner. The period of the oscillation appears to be roughly 1 year (12 months).
The periodic nature of the data suggests that an appropriate model may be

2xkrn 2xkn i
N ) +&ln),

Xlﬂf'=u+2{ﬂkm:; N + By cos
k

where # is the overall mean, V is the length of the time series, and £(7) is a white noise
sequence of independent and identically-distributed (iid) Gaussian random variables with
zero mean and some variance. The additive noise term accounts for the randomness
inherent in the data. The parameters of the model are the overall mean and the
amplitudes of the cosines and sines. The model is linear in the parameters.
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To construct a linear regression model in the time domain, you have to specify which
frequencies to use for the cosines and sines, form the design matrix, and solve the normal
equations in order to obtain the least-squares estimates of the model parameters. In this
case, it is easier to use the discrete Fourier transform to detect the periodicities, retain
only a subset of the Fourier coefficients, and invert the transform to obtain the fitted time
series.

Perform a spectral analysis of the data to reveal which frequencies contribute
significantly to the variability in the data. Because the overall mean of the signal is
approximately 9,000 and is proportional to the Fourier transform at 0 frequency, subtract
the mean prior to the spectral analysis. This reduces the large magnitude Fourier
coefficient at 0 frequency and makes any significant oscillations easier to detect. The
frequencies in the Fourier transform are spaced at an interval that is the reciprocal of the
time series length, 1/72. Sampling the data monthly, the highest frequency in the spectral
analysis is 1 cycle/2 months. In this case, it is convenient to look at the spectral analysis
in terms of cycles/year so scale the frequencies accordingly for visualization.

tsdft = fft(ts-mean(ts));
freq = 0:1/72:1/2;

plot(freq.*12,abs(tsdft(1:length(ts)/2+1)), 'o-",
'MarkerFaceColor', 'auto"')

xlabel('Cycles/Year")

ylabel('Magnitude")

ax = gca;

ax.XTick = [1/6 1 2 3 4 5 6];
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Based on the magnitudes, the frequency of 1 cycle/12 months is the most significant
oscillation in the data. The magnitude at 1 cycle/12 months is more than twice as large as
any other magnitude. However, the spectral analysis reveals that there are also other
periodic components in the data. For example, there appears to be periodic components
at harmonics (integer multiples) of 1 cycle/12 months. There also appears to be a periodic
component with a period of 1 cycle/72 months.

Based on the spectral analysis of the data, fit a simple linear regression model using a
cosine and sine term with a frequency of the most significant component: 1 cycle/year (1
cycle/12 months).

Determine the frequency bin in the discrete Fourier transform that corresponds to 1
cycle/12 months. Because the frequencies are spaced at 1/72 and the first bin
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corresponds to 0 frequency, the correct bin is 72/12+1. This is the frequency bin of the
positive frequency. You must also include the frequency bin corresponding to the negative
frequency: -1 cycle/12 months. With MATLAB indexing, the frequency bin of the negative
frequency is 72-72/12+1.

Create a 72-by-1 vector of zeros. Fill the appropriate elements of the vector with the
Fourier coefficients corresponding to a positive and negative frequency of 1 cycle/12
months. Invert the Fourier transform and add the overall mean to obtain a fit to the
accidental death data.

fregbin = 72/12;

fregbins = [fregbin 72-fregbin]+1;
tsfit = zeros(72,1);
tsfit(fregbins) = tsdft(freqbins);
tsfit = ifft(tsfit);

mu = mean(ts);

tsfit = mu+tsfit;

Plot the original data along with the fitted series using two Fourier coefficients.

plot(years,ts,'o-"', 'MarkerFaceColor', 'auto")
xlabel('Year')

ylabel('Number of Accidental Deaths')

hold on

plot(years,tsfit, 'linewidth',2)
legend('Data', 'Fitted Model')

hold off
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The fitted model appears to capture the general periodic nature of the data and supports
the initial conclusion that data oscillate with a cycle of 1 year.

To assess how adequately the single frequency of 1 cycle/12 months accounts for the
observed time series, form the residuals. If the residuals resemble a white noise
sequence, the simple linear model with one frequency has adequately modeled the time
series.

To assess the residuals, use the autocorrelation sequence with 95%-confidence intervals
for a white noise.

resid = ts-tsfit;
[xc,lags] = xcorr(resid,50, ' coeff');
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Correlation Coefficient

12-42

stem(lags(51:end),xc(51:end), 'filled")
hold on

lconf = -1.96*ones(51,1)/sqrt(72);
uconf = 1.96*ones(51,1)/sqrt(72);
plot(lags(51:end),lconf, 'r")
plot(lags(51:end),uconf, 'r")
xlabel('Lag")

ylabel('Correlation Coefficient')
title('Autocorrelation of Residuals')
hold off

Autocorrelation of Residuals
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The autocorrelation values fall outside the 95% confidence bounds at a number of lags. It
does not appear that the residuals are white noise. The conclusion is that the simple
linear model with one sinusoidal component does not account for all the oscillations in the
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number of accidental deaths. This is expected because the spectral analysis revealed
additional periodic components in addition to the dominant oscillation. Creating a model
that incorporates additional periodic terms indicated by the spectral analysis will improve
the fit and whiten the residuals.

Fit a model which consists of the three largest Fourier coefficient magnitudes. Because
you have to retain the Fourier coefficients corresponding to both negative and positive
frequencies, retain the largest 6 indices.

tsfit2dft = zeros(72,1);

[Y,I] = sort(abs(tsdft), 'descend');
indices = I(1:6);

tsfit2dft(indices) = tsdft(indices);

Demonstrate that preserving only 6 of the 72 Fourier coefficients (3 frequencies) retains
most of the signal's energy. First, demonstrate that retaining all the Fourier coefficients
yields energy equivalence between the original signal and the Fourier transform.

norm(1l/sqrt(72)*tsdft,2)/norm(ts-mean(ts),2)

ans = 1.0000

The ratio is 1. Now, examine the energy ratio where only 3 frequencies are retained.
norm(1l/sqrt(72)*tsfit2dft,2)/norm(ts-mean(ts),2)

ans = 0.8991

Almost 90% of the energy is retained. Equivalently, 90% of the variance of the time series
is accounted for by 3 frequency components.

Form an estimate of the data based on 3 frequency components. Compare the original
data, the model with one frequency, and the model with 3 frequencies.

tsfit2 = mu+ifft(tsfit2dft, 'symmetric');

plot(years,ts, 'o-', 'markerfacecolor', 'auto')
xlabel('Year")

ylabel('Number of Accidental Deaths')

hold on

plot(years,tsfit, 'linewidth',2)
plot(years,tsfit2, 'linewidth',2)
legend('Data', 'l Frequency', '3 Frequencies')
hold off
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Using 3 frequencies has improved the fit to the original signal. You can see this by
examining the autocorrelation of the residuals from the 3-frequency model.

resid = ts-tsfit2;

[xc,lags]

= xcorr(resid, 50, 'coeff');

stem(lags(51:end),xc(51:end), 'filled")

hold on

lconf = -1.96*ones(51,1)/sqrt(72);
uconf = 1.96*ones(51,1)/sqrt(72);

plot(lags(51:end),lconf, 'r")
plot(lags(51:end),uconf, 'r")

xlabel('Lag")
ylabel('Correlation Coefficient')
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Correlation Coefficient
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Using 3 frequencies has resulted in residuals that more closely approximate a white noise
process.

Demonstrate that the parameter values obtained from the Fourier transform are
equivalent to a time-domain linear regression model. Find the least-squares estimates for
the overall mean, the cosine amplitudes, and the sine amplitudes for the three
frequencies by forming the design matrix and solving the normal equations. Compare the
fitted time series with that obtained from the Fourier transform.

X = ones(72,7);
X(:,2) = cos(2*pi/72*(0:71))";
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X(:,3) = sin(2*pi/72*(0:71))";
X(:,4) = cos(2*pi*6/72*(0:71))";
X(:,5) = sin(2*pi*6/72*(0:71))";
X(:,6) = cos(2*pi*12/72*(0:71))";
X(:,7) = sin(2*pi*12/72*(0:71))";
beta = X\ts;

tsfit lm = X*beta;
max(abs(tsfit lm-tsfit2))

ans = 7.2760e-12

The two methods yield identical results. The maximum absolute value of the difference
between the two waveforms is on the order of 10-12. In this case, the frequency-domain
approach was easier than the equivalent time-domain approach. You naturally use a
spectral analysis to visually inspect which oscillations are present in the data. From that
step, it is simple to use the Fourier coefficients to construct a model for the signal
consisting of a sum cosines and sines.

For more details on spectral analysis in time series and the equivalence with time-domain
regression see (Shumway and Stoffer, 2006).

While spectral analysis can answer which periodic components contribute significantly to
the variability of the data, it does not explain why those components are present. If you
examine these data closely, you see that the minimum values in the 12-month cycle tend
to occur in February, while the maximum values occur in July. A plausible explanation for
these data is that people are naturally more active in summer than in the winter.
Unfortunately, as a result of this increased activity, there is an increased probability of the
occurrence of fatal accidents.

References

Brockwell, Peter J., and Richard A. Davis. Time Series: Theory and Methods. New York:
Springer, 2006.

Shumway, Robert H., and David S. Stoffer. Time Series Analysis and Its Applications with
R Examples. New York: Springer, 2006.

See Also
fft|ifft | xcorr
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Measure Total Harmonic Distortion

This example shows shows how to measure the total harmonic distortion (THD) of a
sinusoidal signal. The example uses the following scenario: A manufacturer of audio
speakers claims the model A speaker produces less than 0.09% harmonic distortion at 1
kHz with a 1 volt input. The harmonic distortion is measured with respect to the
fundamental (THD-F).

Assume you record the following data obtained by driving the speaker with a 1 kHz tone
at 1 volt. The data is sampled at 44.1 kHz for analysis.

= 44.1e3;
0:1/Fs:1;
COoS(2*pi*1000*t)+8e-4*sin(2*pi*2000*t)+2e-5%cos (2*pi*3000*t-pi/4)+...
8e-6*sin(2*pi*4000*t);

Fs
t
X

Obtain the total harmonic distortion of the input signal in dB. Specify that six harmonics
are used in calculating the THD. This includes the fundamental frequency of 1 kHz. Input
the sampling frequency of 44.1 kHz. Determine the frequencies of the harmonics and
their power estimates.

nharm = 6;
[thd _db,harmpow,harmfreq] = thd(x,Fs,nharm);

The function thd outputs the total harmonic distortion in dB. Convert the measurement
from dB to a percentage to compare the value against the manufacturer's claims.

percent thd 100* (10~ (thd_db/20))

0.0800

percent thd

The value you obtain indicates that the manufacturer's claims about the THD for speaker
model A are correct.

You can obtain further insight by examining the power (dB) of the individual harmonics.

T = table(harmfreq,harmpow, 'VariableNames',{'Frequency', 'Power'})

T=6x2 table
Frequency Power
1000 -3.0103
2000 -64.949
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3000 -96.99
4000 -104.95
4997.9 -306.11
5998.9 -310.56

The total harmonic distortion is approximately —62 4. 1f you examine the power of the
individual harmonics, you see that the major contribution comes from the harmonic at 2
kHz. The power at 2 kHz is approximately 62 dB below the power of the fundamental. The
remaining harmonics do not contribute significantly to the total harmonic distortion.
Additionally, the synthesized signal contains only four harmonics, including the
fundamental. This is confirmed by the table, which shows a large power reduction after 4
kHz. Therefore, repeating the calculation with only four harmonics does not change the
total harmonic distortion significantly.

Plot the signal spectrum, display the total harmonic distortion on the figure title, and
annotate the harmonics.

thd(x,Fs,nharm);
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Related Examples

. “Analyzing Harmonic Distortion”
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Measure Mean Frequency, Power, Bandwidth

Generate 1024 samples of a chirp sampled at 1024 kHz. The chirp has an initial frequency
of 50 kHz and reaches 100 kHz at the end of the sampling. Add white Gaussian noise such
that the signal-to-noise ratio is 40 dB.

nSamp = 1024;

Fs = 1024e3;

SNR = 40;

t = (0:nSamp-1)'/Fs;

x = chirp(t,50e3,nSamp/Fs,100e3);

X = x+randn(size(x))*std(x)/db2mag(SNR);

Estimate the 99% occupied bandwidth of the signal and annotate it on a plot of the power
spectral density (PSD).

obw(x,Fs);
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Fowerffrequency (dB/Hz)
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Compute the power in the band and verify that it is 99% of the total.
[bw, flo, fhi,powr] = obw(x,Fs);

pcent powr/bandpower(x)*100

pcent 99

Generate another chirp. Specify an initial frequency of 200 kHz, a final frequency of 300
kHz, and an amplitude that is twice that of the first signal. Add white Gaussian noise.

X2
X2

2*chirp(t,200e3,nSamp/Fs,300e3);
x2+randn(size(x2))*std(x2)/db2mag(SNR) ;
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Add the two chirps to form a new signal. Plot the PSD of the signal and annotate its
median frequency.

medfreq([x+x21,Fs);
Median Frequency Estimate: 237.563 kHz
T T T T T T T
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Plot the PSD and annotate the mean frequency.

meanfreq([x+x2],Fs);
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Fowerffrequency (dB/Hz)

Mean Frequency Estimate: 214.962 kHz
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-110

Now consider each chirp to represent a separate channel. Estimate the mean frequency

of each channel. Annotate the mean frequencies on a plot of the PSDs.

meanfreq([x x2],Fs)

12-53



12 Spectral Analysis

Mean Frequency Estimate
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ans = 1Ix2
105 x

0.7503 2.4999
Estimate the half-power bandwidth of each channel. Annotate the 3-dB bandwidths on a

plot of the PSDs.

powerbw([x x2]1,Fs)
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Periodogram of Data Set with Missing Samples

12-56

Galileo Galilei observed the motion of Jupiter's four largest satellites during the winter of
1610. When the weather allowed, Galileo recorded the satellites' locations. Use his
observations to estimate the orbital period of one of the satellites, Callisto.

Callisto's angular position is measured in minutes of arc. Missing data due to cloudy
conditions are specified using NaNs. The first observation is dated January 15. Generate a
datetime array of observation times.

yg = [10.5 NaN 11.5 10.5 NaN NaN NaN -5.5 -10.0 -12.0 -11.5 -12.0 -7.5 ...
NaN NaN NaN NaN 8.5 12.5 12.5 10.5 NaN NaN NaN -6.0 -11.5 -12.5 ...
-12.5 -10.5 -6.5 NaN 2.0 8.5 10.5 NaN 13.5 NaN 10.5 NaN NaN NaN ...
-8.5 -10.5 -10.5 -10.0 -8.0]"';

obsv = datetime(1610,1,14+(1:1length(yg)));
plot(yg,'o")

ax = gca;

nights = [1 18 32 46];

ax.XTick = nights;

ax.XTickLabel = char(obsv(nights));
grid
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Estimate the power spectrum of the data using plomb. Specify an oversampling factor of
10. Express the resulting frequencies in inverse days.

[pxx,f] = plomb(yg,obsv,[]1,10, 'power');
f = f*86400;

Use findpeaks to determine the location of the only prominent peak of the spectrum.
Plot the power spectrum and show the peak.

[pk,fO] = findpeaks (pxx,f, 'MinPeakHeight',10);

plot(f,pxx,f0,pk,'0")
xlabel('Frequency (day~{-1})")

12-57



12 Spectral Analysis

title('Power Spectrum and Prominent Peak')
grid

Power Spectrum and Prominent Peak
100 T T . . . .
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60 | |
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Frequency {day"j
Determine Callisto's orbital period (in days) as the inverse of the frequency of maximum
energy. The result differs by less than 1% from the value published by NASA.
Period = 1/10
Period = 16.6454

NASA = 16.6890184;
PercentDiscrep = (Period-NASA)/NASA*100

PercentDiscrep = -0.2613
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See Also
findpeaks | plomb
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Welch Spectrum Estimates

12-60

Create a signal consisting of three noisy sinusoids and a chirp, sampled at 200 kHz for 0.1
second. The frequencies of the sinusoids are 1 kHz, 10 kHz, and 20 kHz. The sinusoids
have different amplitudes and noise levels. The noiseless chirp has a frequency that starts
at 20 kHz and increases linearly to 30 kHz during the sampling.

Fs = 200e3;

Fc = [1 10 20]'*1e3;

Ns = 0.1*Fs;

t = (0:Ns-1)/Fs;

x = [1 1/10 10]*sin(2*pi*Fc*t)+[1/200 1/2000 1/20]1*randn(3,Ns);
X = x+chirp(t,20e3,t(end),30e3);

Compute the Welch PSD estimate and the maximum-hold and minimum-hold spectra of
the signal. Plot the results.

(x,[1,01,[1,Fs);
[1,[1,[1,Fs, "maxhold");
[1,[1,[1,Fs, 'minhold");

[pxx,f] = pwelch
pmax pwelch(x,
pmin pwelch(x,

plot(f/1000, pow2db(pxx))

hold on

plot(f/1000,pow2db([pmax pmin]),':")
hold off

xlabel('Frequency (kHz)")
ylabel('PSD (dB/Hz)"')
legend('pwelch', 'maxhold', 'minhold")
grid



Welch Spectrum Estimates
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Repeat the procedure, this time computing centered power spectrum estimates.

[pxx,f] = pwelch(x,[],[],[],Fs, ' 'centered', 'power');
pmax pwelch(x,[]1,[]1,[]1,Fs, 'maxhold', 'centered', 'power');
pmin pwelch(x,[]1,[]1,[]1,Fs, 'minhold', 'centered', 'power');

plot(f/1000, pow2db(pxx))

hold on

plot(f/1000,pow2db([pmax pmin]),':")
hold off

xlabel('Frequency (kHz)"')
ylabel('Power (dB)"')
legend('pwelch', 'maxhold', 'minhold")
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title('Centered Power Spectrum Estimates')

grid
20 Centered Power Spectrum Estimates
pwelch
---------- maxhold
or minhold | ]
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See Also
chirp | pow2db | pwelch
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* “Prediction Polynomial” on page 13-2
* “Formant Estimation with LPC Coefficients” on page 13-6
* “AR Order Selection with Partial Autocorrelation Sequence” on page 13-10
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Prediction Polynomial

13-2

This example shows how to obtain the prediction polynomial from an autocorrelation
sequence. The example also shows that the resulting prediction polynomial has an inverse
that produces a stable all-pole filter. You can use the all-pole filter to filter a wide-sense
stationary white noise sequence to produce a wide-sense stationary autoregressive
process.

Create an autocorrelation sequence defined by

rlk) =222 _ 273k p—0 1.2
3 10

k =0:2;
rk = (24/5)*2.7(-k)-(27/10)*3.7(-k);

Use ac2poly to obtain the prediction polynomial of order 2, which is

izl =1- -:_l‘l‘—l:_:_
' 6

| n

A = ac2poly(rk);
Examine the pole-zero plot of the FIR filter to see that the zeros are inside the unit circle.

zplane(A,1)
grid



Prediction Polynomial

Imaginary Part

06

0.4

Real Part

The inverse all-pole filter is stable with poles inside the unit circle.
zplane(1,A)

grid

title('Poles and Zeros')
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Poles and Zeros

0.6 . E -
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Real Part

Use the all-pole filter to produce a realization of a wide-sense stationary AR(2) process
from a white-noise sequence. Set the random number generator to the default settings for
reproducible results.

rng default

X

randn(1000,1);
y .

filter(1,A,x);

Compute the sample autocorrelation of the AR(2) realization and show that the sample
autocorrelation is close to the true autocorrelation.

[xc,lags] = xcorr(y,2, 'biased"');
[xc(3:end) rk']
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ans = 3x2
2.2401 2.1000

1.6419 1.5000
0.9980 0.9000
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Formant Estimation with LPC Coefficients

13-6

This example shows how to estimate vowel formant frequencies using linear predictive
coding (LPC). The formant frequencies are obtained by finding the roots of the prediction
polynomial.

This example uses the speech sample mtlb.mat, which is part of Signal Processing
Toolbox™. The speech is lowpass-filtered. Because of the low sampling frequency, this
speech sample is not optimal for this example. The low sampling frequency limits the
order of the autoregressive model you can fit to the data. In spite of this limitation, the
example illustrates the technique for using LPC coefficients to determine vowel formants.

Load the speech signal. The recording is a woman saying "MATLAB". The sampling
frequency is 7418 Hz.

load mtlb
The MAT file contains the speech waveform, mtlb, and the sampling frequency, Fs.

Use the spectrogram function to identify a voiced segment for analysis.

segmentlen = 100;
noverlap = 90;
NFFT = 128;

spectrogram(mtlb, segmentlen,noverlap,NFFT,Fs, 'yaxis')
title('Signal Spectrogram')



Formant Estimation with LPC Coefficients
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Extract the segment from 0.1 to 0.25 seconds for analysis. The extracted segment

corresponds roughly to the first vowel, /ae/, in "MATLAB".

= 1/Fs;

= round(0.1/dt);
nd = round(0.25/dt);
= mtlb(I0:Iend);

dt
I0
Ien
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Two common preprocessing steps applied to speech waveforms before linear predictive

coding are windowing and pre-emphasis (highpass) filtering.
Window the speech segment using a Hamming window.

x1 = x.*hamming(length(x));
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Apply a pre-emphasis filter. The pre-emphasis filter is a highpass all-pole (AR(1)) filter.

preemph = [1 0.63];
x1 = filter(1,preemph,xl);

Obtain the linear prediction coefficients. To specify the model order, use the general rule
that the order is two times the expected number of formants plus 2. In the frequency
range, [0,|Fs|/2], you expect three formants. Therefore, set the model order equal to 8.
Find the roots of the prediction polynomial returned by lpc.

A = 1pc(x1,8);
rts = roots(A);

Because the LPC coefficients are real-valued, the roots occur in complex conjugate pairs.
Retain only the roots with one sign for the imaginary part and determine the angles
corresponding to the roots.

rts = rts(imag(rts)>=0);
angz = atan2(imag(rts),real(rts));

Convert the angular frequencies in rad/sample represented by the angles to Hz and
calculate the bandwidths of the formants.

The bandwidths of the formants are represented by the distance of the prediction
polynomial zeros from the unit circle.

[frqs,indices] = sort(angz.*(Fs/(2*pi)));
bw = -1/2*(Fs/(2*pi))*Llog(abs(rts(indices)));

Use the criterion that formant frequencies should be greater than 90 Hz with bandwidths
less than 400 Hz to determine the formants.

nn = 1;
for kk = 1:length(frgs)
if (frgs(kk) > 90 && bw(kk) <400)
formants(nn) = frqgs(kk);
nn = nn+l;
end
end
formants

formants = 1x3
103 x



Formant Estimation with LPC Coefficients

0.8697 2.0265 2.7380

The first three formants are 869.70, 2026.49, and 2737.95 Hz.

References
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AR Order Selection with Partial Autocorrelation
Sequence

13-10

This example shows how to assess the order of an autoregressive model using the partial
autocorrelation sequence. For these processes, you can use the partial autocorrelation
sequence to help with model order selection. For a stationary time series with values

X(1), X(2),X(3),...,- X{k + 1) the partial autocorrelation sequence at lag k is the
correlation between X (1) and X (F + 1} after regressing ¥ (1) and Xk + 1) on the

intervening observations, ¥ (2). X(3), X(4)..... X (k). For a moving average process,
you can use the autocorrelation sequence to assess the order. However, for an
autoregressive (AR) or autoregressive moving average (ARMA) process, the
autocorrelation sequence does not help in order selection. Consider the AR(2) process
defined by

X(n)+15X(n—-1)+0.75X(n — 2) =e(n),

where (7} is an V(0. 1} Gaussian white noise process. The following example:

* Simulates a realization of the AR(2) process

* Graphically explores the correlation between lagged values of the time series

+ Examines the sample autocorrelation sequence of the time series

» Fits an AR(15) model to the time series by solving the Yule-Walker equations (aryule)

» Uses the reflection coefficients returned by aryule to compute the partial
autocorrelation sequence

* Examines the partial autocorrelation sequence to select the model order

Simulate a 1000-sample time series from the AR(2) process defined by the difference
equation. Set the random number generator to the default settings for reproducible
results.

A=1[11.50.75];

rng default

x = filter(1,A,randn(1000,1));

View the frequency response of the AR(2) process.

freqz(1,A)
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The AR(2) process acts like a highpass filter in this case.

Graphically examine the correlation in x by producing scatter plots of X{n)ys, X(1) for
n=2234,5

x12 = x(1:end-1);
x21 = x(2:end);
subplot(2,2,1)
plot(x12,x21,"'*")
xlabel('X 1)
ylabel('X 2")
grid

x13 = x(1:end-2);
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x31 = x(3:end);
subplot(2,2,2)
plot(x13,x31,"'*")
xlabel('X 1")
ylabel('X 3")

grid
x14 = x(1l:end-3);
x41 = x(4:end);

subplot(2,2,3)
plot(x14,x41,"'*")
xlabel('X 1)
ylabel('X 4')

grid
x15 = x(1:end-4);
x51 = x(5:end);

subplot(2,2,4)
plot(x15,x51,"'*")
xlabel('X 1)
ylabel('X 5")
grid
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In the scatter plot, you see there is a linear relationship between X(1)and X(2)and
between - (1} and X' (3), but not between X (1) and either X (4) or X (5.

The points in the top row scatter plots fall approximately on a line with a negative slope in

the top left panel and positive slope in the top right panel. The scatter plots in the bottom
two panels do not show any apparent linear relationship.

The negative correlation between X(1) and X(2) and the positive correlation between
A1) and X(3) are explained by the highpass-filter behavior of the AR(2) process.

Find the sample autocorrelation sequence out to lag 50 and plot the result.
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[xc,lags] = xcorr(x,50, 'coeff');

figure
stem(lags(51:end),xc(51:end), 'filled")
xlabel('Lag")

ylabel('ACF")

title('Sample Autocorrelation Sequence')
grid

- Sample Autocorrelation Sequence
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The sample autocorrelation sequence shows a negative value at lag 1 and a positive value
at lag 2. Based on the scatter plot, this is the expected result. However, you cannot
determine from the sample autocorrelation sequence what order is appropriate for the AR
model.
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Fit an AR(15) model using aryule. Return the reflection coefficients. The negative of the
reflection coefficients is the partial autocorrelation sequence.

[arcoefs,E,K] = aryule(x,15);
pacf = -K;

Plot the partial autocorrelation sequence along with the large-sample 95% confidence
intervals. If the data are generated by an autoregressive process of order ¥, the values of

the sample partial autocorrelation sequence for lags greater than P follow a V(0. 1/)
distribution, where IV is the length of the time series.

stem(pacf, 'filled")

xlabel('Lag"')

ylabel('Partial ACF')

title('Partial Autocorrelation Sequence')
xlim([1 151)

uconf = 1.96/sqrt(1000);

lconf = -uconf;

hold on

plot([1 15],[1 1]1'*[lconf uconf],'r')
grid
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Partial ACF

13-16

Partial Autocorrelation Sequence
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The only values of the partial autocorrelation sequence outside the 95% confidence
bounds occur at lags 1 and 2. This indicates that the correct model order for the AR
process is 2.

In this example, you generated the time series to simulate an AR(2) process. The partial
autocorrelation sequence only confirms that result. In practice, you have only the
observed time series without any prior information about model order. In a realistic
scenario, the partial autocorrelation is an important tool for appropriate model order
selection in stationary autoregressive time series.
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Complex Cepstrum -- Fundamental Frequency
Estimation

14-2

This example shows how to estimate a speaker's fundamental frequency using the
complex cepstrum. The example also estimates the fundamental frequency using a zero-
crossing method and compares the results.

Load the speech signal. The recording is of a woman saying "MATLAB". The sampling
frequency is 7418 Hz. The following code loads the speech waveform, mt1lb, and the
sampling frequency, Fs, into the MATLAB® workspace.

load mtlb

Use the spectrogram to identify a voiced segment for analysis.

segmentlen = 100;
noverlap = 90;
NFFT = 128;

spectrogram(mtlb, segmentlen,noverlap,NFFT,Fs, 'yaxis"')
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Extract the segment from 0.1 to 0.25 seconds for analysis. The extracted segment
corresponds roughly to the first vowel, /&/, in "MATLAB".

= 1/Fs;

= round(0.1/dt);
nd = round(0.25/dt);
= mtlb(I0:Iend);

dt
10
Ien

Obtain the complex cepstrum.
c = cceps(x);

Select a time range between 2 and 10 ms, corresponding to a frequency range of
approximately 100 to 500 Hz. Identify the tallest peak of the cepstrum in the selected
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range. Find the frequency corresponding to the peak. Use the peak as the estimate of the
fundamental frequency.

t = 0:dt:length(x)*dt-dt;

trng
crng

t(t>=2e-3 & t<=10e-3);
c(t>=2e-3 & t<=10e-3);

[~,I] = max(crng);

fprintf('Complex cepstrum FO estimate is %3.2f Hz.\n',1/trng(I))
Complex cepstrum FO estimate is 239.29 Hz.

Plot the cepstrum in the selected time range and overlay the peak.

plot(trng*le3,crng)
xlabel('ms")

hold on

plot(trng(I)*1le3,crng(I),'o")
hold off
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Use a zero-crossing detector on a lowpass-filtered and rectified form of the vowel to
estimate the fundamental frequency.

[b0,ad] = butter(2,325/(Fs/2));

xin = abs(x);
xin = filter(b0,a0,xin);
Xin = xin-mean(xin);

x2 = zeros(length(xin),1);

x2(1:length(x)-1) = xin(2:length(x));

zc = length(find((xin>0 & x2<0) | (xin<@ & x2>0)));
FO = 0.5*Fs*zc/length(x);

fprintf('Zero-crossing FO estimate is %3.2f Hz.\n',FO)

Zero-crossing FO estimate is 233.27 Hz.
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The estimate of the fundamental frequency obtained with the complex cepstrum is 239.29
Hz and the estimate with the zero-crossing detector is 233.27 Hz.

See Also

cceps | icceps | rceps
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Analytic Signal for Cosine

This example shows how to determine the analytic signal. The example also demonstrates
that the imaginary part of the analytic signal corresponding to a cosine is a sine with the
same frequency. If the cosine has a nonzero mean (DC shift), then the real part of the
analytic signal is the original cosine with the same mean, but the imaginary part has zero
mean.

Create a cosine with a frequency of 100 Hz. The sampling frequency is 10 kHz. Add a DC
offset of 2.5 to the cosine.

t
X

0:1le-4:1;
2.5+cos(2*pi*100*t);

Use the hilbert function to obtain the analytic signal. The real part is equal to the
original signal. The imaginary part is the Hilbert transform of the original signal. Plot the
real and imaginary parts for comparison.

y = hilbert(x);

clf
plot(t,real(y))
hold on
plot(t,imag(y))
x1im([0 0.11])
grid on
text([0.015 0.015]1,[3.7 1.21, ...
{'Real Part \downarrow';'Imaginary Part \downarrow'})
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You see that the imaginary part is a sine with the same frequency as the cosine real part.
However, the imaginary part has a mean of zero, while the real part has a mean of 2.5.

The original signal is
X =254 cos 2x 10008,
The resulting analytic signal is
z(1) = 2.5 4 ef2=10000

Plot 10 periods of the complex-valued analytic signal.
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prds = 1:1000;

figure
plot3(t(prds),real(y(prds)),imag(y(prds)))

xLlabel('Time")
ylabel('Re \{z(t)\}")
zlabel('Im \{z(t)\}")
axis square

Re {z(t)} 1 0 Time
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See Also
hilbert

14-10



Envelope Extraction

Envelope Extraction

This example shows how to extract the envelope of a signal.

Create a double sideband amplitude-modulated signal. The carrier frequency is 1 kHz.
The modulation frequency is 50 Hz. The modulation depth is 100%. The sample rate is 10

kHz.

t = le-4:0.1;
X =

plot(t,x)

x1im([0 0.04])

1.5

057

0:
(1+cos(2*pi*50*t)).*cos(2*pi*1000*t);

0.005

0.01

0.015

0.02

0.025

0.03

0.035

0.04
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Extract the envelope using hilbert function. The envelope is the magnitude of the
analytic signal computed by hilbert. Plot the envelope along with the original signal.
Store the name-value pair arguments of the plot function in a cell array for later use.
The magnitude of the analytic signal captures the slowly varying features of the signal,
while the phase contains the high-frequency information.

y = hilbert(x);
env = abs(y);
plot param = {'Color', [0.6 0.1 0.2],'Linewidth',2};
plot(t,x)

hold on

plot(t,[-1;1]*env,plot param{:})

hold off

x1im([0 0.04])

title('Hilbert Envelope')



Envelope Extraction

™

_25 i i i i i i i
0 0.005 0.01 0.015 0.02 0.025 0.03 0.035 0.04

You can also use the envelope function to generate the signal envelope directly and
modify the way it is computed. For example, you can adjust the length of the Hilbert filter
used to find the analytic envelope. Using a filter length that is too small results in a
distorted envelope.

fll = 12;
[upl,lol] = envelope(x,fll, 'analytic');
f12 = 30;

[up2,102] = envelope(x,fl2, 'analytic');
param_small {'Color',[0.9 0.4 0.1], 'Linewidth',2};
param_large {'Color',[0 0.4 0], 'Linewidth"',2};

plot(t,x)
hold on
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pl = plot(t,upl,param small{:});
plot(t,lol,param small{:});

p2 = plot(t,up2,param large{:});
plot(t,lo2,param large{:});

hold off

legend([pl p2],'fl = 12','fl = 30")
xlim([0 0.04])
title('Analytic Envelope')

Analytic Envelope
25 ; . .

0 0.005 0.01 0.015 0.02 0.025 0.03 0.035 0.04

You can generate moving RMS envelopes by using a sliding window. Using a window
length that is too small results in a distorted envelope. Using a window length that is too
large smooths out the envelope.
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wll = 3;
[upl,lol]
wl2 = 5;
[up2,1l02]
wl3 = 300;
[up3,1l03]

envelope(x,wll, 'rms"');

envelope(x,wl2, 'rms"');

envelope(x,wl3, 'rms"');

plot(t,x)

hold on

pl = plot(t,upl,param small{:});
plot(t,lol,param small{:});

p2 = plot(t,up2,plot param{:});
plot(t,lo2,plot param{:});

p3 = plot(t,up3,param large{:});
plot(t,lo3,param large{:})

hold off

legend([pl p2 p3],'wl = 3','wl =5",'wl = 300")

xlim([0 0.04])
title('RMS Envelope')
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RMS Envelope
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You can generate peak envelopes by using spline interpolation over local maxima
separated by an adjustable number of samples. Spreading out the samples too much
smooths the envelope.

npl = 5;
[upl,lol]
np2 = 50;
[up2,1l02]

envelope(x,npl, 'peak');

envelope(x,np2, 'peak');

plot(t,x)

hold on

pl = plot(t,upl,param small{:});
plot(t,lol,param small{:})

p2 = plot(t,up2,param large{:});
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plot(t,lo2,param large{:})
hold off

legend([pl p2],'np =5','np = 50")

xlim([0 0.04])
title('Peak Envelope')

Peak Envelope

2.5 T T

- —np = 50 P
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Increasing the peak separation parameter can decrease the effect of spurious peaks due
to noise. Introduce random noise to the signal. Use a 5-sample interval to see the effect of
noise on the peak envelope. Repeat the exercise using a 25-sample interval.

fault
+ randn(size(x))/10;
5

ng de
= X

pl =
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[upl,lol] = envelope(q,npl, 'peak');
np2 = 25;

[up2,102] = envelope(q,np2, 'peak');
plot(t,q)

hold on

pl = plot(t,upl,param small{:});
plot(t,lol,param small{:})

p2 = plot(t,up2,param large{:});
plot(t,lo2,param large{:})

hold off

legend([pl p2],'np =5','np = 25")
xlim([0 0.04])
title('Peak Envelope')



See Also
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See Also

envelope | hilbert
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Analytic Signal and Hilbert Transform

14-20

The hilbert function finds the exact analytic signal for a finite block of data. You can
also generate the analytic signal by using an finite impulse response (FIR) Hilbert
transformer filter to compute an approximation to the imaginary part.

Generate a sequence composed of three sinusoids with frequencies 203, 721, and 1001
Hz. The sequence is sampled at 10 kHz for about 1 second. Use the hilbert function to
compute the analytic signal. Plot it between 0.01 seconds and 0.03 seconds.

fs = le4;
t =0:1/fs:1;
X = 2.5 + cos(2*pi*203*t) + sin(2*pi*721*t) + cos(2*pi*1001*t);

y hilbert(x);
plot(t,real(y),t,imag(y))
x1lim([0.01 0.03])
legend('real', 'imaginary"')
title('hilbert Function')



Analytic Signal and Hilbert Transform

hilbert

Function

2T

real

imaginary |

-3
0.01

0.012 0.014 0.016 0018 0.02 0022

0.024 0.026 0028 0.03

Compute Welch estimates of the power spectral densities of the original sequence and the
analytic signal. Divide the sequences into Hamming-windowed, nonoverlapping sections

of length 256. Verify that the analytic signal has no power at negative frequencies.

pwelch([x;y]l."',256,0,[1,fs, 'centered")
legend('Original', "hilbert")
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Power Spectral Density

0 T T T

Criginal
hilbert |

R
=
T
I

L
o

i

tn

=
T
I

Fowerffrequency (dB/Hz)

=]
T
[ —
=
i}
b —— ——
>
1

90 1 1 1 1 1 1 1
-4 -3 -2 -1 0 1 2 3 4 5

Frequency (kHz)

Use the designfilt function to design a 60th-order Hilbert transformer FIR filter.
Specify a transition width of 400 Hz. Visualize the frequency response of the filter.

fo = 60;

d = designfilt('hilbertfir','FilterOrder', fo,
'TransitionWidth',400, 'SampleRate', fs);

freqz(d, 1024, fs)
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Filter the sinusoidal sequence to approximate the imaginary part of the analytic signal.

hb = filter(d,x);

The group delay of the filter, grd, is equal to one-half the filter order. Compensate for this
delay. Remove the first grd samples of the imaginary part and the last grd samples of the
real part and the time vector. Plot the result between 0.01 seconds and 0.03 seconds.

grd = fo/2;

x(l:end-grd) + 1j*hb(grd+l:end);
t(l:end-grd);

y2
t2

plot(t2,real(y2),t2,imag(y2))
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x1lim([0.01 0.03])
legend('real', 'imaginary"')
title('FIR Filter')

FIR Filter

[+ T T T T

real
5 imaginary | -

21 | ' ||

-3
0.01 0,012 0014 0.016 0.018 002 0022 0024 0026 0028 003

Estimate the power spectral density (PSD) of the approximate analytic signal and
compare it to the hilbert result.

pwelch([y;[y2 zeros(1l,grd)]1]1.',256,0,[],fs, 'centered")
legend('hilbert','FIR Filter"')
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See Also
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Hilbert Transform and Instantaneous Frequency

14-26

The Hilbert transform estimates the instantaneous frequency of a signal for
monocomponent signals only. A monocomponent signal is described in the time-frequency
plane by a single "ridge." The set of monocomponent signals includes single sinusoids, but
also includes signals like chirps.

Generate a chirp sampled at 1 kHz for two seconds. Specify the chirp so its frequency is
initially 100 Hz and increases to 200 Hz after one second.

Fs = 1000;
t = 0:1/Fs:2-1/Fs;
y = chirp(t,100,1,200);

Estimate the spectrum of the chirp using the short-time Fourier transform implemented in
the spectrogram function. Divide the signal into sections of length 100, windowed with
a Hamming window. Specify 80 samples of overlap between adjoining sections and

evaluate the spectrum at [100/2+1] =51 frequencies.

spectrogram(y,100,80,100,Fs, 'yaxis')
view(-27,62)
shading interp



Hilbert Transform and Instantaneous Frequency

-100

Powerfrequency (dB/MHz)

100
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The signal is well described by a single peak frequency at each point in time.

Compute the analytic signal and differentiate its phase to measure the instantaneous
frequency. The scaled derivative yields a meaningful estimate.

z = hilbert(y);
instfreq = Fs/(2*pi)*diff(unwrap(angle(z)));

plot(t(2:end),instfreq)
xlabel('Time")

ylabel('Hz")

grid on

title('Instantaneous Frequency')
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Instantaneous Frequency
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Repeat the procedure, this time for a signal that is not monocomponent.

Generate a sum of two sinusoids of frequencies 60 Hz and 90 Hz, sampled at 1023 Hz for
two seconds. Compute and plot the spectrogram. Use Hamming-windowed sections that
have lengths of 200 and sample overlaps of 180. Evaluate the spectrum at

|256/2+1] = 129 frequencies.

Fs = 1023;

t =0:1/Fs:2;

X = sin(2*pi*60*t)+sin(2*pi*90*t);

spectrogram(x,200,180,256,Fs, 'yaxis"')
ax = gca;
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Frequency (Hz)

ax.YTick = [60 90];
shading interp

Powerfrequency (dB/Hz)}

02 04 06 08 1 1.2 14 16 1.8
Time (secs)

Each time point shows the presence of the two components.

Compute the analytic signal and differentiate its phase. Zoom in to the region enclosing
the frequencies of the sinusoids.

z = hilbert(x);
instfreq = Fs/(2*pi)*diff(unwrap(angle(z)));
plot(t(2:end),instfreq)

ylim([60 90])
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xlabel('Time")
ylabel('Hz")
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The analytic signal predicts an instantaneous frequency that is the average of the
sinusoid frequencies.

If you want to estimate both frequencies as functions of time, you can use spectrogram.
The ridges are peaks of the power spectral density.

[s,f,tt,p] = spectrogram(x,200,180,256,Fs);

numcomp = 2;
nt = length(tt);
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zeros(nt,numcomp) ;
zeros(nt,numcomp) ;

for k = 1:nt

pk,lc] = findpeaks(p(:,k),f, 'SortStr', 'descend', 'NPeaks',numcomp);
: pk;

1lc;

—

end
Plot the results.

spectrogram(x,200,180,256,Fs, 'yaxis"')
shading interp
view(2)

hold on
for k = 1:numcomp
plot3(tt,K(:,k),10*1oglO(P(:,k)), 'linewidth',4)

end
hold off
ax = gca;

ax.YTick = [60 90];
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See Also

hilbert | spectrogram

Related Examples
“Detect Closely Spaced Sinusoids” on page 14-33
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Detect Closely Spaced Sinusoids

Detect Closely Spaced Sinusoids
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Create 1024 samples of a signal consisting of two sinusoids. One sinusoid has a

normalized frequency of 0 = ¥/ rad/sample. The other sinusoid has three times the

frequency and three times the amplitude.

024

N 1024;
n 0:N-1;
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wO = pi/5;
X = exp(lj*wO*n)+3*exp(1lj*3*wO*n);

Compute the short-time Fourier transform of the signal. Use a 256-sample Gaussian

window with @ = 20 255 samples of overlap between adjoining sections, and 1024 DFT
points. Plot the absolute value of the transform.

Nw = 256;
nfft = 1024;
alpha = 20;

[s,w,t] = spectrogram(x,gausswin(Nw,alpha),Nw-1,nfft, 'centered');

surf(t,w/pi,abs(s), 'EdgeColor', 'none')

view(2)

axis tight

xlabel('Samples"')

ylabel('Normalized Frequency (\times\pi rad/sample)')
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The Fourier synchrosqueezed transform results in a sharper, better localized estimate of
the spectrum.

[ss,sw,st] = fsst(x,[],gausswin(Nw,alpha));

fsst(x, 'yaxis')
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Magnitude of Fourier Synchrosqueezed Transform

= = = =
[ i (=2} (=

Mormalized Frequency (=« rad/sample)
—_

100 200 300 400 500 600 700 BOO 900 1000
Sample Number

The sinusoids are visible as constant oscillations at the expected frequency values. To see
that the decay away from the ridges is Gaussian, plot an instantaneous value of the
transform and overlay two instances of a Gaussian. Express the Gaussian amplitude and

standard deviation in terms of  and the window length. Recall that the standard
deviation of the frequency-domain window is the reciprocal of the standard deviation of
the time-domain window.

rstdev = (Nw-1)/(2*alpha);
amp = rstdev*sqrt(2*pi);

instransf = abs(s(:,128));

plot(w/pi,instransf)
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hold on

plot(w/pi,[1 3]*amp.*exp(-rstdev™2/2*(w-[1 3]*w0)."2),"'--")
hold off

xlabel('Normalized Frequency (\times\pi rad/sample)')

1lg = legend('Transform', 'First sinusoid', 'Second sinusoid');
lg.Location = 'best’;

ED T T T T T T T T T
Transform i

45 — — — First sinuscid I .
Second sinusoid I
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30
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Mormalized Frequency (=« rad/sample)

The Fourier synchrosqueezed transform concentrates the energy content of the signal at
the estimated instantaneous frequencies.
stem(sw/pi,abs(ss(:,128)))

xlabel('Normalized Frequency (\times\pi rad/sample)')
title('Synchrosqueezed Transform')
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Synchrosqueezed Transform
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The synchrosqueezed estimates of instantaneous frequency are valid only if the sinusoids

are separated by more than 2A where

for a Gaussian window and  is the standard deviation.

Repeat the previous calculation, but now specify that the second sinusoid has a

LU + 1.9A

normalized frequency of rad/sample.
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D = sqrt(2*log(2))/rstdev;
wl = wO+1.9%*D;
x = exp(1lj*wO*n)+3*exp(lj*wl*n);

[s,w,t] = spectrogram(x,gausswin(Nw,alpha),Nw-1,nfft, 'centered');
instransf = abs(s(:,20));

plot(w/pi,instransf)

hold on

plot(w/pi,[1 3]*amp.*exp(-rstdev™2/2*(w-[wO wl]).”2),"'--")
hold off

xlabel('Normalized Frequency (\times\pi rad/sample)')

1lg = legend('Transform','First sinusoid', 'Second sinusoid');
lg.Location = 'best’;
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The Fourier synchrosqueezed transform cannot resolve the sinusoids well because

@) —wy| <28 The spectral estimates decrease significantly in value.

[ss,sw,st] = fsst(x,[],gausswin(Nw,alpha));
stem(sw/pi,abs(ss(:,128)))

xlabel('Normalized Frequency (\times\pi rad/sample)')
title('Synchrosqueezed Transform')
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Synchrosqueezed Transform
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See Also

fsst | gausswin | ifsst | spectrogram

Related Examples

. “Hilbert Transform and Instantaneous Frequency” on page 14-26
. “Instantaneous Frequency of Complex Chirp” on page 14-42
. “Practical Introduction to Time-Frequency Analysis”
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Instantaneous Frequency of Complex Chirp

14-42

This example shows how to compute the instantaneous frequency of a signal using the
Fourier synchrosqueezed transform.

Generate a chirp with sinusoidally varying frequency content. The signal is embedded in
white Gaussian noise and sampled at 3 kHz for 1 second.

fs = 3000;
t =0:1/fs:1-1/fs;

X = exp(2j*pi*100*cos(2*pi*2*t)) + randn(size(t))/100;

Compute and plot the Fourier synchrosqueezed transform of the signal. Display the time
on the x-axis and the frequency on the y-axis.

fsst(x,fs, 'yaxis')



Instantaneous Frequency of Complex Chirp
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Find the instantaneous frequency of the signal by extracting the maximum-energy time-
frequency ridge of the Fourier Synchrosqueezed transform.

[sst,f,tfs] = fsst(x,fs);

fridge = tfridge(sst,f);

Overlay the ridge on the transform plot. Convert time to milliseconds and frequency to
kHz.

hold on

plot(t*1000,fridge/1000, 'r")
hold off
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Magnitude of Fourier Synchrosqueezed Transform
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For a real signal, you can find the instantaneous frequency more easily using the
instfreq function. For example, display the instantaneous frequency of the real part of
the complex chirp by computing the analytic signal and differentiating its phase.

ax = real(x);

instfreq(ax, fs, 'Method', 'hilbert")
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Freguency (kHz)

Instantaneous frequency estimation
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fsst|ifsst | instfreq| pspectrum| spectrogram| tfridge

Related Examples
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. “Hilbert Transform and Instantaneous Frequency” on page 14-26

. “Detect Closely Spaced Sinusoids” on page 14-33

. “Practical Introduction to Time-Frequency Analysis”
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Single-Sideband Amplitude Modulation
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This example shows how to use the Hilbert transform to carry out single-sideband (SSB)
amplitude modulation (AM) of a signal. Single-sideband AM signals have less bandwidth
than normal AM signals.

Generate 512 samples of a simulated broadband signal using the sinc function. Specify a

bandwidth of #/4 rad/sample.

N = 512;
n=0:N-1;
bw = 1/4;

x = sinc((n-N/2)*bw);

Add white Gaussian noise such that the signal-to-noise ratio is 20 dB. Reset the random
number generator for reproducible results. Use the periodogram function to estimate
the power spectral density (PSD) of the signal.

rng default

SNR = 20;

noise = randn(size(x))*std(x)/db2mag(SNR);
X = X + noise;

periodogram(x)
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Amplitude modulate the signal using a cosine of carrier frequency ™« = ¥ /2, Multiply by

V2 5o that the power of the modulated signal equals the power of the original signal.

Estimate the PSD.
= pi/2;
x1 = x.*cos(wc*n)*sqrt(2);

periodogram(x1)
legend('Modulated"')
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SSB amplitude modulation reduces the bandwidth of the signal by half. To carry out SSB
amplitude modulation, you must first compute the Hilbert transform of the signal. Then,

amplitude modulate the signal using a sine with the same carrier frequency, “, as
before, and add it to the previous signal.
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x(n) —— H— v(n)

Hhitbert @ >

SIN W:N

Design a Hilbert transformer using the designfilt function. Specify a filter order of 64
and a transition width of 0.1. Filter the signal.

Hhilbert = designfilt('hilbertfir', 'FilterOrder',64,
'"TransitionWidth',0.1);

xh = filter(Hhilbert,x);

Use the grpdelay function to determine the delay, gd, introduced by the filter.
Compensate for the delay by discarding the first gd points of the filtered signal and
padding with zeros at the end. Amplitude modulate the result and add it to the original.
Compare the PSDs.

gd = mean(grpdelay(Hhilbert));
xh = xh(gd+1l:end);

eh = zeros(size(x));
eh(1l:length(xh)) = xh;

x2 = eh.*sin(wc*n)*sqrt(2);
y = X1+x2;

periodogram([x1;y]l")
legend('Modulated', 'SSB')
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Mormalized Frequency (= rad/sample)

Downconvert the signal and estimate the PSD.
ym = y.*cos(wc*n)*sqrt(2);

periodogram(ym)
legend( 'Downconverted')
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Lowpass filter the modulated signal to recover the original. Specify a 64th-order FIR

lowpass filter with a cutoff frequency of /2, Compensate for the delay introduced by the
filter.

d = designfilt('lowpassfir', 'FilterOrder',64,
'CutoffFrequency',0.5);
dem = filter(d,ym);

gd = mean(grpdelay(d));
dem = dem(gd+1l:end);

dm = zeros(size(x));
dm(1l:length(dem)) = dem;
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Estimate the PSD of the filtered signal and compare it to that of the original.

periodogram([x;dm]")
legend('Original', 'Recovered')
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Use the snr function to compare the signal-to-noise ratios of the two signals. Plot the two
signals in the time domain.
snrOrig = snr(x,noise)

snrOrig = 20.0259

snrRecv snr(dm,noise)

snrRecv 20.1373
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plot(n, [x;dm]")

legend('Original', 'Recovered")

axis tight
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See Also

designfilt | periodogram| snr
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DCT for Speech Signal Compression

This example shows how to compress a speech signal using the discrete cosine transform
(DCT).

Load a file containing the word "strong," spoken by a woman and by a man. The signals
are sampled at 8 kHz.

load(fullfile(matlabroot, 'examples', 'signal', 'strong.mat'))
% To hear, type soundsc(her,fs), pause(l), soundsc(him,fs)

Use the discrete cosine transform to compress the female voice signal. Decompose the
signal into DCT basis vectors. There are as many terms in the decomposition as there are
samples in the signal. The expansion coefficients in vector X measure how much energy is
stored in each of the components. Sort the coefficients from largest to smallest.

x = her';
X = dct(x);
[XX,ind] = sort(abs(X), 'descend');

Find how many DCT coefficients represent 99.9% of the energy in the signal. Express the
number as a percentage of the total.

need = 1;

while norm(X(ind(1:need)))/norm(X)<0.999
need = need+1;

end

xpc = need/length(X)*100;

Set to zero the coefficients that contain the remaining 0.1% of the energy. Reconstruct
the signal from the compressed representation. Plot the original signal, its reconstruction,
and the difference between the two.

X(ind(need+1l:end)) = 0;
xxX = idct(X);

plot ([x;xx;x-xx]")

legend('Original', [int2str(xpc) '% of coeffs.'],'Difference’,
'"Location', 'best')
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% To hear, type soundsc(x,fs), pause(l), soundsc(xx,fs)

Repeat the analysis for the male voice. Find how many DCT coefficients represent 99.9%
of the energy and express the number as a percentage of the total.

him';
dct(y);

y
Y

[YY,ind] = sort(abs(Y), 'descend');
need = 1;

while norm(Y(ind(1l:need)))/norm(Y)<0.999
need = need+1l;

14-56



DCT for Speech Signal Compression

end

ypc

need/length(Y)*100;

Set the rest of the coefficients to zero and reconstruct the signal from the compressed
version. Plot the original signal, its reconstruction, and the difference between the two.

Y(ind(need+1l:end)) = 0;
yy = idct(Y);

plot(ly;yy;y-yyl')
legend('Original', [int2str(ypc)

'"Location', 'best')
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% To hear, type soundsc(y,fs), pause(l), soundsc(yy,fs)

In both cases, about half of the DCT coefficients suffice to reconstruct the speech signal
reasonably. If the required energy fraction is 99%, the number of necessary coefficients
reduces to about 20% of the total. The resulting reconstruction is inferior but still
intelligible.

Analysis of these and other samples suggests that more coefficients are needed to
characterize the man's voice than the woman's.

See Also
dct | idct
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Display Time-Domain Data in Signal Browser

15-2

In this section...

“Import and Display Signals” on page 15-3

“Configure the Signal Browser Properties” on page 15-6

“Modify the Signal Browser Display” on page 15-9

“Inspect Your Data (Scaling the Axes and Zooming)” on page 15-11

This example shows how to use and configure the SPTool Signal Browser to display time-
domain signals. First, open SPTool by typing

sptool

at the MATLAB command line. SPTool opens.

u 5PTool: startup.spt E@
File Edit Window | Help | o
Signals Filters Spectra
miib vectors I 1 5io [gesic B mibse faut) N

chirp [vector] PZlp [imported] chirpse [auto]

train [wector] FIRbp [de=ign] trainze [auto]

[ View | View | View |
[ Hew ] [ Create ]
( Edit | Update |
l Apply ]



matlab:sptool

Display Time-Domain Data in Signal Browser

Import and Display Signals
Displaying Multiple Signals

You can display multiple signals in the Signal Browser by selecting more than one entry in
the SPTool Signals list. In the Signals list, first select mt1lb [vector]. Next, press the
Ctrl key, and select chirp [vector]. Finally, click the View button. The Signal Browser
opens, displaying both signals.

Any signals that you select in SPTool are now visible in the Signal Browser. You can also
select multiple entries using the Shift key. In the SPTool Signals list, first select mt1lb
[vector]. Next, press the Shift key, and select train [vector]. The Signal Browser
automatically updates to display all three signals, as shown in the following figure.

u Signal Browser EIIEI

L'l

File Tools View Help

8la< i dEEEE $E B

A plitucde

Time (secs)
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15-4

Importing New Signals

Using SPTool, you can import signals from variables in the MATLAB workspace. First,
create a 3-second signal, sampled at 10 kHz, that is the sum of two sine waves. At the
MATLAB command line, enter the following commands:

Fs = 1le4;
t 0:1/Fs:3;
S sum(sin(2*pi*[350;440]1*t));

To import the signal from these variables, in the SPTool menu, select File > Import.
Alternatively, you can press the Ctrl+I keyboard shortcut. The Import to SPTool dialog
box opens.

Import te SPTeol EI =] @
Source Workspace Contents — r Import As: Signal -
® From Workspace
From Disk s Data

t

Sampling Freguency
1

— Name

0K Cancel Help sig1

From the Workspace Contents list, select s. Click the right arrow (| —- |) button to the
left of the Data box. Next, from the Workspace Contents list, select Fs. Click the right

arrow (| — |) button to the left of the Sampling Frequency box. You can assign the
signal a name in the Name box, but since you will rename the signal later in this
example, leave it as sigl for now.

Click OK. The SPTool Signals list now contains a signal named sigl [vector].



Display Time-Domain Data in Signal Browser

Selecting a Signal and Playing Audio

In the SPTool Signals list, select sigl [vector], and click the View button. The Signal
Browser reappears in front. To play audio for the signal, click the Play selected signal

(") button. Signal Browser sends the audio signal to the speaker. For more information,
see sound in the MATLAB documentation.

If you have multiple signals selected in SPTool, you can use the Trace Selection panel to
choose which signal to make active. In the SPTool Signals list, press the Ctrl key, and
select mt1lb [vector]. The Signal Browser now displays two signals. In the Signal
Browser menu, select Tools > Measurements > Trace Selection. The Trace Selection
panel appears as shown in the following figure.

* ¥ Trace Selection

Noisy Sine Wawve

Noizy Sine Wave

Fitered Moisy Sine Wave

In the Trace Selection panel drop-down list, select sigl. Then, click the Play selected

signal ( J7) button. Signal Browser sends the audio signal to the speaker.

Note To hear audio when you click the Play selected signal ( #) button, your computer
sound card must be able to support the sample rate of the signal. In this example, the
sample rate of the signal, sigl [vector], is 10 kHz. If your sound card supports this or
a greater sample rate, such as 44.1 kHz, then you can hear the audio on your speaker. For
more information, see sound in the MATLAB documentation.

Change Signal Names from the Legend
When multiple signals are displayed, Signal Browser shows a legend by default. To turn

off the legend, click the Show all legends ([:z] ) button. Click the button again to turn the
legend back on. You can modify the names of the signal directly in the legend. To do so,
when the legend is visible, click and drag it to any location on the display.

You can change the name of any signal directly within the legend. In the legend, double-
click the signal name sigl. A cursor appears, indicating that you can now change this
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15-6

name. Highlight the text, and type Dial Tone. The legend now shows Dial Tone as the
name of that signal. In the SPTool Signals list, the last item is now also named Dial
Tone.

Configure the Signal Browser Properties

First, configure the appearance of the Signal Browser window. In the SPTool Signals list,
first select mt1b [vector]. Next, press the Shift key, and select train [vector]. The
Signal Browser automatically updates to display all three signals.

Multiple Displays

You can display multiple signals on different displays in the Signal Browser window. In the
SPTool Signals list, first ensure all three signals are selected. In the Signal Browser

toolbar, click the Layout () button. Select row 3, column 1, as shown in the following
figure.

||
||

| Cancel

After you make this selection, the Signal Browser is separated into three displays.
Configure Appearance

In the Signal Browser menu, select View > Properties. The Visuals:Time Domain Options
dialog box opens, as shown in the following figure.



Display Time-Domain Data in Signal Browser

4\ Visuals - Time Domain Properties: Signal Browser | 2 |

Main | Display

Time units: [Metric (based on Time Span) *]

Time-axis labels: [AII T]

Show time-axis label

Maximize axes: [Autn - ]

0K ] [ Cancel Apply

L A

In the Visuals:Time Domain Options dialog box, click the Main tab. Choose the
appropriate parameter settings for the Main tab, as shown in the following table.

Parameter Setting

Time units Metric (based on Time Span)
Show time-axis labels Bottom Displays Only
Maximize axes On

When you change the Maximize axes parameter to On, the axes are expanded to fill the
entire display. To conserve space, titles and axis labels are not shown in each display.
Click Apply.

Set Display Properties

In the Visuals:Time Domain Options dialog box, click the Display tab. You can change the
value of the Select display parameter to make different settings for each display. Set the
parameters to the values shown in the following table.
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Parameter Display 1 Setting |Display 2 Setting |Display 3 Setting
Select display 1 2 3

Title mtlb chirp train
Show legend Selected Selected Selected
Show grid Selected Selected Selected
Plot signal(s) as Cleared Cleared Cleared
magnitude and

phase

Minimum Y-limit -2.5 -1 -1.5
Maximum Y-limit |2.5 1 1.5

Y-axis label Amplitude Amplitude Amplitude

Click OK to save your changes and close the Visuals:Time Domain Options dialog box.
The Signal Browser appears as shown in the following figure.




Display Time-Domain Data in Signal Browser

Modify the Signal Browser Display

Use the Style dialog box to modify the appearance of the axes and the lines for each of
the selected signals in SPTool. In the Signal Browser menu, select View > Style. The
Style dialog box opens, as shown in the following figure.

4| Style: Signal Browser — et

Figure color | &y ~ Plot type: | Line w

Axes colors: | . iv

[ Preserve colors for copy to clipboard

Active display: |1 w
Properties for line: | mtlb w
Line: ~ | [0.75 ~ iv
Marker:  none w

oK Cancel Apply

Modify Axes Colors and Line Properties

You can change the value of the Select display parameter to make different settings for
each display. Set the parameters to the values shown in the following table.

Parameter Display 1 Setting |Display 2 Setting |Display 3 Setting
Select display 1 2 3

15-9



15 Signal Generation

Display 3 Setting

Parameter Display 1 Setting |Display 2 Setting

Axes background |Black Black Black
color

Ticks, labels, and |White White White
grid colors

Line color Yellow Cyan Magenta

These settings enable the Signal Browser to display line colors in the same manner as the
Simulink Scope block. Click OK to save your changes and close the Style dialog box. The
Signal Browser now appears as shown in the following figure.

Show and Hide Toolbar

To hide the toolbar, from the Signal Browser menu, select View > Toolbar. Doing so
removes the toolbar from the Signal Browser window and also removes the check mark
beside the Toolbar option in the View menu. You can choose to show the toolbar again at
any time by selecting View > Toolbar.
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Inspect Your Data (Scaling the Axes and Zooming)

So far, you have manually set the y-axis limits. Use one of the following options to let
Signal Browser scale the axes:

* From the Signal Browser menu, select Tools > Scale Axes Limits.

From the Signal Browser toolbar, click the Scale Axes Limits (|:|) button.
* With the Signal Browser as your active window, press Ctrl + A.

Use the Zoom Tools

The zoom tools allow you to zoom in simultaneously in the directions of both the x- and y-
axes, or in either direction individually. For example, to zoom in on the signal between 0
and 0.5 seconds, you can use the Zoom X option.

* To activate the Zoom X tool, select Tools > Zoom X, or press the corresponding

toolbar button (*3+). The Signal Browser indicates that the Zoom X tool is active by
indenting the toolbar button and placing a check mark next to the Tools > Zoom X
menu option.

* Next, zoom in on the region between 0 and 0.5 seconds. In the Signal Browser
window, click on the 0-second mark and drag to the 0.5-second mark. All three
displays reflect this new x-axis setting, as shown in the following figure.
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* To zoom out of the Signal Browser window, right-click inside the window, and select
Zoom Out. Alternatively, you can return to the original view of your signal by right-
clicking inside the Signal Browser window and selecting Reset to Original View.
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* “RMS Value of Periodic Waveforms” on page 16-2

» “Slew Rate of Triangular Waveform” on page 16-6

* “Duty Cycle of Rectangular Pulse Waveform” on page 16-10

+ “Estimate State for Digital Clock” on page 16-14

* “Calculate Settling Time with Signal Browser” on page 16-17
* “Find Peak Amplitudes in Signal Browser” on page 16-22

* “Distortion Measurements” on page 16-26

*  “Prominence” on page 16-31

* “Determine Peak Widths” on page 16-34




16 Signal Measurement

RMS Value of Periodic Waveforms

16-2

This example shows how to find the root mean square (RMS) value of a sine wave, a
square wave, and a rectangular pulse train using rms. The waveforms in this example are
discrete-time versions of their continuous-time counterparts.

Create a sine wave with a frequency of ® /4 rad/sample. The length of the signal is 16
samples, which equals two periods of the sine wave.

n
X

0:15;
cos(pi/4*n);

Compute the RMS value of the sine wave.
rmsval = rms(x)

rmsval = 0.7071

The RMS value is equal to I/ "'rfz, as expected.
Create a periodic square wave with a period of 0.1 seconds. The square wave values
oscillate between —2 and 2.

t
X

= 0:0.01:1;

= 2*square(2*pi*10*t);
stem(t,x, 'filled")
axis([0 1 -2.5 2.5])



RMS Value of Periodic Waveforms
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Find the RMS value.
rmsval = rms(x)

rmsval = 2
The RMS value agrees with the theoretical value of 2.

Create a rectangular pulse train sampled at 1 kHz with the following parameters: the
pulse is on, or equal to 1, for 0.025 seconds, and off, or equal to 0, for 0.075 seconds in
each 0.1 second interval. This means the pulse period is 0.1 seconds and the pulse is on
for 1/4 of that interval. This is referred to as the duty cycle. Use pulstran to create the
rectangular pulse train.
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t =0:0.001:(10*%0.1);

pulsewidth = 0.025;

pulseperiods = [0:10]*0.1;

x = pulstran(t,pulseperiods,@rectpuls,pulsewidth);

plot(t,x)
axis([0 1 -0.5 1.5])

1.5 T T T T T T T T T

Find the RMS value and compare it to the RMS of a continuous-time rectangular pulse
waveform with duty cycle 1/4 and peak amplitude 1.

rmsval = rms(x)

rmsval 0.5007
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RMS Value of Periodic Waveforms

thrms

sqrt(1l/4)
thrms = 0.5000

The observed RMS value and the RMS value for a continuous-time rectangular pulse
waveform are in good agreement.
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Slew Rate of Triangular Waveform

16-6

This example shows how to use the slew rate as an estimate of the rising and falling

slopes of a triangular waveform. Create three triangular waveforms. One waveform has

41

rising-falling slopes of 12 one waveform has rising-falling slopes of 2 and one
|

waveform has a rising slope of +2 and a falling slope of 2 Use slewrate to find the
slopes of the waveforms.

Use tripuls to create a triangular waveform with rising-falling slopes of +2 Set the
sampling interval to 0.01 seconds, which corresponds to a sample rate of 100 hertz.

dt = 0.01;
t = -2:dt:2;

x = tripuls(t);

Compute and plot the slew rate for the triangular waveform. Input the sample rate (100
Hz) to obtain the correct positive and negative slope values.

slewrate(x,1/dt)



Slew Rate of Triangular Waveform
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Change the width of the triangular waveform so it has slopes of 2 Compute and plot

the slew rate.

x = tripuls(t,4);
slewrate(x,1/dt)
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slew rate
signal

X upper cross
. lower cross

upper boundary
---------- upper state
lower boundary
— — —upper reference
— — —lower reference
upper boundary
""""" lower state
lower boundary

D i i
0 1 2 3 4

Time (seconds)

ans = 1Ix2

0.5000 -0.5000

_l
Create a triangular waveform with a rising slope of +2 and a falling slope of 2,
Compute the slew rate.

X
S

tripuls(t,5/2,-3/5);
slewrate(x,1/dt)

1x2

S
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Level (Volis)
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The first element of s is the rising slope and the second element is the falling slope. Plot

the result.

slewrate(x,1/dt);

slew rate
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Duty Cycle of Rectangular Pulse Waveform

16-10

This example shows how to create a rectangular pulse waveform and measure its duty
cycle. You can think of a rectangular pulse waveform as a sequence of on and off states.
One pulse period is the total duration of an on and off state. The pulse width is the
duration of the on state. The duty cycle is the ratio of the pulse width to the pulse period.
The duty cycle for a rectangular pulse describes the fraction of time that the pulse is on in
one pulse period.

Create a rectangular pulse sampled at 1 gigahertz. The pulse is on, or equal to 1, for a
duration of 1 microsecond. The pulse if off, or equal to 0, for a duration of 3
microseconds. The pulse period is 4 microseconds. Plot the waveform.

Fs = 1e9;
t =0:1/Fs:(10*4e-6);

pulsewidth = le-6;
pulseperiods = [0:10]*4e-6;

x = pulstran(t,pulseperiods,@rectpuls,pulsewidth);

plot(t,x)
axis([0 4e-5 -0.5 1.5])



Duty Cycle of Rectangular Pulse Waveform
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Determine the duty cycle of the waveform using dutycycle. Input both the pulse
waveform and the sample rate to output the duty cycle. dutycycle outputs a duty cycle
value for each detected pulse.

D = dutycycle(x,Fs)
D = 1Ix9

0.2500 0.2500 0.2500 0.2500 0.2500 0.2500 0.2500 0.2500

In this example, the duty cycle for each of the detected pulses is identical and equal to
0.25. This is the expected duty cycle because the pulse is on for 1 microsecond and off for
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3 microseconds in each 4 microsecond period. Therefore, the pulse is on for 1/4 of each
period. Expressed as a percentage, this is equal to a duty cycle of 25%.

Calling dutycycle with no output arguments produces a plot with all the detected pulse
widths marked.

dutycycle(x,Fs);

1.2 -
signal
*. mid cross
T s TEEE s TR o EEEEE o IEEET 2 TEREE i IEREE o TEEEE o TETEE o REEET upper boundary
................................. b R R SR o RS o o upper state
lower boundary
0.8}l — — —mid reference
' upper boundary
PR | I A I A I I A N A I A O N | I Rt lower state
= I lower bounda
E 0.6 Y
S| S 0K K K KK S X K B X
[iE}
T 04f
|
0.2
g Pemb bbbt bbb Lanh sk L b L 4
-0.2 '
0 1 2 3 4

Time (seconds) w1072

Using the same sample rate and pulse period, vary the pulse on time (pulse width) from 1
to 3 microseconds in a loop and calculate the duty cycle. Plot the pulse waveforms and
display the duty cycle value in the plot title for each step through the loop. The duty cycle
increases from 0.25 (1/4) to 0.75 (3/4) as the pulse width increases.
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Duty Cycle of Rectangular Pulse Waveform

nwid = 3;

for nn = 1:nwid

= pulstran(t,pulseperiods,@rectpuls,nn*pulsewidth);

subplot(nwid,1,nn)
plot(t,x)
axis([0 4e-5 -0.5 1.5])

= dutycycle(x,Fs);
title(['Duty cycle is ' num2str(mean(D))])
end
. Duty cycle is 025
1
SN ANANNNE
O
_{}5 1 1 i
0 ':}.5 1 1.5 2 2.5 3 35 -
%107
DutycyclemﬂS
1.5
1
UUUIL | UUIU
O
-0.5
0 'D.E 1 1.5 2 2.5 3 3.5 -
%107
. Duty cycle is 0?5
1
l:}- -
0.5 L i i
0 0.5 1 1.5 2 2.5 3 3.5 L
#1007
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16 Signal Measurement

Estimate State for Digital Clock

This example shows how to estimate the high and low state levels for digital clock data. In
contrast to analog voltage signals, signals in digital circuits have only two states: HIGH
and LOW. Information is conveyed by the pattern of high and low state levels.

Load clockex.mat into the MATLAB® workspace. clockex.mat contains a 2.3 volt
digital clock waveform sampled at 4 megahertz. Load the clock data into the variable x
and the vector of sampling times in the variable t. Plot the data.

load('clockex.mat', 'x','t")
stem(t,x, 'filled")

2.5 T T T T
N e Yan e \-lJ
157

0.5

0 05 1 15 2 25
%1072
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Estimate State for Digital Clock

Determine the high and low state levels for the clock data using statelevels.
levels = statelevels(x)

levels = Ix2

0.0027 2.3068

This is the expected result for the 2.3 volt clock data, where the noise-free low-state level
is 0 volts and the noise-free high-state level is 2.3 volts.

Use the estimated state levels to convert the voltages into a sequence of zeros and ones.
The sequence of zeros and ones is a binary waveform representation of the two states. To
make the assignment, use the following decision rule:

* Assign any voltage within a 3%-tolerance region of the low-state level the value 0.

* Assign any voltage within a 3%-tolerance region of the high-state level the value 1.

Determine the widths of the 3%-tolerance regions around the low- and high-state levels.
tolwd = 3/100*diff(levels);

Use logical indexing to determine the voltages within a 3%-tolerance region of the low-
state level and the voltages within a 3%-tolerance region of the high-state level. Assign
the value 0 to the voltages within the tolerance region of the low-state level and 1 to the
voltages within the tolerance region of the high-state level. Plot the result.

y = zeros(size(x));
y(abs(x-min(levels))<=tolwd) = 0;
y(abs(x-max(levels))<=tolwd) = 1;

subplot(2,1,1)
stem(t,x, 'filled")
ylabel('Volts"')
subplot(2,1,2)
stem(t,y, 'filled")
ylabel('\{0,1\}")
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The decision rule has assigned all the voltages to the correct state.
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Calculate Settling Time with Signal Browser

Calculate Settling Time with Signal Browser

This example shows how to use the Bilevel Measurements panel in the SPTool Signal
Browser to find the settling time of a clock signal.

First, open SPTool by typing the following at the MATLAB command line.

sptool
SPTool opens.
B SPTook: startup.spt E=N Eol <=
File Edit Window | Help | o
Signals Filters Spectra
mibjvector]  PIILSIp [desic Nl miise auto) N
chirp [vector] PZIp [imported] chirpse [auto]
train [vector] FIRbp [design] trainze [auto]
[ View | [ View [ View ]
[ Hew ] [ Create ]
( Edit [ Update ]
[ Apply ]

In this example, you import a clock signal from the MAT-file named clockex.mat. In the
SPTool menu, select File > Import. Alternatively, you can press the Ctrl+I keyboard
shortcut. The Import to SPTool dialog box opens.
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16 Signal Measurement

16-18

Under Source, click From Disk.

In the MAT-file Name box, type clockex, and press Enter. The variables x and t
appear under File Contents.

Under File Contents, click x. Click the right arrow (| —= |) button to the left of the
Data box.

In the Sampling Frequency box, type 4000000.
In the Name box, type Clock.
Click OK. The SPTool Signals list now contains a signal named Clock [vector].

In SPTool, in the Signals list, select Clock [vector], and click the View button.
The Signal Browser appears and displays the clock signal.

N o A

Because you selected only one signal, the legend is not needed. Turn off the legend by

clicking the Show All Legends ([:=] ) button. Then, use the Style dialog box to modify the
appearance of the axes and the lines for the signal. In the Signal Browser menu, select
View > Style.

Parameter Display 1 Setting
Axes background color Black

Ticks, labels, and grid colors Dark Gray

Line color Yellow

To show the Bilevel Measurements panel, in the Signal Browser menu, select Tools >
Measurements > Bilevel Measurements. To collapse the Transitions pane, click the

pane collapse button ( ¥ ) next to that label. To expand the Settings pane and the

Overshoots / Undershoots pane, click the pane expand button ( » ) next to each label.
The Signal Browser appears as shown in the following figure.



Calculate Settling Time with Signal Browser

-

TimeScupe
File Tools View Playback Help

Qw3 HEHE F | @REEx D

Amplitude

+ Owvershoot
+ Undershoot
+ Settling Time
- Preshoot

- Owershoot

- Undershoot

- Settling Time

Processing

|Uff5&t=[l T=0

The value for the rising edge Settling Time parameter does not appear in the
Overshoots / Undershoots pane because the Settle Seek parameter is too large. The
Settle Seek value is longer than the entire simulation duration. Enter a value for settle

seek of 2e-6, and press Enter. Signal Browser now displays a rising edge settling time
value 0of 118.392 ns.
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16-20

This settling time value displayed is actually the statistical average of the settling times
for all five rising edges. To display the settling time for only one rising edge, you can

zoom in on that transition. In the Signal Browser toolbar, click the Zoom X button ("<*).
Click the display near a value of 2 microseconds on the time-axis. Drag to the right, and
release near a value of 4 microseconds on the time-axis. Signal Browser updates the
rising edge Settling Time value to reflect the new time window, as shown in the
following figure.



s

See Also

Time Scope

File Tools View Playback Help
Q)2 @ LM F | @REEx| T

T ¥ Bilevel Measurements

Amplitude

+ Overs

+ Undershoot

+ Settling Time

Processing

|Uff5&t=[l T=0

See Also

falltime | overshoot | risetime | settlingtime | slewrate | undershoot
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Find Peak Amplitudes in Signal Browser

This example shows how to use the Peak Finder panel in the SPTool Signal Browser to
find heart rate, given an electrocardiogram (ECG) signal.

First, open SPTool by typing the following at the MATLAB command line.

sptool
SPTool opens.
B SPTook: startup.spt E=N Eol <=
File Edit Window | Help | o
Signals Filters Spectra
mibjvector]  PIILSIp [desic Nl miise auto) N
chirp [vector] PZIp [imported] chirpse [auto]
train [vector] FIRbp [design] trainze [auto]
[ View | [ View [ View ]
[ Hew ] [ Create ]
( Edit [ Update ]
[ Apply ]

Using SPTool, you can import signals from variables in the MATLAB workspace. First,

create an electrocardiogram (ECG) signal, sampled at 4 kHz. To create the signal, save
this function definition in a file called ecg.m:
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Find Peak Amplitudes in Signal Browser

function x = ecg(L)
ao [0,1,40,1,0,-34,118,-99,0,2,21,2,0,0,0];

do [0,27,59,91,131,141,163,185,195,275,307,339,357,390,440];
a = a0 / max(a0);

d = round(do * L / dO(15));
L;

1:14,

d(i) : d(i+l) - 1
slope = (a(i+l) - a(i))
x(m+1l) = a(i) + slope *

—
o
il
[
o

/ (d(i+l) - d(i))
(m - d(i))
end

Now apply the Savitzky-Golay filter to the ECG signal. At the MATLAB command line,
enter the following commands:

x1 = 3.5*%ecg(2700)."';

yl = sgolayfilt(kron(ones(1,13),x1),0,21);
n = (1:30000)"';

del = round(2700*rand(1));

mhb = yl(n + del);

ts = 0.00025;

Fs = 1/ts;

To import the signal from these variables, in the SPTool menu, select File > Import.
Alternatively, you can press the Ctrl+I keyboard shortcut. The Import to SPTool dialog
box appears.

1

Under Workspace Contents, click mhb. Click the right arrow (| —= [) button to the
left of the Data box.

Under Workspace Contents, click Fs. Click the right arrow (| —= |[) button to the
left of the Sampling Frequency box.

3 In the Name box, type ECG.
Click OK. The SPTool Signals list now contains a signal named ECG [vector].

5 In SPTool, in the Signals list, select ECG [vector], and click the View button. The
Signal Browser opens and displays the ECG signal.

Because you only selected one signal, the legend is not needed. Turn off the legend by

clicking the Show All Legends ([i2] ) button. Then, use the Style dialog box to modify the
appearance of the axes and the lines for the signal. In the Signal Browser menu, select
View > Style.
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Amplitude

16-24

Parameter Display 1 Setting
Axes background color Black

Ticks, labels, and grid colors Dark Gray

Line color Yellow

To show the Peak Finder panel, in the Signal Browser menu, select Tools >
Measurements > Peak Finder. To expand the Settings pane, click the pane expand

button ( » ) next to that label. In the Max Num of Peaks box, type 10 and press the
Enter key. Signal Browser now displays in the Peaks pane a list of 10 peak amplitude
values, and the times at which they occur, as shown in the following figure.

¥ ¥ Peak Finder

¥ Settings

Min Pea
Peak Excursion

Label Format

6.450

¥ Peak
L
L
L
L
L
L
L
L
L
L
L



See Also

As you can see from the list of peak values, there is a constant time difference of 0.675
seconds between each heartbeat. Therefore, the heart rate detected by the ECG signal is
given by the following equation.

sec
60— beats
—min_ _gg 89 %2 [pm)
0.675-2¢ min
beat
See Also

findpeaks | sgolay | sgolayfilt

16-25



16 Signal Measurement

Distortion Measurements

16-26

Generate 2048 samples of a sinusoid of frequency 2.5 kHz sampled at 50 kHz. Add white
Gaussian noise such that the signal-to-noise ratio (SNR) is 80 dB.

Fs = 5e4;

f0 = 2.5e3;

N = 2048;

t = (0:N-1)/Fs;

SNR = 80;

X = COoS(2*pi*fO*t);

X = x+randn(size(x))*std(x)/db2mag(SNR);

Pass the result through a weakly nonlinear amplifier represented by a polynomial. The
amplifier introduces spurious tones at the frequencies of the harmonics.

amp = [le-5 5e-6 -le-3 6e-5 1 25e-3];
x = polyval(amp,Xx);

Plot the signal spectrum and annotate the SNR, verifying that it has the expected value.
The snr function computes the power ratio of the fundamental to the noise floor and
ignores the DC component and the harmonics.

snr(x,Fs);



Distortion Measurements

Fower (dB)

SNR: 79.86 dB
L E Fundamental 4
0 II Moise
DC and Harmonics (excluded)
20 1
-40 r T
-60 T
A
-80 T
=100 | 1 @ p |
iy i rar
.[i | | f'm Y V”Hl'f”
=120 “ | |1 |¥
-140 ' '

0 5 10 15 20 25
Frequency (kHz)

Plot the signal spectrum and annotate the total harmonic distortion (THD). The thd
function computes the power ratio of the harmonics to the fundamental and ignores the
DC component and the noise floor.

thd(x,Fs);
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THD: -72.08 dB

Fundamental i
Harmaonics
DC and Moise (excluded)

Fower (dB)

-80

-100 \

-120

-140
0 5 10 15 20 25

Frequency (kHz)

Plot the signal spectrum and annotate the signal to noise and distortion ratio (SINAD).
The sinad function computes the power ratio of the fundamental to the harmonics and
the noise floor. It ignores only the DC component.

sinad(x,Fs);
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Fower (dB)

SINAD: 71.43dB

60 |

-80

Fundamental -
Moise and Distortion
DC (excluded)

r _
|

-140

I

5 10
Frequency (kHz)

25

Verify that the SNR, THD, and SINAD obey the equation

lhs
lhs
rhs

rhs

lﬂ—ﬂH‘R.]I}_l_ ID’IHD.]D: ||:|—'.E|IH'};|:- HJ_

10"~ (-snr(x,Fs)/10)+10"(thd(x,Fs)/10)
7.2203e-08

10~ (-sinad(x,Fs)/10)

7.1997e-08
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16 Signal Measurement

Fower (dB)

16-30

Plot the signal spectrum and annotate the spurious-free dynamic range (SFDR). The
SFDR is the power ratio of the fundamental to the strongest spurious component ("spur").
In this case, the spur corresponds to the third harmonic.

sfdr(x,Fs);

SFDR: 72.16 dB

g

| _
' |
I e M

0 5 10 15 20 25
Frequency (kHz)



Prominence

Prominence

The prominence of a peak measures how much the peak stands out due to its intrinsic
height and its location relative to other peaks. A low isolated peak can be more prominent
than one that is higher but is an otherwise unremarkable member of a tall range.

To measure the prominence of a peak:

Place a marker on the peak.

2  Extend a horizontal line from the peak to the left and right until the line does one of
the following:

* Crosses the signal because there is a higher peak

* Reaches the left or right end of the signal

3 Find the minimum of the signal in each of the two intervals defined in Step 2. This
point is either a valley or one of the signal endpoints.

4 The higher of the two interval minima specifies the reference level. The height of the
peak above this level is its prominence.

findpeaks makes no assumption about the behavior of the signal beyond its endpoints,
whatever their height. This is reflected in Steps 2 and 4 and often affects the value of the
reference level. Consider for example the peaks of this signal:
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16-32

Peak Left Interval (Right Lowest Point|Lowest Point|Reference
Number Lies Interval Lies [on the Left |on the Right |Level
Between Between Interval Interval (Highest
Peak and Peak and Minimum)
1 Left end Crossing due |Left endpoint |a a
to peak 2
2 Left end Right end Left endpoint |h Left endpoint
3 Crossing due |Crossing due |b C C
to peak 2 to peak 4
4 Crossing due |Crossing due |b d b
to peak 2 to peak 6
5 Crossing due |Crossing due |d e e
to peak 4 to peak 6
6 Crossing due |Right end d h d
to peak 2
7 Crossing due |Crossing due |f g g

to peak 6

to peak 8




Prominence

Crossing due |Right end f

to peak 6

Crossing due |Crossing due |h

to peak 8 to right
endpoint
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Determine Peak Widths

Create a signal that consists of a sum of bell curves. Specify the location, height, and
width of each curve.

x = linspace(0,1,1000);

Pos = [12 35 7 8]/10;
Hgt = [4 4 2 2 2 3];
Wdt = [3 8 4 3 4 6]/100;

for n = 1:length(Pos)

Gauss(n,:) = Hgt(n)*exp(-((x - Pos(n))/Wdt(n)).”2);
end
PeakSig = sum(Gauss);

Plot the individual curves and their sum.

plot(x,Gauss,'--"',x,PeakSig)
grid
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Determine Peak Widths

Measure the widths of the peaks using the half prominence as reference.

findpeaks (PeakSig, x, "Annotate’, 'extents')
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E T T T T T T T T T
signal
¥ peak
or prominence T
m width (half-prominence)
'|
M

i \;’| !\ |
| M

0 0.1 0.2

Measure the widths again, this time using the half height as reference.
findpeaks (PeakSig, x, "Annotate', 'extents', 'WidthReference', "halfheight')

title('Signal Peak Widths')
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Signal Peak Widths

v

signal
peak
height
width (half-height)

horder

0.1 0.2
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17 Spectrum Object to Function Replacement

Nonparametric Spectrum Object to Function

Replacement

In this section...

“Periodogram PSD Object to Function Replacement Syntax” on page 17-2
“Periodogram MSSPECTRUM Object to Function Replacement Syntax” on page 17-3
“Welch PSD Object to Function Replacement Syntax” on page 17-4

“Welch MSSPECTRUM Object to Function Replacement Syntax” on page 17-6
“Multitaper PSD Object to Function Replacement Syntax” on page 17-9

Periodogram PSD Object to

The spectrum.periodogram object syntax will be removed in the future. The following

Function Replacement Syntax

table gives the equivalent recommended function syntax for periodogram. In the

modified periodogram, you use a window other than the default rectangular window. To

illustrate modified periodogram syntaxes, the table uses a specific window. In each

example, x is the input signal.

Deprecated Syntax

Replacement Syntax

h = spectrum.periodogram;
psd(h,x);

periodogram(x) ;

% Modified periodogram with window functio
h = spectrum.periodogram('hamming"');
psd(h,x);

'win = hamming(length(x));
periodogram(x,win);

% Window function and optional input argum
h = spectrum.periodogram({'Hamming"', 'perio
psd(h,x);

anilrs = chammitug( femgtth ox) , 'periodic');
fher'dddogram(x,win) ;

% Taylor window and multiple optional inpufnEagumeh;ts

nbar = 4; sll = -30;

sll = 30; win = taylorwin(length(x),nbar,sll);
h = spectrum.periodogram({'Taylor',nbar,sl{@gdriodogram(x,win,[],fs, 'centered');
psd(h,x, 'Fs',fs, 'centerdc', true);

h = spectrum.periodogram(...); win = ...

psd(h,x, 'NFFT',nfft); periodogram(x,win,nfft);
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Nonparametric Spectrum Object to Function Replacement

Deprecated Syntax

Replacement Syntax

h = spectrum.periodogram(...);

psd(h,x, 'Fs',fs);

win = ..
perlodogram(x win,[],fs);

h = spectrum.periodogram(...);

win = ...

psd(h,x, "NFFT',nfft,'Fs', fs); periodogram(x,win,nfft, fs);
h = spectrum.periodogram(...); win = ...
psd(h,x, ..., 'FreqgPoints', 'User Defined',..|periodogram(x,win,w);
'FrequencyVector',w);

h = spectrum.periodogram(...); win = ...

psd(h,x, 'FreqPoints', 'User Defined', periodogram(x,win, f,fs);

'FrequencyVector',f,'Fs',fs);

% Two-sided spectrum of a real signal

win = ...

h = spectrum.periodogram(...); periodogram(x,win, ..., 'twosided');

psd(h,x, , 'SpectrumType', 'TwoSided');

% Two-sided spectrum with DC (0 frequency)|vin the. center

h = spectrum periodogram(...); periodogram(x,win, ..., 'centered');

psd(h , 'CenterDC' true),

h = spectrum periodogram(...); win = ...

psd(h , 'ConfLevel', p); periodogram(x,win, ..., 'ConfidencelLevel',p)|
h = spectrum.periodogram(...); win = ...

hPSD = psd(h,x,...); [Pxx,F] = periodogram(x,win,...);

Pxx = hPSD.Data;

= hPSD.Frequencies;

)3
'ConfLevel',p);

h = spectrum.periodogram(...
hPSD = psd(h,x, ...,
Pxx = hPSD.Data;

= hPSD.Frequencies;
Pxxc = hPSD.ConfInterval;

win = ..

[Pxx,F, Pxxc] periodogram(x,win,...);

Periodogram MSSPECTRUM Object to Function Replacement

Syntax

The spectrum.periodogram MSSPECTRUM object syntax will be removed in the
future. The following table gives the equivalent recommended function syntax for
periodogram. In the modified periodogram, you use a window other than the default

rectangular window. To illustrate modified periodogram syntaxes, the table uses a specific

window. In each example, x is the input signal.
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Deprecated Syntax

Recommended Syntax

h spectrum.periodogram;
msspectrum(h,x);

periodogram(x, 'power');

h = spectrum.periodogram('Hamming"');
msspectrum(h,x);

win = hamming(length(x));
periodogram(x,win, 'power');

h spectrum.periodogram({'Hamming"', 'perio
msspectrum(h,x);

diirf }9 ;hamming (length(x), 'periodic');
periodogram(x,win, 'power');

nbar = 4;
sll = 30;
h = spectrum.periodogram({'Taylor',nbar,sl

msspectrum(h,x);

nbar 4;

sll -30;

Wi = taylorwin(length(x),nbar,sll);
periodogram(x,win, 'power');

h spectrum.periodogram(...);
msspectrum(h,x, '"NFFT',nfft);

win= ...
periodogram(x,win,nfft, 'power');

h = spectrum.periodogram(...);
msspectrum(h,x, 'Fs',fs);

win = ...
periodogram(x,win, [], fs, 'power');

h = spectrum.periodogram(...); win =

msspectrum(h,x, 'NFFT',nfft, 'Fs', fs); periodogram(x,win,nfft, fs, 'power"');

h = spectrum.periodogram(...); win =

msspectrum(h,x, ..., 'SpectrumType', 'TwoSidefperiodogram(x,win, ..., 'twosided', 'power')
h = spectrum.periodogram(...); win =

msspectrum(h, x,..., 'CenterDC', true); periodogram(x,win, ..., 'centered', 'power');
h = spectrum.periodogram(...); win = ...

msspectrum(h,x, ..., 'ConfLevel',p); periodogram(x,win, ..., 'ConfidencelLevel', p
h = spectrum.periodogram(...); win = .

hMS = msspectrum(h,x,...); [Sxx,F] = periodogram(x,win,..., 'power');
Sxx = hMS.Data;

F = hMS.Frequencies;

h = spectrum.periodogram(...); win =

hMS = msspectrum(h,x, ..., 'ConfLevel',p); [Sxx,F,Sxxc] = periodogram(x,win, ..., 'powe
Sxx = hMS.Data;

F = hMS.Frequencies;
SXXC hMS.ConfInterval;

, ... 'power

Welch PSD Object to Function Replacement Syntax

The spectrum.welch object syntax will be removed in the future. The following table
gives the equivalent recommended function syntax for pwelch. To illustrate modified
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periodogram syntaxes, the table uses a specific window. In each example, x is the input

signal.

Deprecated Syntax

Replacement Syntax

h = spectrum.welch; pwelch(x);
psd(h,x);
h = spectrum.welch('Gaussian'); win = gausswin(64);

psd(h,x);

pwelch(x,win);

% Welch estimate with window function and
h spectrum.welch({'Hamming', 'periodic'})
psd(h,x);

it o eammiong: ( 64 g Umeenitedic ') ;
;pwelch(x,win) ;

% Taylor window and multiple optional inpu
nbar = 4;
sll = 30;
h = spectrum.welch({'Taylor', nbar, sll});
psd(h,x);

nzag umeh;t s

sll = -30;

win = taylorwin(64,nbar,sll);
pwelch(x,win);

h spectrum.welch('Hamming', seglLen);
psd(h,x);

win = hamming(seglLen);
pwelch(x,win);

h = spectrum.welch({'Hamming"', 'periodic'},|win = hamming(seglLen, 'periodic');
seglLen); pwelch(x,win);

psd(h,x);

nbar = 4; nbar = 4;

sll = 30; sll = -30;

h = spectrum.welch({'Taylor',nbar,sll},...|lwin = taylorwin(segLen,nbar,sll);
seglLen); pwelch(x,win);

psd(h,x);

h = spectrum.welch('Hamming"', seglLen,ovlpPc
psd(h,x);

twin hamming(seglLen);
Noverlap = ceil((ovlpPct/100)*seglLen);

pwelch(x,win,Noverlap);

h = spectrum.welch({'Hamming', 'periodic'},
seglLen,ovlpPct);

\win hamming(seglLen, 'periodic');
Noverlap = ceil((ovlpPct/100)*seglLen);

psd(h,x); pwelch(x,win,Noverlap);

nbar = 4; nbar = 4;

sll = 30; sll = -30;

h = spectrum.welch({'Taylor',nbar,sll},...|lwin = taylorwin(segLen,nbar,sll);

segLen,ovlpPct);
psd(h,x);

Noverlap = ceil((ovlpPct/100)*seglLen);
pwelch(x,win,Noverlap);
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Deprecated Syntax

Replacement Syntax

h = spectrum.welch(...);
psd(h,x, 'NFFT',nfft);

win .
Noverlap =
pwelch(x,win, Noverlap nfft);

h = spectrum.welch(...);
psd(h,x, 'Fs*,fs);

win
Noverlap = ..
pwelch(x,win, Noverlap [1,fs);

h = spectrum.welch(...);

psd(h,x, '"NFFT',nfft,'Fs',fs);

win
Noverlap = ..
pwelch(x,win, Noverlap nfft,fs);

h = spectrum.welch(...); win =

psd(h,x, ..., 'FreqPoints', 'User Defined',..|periodogram(x,win,w);

'FrequencyVector',w);

h = spectrum.periodogram(...); win = .

psd(h,x, 'FreqPoints', 'User Defined', Noverlap = ..

'FrequencyVector',f,'Fs', fs); pwelch(x,win, Noverlap f,fs);

% Two-sided spectrum of a real signal win =

h = spectrum.welch(...); Noverlap = ..

psd(h,x, ..., 'SpectrumType"', 'TwoSided"'); pwelch(x,win, Noverlap,...,'twosided');

% Two-sided spectrum with DC (0 frequency)|vin the. center

h = spectrum.welch(...); Noverlap = ..

psd(h,x, ..., 'CenterDC', true); pwelch(x,win, Noverlap,...,'centered');

h = spectrum.welch(...); win =

psd(h,x, ..., 'ConfLevel',p); Noverlap =

pwelch(x,win,Noverlap, ... 'ConfidencelLevel!’

h = spectrum.welch(...); win = .

hPSD = psd(h,x,...); Noverlap = .

Pxx = hPSD.Data; [Pxx,F] = pwelch(x win,Noverlap,...);
= hPSD.Frequencies;

h = spectrum.periodogram(...); win =

hPSD = psd(h,x, ..., 'ConfLevel',p); Noverlap =

Pxx = hPSD.Data;
= hPSD.Frequencies;
Pxxc hPSD.ConfInterval;

[Pxx,F,Pxxc] = pwelch(x,win,Noverlap, ...
'ConfidencelLevel',p);

P

Welch MSSPECTRUM Object to Function Replacement Syntax

The spectrum.welch MSSPECTRUM object syntax will be removed in the future. The
following table gives the equivalent recommended function syntax for pwelch. In the

17-6



Nonparametric Spectrum Object to Function Replacement

modified periodogram, you use a window other than the default rectangular window. To
illustrate modified periodogram syntaxes, the table uses a specific window. In each

example, x is the input signal.

Deprecated Syntax

Recommended Syntax

h = spectrum.welch
msspectrum(h,x);

win hamming(64);
pwelch(x,win,[], 'power');

h spectrum.welch('Gaussian');
msspectrum(h,x);

win = gausswin(64);
pwelch(x,win, [], 'power');

h spectrum.welch({'Hamming', 'periodic'})
msspectrum(h,x);

iwin = hamming (64, 'periodic');
pwelch(x,win, [], 'power');

nbar = 4;

sll = 30;

h = spectrum.welch({'Taylor',nbar,sll});
msspectrum(h,x);

nbar = 4;

sll = -30;

win = taylorwin(64,nbar,sll);
pwelch(x,win, [], 'power"');

seglLen 128;
h spectrum.welch('Hamming', seglLen);

msspectrum(h,x);

win = hamming(128);
pwelch(x,win,[], 'power');

seglLen 128;

h spectrum.welch({'Hamming"', 'periodic'},
seglLen);

msspectrum(h,x);

win hamming (128, 'periodic');
.pwelch(x,win, [], 'power');

nbar = 4;

sll = 30;

seglLen 128;

h = spectrum.welch({'Taylor',nbar,sll}, seg
msspectrum(h,x);

nbar = 4;
sll = -30;
segLen = 128;

heir) ;= taylorwin(seglLen,nbar,sll);
pwelch(x,win, [], 'power');

seglLen 128;

ovlpPct = 50;

h = spectrum.welch('Hamming"', seglLen,ovlpPc
msspectrum(h,x);

seglLen 128;

win = hamming(seglLen);

oy LlpPct = 50;

Noverlap = ceil((ovlpPct/100)*seglLen);
pwelch(x,win,Noverlap, 'power');

segLen = 128;
ovlpPct = 50;
h = spectrum.welch({'Hamming', 'periodic'},

seglLen,ovlpPct);
msspectrum(h,x);

seglLen 128;

ovlpPct = 50;

\win hamming(seglLen, 'periodic');
Noverlap = ceil((ovlpPct/100)*seglLen);

pwelch(x,win,Noverlap, 'power');
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17 Spectrum Object to Function Replacement

Deprecated Syntax

Recommended Syntax

nbar = 4; nbar = 4;

sll = ; sll = -30;

segLen = 128; segLen = 128;

ovlpPct = 50; win = taylorwin(seglLen,nbar,sll);

h = spectrum.welch({'Taylor',nbar,sll},...|ovlpPct = 50;

seglLen,ovlpPct); Noverlap = ceil((ovlpPct/100)*seglLen);

msspectrum(h,x); pwelch(x,win,Noverlap, 'power');

h = spectrum.welch(...); win =

msspectrum(h,x, '"NFFT',nfft); Noverlap = ..
pwelch(x,win, Noverlap nfft, 'power');

h = spectrum.welch(...); win =

msspectrum(h,x, 'Fs',fs); Noverlap = ..
pwelch(x,win, Noverlap [1,fs, 'power');

h = spectrum.welch(...); win =

msspectrum(h,x, '"NFFT',nfft, 'Fs', fs); Noverlap =
pwelch(x,win,Noverlap,nfft,fs, 'power');

h = spectrum.welch(...); win = ..

msspectrum(h, x,..., 'FregPoints', 'User DethmMHrLap ..

'FrequencyVector',w); pwelch(x,win,Noverlap, f,fs, 'power');

h = spectrum.welch(...); win =

msspectrum(h,x,...,'SpectrumType','TwoSidedeverlap .
pwelch(x,win,Noverlap, ..., 'twosided', 'powe

h = spectrum.welch(...); win =

msspectrum(h,x, ..., 'CenterDC', true); Noverlap = ..
pwelch(x,win, Noverlap,...,'centered','powe

h = spectrum.welch(...); win =

msspectrum(h,x, ..., 'ConfLevel',p); Noverlap =
pwelch(x,win,Noverlap, ..., 'ConfidencelLevel|

h = spectrum.welch(...); [Sxx,F] = pwelch(..., 'power');

hMS = msspectrum(h,x,...);

Sxx = hMS.Data;

= hMS.Frequencies;
h = spectrum.welch(...); [Sxx,F,Sxxc] = pwelch(..., 'ConfidencelLevel|

hMS = msspectrum(h,
Sxx = hMS.Data;

= hMS.Frequencies;
Sxxc hMS.ConfInterval;

X, =, 'ConfLevel', p);

r');
r');
, P, 'power
,p, 'power
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Nonparametric Spectrum Object to Function Replacement

Multitaper PSD Object to Function Replacement Syntax

The spectrum.mtm object syntax will be removed in the future. The following table gives
the equivalent recommended function syntax for pmtm. In each example, x is the input

signal.
Deprecated Syntax Recommended Syntax
hMTM = spectrum.mtm; pmtm(x,4);
psd(hMTM, x) ;
hMTM = spectrum.mtm(NW) ; pmtm(x,NW) ;
psd(hMTM, x) ;
[E,V] = dpss(length(x),NW); [E,V] = dpss(length(x),NW);
hMTM = spectrum.mtm(E,V); pmtm(x,E,V);
psd(hMTM, x) ;
hMTM = spectrum.mtm(NW) ; pmtm(x,NW, fs);
psd(hMTM, x, 'Fs',fs);
hMTM = spectrum.mtm(E,V); pmtm(x,E,V,fs);
psd(hMTM, x, 'Fs',fs);
hMTM = spectrum.mtm(NW) ; pmtm(x,NW,nfft,fs);
psd(hMTM, x, 'Fs',fs, '"NFFT',nfft);
hMTM = spectrum.mtm(E,V); pmtm(x,E,V,nfft,fs);
psd(hMTM, x, 'Fs',fs, 'NFFT',nfft);
hMTM = spectrum.mtm(NW) ; pmtm(x,NW,w) ;

psd(hMTM, x, 'FregPoints', 'User Defined', ...
'FrequencyVector',w);

hMTM = spectrum.mtm(E,V); pmtm(x,E,V,w);
psd (hMTM, x, 'FreqPoints', 'User Defined', ...
'FrequencyVector',w);

hMTM = spectrum.mtm(NW) ; pmtm(x,E,V,f,fs);
psd(hMTM, x, 'FreqPoints', 'User Defined', ...
'FrequencyVector',f,'Fs', fs);

hMTM = spectrum.mtm(E,V); pmtm(x,E,V,f,fs);
psd(hMTM, x, 'FregPoints', 'User Defined', ...
'FrequencyVector',f,'Fs', fs);

hMTM = spectrum.mtm(..., 'Adaptive'); pmtm(..., 'adapt');
psd(hMTM, ...);
hMTM = spectrum.mtm(..., 'Eigenvalue'); pmtm(..., 'eigen');

psd(hMTM, ...);

17-9



17 Spectrum Object to Function Replacement

Deprecated Syntax

Recommended Syntax

hPSD = psd(hMTM,...);
Pxx = hPSD.Data;
F = hPSD.Frequencies;

hMTM = spectrum.mtm(..., 'Unity'); pmtm(..., 'unity"');

psd(hMTM, ...);

hMTM = spectrum.mtm(...); pmtm(..., 'twosided');

psd (hMTM, ..., 'SpectrumType', 'twosided"');

hMTM = spectrum.mtm(...); pmtm(..., 'centered');
psd(hMTM, ..., 'SpectrumType', 'twosided’, ...

'CenterDC',true);

hMTM = spectrum.mtm(...); pmtm(..., 'ConfidencelLevel',p);
psd(hMTM, ..., '"ConfLevel',p);

hMTM = spectrum.mtm(...); [Pxx,F] = pmtm(...);

hMTM = spectrum.mtm(...);
hPSD = psd(hMTM, x, 'ConfLevel',p);
Pxx = hPSD.Data;

F = hPSD.Frequencies;
Pxxc = hPSD.ConfInterval;

[Pxx,F,Pxxc] = pmtm(x, 'ConfidencelLevel',p)}
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Autoregressive PSD Object to Function Replacement Syntax

Autoregressive PSD Object to Function Replacement
Syntax

The AR PSD object syntax will be removed in the future. The following table gives the
equivalent recommended function syntax. The table uses spectrum.burg and pburg as
examples, but the object-to-function replacement syntaxes are valid for all the AR spectral
estimators with the appropriate substitution: spectrum.burg to pburg, spectrum. cov
to pcov, spectrum.mcov to pmcov, and spectrum.yulear to pyulear. In each
example, x is the input signal.

Deprecated Syntax Replacement Syntax
hBurg = spectrum.burg; pburg(x,4);
psd(hBurg,x);

hBurg = spectrum.burg(order); pburg(x,order);
psd(hBurg,x);

hBurg = spectrum.burg(order); pburg(x,order,nfft);
psd(hBurg,x, '"NFFT',nfft);

hBurg = spectrum.burg(order); pburg(x,order,[],fs);
psd(hBurg,x, 'Fs', fs);

hBurg = spectrum.burg(order); pburg(x,order,nfft,fs);
psd(hBurg,x, 'NFFT',nfft, 'Fs',fs);

hBurg = spectrum.burg(order); pburg(x,order,w) ;
psd(hBurg, x,...,'FregPoints', 'User Definef', ...

'FrequencyVector',w);

hBurg = spectrum.burg(order); pburg(x,order,f,fs);
psd(hBurg, x, 'FregPoints', 'User Defined',..|
'FrequencyVector',f,'Fs', fs);

hBurg = spectrum.burg pburg(..., 'twosided');
psd(...,'SpectrumType', 'TwoSided"');

hBurg = spectrum.burg; pburg(x,..., 'centered"');

psd(..., 'CenterDC', true);

hBurg = spectrum.burg; pburg(x,..., " 'ConfidencelLevel',p);
psd(..., 'ConfLevel',p);

hBurg = spectrum.burg; [Pxx,F] = pburg(...);

hPSD = psd(...);

Pxx hPSD.Data;

F = hPSD.Frequencies;
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17 Spectrum Object to Function Replacement

Deprecated Syntax

Replacement Syntax

hBurg = spectrum.burg;

hPSD = psd(..., 'ConfLevel',p);
Pxx = hPSD.Data;

F = hPSD.Frequencies;

Pxxc = hPSD.ConfInterval;

[Pxx,F,Pxxc] = pburg(...);
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Subspace Pseudospectrum Object to Function Replacement Syntax

Subspace Pseudospectrum Object to Function

Replacement Syntax

The pseudospectrum object syntax will be removed in the future. The following table
gives the equivalent recommended function syntax. The table uses spectrum.music and
the functional equivalent, pmusic, but the syntax replacements are also valid for
spectrum.eigenvector to peig. In each example, x is the input signal.

Deprecated Syntax

Replacement Syntax

h spectrum.music(nsinusoids);
pseudospectrum(h,x);

pmusic(x,nsinusoids)

h spectrum.music(nsinusoids);
pseudospectrum(h,x, 'Fs', fs)

pmusic(x,nsinusoids,[],fs);

h = spectrum.music(nsinusoids,seglLen,ovlpP
"Hamming');
pseudospectrum(h,x)

ofin .= hamming(seglen)
Noverlap = ceil(ovlpPct/100*seglLen);
P = nsinusoids;

Fs = 2*pi;
pmusic(x,P,[],Fs,win,Noverlap);
h = spectrum.music(nsinusoids,seglLen,ovlpPpiin = winfunc(seglen)

winName, thresh);
pseudospectrum(h,x)

Noverlap = ceil(ovlpPct/100*seglen);
P = [nsinusoids thresh];

Fs = 2 *pi;
pmusic(x,P,[],Fs,win,Noverlap);

h spectrum.music(nsinusoids, seglen, ...
ovlpPct,winName, thresh);
pseudospectrum(h,x, 'Fs',fs)

win = hamming(seglLen)

nfft = max(256,2"nexpow2(seglLen));
Noverlap = ceil(ovlpPct/100*seglLen);
P = [nsinusoids thresh];
pmusic(x,P,[],Fs,win,Noverlap);

h = spectrum.music(nsinusoids,seglen,...
ovlpPct,winName, thresh);
pseudospectrum(h,x, 'Fs',fs, 'SpectrumRange’

win hamming(seglLen)
Noverlap = ceil(ovlpPct/100*seglLen);
,Frangsinusoids thresh];

pmusic(x,P,[],Fs,range,win,Noverlap);

h = spectrum.music(nsinusoids,seglen,...
ovlpPct,winName, thresh);
pseudospectrum(h,x, 'Fs"',fs, 'SpectrumRange’

win = hamming(seglLen)

Noverlap = ceil(ovlpPct/100*seglLen);
,Framnglens NS0 iad fithresh] ;
pmusic(x,P,nfft,Fs, range,win,Noverlap);
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17 Spectrum Object to Function Replacement

Deprecated Syntax

Replacement Syntax

h = spectrum.music(nsinusoids,seglen,...
ovlpPct,winName, thresh);
pseudospectrum(h,x, ..., 'FreqgPoints', 'User
'Frequency Vector', fVec)

win hamming(seglLen)
Noverlap = ceil(ovlpPct/100*seglLen);
PR = nusinusoids threshl];

pmusic(x,P,fVec,Fs, range,win,Noverlap);

h = spectrum.music(
pseudospectrum(...)

..., DataMatrix');

nfft = min(256,2"nextpow2(size(x,1)));
pmusic(x,P,nfft,Fs, range,win)

h = spectrum.music(
pseudospectrum(...)

..., 'CorrelationMatrix'

pmusic(x,P, 'corr',nfft,Fs, range,win,Noverl
% or equivalently
pmusic(x,P,'corr',fVec,Fs, range,win,Noverl

°

h spectrum.music(...);
pseudospectrum(..., 'CenterDC', true)

pmusic(...,'centered');

[Spec,F] = pseudospectrum(...)

[Spec,F] = pmusic(...);
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Vibration Analysis

* “Frequency-RPM Map of Helicopter Vibration Data” on page 18-2
* “Find Ridge of Noisy Signal” on page 18-6

* “Modal Parameters of MIMO System” on page 18-10

* “Compute and Display Order-RPM Map” on page 18-15

» “MIMO Stabilization Diagram” on page 18-18

* “Modal Analysis of Identified Models” on page 18-23



18 Vvibration Analysis

Frequency-RPM Map of Helicopter Vibration Data

18-2

Analyze simulated data from an accelerometer placed in the cockpit of a helicopter.

Load the helicopter data. The vibrational measurements, vib, are sampled at a rate of
500 Hz for 10 seconds. Inspection of the data reveals that it has a linear trend. Remove
the trend to prevent it from degrading the quality of the frequency estimation.

load('helidata.mat')
vib = detrend(vib);

Plot the nonlinear RPM profile. The rotor runs up until it reaches a maximum rotational
speed of about 27,600 revolutions per minute and then coasts down.

plot(t, rpm)
xLlabel('Time (s)')
ylabel('RPM")



Frequency-RPM Map of Helicopter Vibration Data

RFPM
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Compute the frequency-RPM map. Specify a resolution bandwidth of 2.5 Hz.

[map, freq, rpmOut, time] =
Visualize the map.

imagesc(time, freq,map)
ax = gca;

ax.YDir = 'normal’';
xlabel('Time (s)')
ylabel('Frequency (Hz)"')

Time (s)

rpmfregmap(vib, fs,rpm,2.5);

9 10
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18 Vvibration Analysis
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Repeat the computation using a finer resolution bandwidth. Plot the map using the built-
in functionality of rpmfregmap. The gain in frequency resolution comes at the expense of
time resolution.

rpmfregmap(vib, fs,rpm,1.5);
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Frequency-RPM Map of Helicopter Vibration Data

[+ Frequency Map

File Tools

PR RN

200

150

100

Frequency (Hz)

e o W

Frequency Map

RMS Amplitude

RPM (= 13}
nEnhBR

Time (s)

F= 124750 Hz

|RPM = 27588835

[T=5001s
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18 Vvibration Analysis

Find Ridge of Noisy Signal

Create a matrix that resembles a time-frequency matrix with a sharp ridge. Visualize the
matrix in three dimensions.

t 0.05:10;
f 0.2:8;
rv = 1;

= 0:
= 0:

[F,T] = ndgrid(f,t);

S = zeros(size(T));

’

)
S(abs((F-4)-cos((T-6).72))<0.1) = rv;

mesh(T,F,S)
view(-30,60)
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Find Ridge of Noisy Signal

0.5

2

I

Ul

Add noise to the matrix and redisplay the plot.

S = S+rand(size(S))/10;

mesh(T,F,S)
view(-30,60)
xlabel('Time")
ylabel('Frequency"')

10
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18 Vvibration Analysis

Extract the ridge and plot the result.

[fridge,~,lridge] = tfridge(S,f);
rvals = S(lridge);
hold on

plot3(t,fridge, rvals, 'k', 'linewidth',4)
hold off
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Find Ridge of Noisy Signal
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18 Vvibration Analysis

Modal Parameters of MIMO System

18-10

Compute the natural frequencies, the damping ratios, and the mode shapes for a two-
input/three-output system excited by several bursts of random noise. Each burst lasts for
1 second, and there are 2 seconds between the end of each burst and the start of the
next. The data are sampled at 4 kHz.

Load the data file. Plot the input signals and the output signals.

load modaldata

subplot(2,1,1)
plot(Xburst)
title('Input Signals')
subplot(2,1,2)
plot(Yburst)
title('Output Signals')



Modal Parameters of MIMO System
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Compute the frequency-response functions. Specify a rectangular window with length
equal to the burst period and no overlap between adjoining segments.

burstLen = 12000;

[frf,f] = modalfrf(Xburst,Yburst,fs,burstLen);

Visualize a stabilization diagram and return the stable natural frequencies. Specify a

maximum model order of 30 modes.

figure
modalsd(frf,f,fs, '"MaxModes',b30);
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18 Vvibration Analysis

Stabilization Diagram -
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Frequency (kHz)

Zoom in on the plot. The averaged response function has maxima at 373 Hz, 852 Hz, and
1371 Hz, which correspond to the physical frequencies of the system. Save the maxima to
a variable.

phfr [373 852 1371];

Compute the modal parameters using the least-squares complex exponential (LSCE)
algorithm. Specify a model order of 6 modes and specify physical frequencies for the 3
modes determined from the stabilization diagram. The function generates one set of
natural frequencies and damping ratios for each input reference.

[fn,dr,ms,ofrf] modalfit(frf,f,fs,6, 'PhysFreq',phfr);



Modal Parameters of MIMO System

Plot the reconstructed frequency-response functions and compare them to the original
ones.

for k = 1:2
for m = 1:3
subplot(2,3,m+3*(k-1))
plot(f/1000,10*1loglO(abs(frf(:,m,k))))

hold on

plot(f/1000,10*loglO(abs(ofrf(:,m,k))))

hold off

text(1,-50,[['Output ';' Input '] num2str([m k]')])
ylim([-100 -40])

end
end
subplot(2,3,2)
title('Frequency-Response Functions')
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18 Vvibration Analysis
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Compute and Display Order-RPM Map

Compute and Display Order-RPM Map

Generate a signal that consists of two linear chirps and a quadratic chirp, all sampled at
600 Hz for 5 seconds. The system that produces the signal increases its rotational speed
from 10 to 40 revolutions per second during the testing period.

Generate the tachometer readings.

fs = 600;

tl = 5;

t =0:1/fs:t1;
fo = 10;

fl = 40;

rpm = 60*linspace(f0,fl,length(t));

The linear chirps have orders 1 and 2.5. The component with order 1 has twice the
amplitude of the other. The quadratic chirp starts at order 6 and returns to this order at
the end of the measurement. Its amplitude is 0.8. Create the signal using this information.

ol = 1;
02 = 2.5;
06 = 6;

X = 2¥chirp(t,ol*f0,tl,0l1*fl)+chirp(t,02*f0,tl,02*fl) + ...
0.8*chirp(t,06*f0,tl,06*fl, 'quadratic');

Compute the order-RPM map of the signal. Use the peak amplitude at each measurement
cell. Specify a resolution of 0.25 orders. Window the data with a Chebyshev window
whose sidelobe attenuation is 80 dB.

[map,or,rp] = rpmordermap(x,fs,rpm,0.25,
"Amplitude', 'peak', 'Window', {'chebwin',50});

Draw the order-RPM map as a waterfall plot.

[OR,RP] = meshgrid(or,rp);
waterfall(OR,RP,map")
view(-15,45)
xlabel('Order"')
ylabel('RPM")
zlabel('Amplitude"')
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18 Vvibration Analysis

Amplitude

Use the built-in functionality of rpmordermap to display the map. Specify a resolution of
0.2 orders and 80% overlap between adjoining segments.

rpmordermap(x, fs,rpm,0.2, ...
"Amplitude', 'peak’', 'OverlapPercent',80, 'Window', {'chebwin',80})
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See Also

T Order Map EI@

File Tools
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See Also
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18-17



18 Vvibration Analysis

MIMO Stabilization Diagram

18-18

Compute the frequency-response functions for a two-input/two-output system excited by
random noise.

Load the data file. Compute the frequency-response functions using a 5000-sample Hann
window and 50% overlap between adjoining data segments. Specify that the output
measurements are displacements.

load modaldata
winlen = 5000;

[frf,f] = modalfrf(Xrand,Yrand, fs,hann(winlen),0.5*winlen, 'Sensor', 'dis');

Generate a stabilization diagram to identify up to 20 physical modes.

modalsd(frf,f,fs, 'MaxModes"', 20)
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Repeat the computation, but now tighten the criteria for stability. Classify a given pole as
stable in frequency if its natural frequency changes by less than 0.01% as the model order

increases. Classify a given pole as stable in damping if the damping ratio estimate

changes by less than 0.2% as the model order increases.

modalsd(frf,f,fs, '"MaxModes',20, 'SCriteria',[le-4 0.002])
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Stabilization Diagram
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Restrict the frequency range to between 0 and 500 Hz. Relax the stability criteria to 0.5%
for frequency and 10% for damping.

modalsd(frf,f,fs, '"MaxModes"',20, 'SCriteria',[5e-3 0.1], 'FregRange',[0 500])
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Repeat the computation using the least-squares rational function algorithm. Restrict the
frequency range from 100 Hz to 350 Hz and identify up to 10 physical modes.

modalsd(frf,f,fs, '"MaxModes"', 10, 'FreqRange', [100 350], 'FitMethod"', 'lsrf')
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Stabilization Diagram

10 1 2 Stable in frequency
+  Stable in frequency and damping
97 T * Mot stable in frequency .
I Averaged response function
BT Til‘ =
|
7h rr', & :
|
_ | |I )
2 6 o] il
] |l|I I'. |I |
o | ] '.I I| ', -
T 5 / + II.@*II
/ Y / |
= af VAR [
3 '____ - 8 # + !
2r o T N i .--*'f’ + \
1r +
D i i i i
100 150 200 250 300
Frequency (Hz)
See Also

modalfit | modalfrf | modalsd

Related Examples
. “Order Analysis of a Vibration Signal”
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Modal Analysis of Identified Models

Identify state-space models of systems. Use the models to compute frequency-response
functions and modal parameters. This example requires a System Identification Toolbox™
license.

Hammer Excitation

Load a file containing three-input/three-output hammer excitation data sampled at 4 kHz.

Use the first 10° samples for estimation and samples 2x 104 to X 10 for model
quality validation. Specify the sample time as the inverse of the sample rate. Store the
data as @iddata objects.

load modaldata XhammerMISO1l YhammerMISO1l fs

rest = 1:1e4;

rval = 2e4:5e4;

Ts = 1/fs;

Estimation = iddata(YhammerMISOl(rest, :),XhammerMISOl(rest,:),Ts);

Validation = iddata(YhammerMISO1l(rval, :),XhammerMISOl(rval,:),Ts, 'Tstart',6rval(1l)*Ts);

Plot the estimation data and the validation data.

plot(Estimation,Validation)
legend(gca, 'show")
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Amplitude
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Use the ssest function to estimate a 7th-order state-space model of the system that
minimizes the simulation error between the measured outputs and the model outputs.
Specify that the state-space model has feedthrough.

Orders = 7;
opt = ssestOptions('Focus', 'simulation');

sys = ssest(Estimation,Orders, 'Feedthrough',true, 'Ts',Ts,opt);

(To find the model order that gives the best tradeoff between accuracy and complexity, set
Orders to 1:15 in the previous code. ssest outputs a log plot of singular values that lets
you specify the order interactively. The function also recommends a model order of 7.)
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Model Order Selection
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Validate the model quality on the validation dataset. Plot the normalized root mean square
error (NRMSE) measure of goodness-of-fit. The model describes accurately the output
signals of the validation data.

compare(Validation,sys)
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Estimate the frequency-response functions of the model. Display the functions using
modalfrf without output arguments.

[frf,f] = modalfrf(sys);
modalfrf(sys)
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Dynamic Flexibility: Magnitude and Phase
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Assume that the system is well described using three modes. Compute the natural
frequencies, damping ratios, and mode-shape vectors of the three modes.

Modes = 3;
[fn,dr,ms] = modalfit(sys,f,Modes)

fn = 3x1
103 x

0.3727

0.8525
1.3706
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dr = 3x1

0.0008
0.0018
0.0029

ms = 3x3 complex
0.0036 - 0.0019i 0.0039 - 0.00051i 0.0021 + 0.0006i

0.0043 - 0.00231i 0.0010 - 0.00011i -0.0033 - 0.00101
0.0040 - 0.0021i -0.0031 + 0.00041i 0.0011 + 0.00031

Compute and display the reconstructed frequency-response functions. Express the
magnitudes in decibels.

[~,~,~,0ofrf] = modalfit(sys,f,Modes);
clf
for ij = 1:3

for ji = 1:3

subplot(3,3,3*(ij-1)+ji)
plot(f/1000,20*1ogl0(abs(ofrf(:,ji,ij))))
axis tight
title(sprintf('In%d -> Out%d',ij,ji))
if ij==
xlabel('Frequency (kHz)"')
end
end
end
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Controlled Unstable Process

Load a file containing a high modal density frequency-response measurement. The data
corresponds to an unstable process maintained at equilibrium using feedback control.
Store the data as an idfrd object for identification. Plot the Bode diagram.

load HighMOdalDensityData FRF f

G

figure
bodemag (G)

x1im([0.01,2e3])

idfrd(permute(FRF,[2 3 1]1),f,0, 'FrequencyUnit', 'Hz");
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Bode Diagram
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Identify a transfer function with 32 poles and 32 zeros.
sys = tfest(G,32,32);
Compare the frequency response of the model with the measured response.
bodemag (G, sys)

x1im([0.01,2e3])
legend(gca, 'show")

18-30



Modal Analysis of Identified Models
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Extract the natural frequencies and damping ratios of the first 10 least-damped
oscillatory modes. Store the results in a table.

[fn,dr] = modalfit(sys,[],10);
T = table((1:10)',fn,dr, 'VariableNames',{'Mode"', 'Frequency', 'Damping'})

T=10x3 table

Mode Frequency Damping
1 82.764 0.011304
2 85.013 0.015632
3 124.04 0.025252
4 142.04 0.017687
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* “Using Signal Analyzer App” on page 19-2

* “Find Delay Between Correlated Signals” on page 19-24

* “Plot Signals from the Command Line” on page 19-29

* “Resolve Tones by Varying Window Leakage” on page 19-33

* “Resolve Tones by Varying Window Leakage” on page 19-39

* “Analyze Signals with Inherent Time Information” on page 19-41
* “Spectrogram View of Dial Tone Signal” on page 19-44

* “Find Interference Using Persistence Spectrum” on page 19-47
* “Extract Regions of Interest from Whale Song” on page 19-53

* “Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
* “Scalogram of Hyperbolic Chirp” on page 19-65

+ “Extract Voices from Music Signal” on page 19-69

* “Edit Sample Rate and Other Time Information” on page 19-76
» “Data Types Supported by Signal Analyzer” on page 19-81

* “Spectrum Computation in Signal Analyzer” on page 19-84

* “Persistence Spectrum in Signal Analyzer” on page 19-89

* “Spectrogram Computation in Signal Analyzer” on page 19-92

* “Scalogram Computation in Signal Analyzer” on page 19-100

* “Keyboard Shortcuts for Signal Analyzer” on page 19-105

» “Signal Analyzer Tips and Limitations” on page 19-108
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Using Signal Analyzer App

The Signal Analyzer app is an interactive tool for visualizing, measuring, analyzing, and
comparing signals in the time domain, in the frequency domain, and in the time-frequency
domain. The app provides a way to work with many signals of varying durations at the
same time and in the same view.

Start the app by choosing it from the Apps tab on the MATLAB Toolstrip. You can also
start the app by typing signalAnalyzer at the MATLAB command prompt.
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A typical workflow for inspecting and comparing signals using the Signal Analyzer app
is:

1  Select Signals to Analyze on page 19-4 — Select any signal available in the
MATLAB workspace. The app accepts real numeric arrays and signals with inherent

19-2
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time information, such as MATLAB timetables and timeseries objects. See “Data
Types Supported by Signal Analyzer” on page 19-81 for more information.

“Preprocess Signals” on page 19-6 — Lowpass, highpass, bandpass, or bandstop
filter signals. Smooth signals using moving averages, regression, Savitzky-Golay
filters, or other methods. Generate MATLAB functions to automate preprocessing
operations.

* “Duplicate and Rename Signals” on page 19-7

» “Filter Signals” on page 19-8

* “Smooth Signals” on page 19-8

* “Generate MATLAB Scripts and Functions” on page 19-17

Explore Signals on page 19-8 — Add time information to signals using sample
rates, numeric vectors, duration arrays, or MATLAB expressions. Plot, measure,
and compare data, their spectra, their spectrograms, or their scalograms. Look for
features and patterns in the time domain, in the frequency domain, and in the time-
frequency domain. Compute persistence spectra to analyze sporadic signals and
sharpen spectrogram estimates using reassignment. Extract regions of interest from
signals.

* “Plot Signals” on page 19-8

* “Visualize Signal Spectra” on page 19-9

* “Visualize Persistence Spectra” on page 19-10

* “Visualize Signal Spectrograms” on page 19-10

* “Visualize Signal Scalograms” on page 19-11

+ “Edit Time Information and Link Displays in Time” on page 19-13

* “Measure Signal, Spectrum, and Time-Frequency Data” on page 19-14

+ “Extract Signal Regions of Interest” on page 19-15

Share Analysis on page 19-16 — Copy displays from the app to the clipboard as
images. Export signals to the MATLAB workspace or save them to MAT-files.
Generate MATLAB scripts to automate the computation of power spectrum,
spectrogram, or persistence spectrum estimates and the extraction of regions of
interest. Save Signal Analyzer sessions to resume your analysis later or on another
machine.

* “Copy Displays” on page 19-16
» “Export Signals” on page 19-16
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19-4

* “Generate MATLAB Scripts and Functions” on page 19-17
* Save and Load Signal Analyzer Sessions on page 19-18

Select Signals to Analyze

The Signal Analyzer app works with vectors, matrices, MATLAB timetables, or
timeseries objects in the MATLAB workspace. When you start the app, all usable
signals in the workspace appear in the Workspace browser at the bottom-left corner. See
“Data Types Supported by Signal Analyzer” on page 19-81 for more information.

Select Signals from the Workspace Browser

Select signals from the Workspace browser by clicking their names and dragging them to
the Signal table at the top-left corner. To plot a signal, drag it to a display. If you select the
check box next to the name of a signal in the Signal table, the signal is plotted in the
selected display. You can also drag signals directly from the Workspace browser to a
display. The dragged signals are plotted in the display and listed in the Signal table.

Each column of a matrix is treated as an independent signal. For example, a 100-by-3
matrix called sgn appears in the Signal table as three 100-sample signals, sgn(:,1),
sgn(:,2),and sgn(:,3).

There are two different ways to choose signals in the Signal table. Each way gives you
access to a different set of operations.

* Selecting the signal by clicking the Name, Info, Time, or Start Time column in the
Signal table enables you to perform all the operations in the Analyzer tab. You can
change the time information and smooth, filter, or duplicate the signals. It is not
necessary to plot a signal to preprocess it.

* Selecting the check box to the left of the signal name plots the signal in the currently
selected display and enables you to perform all the operations in the Display tab. You
can display the signal in the frequency domain or the time-frequency domain or you
can measure the signal using cursors.

Note If you attempt to import signals with more than 100 columns, the app displays a
warning. The matrix you are trying to import might be the transpose of a multichannel
signal that you want to analyze. In that case, click No in the warning dialog box and
transpose the matrix in the workspace. If you do want to import the columns as separate
signals, click Yes. If you drag the matrix to a display and click Yes in the warning dialog
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box, then the app plots only the first 10 columns of the matrix but imports all the
columns. To plot signal columns beyond the tenth, drag them to the display. Alternatively,
in the Signal table, select the check boxes next to the names of the signals you want to
plot.

If you modify a signal in the MATLAB workspace, the Workspace browser updates
automatically. However, the app will not recognize the changes until you reimport the
signal by dragging it again to the Signal table or to a display.

If you add or remove matrix columns, the app deletes the signals, clears any plots of
them, and creates new signals with the modified matrix dimensions.

Filter Signals in the Signal Table

To help search through a large amount of data in the Signal table, you can filter signals.
The filter criteria can be any text that is contained in the signal name or in other columns.

» To show signals with a given name, enter a search phrase into the Filter Signals text
box. The matches are highlighted in the filter results.

Suppose you have three sig signals, sig01, sig02, and sig03, and three sgn signals,
sgn01, sgn02, and sgn0B3. You can enter sg to show the three sgn signals, or enter 2
to show sig02 and sgn02.

50

g

sgni1
sgn03 sgni2

sgn3

Flotted

ADVANCED »

* You can also filter signals according to their time information. To access this
functionality, click inside the search results box, and then click Advanced. For details
on entering time information, see Edit Sample Rate and Other Time Information on
page 19-76.
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Suppose that you have six signals with these sample times and start times:

Filter Signals
sgni01 ——— Fs:200Hz 0Os
sgni2 —— Fs:250Hz 0Os
sgni3 Fs:200Hz 1s
sig01 ) Fs:200Hz 0Os
sigh2 ——— Fs:250Hz 0s
5igh3 Fs:200Hz 1s

The Advanced menu lets you search signals by Name, Samples, Start Time, or
Time in terms of sample rate or sample time.

If you select the Time option and enter 20, the app finds the four signals sampled at
200 Hz. In the second text box, if you select the Start Time option and enter 0, the
app finds sgn@1 and sig01.

Note The filter matches values as text, not numbers. For instance, if you choose the
Start Time option and enter 00, then the filter does not return any results.

time:20 starttime:0 0s SEARCH BY COLU
Plotted Select columns and enter search terms
sgn01 — Fs:200Hz 0s

Time - 20
sig01 — Fs:200Hz 0s ADVANCED <

Start Time * 0

4

* You can save and store a filter for future use. From the Advanced menu of the search
results box, click Quick Search Settings. Enter a name in the Save Search As box,
and click Save.

Preprocess Signals

You can use the Signal Analyzer app to perform several signal preprocessing tasks. The
different processing options appear in the Analyzer tab:
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|Eea'-:’| & =58
PREPROCESSING OPTIONS

il

Smooth Lowpass Highpass

Eandpass Bandstop

Preprocessing operations, undo operations, and function generation apply to all signals
currently selected in the Signal table. To select signals, click their Name, Info, Time, or
Start Time column in the Signal table.

Note Preprocessing operations overwrite the signal on which they work. If you want to
keep the original signal, duplicate it and operate on the duplicate.

You can perform smoothing and filtering actions any number of times and in any order.

The Info column in the Signal table includes an icon ‘% that indicates if any
preprocessing has been performed on a signal. Clicking on the icon enumerates the
actions and the order in which they were performed. Preprocessing steps can be undone
by clicking Undo Preprocessing on the Analyzer tab or on any tab arising from a
preprocessing action. The steps are undone one at a time, starting with the most recent.

Tip To see a full summary of the preprocessing steps you took, including all settings you
chose, click Generate Function on the Analyzer tab.

Duplicate and Rename Signals

Signal Analyzer enables you to duplicate and rename signals that you can then export
for further analysis.

To duplicate a signal, use the Duplicate button on the Analyzer tab or on any tab arising
from a preprocessing action. Alternatively, right-click the signal in the Signal table and
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19-8

select Duplicate. The duplicate has the same name as the original signal with _copy
appended.

To rename a signal, double click the signal name in the Signal table and change the name.
Alternatively, right-click the signal in the Signal table and select Rename.

Filter Signals

To filter one or more selected signals, on the Analyzer tab, click the Lowpass, Highpass,
Bandpass, or Bandstop icon in the Preprocessing gallery. The app uses the Lowpass,
highpass, bandpass, and bandstop functions to perform the filtering. You can control
the stopband attenuation, the passband frequencies, and the widths of the transition
regions. See the function reference pages for additional information. Filtering does not
support nonuniformly sampled signals.

Smooth Signals

To smooth one or more selected signals, on the Analyzer tab, click the Smooth icon in
the Preprocessing gallery. The app uses the MATLAB function smoothdata to perform
the smoothing. The following smoothing methods are available:

* Moving mean

* Moving median

* (Gaussian

* Linear regression

* Quadratic regression

* Robust linear regression

* Robust quadratic regression
* Savitzky-Golay filtering

Like with filtering, you can undo the smoothing at any time.

Explore Signals

You can use the Signal Analyzer app to perform several tasks that help you explore your
data.

Plot Signals

Select a signal by clicking its name in the Workspace browser or the Signal table. Then
plot your selection by dragging it to a display. This action also selects the check box to the
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left of the signal Name on the Signal table. You can also plot a signal by selecting this
check box. The app displays a set of axes with the time-domain waveform and a Time tab
with options to control the view.

If you drag a matrix from the Workspace browser to a display, the app automatically plots
each column as a separate signal, up to a maximum of 10 columns. The app creates
signals in the Signal table for the remaining columns, but you must drag the additional
signals to the display.

Note Signals with no time information are plotted in units of samples on the x-axis.
Signals with time information are plotted in units of time on the x-axis. To plot several
signals on the same display, ensure that they all have time information or are all in
samples. Otherwise, you get a warning.

View Signals on Multiple Plots

C10]
10

Click Display Grid to create or remove displays.

Move Signals Between Displays

To move a signal from one display to another, click the plotted line or select its name on

its Legend, for example, ® 52107 Click the resulting thicker line and drag it to the target
display.

Visualize Signal Spectra

Use the Signal Analyzer app to analyze signals in the frequency domain. To activate the

frequency-domain view of a signal, click Spectrum @ Vv on the Display tab and select
Spectrum. The app displays a set of axes with the signal spectrum, and a Spectrum tab
with options to control the view.

» Ifthe panner is activated and is zoomed in on a particular region of interest, the
spectrum in the display corresponds to the region of interest, not the whole signal.

* Ifyou zoom in on a region of the signal in the time plot using one of the zoom actions
on the Display tab, the spectrum in the display corresponds to the region of interest,
not the whole signal.

* You cannot zoom out in frequency beyond the Nyquist range.
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» To see a time plot and a spectrum plot of the same signal side-by-side, use different

displays. Drag the signal to two displays. Click Time P\
Display tab to control what is plotted on each display.

or Spectrum E on the

For more information on how Signal Analyzer computes spectra, see “Spectrum
Computation in Signal Analyzer” on page 19-84.

If a signal is nonuniformly sampled, then Signal Analyzer interpolates the signal to a
uniform grid to compute spectral estimates. The app uses linear interpolation and
assumes a sample time equal to the median of the differences between adjacent time
points. For a nonuniformly sampled signal to be supported, the median time interval and
the mean time interval must obey

L < Median time interval <100.

100 Mean time interval

Visualize Persistence Spectra

Use the Signal Analyzer app to visualize the persistence spectrum of a signal: The
persistence spectrum contains time-dependent probabilities of occurrence of signals at
given frequency locations and power levels. This type of spectrum is useful for detecting
brief events.

To activate the persistence spectrum, click Spectrum @ V¥ on the Display tab and
select Persistence Spectrum. The app displays a set of axes with the persistence
spectrum, and a Persistence Spectrum tab with options to control the view. You cannot
zoom out in frequency beyond the Nyquist range.

Note You can plot the persistence spectrum of only one signal per display.

For more information on how Signal Analyzer computes persistence spectra, see
“Persistence Spectrum in Signal Analyzer” on page 19-89.

Visualize Signal Spectrograms
Use the Signal Analyzer app to analyze a signal in the time-frequency domain. To

activate the spectrogram view of a signal, click Time-Frequency M V¥ on the Display
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tab and select Spectrogram. The app displays a set of axes with the signal spectrogram,
and a Spectrogram tab with options to control the view.

Note You can plot the spectrogram of only one signal per display.

» If the panner is activated and is zoomed in on a particular region of interest, the
spectrogram in the display corresponds to the region of interest, not the whole signal.

» If you zoom in on a region of the signal in the time plot using one of the zoom actions
on the Display tab, the spectrogram in the display corresponds to the region of
interest, not the whole signal.

* You cannot zoom out in frequency beyond the Nyquist range.
* To see a time plot and a spectrogram plot of the same signal side-by-side, use different

displays. Drag the signal to two displays. Click Time P\
the Display tab to control what is plotted on each display.

or Time-Frequency M on

For more information on how Signal Analyzer computes spectrograms, see
“Spectrogram Computation in Signal Analyzer” on page 19-92.

The reassignment technique sharpens the time and frequency localization of
spectrograms by reassigning each power spectrum estimate to the location of its center
of energy. If your signal contains well-localized temporal or spectral components, then
this option generates a spectrogram that is easier to read and interpret. To apply
reassignment to a spectrogram, check Reassign in the Spectrogram tab.

If a signal is nonuniformly sampled, then Signal Analyzer interpolates the signal to a
uniform grid to compute spectral estimates. The app uses linear interpolation and
assumes a sample time equal to the median of the differences between adjacent time
points. For a nonuniformly sampled signal to be supported, the median time interval and
the mean time interval must obey

1 < Median time interval <100.

100 Mean time interval

Visualize Signal Scalograms

Use the Signal Analyzer app to visualize the scalogram of a signal. The scalogram is
useful for identifying signals with low-frequency components and for analyzing signals
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whose frequency content changes rapidly with time. You need a Wavelet Toolbox™ license
to use the scalogram view.

To activate the scalogram view of a signal, click Time-Frequency @ V¥ on the Display
tab and select Scalogram. The app displays a set of axes with the signal scalogram and a
Scalogram tab with options to control the view.

Note You can plot the scalogram of only one signal per display.

» If the panner is activated and is zoomed in on a particular region of interest, the
scalogram in the display corresponds to the whole signal, not just the region of
interest. Signal Analyzer performs an optical zooming, using interpolation to display
a smooth curve.

* Ifyou zoom in on a region of the signal in the time plot using one of the zoom actions
on the Display tab, the scalogram in the display corresponds to the whole signal, not
just the region of interest. Signal Analyzer performs an optical zooming, using
interpolation to display a smooth curve.

* To see a time plot and a scalogram plot of the same signal side-by-side, use different
displays. On the Display tab, click Display Grid, create a side-by-side pair of displays,

M\

and drag-and-drop the signal on both displays. Click Time or Time-Frequency

@ on the Display tab to control what is plotted on each display.

Note Scalogram view does not support nonuniformly sampled signals.

For more information on how Signal Analyzer computes scalograms, see “Scalogram
Computation in Signal Analyzer” on page 19-100.

Zoom and Pan Through Signals

The Signal Analyzer app features a panner that enables you to zoom in on and navigate
through signals to see how they change in frequency and time. To activate the panner, on

Vi

the Display tab, click Panner
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The panner renders signals in their entire duration. To select a region of interest, click
the panner and drag to create a zoom window. Use the mouse to resize or slide the zoom
window along the length of the signal.

» If the spectrum of the signal is plotted, it corresponds to the region of interest, not the
whole signal. See “Spectrum Computation in Signal Analyzer” on page 19-84 for
more details.

» If the persistence spectrum of the signal is plotted, it corresponds to the region of
interest, not the whole signal. See “Persistence Spectrum in Signal Analyzer” on page
19-89 for more details.

+ If the spectrogram of the signal is plotted, it corresponds to the region of interest, not
the whole signal. See “Spectrogram Computation in Signal Analyzer” on page 19-92
for more details.

» If the scalogram of the signal is plotted, it corresponds to the whole signal, not the
region of interest. Signal Analyzer performs an optical zooming, using interpolation
to display a smooth curve. See “Scalogram Computation in Signal Analyzer” on page
19-100 for more details.

* You cannot zoom out in frequency beyond the Nyquist range.
Edit Time Information and Link Displays in Time

Use the Signal Analyzer app to add time information to signals. In the Signal table,
select the signals whose time information you want to add or modify. Add time
information to the signals by clicking Time Values in the Analyzer tab.

You can express the time information in terms of a sample rate or sample time, and a start
time. You can also add explicit time values using a numeric vector, a duration array, or a
MATLAB expression. Time values must be unique and cannot be NaN, but they need not
be uniformly spaced. The app derives a sample rate from the time values and displays it in
the Time column of the Signal table. See “Edit Sample Rate and Other Time Information”
on page 19-76 for more details.

Note Filtering and scalogram view do not support nonuniformly sampled signals.

+ If a signal is nonuniformly sampled, then Signal Analyzer interpolates the signal to a
uniform grid to compute spectral estimates. The app uses linear interpolation and
assumes a sample time equal to the median of the differences between adjacent time
points. The derived sample rate in the Signal table has an asterisk to indicate that the
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signal is nonuniformly sampled. For a nonuniformly sampled signal to be supported,
the median time interval and the mean time interval must obey

1 Median time interval <

- . : 100.
100 Mean time interval

Note The interpolation is used only to compute spectral estimates. Time plots are not
resampled.

* You can link display time spans so that plots respond in sync when you pan and zoom
horizontally. The signals in the displays you want to link must contain time
information. To link the time span of a display to those of the displays linked already,
select the display and, on the Display tab, select Link Time. To unlink a display,
select it and clear Link Time.

Note Selecting Link Time links the selected display to the complete collection of
displays that have already been linked.

Displays with linked time spans have the following operations synchronized:

* Panning by selecting and dragging the plot or by using the display panner.

* Zooming in, zooming out, or zooming on the time axis. Zooming in or out on one
display affects only the time axis in the remaining linked displays.

+ Fitting data to view. The app stretches the common time axis so that it shows the
span from the earliest to the latest time among all signals in the linked displays.

+ If the axes of two displays are linked in time, then the time cursors in the displays
are linked.

The time axis of a linked display might update as you add or remove signals.

Note Frequency axes are never linked between displays.

Measure Signal, Spectrum, and Time-Frequency Data

Measure your data using data cursors:
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6

On the Display tab, click Data Cursors ¥ to add one or two data cursors to all the
displays. Time-domain and frequency-domain cursors are not linked and can be
moved independently.

The persistence spectrum, spectrogram, and scalogram views display two-
dimensional crosshair cursors.

To move a data cursor, drag it left, right, up, or down to a point of interest. To move
the cursor sample-by-sample, click the time or frequency field and use the arrow
keys.

You can move a data cursor to a specific point without dragging it. Click the data
cursor time or frequency field and enter a value.

:11 3-75"i'|ﬂ A

If the signal was not sampled at a point of interest, then the app linearly interpolates
the value. If the value is interpolated, an asterisk appears in the data cursor label.

By default, cursors snap to the nearest data point. To change this behavior, clear the
Snap to Data check box on the Display tab.

To toggle the cursors, click Data Cursors.

Extract Signal Regions of Interest

The Signal Analyzer app enables you to extract regions of interest from the signals you
are studying and export them for further analysis. To extract regions of interest, select
the display that has them. On the Display tab, click Extract Signals, or right-click the
display and select Extract Signals

Select Between Time Limits to extract a region of interest defined by the time
limits of the selected display. To change the time limits, you can use the panner, select
one of the zoom actions on the Display tab, or change the limit values on the Display,
Time, Spectrogram, or Scalogram tabs.

Select Between Time Cursors to extract a region of interest defined by the
locations of the time-domain cursors in the selected display.
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» If a signal has time information, you can preserve the start time of the region of
interest by checking Preserve Start Time.

The extracted regions of interest are added at the bottom of the Signal table.

Share Analysis
Copy Displays

You can share the plots that you have produced using the Signal Analyzer app by
copying one or more displays to the clipboard as images and pasting them into another
application.

To copy displays to the clipboard, on the Display tab, click Copy All Displays V. You can
then copy either the selected display or the complete display layout.

To copy a single display to the clipboard, you can also right-click the display and select
Copy Display.

Export Signals

You can export any signals in the Signal Analyzer Signal table to the MATLAB
workspace or to a MAT-file.

To export signals:
Select one or more signals from the Signal table.

On the Analyzer tab, click Export i, Export,

3 Choose whether you want to export the selected signals to the MATLAB workspace or
save them to a MAT-file. If you choose to save the signals, browse to where you want
to save the file, name the file, and click Save.

You can also select the signals, right-click, and select Export.
Signals are exported differently, depending on their type:

+ Signals with no time information are exported or saved as numeric vectors.
» Signals stored as timetables are exported or saved as timetables.

» Signals that have time information but are not stored as timetables are exported or
saved as numeric vectors. If you want to preserve the time information, you can save
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the signals as timetables. On the Analyzer tab, click Preferences and check Always
use timetables when signals have time information.

Generate MATLAB Scripts and Functions

You can generate MATLAB scripts to extract signal regions of interest or automate the
computation of power spectrum, persistence spectrum, spectrogram, or scalogram
estimates obtained with the Signal Analyzer app.

To generate a MATLAB script, on the Display tab, click Generate Script. The generated
script opens in the Editor.

Select ROI Script Between Time Limits to generate a MATLAB script that
extracts a region of interest defined by the time limits of the selected display.
Depending on the preferences, the regions of interest are saved as numeric vectors or
as a timetable.

Select ROI Script Between Time Cursors to generate a MATLAB script that
extracts a region of interest defined by the locations of the time-domain cursors in the
selected display. Depending on the preferences, the regions of interest are saved as
numeric vectors or as a timetable.

Select Spectrum Script to generate a MATLAB script that computes the power
spectrum appearing in the spectrum view of the selected display, including all current
settings.

Select Persistence Spectrum Script to generate a MATLAB script that computes
the persistence spectrum appearing in the spectrum view of the selected display,
including all current settings.

Select Spectrogram Script to generate a MATLAB script that computes the
spectrogram appearing in the spectrogram view of the selected display, including all
current settings.

Select Scalogram Script to generate a MATLAB script that computes the
scalogram appearing in the scalogram view of the selected display, including all
current settings. You need a Wavelet Toolbox license to use the scalogram view.

You can generate MATLAB functions to automate signal preprocessing steps performed
with the Signal Analyzer app.

To generate a MATLAB preprocessing function, on the Analyzer tab, click Generate
Function. The generated function opens in the Editor.
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Save and Load Signal Analyzer Sessions

If you want to share session snapshots or archive them to view later, save the Signal
Analyzer session to a MAT-file or MLDATX-file. Using MLDATX-files results in faster save
and load times.

To save a session to a MAT-File or MLDATX-File:

1 On the Analyzer tab, click Save ¥ and select Save.

2  Browse to where you want to save the file, name the file, choose the format, and click
Save.

If you want to update the file, click Save. If you want to save the session to a different file,
click Save V¥ and select Save as.

To load a saved session:

On the Analyzer tab, click Open.

2 Browse to the MAT-file or MLDATX-file saved from a previous session, select it, and
click Open. The signal data and properties appear as they were when the file was
last saved.

To start a new session, on the Analyzer tab, click New.

Customize Signal Analyzer
Specify Line Color and Style

To specify the line style and color, click in the Line column of a signal. If the line column

is not shown, add the column using the column selector button **. Select a color from the
palette and a line style. Click Custom to choose custom colors for your signals. You can
specify custom colors as RGB triplets or as hexadecimal codes.
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Filter Signals

sgni1
sgni02
sgn03

5ig01
sig02

Moot | | |

gna 02 I

gna 03 —

Add or Remove Columns in the Signal Table

Columns in the Signal table display the plot configuration and signal properties. To add or

remove a column, click the column selector button **. From the list, select the columns
that you want to display and click OK. After you select a column, the new column is added
to the table in the order that it appears in the column selection list.
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gnalz2

gnal3

Modify Signal Analyzer Displays

Filter Signals

- - FO_|TME « Line s
sgnd1 — Fs: 200« Info

_ | Time
Sgn02 Fs:250 "' Start Time
sqni3 Fs: 200 Samples -
GigO1  e— e=- 200 I
sig02 F— Fs: 250 Hz 0s
sig03 5. 200 Hz 0s

:m----

Goal

Action

Hide the Workspace browser or the Signal
table to enlarge the display area.

On the Analyzer tab, click one of the layout
buttons.

]

Signal
Table

]

Workspace
Browser

Zoom and pan to inspect the data.

On the Display tab, select one of the zoom
actions.

Alternatively, activate the panner by

i

clicking Panner
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Goal

Action

Fit spectrogram, scalogram, or persistence
spectrum colormap to current power or
density limits.

On the Display tab, click the Fit Colormap
button M.

Set the minimum and maximum values of
the plot axes.

On the Time, Spectrum, Persistence
Spectrum, Spectrogram, or Scalogram
tab, enter the axes limit values. You can
also change the minimum and maximum
time values on the Display tab.

Units: |5 -

Min: | -3.270418217
Min: | 6.136039526

Max: 3904530995
Max: | 1.669256407e+1

When setting axes for a display, you can
specify time or frequency units before
specifying limit values. Several engineering
units are available:

Quantity Units

Time ps, 1ns, ps, ms,
seconds, minutes,
hours, days, years

Frequency cycles/year, cycles/

day, cycles/hour,
cycles/minute, mHz,
Hz, kHz, MHz, GHz,
THz

Note Selecting different time or frequency
units for axes limit values does not change
any plots.
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Goal

Action

Show or hide legends identifying plotted
signals.

o
On the Display tab, click Legend l==],

Each display gets its own legend. The
legends appear either at the top of the
display or to the right of the display.

Link or unlink a display.

Select a display. On the Display tab, select
Link Time. Link Time is enabled only
when there are two or more displays and at
least one signal contains time information.

To unlink a display, select it and clear Link
Time.

Frequency axes are never linked between
displays.

Normalize the data for each signal from 0
to 1 along the y-axis of a time plot.

On the Time tab, select Normalize Y Axis.

Show markers at each sample point in a
time plot of a signal.

On the Time tab, select Show Markers.

Signal Analyzer Preferences

» Ifyou export or save signals that have time information but are not stored as
timetables, the time information by default is not saved. If you want to preserve the
time information by saving the signals as timetables, on the Analyzer tab, click
Preferences and check Always use timetables when signals have time

information.

» Ifyou generate scripts involving signals that have time information but are not stored
as timetables, the time information by default is not saved. If you want to preserve the
time information by generating scripts that treat signals as timetables, on the
Analyzer tab, click Preferences and check Always use timetables when

signals have time information.

See Also
Signal Analyzer
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Related Examples

“Find Delay Between Correlated Signals” on page 19-24

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108
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Find Delay Between Correlated Signals

Three sensors at different locations measure vibrations caused by a car as it crosses a
bridge. The signals they produce arrive at the analysis station at different times. The
sample rate is 11,025 Hz. Use the Signal Analyzer app to determine the delays between
the signals.

Load the signals into the MATLAB workspace and start the app. The name of each signal
includes the number of the sensor that took it. Create three displays. Drag each signal
from the Workspace browser to its own display. The signal from Sensor 2 arrives earlier
than the signal from Sensor 1. The signal from Sensor 1 arrives earlier than the signal
from Sensor 3.

load sensorData
signalAnalyzer
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Add time information. Select the three signals in the Signal table and click the Time
Values button on the Analyzer tab. Select the Sample Rate and Start Time option
and enter the sample rate of 11,025 Hz. For more information, see “Edit Sample Rate and
Other Time Information” on page 19-76.

The signals share a common time axis. Link their time spans by selecting each display and
selecting Link Time on the Display tab.

To estimate the delays between the signals, pan them horizontally and line up a salient
feature to the end of the time axis. From the Time tab, read the time from the lower limit
of the time-axis. Choose a region where the signal-to-noise ratio is high, such as the signal
maximum toward the end of each signal. In the signal from Sensor 2, that feature occurs
about 0.197 second after the clock starts.
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Similarly, the signal from Sensor 1 has that feature about 0.229 second after the start,
and the signal from Sensor 3 has it about 0.243 second after the start. Thus, the delays
are approximately 0.032 second and 0.014 second long.

You can also use data cursors to find the delays. Press the space bar to reset the view. On
the Display tab, click the arrow under the Data Cursors ¥ and select Two. Place a
cursor on the maximum of each of the top two signals. You can read the lag of
approximately 0.032 second directly from the app.
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Similarly, the lag between the top and bottom signals is 0.014 second.

You can get similar results with the finddelay and xcorr functions.

See Also

Apps
Signal Analyzer

Functions
alignsignals | finddelay | xcorr
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Related Examples

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69
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“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
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“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108



Plot Signals from the Command Line

Plot Signals from the Command Line

You can plot signals in the Signal Analyzer app by calling the app in the command line.

Create a three-channel random signal sampled for 1 second at 1 kHz. Plot the signal in
Signal Analyzer.

signalAnalyzer(randn(1000,3), 'SampleRate', 1e3)
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Use Display Grid on the Display tab to open an empty display. Select the new

display and click Spectrum E. Create a two-channel sinusoidal signal sampled for 1
second at 100 Hz. The sinusoids have frequencies of 5 Hz and 7 Hz. Plot the signal in the
new display.

signalAnalyzer(sin(2*pi*[5 7].*(0:100)'/100), 'SampleRate',100)
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Select the display with the three random signals. Remove the random signals from the

display by clearing the check boxes next to their names. Click Time-Frequency .
Create a quadratic chirp sampled for 5 seconds at 600 Hz. The chirp has an initial
frequency of 60 Hz that increases to 240 Hz by the end of the measurement. Plot the
chirp.

signalAnalyzer(chirp(0:1/600:5,60,5,240, 'quadratic'), 'SampleRate',600)
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See Also

Apps
Signal Analyzer

Functions
chirp

Related Examples

. “Find Delay Between Correlated Signals” on page 19-24

. “Resolve Tones by Varying Window Leakage” on page 19-33

. “Analyze Signals with Inherent Time Information” on page 19-41
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“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69
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Resolve Tones by Varying Window Leakage

Resolve Tones by Varying Window Leakage

You can adjust the spectral leakage of the analysis window to resolve sinusoids in Signal
Analyzer.

Generate a two-channel signal sampled at 100 Hz for 2 seconds.

1 The first channel consists of a 20 Hz tone and a 21 Hz tone. Both tones have unit
amplitude.

2 The second channel also has two tones. One tone has unit amplitude and a frequency
of 20 Hz. The other tone has an amplitude of 1/100 and a frequency of 30 Hz.

fs = 100;

t

(0:1/fs:2-1/fs)';

X

sin(2*pi*[20 20].*t)+[1 1/100].*sin(2*pi*[21 30].*t);

Embed the signal in white noise. Specify a signal-to-noise ratio of 40 dB. Open Signal
Analyzer and plot the signal.

X = x+randn(size(x)).*std(x)/db2mag(40);

signalAnalyzer(x, 'SampleRate', fs)

Click Spectrum @ to add spectral plots to the display. Click the Spectrum tab that
appears.
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The slider that controls the spectral leakage is in the middle position, corresponding to a
resolution bandwidth of about 1.29 Hz. The two tones in the first channel are not
resolved. The 30 Hz tone in the second channel is visible, despite being much weaker

than the other one.

Increase the leakage so that the resolution bandwidth is approximately 0.84 Hz. The weak

tone in the second channel is clearly resolved.
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Move the slider to the maximum value. The resolution bandwidth is approximately 0.5 Hz.
The two tones in the first channel are resolved. The weak tone in the second channel is
masked by the large window sidelobes.
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Click the Display tab. Use the horizontal zoom to magnify the frequency axis. Add
frequency-domain cursors to estimate the frequencies of the tones.
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. “Find Delay Between Correlated Signals” on page 19-24

. “Plot Signals from the Command Line” on page 19-29

. “Analyze Signals with Inherent Time Information” on page 19-41
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Resolve Tones by Varying Window Leakage
Go back to example on page 19-33
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Analyze Signals with Inherent Time Information

Analyze Signals with Inherent Time Information

Load a file that contains measurements of the international normalized ratio (INR)
performed on a patient over a five-year period. The INR measures the effect of warfarin, a
blood thinner used to treat people predisposed to clotting.

The file includes a datetime array with the date and time of each measurement, and a
vector of INR readings. Display the first five time points.

load INR
Date(1:5)

ans = 5x1 datetime array
05/15/09 11:28 AM
06/16/09 09:05 AM
07/02/09 09:50 AM
07/16/09 11:20 AM
07/31/09 12:05 PM

Convert the time readings to a duration array by subtracting the first time point.
Convert the duration array to seconds.

t
S

Date-Date(1);
seconds(t);

Create a timetable with the duration array and the INR readings.

TT = timetable(t,INR);

Create a timeseries object with the time in seconds and the INR readings.
ts = timeseries(INR,s, 'Name', 'inr');

Open Signal Analyzer. Under Display Grid, select three displays.

Drag the timetable to the first display. The app calls this signal TT. INR.
Drag the timeseries object to the second display. The app calls this signal ts.inr.

Drag the array of INR readings to the third display. Add time information. Select the
signal by clicking its legend. From the Analyzer tab, click Time Values. Select the
Time Values option and in the Time Values field, enter t.
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Related Examples

. “Find Delay Between Correlated Signals” on page 19-24
. “Plot Signals from the Command Line” on page 19-29
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Spectrogram View of Dial Tone Signal

19-44

Create a signal, sampled at 4 kHz, that resembles dialing all the keys of a digital
telephone. Save the signal as a MATLAB® timetable.

fs = 4e3;
t =0:1/fs:0.5-1/Fs;

[697 770 852 941];
[1209 1336 1477];

ver
hor

[1;

tones

for k = 1l:length(ver)
for 1 = 1l:length(hor)
tone = sum(sin(2*pi*[ver(k);hor(l)].*t))"';
tones = [tones;tone;zeros(size(tone))];
end
end

% To hear, type soundsc(tones,fs)
S = timetable(seconds(0:length(tones)-1)'/fs,tones);

Open Signal Analyzer and drag the timetable to a display. Click Time-Frequency to add
a spectrogram view. On the Spectrogram tab, under Time Resolution, select Specify.
Enter a time resolution of 0.5 second and zero overlap between adjoining segments.
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The spectrogram view shows that each key is dialed for half a second, with half-second
silent pauses between keys. The first tone has its frequency content concentrated around
697 Hz and 1209 Hz, corresponding to the digit '1' in the DTMF standard.
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Find Interference Using Persistence Spectrum

Find Interference Using Persistence Spectrum

Visualize an interference narrowband signal embedded within a broadband signal.

Generate a chirp sampled at 1 kHz for 500 seconds. The frequency of the chirp increases
from 180 Hz to 220 Hz during the measurement.

fs = 1000;
t (0:1/fs:500)"';
X chirp(t,180,t(end),220) + 0.15*randn(size(t));

The signal also contains a 210 Hz sinusoid. The sinusoid has an amplitude of 0.05 and is
present only for 1/6 of the total signal duration.

idx = floor(length(x)/6);
x(1l:idx) = x(1l:idx) + 0.05*cos(2*pi*t(1:idx)*210);

Save the signal as a MATLAB® timetable.
S = timetable(seconds(t),x);

Open Signal Analyzer and drag the timetable from the Workspace browser to a display.
Click the Time-Frequency button to add a spectrogram view. On the Spectrogram tab,
under Time Resolution, select Specify and enter a time resolution of 1 second. Set the
Frequency Limits to 100 Hz and 290 Hz. Both signal components are visible.
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Go back to the Display tab. Click the Time button to remove the time view and click the
Spectrum button to add a power spectrum view. The frequency range continues to be
from 100 Hz to 290 Hz. The weak sinusoid is obscured by the chirp.
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Click the Spectrum V¥ button to change the Spectrum view to a Persistence
Spectrum view. On the Persistence Spectrum tab, under Time Resolution, select
Specify and enter a time resolution of 1 second. Specify zero overlap between adjoining
segments. Set the Power Limits to -50 dB and 0 dB and the Density Limits to 0.1 and 4.
Now both signal components are clearly visible.
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On the Display tab, under Share, click Generate Script ¥ and select Persistence
Spectrum Script. The script appears in the MATLAB Editor.

% Compute persistence spectrum

enerated by MATLAB(R) 9.3 and Signal Processing Toolbox 7.5.
enerated on: 15-Jul-2017 18:43:37

% Parameters

timeLimits = seconds([0 500]); %
frequencyLimits = [100 290]; % Hz
timeResolution = 1; % seconds
overlapPercent = 0;

seconds

Index into signal time region of interest
S x ROI = S(:,'x");
S x S x ROI(timerange(timeLimits(1l),timeLimits(2)),1);

)

o

—
1}
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Compute spectral estimate
Run the function call below without output arguments to plot the results
P,F,PWR] = pspectrum(S x ROI,

'persistence’,

'FrequencyLimits', frequencyLimits,
'TimeResolution',timeResolution,
'OverlapPercent',overlapPercent);
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Extract Regions of Interest from Whale Song

Extract Regions of Interest from Whale Song

Load a file that contains audio data from a Pacific blue whale, sampled at 4 kHz. The file
is from the library of animal vocalizations maintained by the Cornell University
Bioacoustics Research Program. The time scale in the data is compressed by a factor of
10 to raise the pitch and make the calls more audible. Convert the signal to a MATLAB®
timetable.

whaleFile = fullfile(matlabroot, 'examples', 'matlab', 'bluewhale.au');
[w,fs] = audioread(whaleFile);

whale = timetable(seconds((0:length(w)-1)"'/fs),w);
% To hear, type soundsc(w,fs)

Open Signal Analyzer and drag the timetable to a display. Four features stand out from
the noise. The first is known as a trill, and the other three are known as moans.
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On the Display tab, click Spectrum to open a spectrum view and click Panner to
activate the panner. Use the panner to create a zoom window with a width of about 2
seconds. Drag the zoom window so that it is centered on the trill. The spectrum shows a
noticeable peak at around 900 Hz.
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Extract the three moans to compare their spectra:

1  Center the panner zoom window on the first moan. The spectrum has eight clearly

defined peaks, located very close to multiples of 170 Hz. Click Extract Signals ¥ and
select Between Time Limits.

2  Click Panner to hide the panner. Press the space bar to see the full signal. Click
Zoom in X and zoom in on a 2-second interval of the time view centered on the
second moan. The spectrum again has peaks at multiples of 170 Hz. Click Extract
Signals ¥ and select Between Time Limits.

3  Press the space bar to see the full signal. Click Data Cursors ¥ and select Two. Place
the time-domain cursors in a 2-second interval around the third moan. Again, there

are peaks at multiples of 170 Hz. Click Extract Signals ¥ and select Between Time
Cursors.
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Remove the original signal from the display by clearing the check box next to its name in
the Signal table. Display the three regions of interest you just extracted. Their spectra lie
approximately on top of each other. Move the frequency-domain cursors to the locations

of the first and third spectral peaks. Asterisks in cursor labels indicate interpolated signal
values.
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. “Find Delay Between Correlated Signals” on page 19-24
. “Plot Signals from the Command Line” on page 19-29

19-57



19 Signal Analyzer App

19-58

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108



Find and Track Ridges Using Reassigned Spectrogram

Find and Track Ridges Using Reassigned Spectrogram

Load a datafile containing an echolocation pulse emitted by a big brown bat (Eptesicus
fuscus) and measured with a sampling interval of 7 microseconds. Create a MATLAB®
timetable using the signal and the time information.

load batsignal

t = (0:length(batsignal)-1)*DT;
sg = timetable(seconds(t) ', batsignal);

Open Signal Analyzer and drag the timetable from the Workspace browser to the Signal
table. Click Display Grid V¥ to create two side-by-side displays. Select each display and
click the Time-Frequency button to add a spectrogram view.

Drag the timetable to both displays.
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Select the Spectrogram tab. On the display at right, check Reassign. For each display:

* Set the time resolution to 280 microseconds and specify 85% overlap between
adjoining segments.

* Use the Leakage slider to increase the leakage until the RBW is about 4.5 kHz.
* Set the power limits to -45 dB and -20 dB.

The reassigned spectrogram clearly shows three time-frequency ridges. To track the
ridges, select the display at right. On the Display tab, click Generate Script and select
Spectrogram Script. The script appears in the Editor.

% Compute spectrogram
%

enerated by MATLAB(R) 9.3 and Signal Processing Toolbox 7.5.

G
Generated on: 13-Jul-2017 19:32:31

)
©
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% Parameters
timeLimits = seconds([3.805177e-06 0.002796805]); % seconds
frequencyLimits = [0 71428.57]; % Hz

leakage = 0.9;

timeResolution = 0.00028; % seconds

overlapPercent = 85;
reassignfFlag = true;

% Index into signal time region of interest
sg _batsignal ROI sg(:, 'batsignal');
sg _batsignal ROI sg batsignal ROI(timerange(timeLimits(1l),timeLimits(2)),1);

% Compute spectral estimate
% Run the function call below without output arguments to plot the results
[P,F,T] = pspectrum(sg batsignal ROI,

'spectrogram',

'FrequencyLimits', frequencyLimits,

'Leakage', leakage,

'TimeResolution',timeResolution,

'OverlapPercent',overlapPercent,

'Reassign', reassignFlag);

Run the script. Plot the reassigned spectrogram.

mesh(seconds(T),F,P)
xlabel('Time")
ylabel('Frequency")
axis tight

view(2)

colormap pink
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Frequency

0.5 1 15 2 25
Time « 1072

Use the tfridge function to track the ridges.
[fridge,~,lridge] = tfridge(P,F,0.01, 'NumRidges',3, 'NumFrequencyBins',10);
hold on

plot3(seconds(T),fridge,P(lridge),': "', 'linewidth',3)
hold off
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Frequency

0.5 1 15 2 25
Time « 1072

Thanks to Curtis Condon, Ken White, and Al Feng of the Beckman Center at the
University of Illinois for the bat data and permission to use it in this example.

See Also

Apps
Signal Analyzer

Functions
pspectrum | tfridge | timetable
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Related Examples

“Find Delay Between Correlated Signals” on page 19-24

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33
“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108



Scalogram of Hyperbolic Chirp

Scalogram of Hyperbolic Chirp

Use Signal Analyzer to display a hyperbolic chirp and its scalogram. This example
requires a Wavelet Toolbox license.

Generate a signal sampled at 1 kHz for 1 second. The signal consists of two hyperbolic

chirps. One of the chirps is active between 0.1 second and 0.68 second. The other chirp
has twice the amplitude and one-third of the instantaneous frequency of the first chirp.

The second chirp is active between 0.1 second and 0.75 second.

n
t

1000;
(0:n-1)/n;

ff = [1 2]1*(sin(pi*[15 5]'./(t-0.8001)).*(t>0.1 & t<[0.68 0.75]'));

The chirp is modulated by an envelope that starts at 0.1 second and is nonzero for 0.7
second.

envl = zeros(size(t));

M= 0.7*%n;

envl(n/10+(1:M)) = tukeywin(M,0.8);

nw = ff.*envl;

Display the signal in Signal Analyzer. Click Time-Frequency M V¥ on the Display tab

and select Scalogram.

signalAnalyzer(nw, 'TimeValues',t)
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On the Scalogram tab, set the Voices Per Octave to the maximum possible value. Set
the lower magnitude limit to 0.5.
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See Also

Apps
Signal Analyzer

Functions
cwt | cwtfilterbank | pspectrum

Related Examples

. “Find Delay Between Correlated Signals” on page 19-24
. “Plot Signals from the Command Line” on page 19-29
. “Resolve Tones by Varying Window Leakage” on page 19-33
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“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108



Extract Voices from Music Signal

Extract Voices from Music Signal

Implement a basic digital music synthesizer and use it to play a traditional song in a
three-voice arrangement. Specify a sample rate of 2 kHz. Save the song as a MATLAB®
timetable.

fs = 2e3;
t 0:1/fs:0.3-1/fs;

[0 130.81 146.83 164.81 174.61 196.00 220 246.94];
[0 261.63 293.66 329.63 349.23 392.00 440 493.88];
[0 523.25 587.33 659.25 698.46 783.99 880 987.77];

1
m
h
note = @(f,g) [1 1 1]*sin(2*pi*[1(g) m(g) h(f)]"'.*t);

[ L | I

(o]

mel

g
3
acc 3

w w

33022203550
03320223055

w w
w w
w w

2123 2 5 212
0503 0 0 050

[
[
song = []
for Kkj

[1;
= 1:length(mel)
song = [

song note(mel(kj),acc(kj)) zeros(1l,0.01*fs)];
end
song = song'/(max(abs(song))+0.1);

% To hear, type sound(song,fs)
tune = timetable(seconds((0:1length(song)-1)'/fs),song);

Open Signal Analyzer and drag the timetable from the Workspace browser to the Signal
table. Click Display Grid V¥ to create a two-by-two grid of displays. Select the top two
displays and the lower left display and click the Spectrum button to add a spectrum view.
Select the lower right display, click Time-Frequency to add a spectrogram view, and
click Time to remove the time view. Drag the song to all four displays. Select the lower
right display, and in the Spectrogram tab, specify a time resolution of 0.31 second (310

ms) and 0% overlap between adjoining segments. Set the Power Limits to —50 4B and
—10 4B,
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On the Analyzer tab, click Duplicate three times to create three copies of the song.
Rename the copies as high, medium, and low by double-clicking the Name column in the
Signal table. Move the copies to the top two and lower left displays.
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Preprocess the duplicate signals using filters.

1

Select the high signal by clicking its name in the Signal table. On the Analyzer tab,
click Highpass. On the Highpass tab that appears, enter a passband frequency of
450 Hz and increase the steepness to 0.95. Click Highpass.

Select the medium signal by clicking its name in the Signal table. On the Analyzer
tab, click Preprocessing ¥ and select Bandpass. On the Bandpass tab that
appears, enter 230 Hz and 450 Hz as the lower and upper passband frequencies,
respectively. Increase the steepness to 0.95. Click Bandpass.

Select the low signal by clicking its name in the Signal table. On the Analyzer tab,
click Lowpass. On the Lowpass tab that appears, enter a passhand frequency of 230
Hz and increase the steepness to 0.95. Click Lowpass.
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On each of the three displays containing filtered signals:

Remove the original signal by clearing the check box next to its name.

On the Display tab, click Time-Frequency to add a spectrogram view and click
Time to remove the time view.

3 On the Spectrogram tab, specify a time resolution of 0.31 second and 0% overlap

between adjoining segments. Set the Power Limits to —30 gB and —10 ¢B.
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Select the three filtered signals by clicking their Name column in the Signal table. On the
Analyzer tab, click Export and save the signals to a MAT-file called music.mat. In
MATLAB, load the file to the workspace. Plot the spectra of the three signals.

load music

pspectrum(low)
hold on
pspectrum(medium)
pspectrum(high)
hold off
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Fower Spectrum (dB)

0 01 02 03 04 05 06 07 08 09 1
Frequency (kHz)

% To hear the different voices, type
% sound(low.Varl,fs), pause(5), sound(medium.Varl,fs), pause(5), sound(high.Varl,fs)

See Also

Apps
Signal Analyzer

Functions
bandpass | bandstop | highpass | Llowpass | pspectrum
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Related Examples

“Find Delay Between Correlated Signals” on page 19-24

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108
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Edit Sample Rate and Other Time Information

19-76

You can add and edit the time information in the Signal Analyzer app for any signal that
isnot a timetable or a timeseries object. Select one or more signals with no inherent
time information in the Signal table and on the Analyzer tab, click Time Values.

Note Select a signal in the Signal table by clicking its Name column. The complete row
is highlighted, indicating that the signal is selected. The check box next to the name of
the signal indicates whether or not the signal is plotted in the active display.

In the Time Values dialog box, select a Time Specification option.

Time Specification Option

Description

Work in Samples (default)

This option enables you to explore signals
without the need to specify a sample rate or
a sample time. It is equivalent to plotting
the signal in MATLAB without x-axis
information.

Sample Rate and Start Time

Use this option when you know the rate at
which the signal has been sampled. Specify
the sample rate and the instant
corresponding to the first sample.

The Sample Rate can be expressed in Hz,
kHz, MHz, or GHz.

The Start Time can be expressed in
seconds, years, days, hours, minutes,
milliseconds, microseconds, or
nanoseconds.

Set the sample rate so that the signal is
plotted in units of time on a display.




Edit Sample Rate and Other Time Information

Time Specification Option

Description

Sample Time and Start Time

Use this option when you know the time
interval between samples. Specify the
sample time and the instant corresponding
to the first sample.

The Sample Time and Start Time each
can be expressed in seconds, years, days,
hours, minutes, milliseconds, microseconds,
or nanoseconds.

Set the sample time so that the signal is
plotted in units of time on a display.
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Time Specification Option

Description

Time Values

Use this option when you know the time
value corresponding to each sample.
Specify the time values using a variable
name or a MATLAB expression.

The Time Values can be stored in a
numeric vector with real time values
expressed in seconds. The values must be
unique and cannot be NaN, but they need
not be uniformly spaced. The vector must
have the same length as the signal.

The time values can also be stored in a
duration array. The values must be unique
and cannot be NaN, but they need not be
uniformly spaced. The array must have the
same length as the signal.

The time values can also be entered as a
MATLAB expression. The expression must
specify an array with the same length as
the signal. The values must be unique and
cannot be NaN, but they need not be
uniformly spaced. Valid examples include:

* (0:length(s)-1)'/Fs, where s is the
signal and Fs is a scalar in the
workspace representing a sample rate.

o linspace(2,2.5,length(s))"',
where s is the signal.

* minutes(0:15)"', equivalent to taking
measurements every minute for 15
minutes.

e [0:10 20:30], equivalent to taking
two sets of measurements at 1 Hz with a
long pause between the sets.

In all cases, the app derives a sample rate
from the time values and displays it in the




Edit Sample Rate and Other Time Information

Time Specification Option Description

Time column of the Signal table. An
asterisk preceding the sample rate
indicates that the signal is nonuniformly
sampled.

Note Signals with no time information are plotted in units of samples on the x-axis.
Signals with time information are plotted in units of time on the x-axis. To plot several
signals on the same display, ensure that they all have time information or are all in
samples. Otherwise, you get a warning:

Warning

Cannot combine signals with and without time

information in the same display.

+ If a signal has missing or duplicate time points, you can fix it using the tips in “Clean
Timetable with Missing, Duplicate, or Nonuniform Times” (MATLAB).

+ If a signal is nonuniformly sampled, then Signal Analyzer interpolates the signal to a
uniform grid to compute spectral estimates. The app uses linear interpolation and
assumes a sample time equal to the median difference between adjacent time points.
The derived sample rate in the Signal table has an asterisk to indicate that the signal
is nonuniformly sampled.

Note The interpolation is used only to compute spectral estimates. Time plots are not
resampled.

For a nonuniformly sampled signal to be supported, the median time interval and the
mean time interval must obey
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ﬁ Mean time interval

1 Median time interval <100.

Filtering and scalogram view do not support nonuniformly sampled signals.

See Also
Signal Analyzer

Related Examples

“Find Delay Between Correlated Signals” on page 19-24

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108



Data Types Supported by Signal Analyzer

Data Types Supported by Signal Analyzer

Numeric Data

Real numeric vectors and matrices with finite elements are supported.
Example: cos(pi./[4;2]1*(0:159)) '+randn(160,2) is a two-channel signal
consisting of sinusoids embedded in white noise.

Scalars, empty arrays, multidimensional arrays, and the ans variable are not
supported.

MATLAB Timetables

Timetables with one or more variables are supported. Each variable can be a vector or
a matrix. Signal Analyzer supports timetable inputs only when the time values are
increasing and finite. If a signal has missing, nonfinite, or duplicate time points, you
can fix it using the tips in “Clean Timetable with Missing, Duplicate, or Nonuniform
Times” (MATLAB).

Example: timetable(seconds(0:4)',rand(5,2)) and
timetable(seconds(0:4)',rand(5,1),rand(5,1)) both specify a two-channel
random variable sampled at 1 Hz for 4 seconds.

Empty timetables and timetables with row times specified as datetime arrays are not
supported.

Tip To analyze timetables with time values stored as a datetime array, convert the array
to a duration array by subtracting the first time point, and then convert the duration
array to seconds. See “Analyze Signals with Inherent Time Information” on page 19-41 for
an example.

timeseries Objects

Single-channel and multichannel timeseries objects are supported. To be supported,
a timeseries object must have its DataInfo.Interpolation property set to
‘linear'. Use the timeseries.setinterpmethod method to change the property.

Example: timeseries(rand(5,2)) and timeseries(rand(5,2),0:4) both
specify a two-channel random variable sampled at 1 Hz for 4 seconds.
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+ Empty timeseries objects, timeseries objects with time vectors specified as date
strings, and timeseries objects whose Name property is not a valid MATLAB variable
name are not supported. See isvarname for more information on valid variable
names..

Nonuniformly Sampled Signals

» Filtering and scalogram view do not support nonuniformly sampled signals.

» If a signal is nonuniformly sampled, then Signal Analyzer interpolates the signal to a
uniform grid to compute spectral estimates. The app uses linear interpolation and
assumes a sample time equal to the median difference between adjacent time points.
The derived sample rate in the Signal table has an asterisk to indicate that the signal
is nonuniformly sampled. For a nonuniformly sampled signal to be supported, the
median time interval and the mean time interval must obey

1 < Median time interval

= <100.
100 Mean time interval

Note The interpolation is used only to compute spectral estimates. Time plots are not
resampled.

See Also

Apps
Signal Analyzer

Functions
timeseries | timetable

Related Examples

. “Find Delay Between Correlated Signals” on page 19-24

. “Plot Signals from the Command Line” on page 19-29

. “Resolve Tones by Varying Window Leakage” on page 19-33

. “Analyze Signals with Inherent Time Information” on page 19-41
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“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108
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Spectrum Computation in Signal Analyzer
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To compute signal spectra, Signal Analyzer finds a compromise between the spectral
resolution achievable with the entire length of the signal and the performance limitations
that result from computing large FFTs.

» If the resolution resulting from analyzing the full signal is achievable, the app
computes a single modified periodogram of the whole signal using an adjustable
Kaiser window.

» If the resolution resulting from analyzing the full signal is not achievable, the app
computes a Welch periodogram: It divides the signal into overlapping segments,
windows each segment using a Kaiser window, and averages the periodograms of the
segments.

Spectral Windowing

Any real-world signal is measurable only for a finite length of time. This fact introduces
nonnegligible effects into Fourier analysis, which assumes that signals are either periodic
or infinitely long. Spectral windowing, which consists of assigning different weights to
different signal samples, deals systematically with finite-size effects.

The simplest way to window a signal is to assume that it is identically zero outside of the
measurement interval and that all samples are equally significant. This “rectangular
window” has discontinuous jumps at both ends that result in spectral ringing. All other
spectral windows taper at both ends to lessen this effect by assigning smaller weights to
samples close to the signal edges.

The windowing process always involves a compromise between conflicting aims:
improving resolution and decreasing leakage.

* Resolution is the ability to know precisely how the signal energy is distributed in the
frequency space. A spectrum analyzer with ideal resolution can distinguish two
different tones (pure sinusoids) present in the signal, no matter how close in
frequency. Quantitatively, this ability relates to the mainlobe width of the transform of
the window.

* Leakage is the fact that, in a finite signal, every frequency component projects energy
content throughout the complete frequency span. The amount of leakage in a
spectrum can be measured by the ability to detect a weak tone from noise in the
presence of a neighboring strong tone. Quantitatively, this ability relates to the
sidelobe level of the frequency transform of the window.



Spectrum Computation in Signal Analyzer

The better the resolution, the higher the leakage, and vice versa. At one end of the range,
a rectangular window has the narrowest possible mainlobe and the highest sidelobes.
This window can resolve closely spaced tones if they have similar energy content, but it
fails to find the weaker one if they do not. At the other end, a window with high sidelobe
suppression has a wide mainlobe in which close frequencies are smeared together.

Signal Analyzer uses Kaiser windows to carry out windowing. For Kaiser windows, the
fraction of the signal energy captured by the mainlobe depends most importantly on an
adjustable shape factor, B. The shape factor ranges from = 0, which corresponds to a
rectangular window, to B = 40, where a wide mainlobe captures essentially all the
spectral energy representable in double precision. An intermediate value of 8 = 6
approximates a Hann window quite closely. To control 3, use the Leakage slider on the
Spectrum and Spectrogram tabs. If you set the leakage to #using the slider, then /and
are related by B = 40(1 - 9. See kaiser for more details.

Parameter and Algorithm Selection

To compute the spectra of the signals appearing on a given display, Signal Analyzer
initially determines the resolution bandwidth, which measures how close two tones can
be and still be resolved. The resolution bandwidth has a theoretical value of

RBW ENBW

theory = ¢ .
max min

*  tmax - tmin, the record length, is the time-domain duration of the selected signal region.

Use the panner to select and adjust the record length or region of interest.
Equivalently, you can zoom in on the time-domain plot or change the limits on the
Time tab.

+ ENBW is the equivalent noise bandwidth of the spectral window. See enbw for more
details.

Use the Leakage slider in the Spectrum tab to control the ENBW. The minimum
value in the slider range corresponds to a Kaiser window with f = 40. The maximum
value corresponds to a Kaiser window with g = 0.

In practice, however, the app might coarsen the resolution. This coarsening makes it
possible to compute the spectrum in a reasonable amount of time and to display it with a
finite number of pixels. The coarsening criterion is that the resolution bandwidth cannot
be smaller than
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RBW . = w,
P 4096

where max(fyyquist) is the highest Nyquist frequency among all the signals in the display.
(If there is no aliasing, the Nyquist frequency is one-half the sample rate.) RBW e tormance
cannot be adjusted.

To compute the spectrum of a signal, the app chooses the larger of the two values:

RBW = max(RBW,

theory ?

RBW

performance

).

This target resolution bandwidth is displayed on the Spectrum tab.

* If the resolution bandwidth is RBWy,.y, then Signal Analyzer computes a single
modified periodogram for the whole signal. The app uses a Kaiser window with the
slider-controlled shape factor and applies zero-padding when the time limits on the
axes exceed the signal duration. See periodogram for more details.

* If the resolution bandwidth is RBW ¢rformance, then Signal Analyzer computes a Welch
periodogram for the signal. The app:
1 Divides the signals into overlapping segments.

2 Windows each segment separately using a Kaiser window with the specified shape
factor.

3 Averages the periodograms of all the segments.
Welch’s procedure is designed to reduce the variance of the spectrum estimate by

averaging different “realizations” of the signals, given by the overlapping sections, and
using the window to remove redundant data. See pwelch for more details.

* The length of each segment (or, equivalently, of the window) is computed using

max(fyyquist )X ENBW

S t1 h =
egment lengt RBW

* The stride length is found by adjusting an initial estimate,

. Segment length
Stride 1 h=S tl h — Overlap =
ride lengt egment lengt verlap 2 ENBW —1

’



See Also

so that the first window starts exactly on the first sample of the first segment and
the last window ends exactly on the last sample of the last segment.

Zooming

If you zoom in on a region of a signal spectrum using one of the zoom actions on the
Display tab, the app does not change the resolution bandwidth. Instead, Signal
Analyzer performs an optical zooming, using bandlimited interpolation to display a
smooth spectral curve.

Zooming in on a time-domain region of a signal is equivalent to setting the record length
or region of interest with the panner.

If the selected time interval extends beyond the ends of a signal, the app zero-pads the
signal. If a signal has no samples within the selected time interval, the app displays
nothing.

References
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“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108
“Nonparametric Methods” on page 6-9
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Persistence Spectrum in Signal Analyzer

The persistence spectrum of a signal is a time-frequency view that shows the percentage
of the time that a given frequency is present in a signal. The persistence spectrum is a
histogram in power-frequency space. The longer a particular frequency persists in a
signal as the signal evolves, the higher its time percentage and thus the brighter or
"hotter" its color in the display. Use the persistence spectrum to identify signals hidden in
other signals.

To compute the persistence spectrum, Signal Analyzer performs these steps:

1

Compute the spectrogram using the specified leakage, time resolution, and overlap.
(When you zoom in time using the panner or a zoom button, the app computes and
displays the persistence spectrum using the segments that fall within the visible
zoomed-in region of interest, including those that are only partially visible. See
“Spectrogram Computation in Signal Analyzer” on page 19-92 for more details.)

Partition the power and frequency values into 2-D bins. (To adjust the power or the
frequency limits, enter the minimum and maximum Power Limits or Frequency
Limits values on the Persistence Spectrum tab.)

For each time value, compute a bivariate histogram of the logarithm of the power
spectrum. For every power-frequency bin where there is signal energy at that instant,
increase the corresponding matrix element by 1. Sum the histograms for all the time
values.

Plot the accumulated histogram against the power and the frequency, with the color
proportional to the logarithm of the histogram counts expressed as normalized
percentages. To represent zero values, use one-half of the smallest possible
magnitude.

(To adjust the range of histogram counts represented in the colormap, enter the
minimum and maximum Density Limits on the Persistence Spectrum tab. To fit

the colormap to the current density limits, click the Fit colormap I button on the
Display tab.)

Power Spectra
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Histograms

Accumulated Histogram

See Also

Apps
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. “Find Delay Between Correlated Signals” on page 19-24

. “Plot Signals from the Command Line” on page 19-29

. “Resolve Tones by Varying Window Leakage” on page 19-33

. “Analyze Signals with Inherent Time Information” on page 19-41
. “Spectrogram View of Dial Tone Signal” on page 19-44
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A nonstationary signal is a signal whose frequency content changes with time. The
spectrogram of a nonstationary signal is an estimate of the time evolution of its frequency
content. To construct the spectrogram of a nonstationary signal, Signal Analyzer follows
these steps:

1 Divide the signal into equal-length segments. The segments must be short enough
that the frequency content of the signal does not change appreciably within a
segment. The segments may or may not overlap.

2 Window each segment and compute its spectrum to get the short-time Fourier
transform.

3 Display segment-by-segment the power of each spectrum in decibels. Depict the
magnitudes side-by-side as an image with magnitude-dependent colormap.

The spectrogram view is available in displays that contain only one signal.



Spectrogram Computation in Signal Analyzer
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Divide Signal into Segments

To construct a spectrogram, first divide the signal into possibly overlapping segments. In
Signal Analyzer, you can control the length of the segments and the amount of overlap
between adjoining segments using Time Resolution and Overlap. If you do not specify
the length and overlap, Signal Analyzer chooses a length based on the entire length of
the signal, and 50% overlap. The app aligns the time axis of the spectrogram with the axis
of the time-domain plot.

Specified Time Resolution

On the Spectrogram tab, in the Time Resolution section, click Specify.

» If the signal does not have time information, specify the time resolution (segment
length) in samples. The time resolution must be an integer greater than or equal to 1
and smaller than or equal to the signal length.

If the signal has time information, specify the time resolution in seconds. The app
converts the result into a number of samples and rounds it to the nearest integer that
is less than or equal to the number but not smaller than 1. The time resolution must be
smaller than or equal to the signal duration.

* Specify the overlap as a percentage of the segment length. The app converts the result
into a number of samples and rounds it to the nearest integer that is less than or equal
to the number.

Default Time Resolution
If you select Auto for the time resolution computation, then Signal Analyzer uses the

length of the entire signal to choose the length of the segments. The app sets the time
resolution as

il

samples, where the brackets denote the ceiling function, N is the length of the signal, and
d is a divisor that depends on N:

Signal Length (N) Divisor (d) Segment Length

2 samples - 63 samples 2 1 sample - 32 samples
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Signal Length (N) Divisor (d) Segment Length

64 samples - 255 samples |8 8 samples - 32 samples

256 samples - 2047 8 32 samples - 256 samples

samples

2048 samples - 4095 16 128 samples - 256 samples

samples

4096 samples - 8191 32 128 samples - 256 samples

samples

8192 samples - 16383 64 128 samples - 256 samples

samples

16384 samples - N samples 128 128 samples - [N / 128]
samples

You can still specify the overlap between adjoining segments. Specifying the overlap
changes the number of segments. Segments that extend beyond the signal endpoint are
zero-padded.

Consider the seven-sample signal [sO s1 s2 s3 s4 s5 s6]. Because [7/2] =[3.5] =4,
the app divides the signal into two segments of length four when there is no overlap. The
number of segments changes as the overlap increases.

Number of Overlapping Samples Resulting Segments
0 sO sl s2 s3
s4 s5 s6 0
1 sO sl s2 s3
s3 s4 s5 s6
2 sO sl s2 s3
s2 s3 s4 s5
s4 s5 s6 0
3 sO sl s2 s3
sl s2 s3 s4
s2 s3 s4 s5
s3 s4 s5 s6

Time Alignment

Once the segment length and overlap are set, the number of segments and their edge
locations stay fixed and are independent of any zooming or panning. When you zoom and
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pan, the app computes and displays the spectrogram using the segments that fall within
the visible zoomed-in region of interest.

The app:

» Aligns the time axis of the spectrogram with the axis of the corresponding time-
domain plot. That way, the spectral content at a given time aligns with its occurrence.

» For nonzero overlap, extends the first and last segments to the signal endpoints.
» Zero-pads the signal if the last segment extends beyond the signal endpoint.

When the segments have 0% overlap, each segment is centered at the actual time of
occurrence. When the overlap is nonzero, the alignment of the spectrogram time axis with
the time-domain axis has the effect that the first and last time intervals are elongated. All
other time intervals are of the same length. In other words, the center of each segment,
except for the first and last, corresponds to the actual time of occurrence. Consider this
example:
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Window the Segments and Compute Spectra

After Signal Analyzer divides the signal into overlapping segments, the app windows
each segment with a Kaiser window. The shape factor § of the window, and therefore the
leakage, is adjustable.

Note The leakage used to compute the signal spectrum and the leakage used to window
the spectrogram segments are independent of each other. You can adjust them separately.

The app then computes the spectrum of each segment, using the procedure outlined in
“Spectrum Computation in Signal Analyzer” on page 19-84. In summary, Signal Analyzer
finds a compromise between the spectral resolution achievable with the entire length of
the segment and the performance limitations that result from computing large FFTs.

» If the resolution resulting from analyzing the full segment is achievable, the app
computes a single modified periodogram of the whole segment using a Kaiser window
with the specified shape factor.

» If the resolution resulting from analyzing the full segment is not achievable, the app
computes a Welch periodogram: It divides the segment into overlapping subsegments,
windows each subsegment, and averages the periodograms of the subsegments. The
app chooses the subsegment size, the window, and the overlap so that the composite
periodogram is equivalent to a modified periodogram of the whole segment with the
specified Kaiser window.

Display Spectrum Power

The app displays the power of the short-time Fourier transform in decibels, using a color
bar with the default MATLAB colormap. The color bar comprises the full power range of
the spectrogram and does not change if you zoom or pan.

You can change the magnitude levels represented by a given color range. On the
Spectrogram tab, change the minimum and maximum power values to display. You can
also set the colormap so that it comprises the full power range of the zoomed-in section of

the spectrogram. On the Display tab, click the scale color button Ly
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See Also

Apps
Signal Analyzer

Functions
pspectrum | spectrogram | xspectrogram

Related Examples

“Find Delay Between Correlated Signals” on page 19-24

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108
“Nonparametric Methods” on page 6-9
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The scalogram is the absolute value of the continuous wavelet transform (CWT) of a
signal, plotted as a function of time and frequency. The scalogram can be more useful
than the spectrogram for identifying signals with low-frequency components or rapidly
changing frequency content. Use the scalogram when you want better time localization
for short-duration, high-frequency events and better frequency localization for low-
frequency, longer-duration events.

Unlike the spectrogram, which decomposes the input signal into sinusoids of infinite
duration, the CWT decomposes the signal into wavelets. Wavelets are good for analyzing
data that exhibit regular behavior punctuated with abrupt changes because they are
localized in both frequency and time. In other words, wavelets have a beginning and an
end. The finite duration of wavelets makes it possible to control not just their amplitude
and shape, but also their location. This extra degree of freedom enables the CWT to
detect transients and identify regions where a signal has abrupt changes in frequency.

Note You need a Wavelet Toolbox license to use the scalogram view.

To achieve localization in time, the spectrogram divides the input signal into windowed
segments, which it Fourier transforms one-by-one and then displays. (See “Spectrogram
Computation in Signal Analyzer” on page 19-92 for more information.) The length of the
window, however, is fixed, and the uncertainty principle imposes a trade-off between time
resolution and frequency resolution:

* Improving the time resolution, for example to detect a burst, comes at the expense of
the frequency resolution.

* Improving the frequency resolution, for example to characterize tones to high
precision, comes at the expense of the time resolution.

The scalogram, on the other hand, can resize the wavelet as the signal evolves and adjust
the wavelet when conditions change. The procedure stretches the wavelet to capture
long-duration, low-frequency information and shrinks the wavelet to capture short-
duration, high-frequency information. Using this procedure, the scalogram can achieve
good frequency localization at low frequencies and good time localization at high
frequencies.

To compute the scalogram, Signal Analyzer performs these steps:



Scalogram Computation in Signal Analyzer

1 If the signal has more than 1 million samples, divide the signal into overlapping
segments.
Compute the CWT of each segment to get its scalogram.
Display the scalogram segment by segment.

Tip

The scalogram view does not support nonuniformly sampled signals. To compute the
scalogram of a nonuniformly sampled signal, resample your signal to a uniform grid by
using the resample function.

The scalogram view is available in displays that contain only one signal. To compare
scalograms of different signals, open separate displays and drag each signal to its own
display.

Divide the Signal into Segments

If the input signal has 1 million samples or less, Signal Analyzer uses the cwt function
directly. If the signal has more than 1 million samples, the app performs these steps:

1

Divide the signal into segments of 1 million samples, with 50% overlap between
adjoining segments.

If the last segment extends beyond the signal endpoint, zero-pad the signal until the
last segment has 1 million samples.

After computing the scalogram of each segment, remove edge effects:

* Discard the first 250,000 and the last 250,000 scalogram samples of all segments
except the first and the last.

* Discard the last 250,000 scalogram samples of the first segment.

* In the last segment, discard the scalogram samples corresponding to the zero-
padded region.

Consider, for example, a signal with 2.6 x 10% samples:
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Compute the Continuous Wavelet Transform

Signal Analyzer computes the CWT using the default settings of the cwt function. The
app uses generalized analytic Morse wavelets with gamma factor y = 3. See “Morse

Wavelets” (Wavelet Toolbox) for more information.

Signal Analyzer provides two separate controls for frequency resolution.

* The Time-Bandwidth slider controls the time-bandwidth product, which is
proportional to the wavelet duration in the time domain. Increasing the time-

bandwidth product results in wavelets with more oscillations in their central portions,

larger spreads in time, and narrower spreads in frequency. The slider moves in the
range from 3 to 120. The default value is 60. The figure shows some Morse wavelets

with varying time-bandwidth product P. The real part is in blue, the imaginary part is
in red, and the absolute value is in black.
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P=3

P =30

P =60

P =90

P =120 _

* The Voices Per Octave slider controls the number of scales per octave used to
discretize the CWT. As the number of voices per octave increases, the scale resolution
becomes finer. The slider moves in steps of multiples of 4 in the range from 4 to 16.
The default value is 8.

Display the Scalogram

Signal Analyzer plots the absolute value of the CWT coefficients as a function of time
and frequency. If the signal was divided into segments, the app concatenates portions of
the scalograms of the individual segments and displays them. The app also plots the cone
of influence, which shows where edge effects become significant.
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See Also

Apps
Signal Analyzer

Functions
cwt | cwtfilterbank | pspectrum

Related Examples

“Find Delay Between Correlated Signals” on page 19-24

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Morse Wavelets” (Wavelet Toolbox)

“Continuous and Discrete Wavelet Transforms” (Wavelet Toolbox)
“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Keyboard Shortcuts for Signal Analyzer” on page 19-105
“Signal Analyzer Tips and Limitations” on page 19-108
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Keyboard Shortcuts for Signal Analyzer

Note On Macintosh platforms, use the Command key instead of Ctrl.

General Actions

Task Shortcut
Start a new session Ctrl+N

Open a session Ctrl+0

Save a session Ctrl+S

Link or unlink a display Ctrl+U
Delete a signal Del

Copy a display to the clipboard Ctrl+C
Zooming

Task Shortcut
Zoom in X-axis (time or frequency) Ctrl+Shift+T
Zoom in Y-axis Ctrl+Shift+Y

Zoomin X and Y

Ctrl++ (numeric keypad only)

Zoom out Ctrl+- (numeric keypad only)
Fit to view Spacebar

Fit colormap to current power limits Ctrl+Spacebar

Cancel zoom operation or signal dragging |Esc

Data Cursors

Task Shortcut

Show a data cursor Ctrl+I

Hide all data cursors Shift+Del
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Task Shortcut
Move a selected data cursor to the next Right arrow
data point

Move a selected data cursor to the previous |Left arrow
data point

Activate first (left) cursor Ctrl+1
Activate second (right) cursor Ctrl+2
See Also

Signal Analyzer

Related Examples

“Find Delay Between Correlated Signals” on page 19-24

“Plot Signals from the Command Line” on page 19-29

“Resolve Tones by Varying Window Leakage” on page 19-33

“Analyze Signals with Inherent Time Information” on page 19-41
“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
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“Scalogram Computation in Signal Analyzer” on page 19-100
“Signal Analyzer Tips and Limitations” on page 19-108
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Frequently asked questions about current limitations of the Signal Analyzer app.

Select Signals to Analyze

1

"T dragged a 512-by-24 matrix into a display, but the app plotted only 10 of the 24
signals. How do I plot the others?"

By default, Signal Analyzer imports all the columns of a multichannel signal but
plots only the first 10 columns. To plot signal columns beyond the tenth, drag them to
the display. Alternatively, on the Signal table, select the check boxes next to the
names of the signals you want to plot.

"My data is saved in structures. How can I analyze them in Signal Analyzer?"

To study a structure in Signal Analyzer, convert it to a timetable. The easiest way to
do the conversion is to convert the structure to a table and then convert the table to a
timetable. The second step involves converting the time variable to a duration array.
The following example creates a structure with three fields, one of them containing
the time values, and converts the structure to a timetable readable by Signal
Analyzer.

str.st = (0:999)'/1000;
str.sl = randn(1000,1);
str.s2 = sin(2*pi*20*str.st);

T = struct2table(str);

T.st = seconds(T.st);

TT = table2timetable(T, 'RowTimes', 'st');

"What does it mean when a row in the Signal table is highlighted in gray and what
does the check box mean?"

There are two different ways to choose signals in the Signal table. Each way gives
you access to a different set of operations.

* Selecting the signal by clicking the Name, Info, Time, or Start Time column in
the Signal table enables you to perform all the operations in the Analyzer tab. You
can change the time information and smooth, filter, or duplicate the signals. You
can run preprocessing operations on a signal without plotting the signal.

* Selecting the check box to the left of the signal name plots the signal in the
currently selected display and enables you to perform all the operations in the
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Display tab. You can display the signal in the frequency domain or the time-
frequency domain, or you can measure the signal using cursors.

"I use timetables with the time values stored as datetime arrays. How can I analyze
them?"

To analyze timetables with time values stored as a datetime array, convert the array
to a relative duration array by subtracting the first element from all the others. The
following example creates a timetable with datetime row times and converts it to a
timetable readable by Signal Analyzer.

tt = timetable(datetime(2016,11,9,2,30,1:10)"',randn(10,1));
dt = tt.Time-tt.Time(1);
tn = timetable(dt,tt.Varl);

See “Analyze Signals with Inherent Time Information” on page 19-41 for another
example.

"T have a timetable but only some of its variables were imported. How can I import
them?"

Signal Analyzer lists only the variables that it can display and process. If some
variables of a timetable are not being imported, they probably are complex or have
NaNs. To be able to import them to the app, you must fix them in MATLAB first. To fix
timetables, you can use the tips in “Clean Timetable with Missing, Duplicate, or
Nonuniform Times” (MATLAB).

"I changed a variable in the MATLAB workspace. Why is there no change in the
Signal Analyzer display?"

If you modify a signal in the MATLAB workspace, the Workspace browser updates
automatically. To have the app recognize the changes, reimport the signal by
dragging it again to the Signal table or to a display.

Preprocess Signals

1

"How do I apply a lowpass filter to a signal that is not uniformly sampled?"

The filtering functionality of Signal Analyzer supports only uniformly sampled
signals. You can resample your signal to a uniform grid by using the resample
function. The function returns the resampled signal and the uniform grid of time
values.

"How do I know what parameters were used for a preprocessing operation?"
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To see a full summary of the preprocessing steps you took, including all settings you
chose, click Generate Function on the Analyzer tab.

Explore Signals

1 "I want to view a scalogram of my signal, but I get a warning saying that I have to
create a uniformly sampled signal. How do [ resample my signal?"

You can resample your signal to a uniform grid by using the resample function. The
function returns the resampled signal and the uniform grid of time values.

2  "Why can’t I zoom out beyond the Nyquist range of a scalogram?"
If a real signal is sampled properly, then all of its frequency information is contained
within the Nyquist range.

3 "How can I compare spectrograms of ten different signals?"
The time-frequency views of Signal Analyzer support only one signal per display. To
compare spectrograms of ten different signals, open 10 displays and drag each signal

to its own display. You can use the same procedure for persistence spectra and
scalograms.

Share Analysis
"I generated a script that doesn’t run because the variable it uses does not exist. Why?"

If you extract, duplicate, or rename a signal in Signal Analyzer and generate a MATLAB
script without exporting the modified signal, the script will not work. Remember to export
any signals you use as starting points for scripts.

See Also
Signal Analyzer

Related Examples

. “Find Delay Between Correlated Signals” on page 19-24

. “Plot Signals from the Command Line” on page 19-29

. “Resolve Tones by Varying Window Leakage” on page 19-33
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“Spectrogram View of Dial Tone Signal” on page 19-44

“Find Interference Using Persistence Spectrum” on page 19-47
“Extract Regions of Interest from Whale Song” on page 19-53

“Find and Track Ridges Using Reassigned Spectrogram” on page 19-59
“Scalogram of Hyperbolic Chirp” on page 19-65

“Extract Voices from Music Signal” on page 19-69

More About

“Using Signal Analyzer App” on page 19-2

“Edit Sample Rate and Other Time Information” on page 19-76
“Data Types Supported by Signal Analyzer” on page 19-81
“Spectrum Computation in Signal Analyzer” on page 19-84
“Persistence Spectrum in Signal Analyzer” on page 19-89
“Spectrogram Computation in Signal Analyzer” on page 19-92
“Scalogram Computation in Signal Analyzer” on page 19-100
“Keyboard Shortcuts for Signal Analyzer” on page 19-105

19-111






Common Applications




20 common Applications

Create Uniform and Nonuniform Time Vectors

20-2

You can create uniform and nonuniform time vectors for use in computations involving
time series.

Use the colon operator if you know the sampling frequency. If your system samples time
at a rate of 15 Hz during one second, you get 16 readings, including the one at zero.

Fs = 15;
Ts = 1/Fs;
ts = 0:Ts:1;

Use linspace if you know the beginning and end of the time interval and the number of
samples. Suppose you start a stopwatch and stop it one second later. If you know your
instrument took 15 readings, you can generate the time vector.

tl = linspace(0,1,15);

You can compute the sample rate directly from the samples and use it to reconstruct the
time vector.

st

1/(t1(2)-tl(1));
TL = (0:1length(tl)-1)/sf;

ErrorTL = max(abs(tl-TL))

ErrorTL 0

You can also reconstruct ts using linspace.

1ts = length(ts);
TS = linspace(ts(1l),ts(lts),lts);

ErrorTS = max(abs(ts-TS))

ErrorTS = 1.1102e-16

linspace and the colon operator create row vectors by default. Transpose them to
obtain column vectors.

tcol = tl';
ttrans = ts';



Create Uniform and Nonuniform Time Vectors

Combine linspace and the colon operator to generate nonuniform time vectors of
arbitrary characteristics.

Suppose you have a Gaussian-modulated sinusoidal pulse that you must sample. The pulse
changes rapidly during a one-second interval but slowly during the preceding and
following seconds.

Sample the region of interest at 100 Hz and take only five samples before and after.
Concatenate the vectors using square brackets.

gpl = @(x) 2.1*gauspuls(x-1.5,5,0.4);

Ffast = 100;
Tf = 1/Ffast;
Nslow = 5;

tdisc = [linspace(0,1,Nslow) 1+Tf:Tf:2-Tf linspace(2,3,Nslow)];

Generate 20001 samples of the function to simulate the continuous-time pulse. Overlay a
plot of the samples defined by tsf.

Tcont = linspace(0,3,20001)"';

plot(Tcont,gpl(Tcont),tdisc,gpl(tdisc),'o"', 'markersize',5)
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See Also

gauspuls
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Remove Trends from Data

Measured signals can show overall patterns that are not intrinsic to the data. These
trends can sometimes hinder the data analysis and must be removed.

Consider two electrocardiogram (ECG) signals with different trends. ECG signals are
sensitive to disturbances such as power source interference. Load the signals and plot
them.

load(fullfile(matlabroot, 'examples', 'signal', 'ecgSignals.mat'))
t = (1l:length(ecgl))’;

subplot(2,1,1)

plot(t,ecgl), grid

title 'ECG Signals with Trends', ylabel 'Voltage (mV)'
subplot(2,1,2)

plot(t,ecgnl), grid
xlabel Sample, ylabel 'Voltage (mV)'
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ECG Signals with Trends
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The signal on the first plot shows a linear trend. The trend on the second signal is
nonlinear. To eliminate the linear trend, use the MATLAB® function detrend.

dt_ecgl = detrend(ecgl);

To eliminate the nonlinear trend, fit a low-order polynomial to the signal and subtract it.
In this case, the polynomial is of order 6. Plot the two new signals.

opol = 6;
[p,s,mu] = polyfit(t,ecgnl,opol);
f_y = polyval(p,t,[],mu);

dt ecgnl = ecgnl - f y;
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subplot(2,1,1)
plot(t,dt ecgl), grid
title 'Detrended ECG Signals', ylabel 'Voltage (mV)'

subplot(2,1,2)

plot(t,dt ecgnl), grid
xlabel Sample, ylabel 'Voltage (mV)'

Detrended ECG Signals
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The trends have been effectively removed. Observe how the signals do not show a
baseline shift anymore. They are ready for further processing.
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See Also
detrend | polyfit | polyval

Related Examples
. “Peak Analysis”



Remove the 60 Hz Hum from a Signal

Remove the 60 Hz Hum from a Signal

Alternating current in the United States and several other countries oscillates at a
frequency of 60 Hz. Those oscillations often corrupt measurements and have to be
subtracted.

Study the open-loop voltage across the input of an analog instrument in the presence of
60 Hz power-line noise. The voltage is sampled at 1 kHz.

load openloop6Ohertz, openLoop = openLoopVoltage;

Fs = 1000;
t = (0:length(openLoop)-1)/Fs;

plot(t,openLoop)

ylabel('Voltage (V)"')

xlabel('Time (s)"')

title('Open-Loop Voltage with 60 Hz Noise')
grid
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Open-Loop Voltage with 60 Hz Noise

do
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Time (s)

Eliminate the 60 Hz noise with a Butterworth notch filter. Use designfilt to design it.
The width of the notch is defined by the 59 to 61 Hz frequency interval. The filter removes
at least half the power of the frequency components lying in that range.

d = designfilt('bandstopiir','FilterOrder',2,

'HalfPowerFrequencyl',59, 'HalfPowerFrequency2',61,
'DesignMethod’, 'butter', 'SampleRate',Fs);

Plot the frequency response of the filter. Note that this notch filter provides up to 45 dB of
attenuation.

fvtool(d, 'Fs',Fs)



Remove the 60 Hz Hum from a Signal
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Filter the signal with filtfilt to compensate for filter delay. Note how the oscillations
decrease significantly.

buttLoop = filtfilt(d, openLoop);

plot(t,openLoop,t,buttLoop)
ylabel('Voltage (V)')
xlabel('Time (s)"')
title('Open-Loop Voltage')
legend('Unfiltered', 'Filtered')
grid
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Open-Loop Voltage
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Yoltage (V)
do
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Time (s)
Use the periodogram to see that the "spike" at 60 Hz has been eliminated.

periodogram(openLoop,[1,[],Fs);
periodogram(buttLoop,[],[]1,Fs);

[popen, fopen] =
[pbutt, fbutt] =
plot(fopen,20*loglO(abs(popen)), fbutt,20*1ogld(abs(pbutt)),'--")
ylabel('Power/frequency (dB/Hz)')

xlabel('Frequency (Hz)"')

title('Power Spectrum')

legend('Unfiltered', 'Filtered')

grid
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See Also
designfilt | filtfilt | fvtool | periodogram

Related Examples
. “Signal Smoothing”

20-13



20 common Applications

Remove Spikes from a Signal

20-14

Sometimes data exhibit unwanted transients, or spikes. Median filtering is a natural way
to eliminate them.

Consider the open-loop voltage across the input of an analog instrument in the presence
of 60 Hz power-line noise. The sample rate is 1 kHz.

load openloop6Ohertz

fs = 1000;
t = (0:numel(openLoopVoltage) - 1)/fs;

Corrupt the signal by adding transients with random signs at random points. Reset the
random number generator for reproducibility.

rng default

spikeSignal = zeros(size(openLoopVoltage));

spks = 10:100:1990;

spikeSignal(spks+round(2*randn(size(spks)))) = sign(randn(size(spks)));
noisyLoopVoltage = openLoopVoltage + spikeSignal;
plot(t,noisyLoopVoltage)

xlabel('Time (s)"')

ylabel('Voltage (V)")
title('Open-Loop Voltage with Added Spikes')



Remove Spikes from a Signa

Open-Loop Voltage with Added Spikes
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yax = ylim;

The function medfilt1l replaces every point of a signal by the median of that point and a
specified number of neighboring points. Accordingly, median filtering discards points that
differ considerably from their surroundings. Filter the signal, using sets of three
neighboring points to compute the medians. Note how the spikes vanish.

medfiltLoopVoltage = medfiltl(noisylLoopVoltage,3);
plot(t,medfiltLoopVoltage)
xLlabel('Time (s)')

ylabel('Voltage (V)")
title('Open-Loop Voltage After Median Filtering')
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See Also
medfiltl

Related Examples
*  “Signal Smoothing”
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Process a Signal with Missing Samples

Consider the weight of a person as recorded (in pounds) during the leap year 2012. The
person did not record their weight every day. You would like to study the periodicity of the
signal, but before you can do so you must take care of the missing data.

Load the data and convert the measurements to kilograms. Missed readings are set to
NaN. Determine how many points are missing.

load(fullfile(matlabroot, 'examples’', 'signal', 'weight2012.dat"'))

wgt = weight2012(:,2)/2.20462;
daynum = 1:length(wgt);
missing = isnan(wgt);

fprintf('Missing %d samples of %d\n',sum(missing),max(daynum))
Missing 27 samples of 366

Assign values to the missing points using resample. By default, resample makes
estimates using linear interpolation. Plot the original and interpolated readings. Zoom in
on days 200 through 250, which contain about half of the missing points.

wgt orig = wgt;
wgt = resample(wgt,daynum);

plot(daynum,wgt orig,'.-',daynum,wgt,'o")
xlabel('Day"')

ylabel('Weight (kg)"')

axis([200 250 73 771])

legend('Original', 'Interpolated')

grid
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Determine if the signal is periodic by analyzing it in the frequency domain. Find the cycle
duration, measuring time in weeks. Subtract the mean to concentrate on fluctuations.

[p,f] = pwelch(wgt-mean(wgt),[1,[],[]1,Fs);

plot(f,p)
xlabel('Frequency (week™{-1})")
grid
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Notice how the person's weight oscillates weekly. Is there a noticeable pattern from week
to week? Eliminate the last two days of the year to get 52 weeks. Reorder the
measurements according to the day of the week.

wgd = reshape(wgt(1l:7*52),[7 52]);

plot(wgd")

xlabel( 'Week")

ylabel('Weight (kg)"')

g = legend(datestr(datenum(2012,1,1:7),'dddd"));

g.Location = 'NorthWest';
grid
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Smooth out the fluctuations using a filter that fits low-order polynomials to subsets of the
data. Specifically, set it to fit cubic polynomials to sets of seven days.

wgs = sgolayfilt(wgd',3,7);

plot(wgs)

xlabel( 'Week")

ylabel('Weight (kg)"')

title('Smoothed Weight Fluctuations')

g = legend(datestr(datenum(2012,1,1:7),'dddd"));

g.Location = 'SouthEast';
grid
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This person tends to eat more, and thus weigh more, during the weekend. Verify by
computing the daily means.

for jk = 1:7
fprintf('%s3s mean: %5.1f kg\n', ...
datestr(datenum(2012,1, jk), 'ddd"') "' ,mean(wgd(jk,:)))

end

Sun mean: 76.2 kg
Mon mean: 75.7 kg
Tue mean: 75.2 kg
Wed mean: 74.9 kg
Thu mean: 75.1 kg
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Fri mean: 75.3 kg
Sat mean: 75.8 kg

See Also
pwelch | sgolayfilt

Related Examples
. “Signal Smoothing”



Reconstruct a Signal from Irregularly Sampled Data

Reconstruct a Signal from Irregularly Sampled Data

People predisposed to blood clotting are treated with warfarin, a blood thinner. The
international normalized ratio (INR) measures the effect of the drug. Larger doses
increase the INR and smaller doses decrease it. Patients are monitored regularly by a
nurse, and when their INRs fall out of the target range, their doses and the frequencies of
their tests change.

The file INR.mat contains the INR measurements performed on a patient over a five-year
period. The file includes a datetime array with the date and time of each measurement,
and a vector with the corresponding INR readings. Load the data. Plot the INR as a
function of time and overlay the target INR range.

load(fullfile(matlabroot, 'examples', 'signal', "INR.mat"))
plot(Date,INR, '0"', 'DatetimeTickFormat"', 'MM/dd/yy")
xlim([Date(1) Date(end)])

hold on
plot([xlim;xlim]"',[2 3;2 371, 'k:")
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Resample the data to make the INR readings uniformly spaced. The first reading was
taken at 11:28 a.m. on a Friday. Use resample to estimate the patient's INR at that time
on every subsequent Friday. Specify a sample rate of one reading per week, or

equivalently,
resampling.

Date.Format = 'eeee, MM/dd/yy, HH:mm';
First = Date(1)

First = datetime

1/(7 x 86400)

Friday, 05/15/09,

20-24
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readings per second. Use spline interpolation for the



Reconstruct a Signal from Irregularly Sampled Data

perweek = 1/7/86400;
[rum,tee] = resample(INR,Date,perweek,1,1, ' 'spline');
plot(tee,rum,'.-"', 'DatetimeTickFormat"', 'MM/dd/yy")

title('INR")
xlim([Date(1) Date(end)])

hold off
. INR
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Each INR reading determines when the patient must be tested next. Use diff to
construct a vector of time intervals between measurements. Express the intervals in
weeks and plot them using the same x-axis as before. For the last point, use the next date
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prescribed by the anticoagulation nurse. The measurements are carried out in the United
States.

nxt = datetime('10/30/2014 07:00 PM', 'Locale','en US");

plot(Date,diff(datenum([Date;nxt]))/7,'0-",
'DatetimeTickFormat', 'MM/dd/yy")

title('Time Until Next Reading')
xlim([Date(1) Date(end)])
ylabel( 'Weeks")

Time Until Next Reading

Weeks
I

D i i i i i
01/0110 01/ 01/0112 01/01/13 01/01/14

When the INR is out of range, the times between INR readings remain short. When the
INR is too low, patients get their readings more often because the risk of thrombosis is
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See Also

elevated. When the patient's INR is in range, the times between readings increase
steadily until the ratio becomes too small or too large.

The large fluctuations in the resampling could be a sign of overshooting. However,
warfarin has an enormous effect on the body. Small changes in warfarin dose can change
the INR drastically, as can changes in diet, time spent in airplanes, or other factors.
Moreover, when the ratio goes very low (as in late 2010, where the fluctuations are
largest), the warfarin is supplemented by emergency injections of enoxaparin, whose
effects are even greater.

See Also

datenum | datestr | resample
External Websites

. National Institutes of Health. Blood Thinners. http://www.nlm.nih.gov/medlineplus/
bloodthinners.html
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Align Signals with Different Start Times

Many measurements involve data collected asynchronously by multiple sensors. If you
want to integrate the signals, you have to synchronize them. The Signal Processing
Toolbox™ has functions that let you do just that.

For example, consider a car crossing a bridge. The vibrations it produces are measured
by three identical sensors located at different spots. The signals have different arrival

times.

Load the signals into the MATLAB® workspace and plot them.

load relatedsig

ax(l) = subplot(3,1,1);
plot(sl)
ylabel('s 1")

ax(2) = subplot(3,1,2);
plot(s2)
ylabel('s 2")

ax(3) = subplot(3,1,3);
plot(s3)

ylabel('s 3")
xlabel('Samples"')

linkaxes(ax, 'x"')



Align Signals with Different Start Times
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Signal s1 lags s2 and in turn leads s3. The delays can be computed exactly using
finddelay. You see that s2 leads s1 by 350 samples, s3 lags s1 by 150 samples, and s2
leads s3 by 500 samples.

t21 = finddelay(s2,s1)
t31 = finddelay(s3,s1)
t32 = finddelay(s2,s3)
t21 =

350
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t31 =

-150

t32 =

500

Line up the signals by leaving the earlier signal untouched and clipping the delays out of
the other vectors. Add 1 to the lag differences to account for the one-based indexing used
by MATLAB®. This method aligns the signals using as reference the earliest arrival time,
that of s2.

axes(ax(1))
plot(sl(t21+1l:end))

axes(ax(2))
plot(s2)

axes(ax(3))
plot(s3(t32+1:end))
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Use alignsignals to align the signals. The function works by delaying earlier signals,

so use as reference the latest arrival time, that of s3.

[x1,x3]

= alignsignals(sl,s3);

x2 = alignsignals(s2,s3);

axes(ax(1l))

plot(x1)

axes(ax(2))

plot(x2)

axes(ax(3))

plot(x3)
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The signals are now synchronized and ready for further processing.

See Also

alignsignals | finddelay | xcorr

Related Examples
. “Measuring Signal Similarities”
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Align Signals Using Cross-Correlation

Many measurements involve data collected asynchronously by multiple sensors. If you
want to integrate the signals and study them in tandem, you have to synchronize them.
Use xcorr for that purpose.

For example, consider a car crossing a bridge. The vibrations it produces are measured
by three identical sensors located at different spots. The signals have different arrival
times.

Load the signals into the MATLAB® workspace and plot them.

load relatedsig

ax(l) = subplot(3,1,1);
plot(sl)

ylabel('s 1")

axis tight

ax(2) = subplot(3,1,2);
plot(s2)

ylabel('s 2")

axis tight

ax(3) = subplot(3,1,3);
plot(s3)

ylabel('s 3")

axis tight
xlabel('Samples"')

linkaxes(ax, 'x"')
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Compute the cross-correlations between the three pairs of signals. Normalize them so
their maximum value is one.

[C21,1ag21l] = xcorr(s2,sl);
C21 = C21/max(C21);

[C31,1ag31] = xcorr(s3,sl);
C31 = C31/max(C31);

[C32,1ag32] = xcorr(s3,s2);
€32 = C32/max(C32);

The locations of the maximum values of the cross-correlations indicate time leads or lags.
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[M21,121] = max(C21);
t21 = lag21(I21);

[M31,I31] = max(C31);
t31 = 1ag31(I31);

[M32,1I32] = max(C32);
t32 = 1ag31(I132);

Plot the cross-correlations. In each plot display the location of the maximum.

subplot(3,1,1)

plot(lag21,C21,[t21 t21],[-0.5 11,'r:")
text(t21+100,0.5,['Lag: ' int2str(t21)])
ylabel('C {21}")

axis tight

title('Cross-Correlations')

subplot(3,1,2)

plot(lag31,C31,[t31 t31]1,[-0.5 11,'r:")
text(t31+100,0.5,['Lag: ' int2str(t31)])
ylabel('C {31}")

axis tight

subplot(3,1,3)

plot(lag32,C32,[t32 t32],[-0.5 11,'r:")
text(t32+100,0.5,['Lag: ' int2str(t32)])
ylabel('C {32}")

axis tight

xlabel('Samples"')
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s2 leads s1 by 350 samples; s3 lags s1 by 150 samples. Thus s2 leads s3 by 500
samples. Line up the signals by clipping the vectors with longer delays.

sl
s3

sl(-t2l:end);
s3(t32:end);

ax(1l) = subplot(3,1,1);
plot(sl)

ylabel('s 1')

axis tight

ax(2) = subplot(3,1,2);

plot(s2)
ylabel('s 2')
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axis tight

ax(3)
plot(s3)
ylabel('s 3')
axis tight
xLlabel('Samples')

= subplot(3,1,3);

linkaxes(ax, 'x')
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The signals are now synchronized and ready for further processing.
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See Also

alignsignals | finddelay | xcorr

Related Examples
. “Measuring Signal Similarities”



Align Two Simple Signals

Align Two Simple Signals

This example shows how to use cross-correlation to align signals. In the most general
case, the signals have different lengths, and to synchronize them properly, you must take
into account the lengths and the order in which you input the arguments to xcorr.

Consider two signals, identical except for the number of surrounding zeros and for the
fact that one of them lags the other.

sz = 30;

sg = randn(1l,randi(8)+3);

sl = [zeros(l,randi(sz)-1) sg zeros(1l,randi(sz)-1)1];
s2 = [zeros(l,randi(sz)-1) sg zeros(l,randi(sz)-1)1];
mx = max(numel(sl),numel(s2));

ax(1l) = subplot(2,1,1);
stem(sl)
x1im ([0 mx+1])

ax(2) = subplot(2,1,2);

stem(s2,'*")
x1im ([0 mx+1])
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Determine which of the two signals is longer than the other in the sense of having more
elements, be they zeros or not.

if numel(sl) > numel(s2)

slong = sl;

sshort = s2;
else

slong = s2;

sshort = s1;
end

Compute the cross-correlation of the two signals. Run xcorr with the longer signal as
first argument and the shorter signal as second argument. Plot the result.



Align Two Simple Signals

[acor,lag] = xcorr(slong,sshort);

[acormax,I] = max(abs(acor));
lagDiff = lag(I)

lagDiff 15

figure

stem(lag,acor)

hold on
plot(lagDiff,acormax, '*')
hold off

-80 -60 =40 =20 0 20 40 G0 80
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Align the signals. Think of the lagging signal as being "longer" than the other, in the sense
that you have to "wait longer" to detect it.

+ If lagDiff is positive, "shorten" the long signal by considering its elements from
lagDiff+1 to the end.

+ If lagDiff is negative, "lengthen" the short signal by considering its elements from -
lagDiff+1 to the end.

You must add 1 to the lag difference because MATLAB® uses one-based indexing.

if lagbiff > 0

sorig = sshort;

salign = slong(lagDiff+l:end);
else

sorig = slong;

salign = sshort(-lagDiff+l:end);
end

Plot the aligned signals.

subplot(2,1,1)
stem(sorig)
Xx1im ([0 mx+1])

subplot(2,1,2)

stem(salign, '*")
Xx1im ([0 mx+1])
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0 10 20 30 40 50 &0

&0

The method works because the cross-correlation operation is antisymmetric and because
xcorr deals with signals of different lengths by adding zeros at the end of the shorter
signal. This interpretation lets you align the signals easily using MATLAB's end operator
without having to pad them by hand.

You can also align the signals at one stroke by invoking the alignsignals function.
[x1,x2] = alignsignals(sl,s2);

subplot(2,1,1)

stem(x1)

x1im([0 mx+1])

subplot(2,1,2)
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stem(x2, '*")
x1im([O0 mx+1])
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Find Peaks in Data

Find Peaks in Data

Use findpeaks to find values and locations of local maxima in a set of data.

The file spots num.mat contains the average number of sunspots observed every year
from 1749 to 2012. The data are available from NASA.

Find the maxima and their years of occurrence. Plot them along with the data.
load(fullfile(matlabroot, 'examples', 'signal', 'spots num.mat'))
[pks,locs] = findpeaks(avSpots);
plot(year,avSpots,year(locs),pks, 'or')

xlabel('Year")

ylabel( 'Number"')
axis tight
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Some peaks are very close to each other. The ones that are not recur at regular intervals.
There are roughly five such peaks per 50-year period.

To make a better estimate of the cycle duration, use findpeaks again, but this time

restrict the peak-to-peak separation to at least six years. Compute the mean interval
between maxima.

[pks,locs] = findpeaks(avSpots, 'MinPeakDistance',6);

plot(year,avSpots,year(locs),pks, 'or")
xlabel('Year")

ylabel( 'Number"')

title('Sunspots')

axis tight



Find Peaks in Data

legend('Data’', 'peaks', 'Location', 'NorthWest")
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cycles = diff(locs);
meanCycle = mean(cycles)

meanCycle = 10.8696

It is well known that solar activity cycles roughly every 11 years. Check by using the
Fourier transform. Remove the mean of the signal to concentrate on its fluctuations.
Recall that the sample rate is measured in years. Use frequencies up to the Nyquist
frequency.
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1 .

Fs ;
512;

Nf

Fs/Nf;

df
f = 0:df:Fs/2-df;

trSpots fftshift(fft(avSpots-mean(avSpots),Nf));

dBspots 20*1logl0(abs(trSpots(Nf/2+1:Nf)));

yaxis = [20 85];

plot(f,dBspots,1./[meanCycle meanCycle],yaxis)
xlabel('Frequency (year™{-1})")

ylabel('| FFT | (dB)"')

axis([0 1/2 yaxis])

text(1l/meanCycle + .02,25,['<== 1/' num2str(meanCycle)])
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The Fourier transform indeed peaks at the expected frequency, confirming the 11-year

conjecture. You also can find the period by locating the highest peak of the Fourier
transform.

[pk,MaxFreq] = findpeaks(dBspots, 'NPeaks',1, 'SortStr', 'descend');

Period 1/f(MaxFreq)

Period 10.8936

hold on

plot(f(MaxFreq),pk, 'or')

hold off

legend('Fourier transform','l/meanCycle','1l/Period")
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Fourier transform |
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The two estimates coincide quite well.

See Also
dlmread | findpeaks

Related Examples
“Peak Analysis”
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Find a Signal in a Measurement

You receive some data and would like to know if it matches a longer stream you have
measured. Cross-correlation allows you to make that determination, even when the data
are corrupted by noise.

Load into the workspace a recording of a ring spinning on a tabletop. Crop a one-second
fragment and listen to it.

load(fullfile(matlabroot, 'examples', 'signal', 'Ring.mat"))
Time = 0:1/Fs: (length(y)-1)/Fs;

m
M

min(y);
max(y);

Full sig = double(y);

timeA 7;
timeB = 8;
snip = timeA*Fs:timeB*Fs;

Fragment = Full sig(snip);

% To hear, type soundsc(Fragment,Fs)

Plot the signal and the fragment. Highlight the fragment endpoints for reference.
plot(Time,Full sig, [timeA timeB;timeA timeB],[m m;M M], 'r--")
xlabel('Time (s)"')

ylabel('Clean')
axis tight
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plot(snip/Fs,Fragment)
xlabel('Time (s)')
ylabel('Clean')
title('Fragment')

axis tight
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Compute and plot the cross-correlation of the full signal and the fragment.
[xCorr,lags] = xcorr(Full sig,Fragment);

plot(lags/Fs,xCorr)
grid

xlabel('Lags (s)')
ylabel('Clean')
axis tight
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Clean

Lags (s)

The lag at which the cross-correlation is greatest is the time delay between the signals'
starting points. Replot the signal and overlay the fragment.

[~,I]1 = max(abs(xCorr));
maxt = lags(I);

Trial = NaN(size(Full sig));
Trial(maxt+1l:maxt+length(Fragment)) = Fragment;

plot(Time,Full sig,Time,Trial)
xlabel('Time (s)"')
ylabel('Clean')

axis tight
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Clean
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Repeat the procedure, but add noise separately to signal and fragment.
be picked out from the noise.

NoiseAmp = 0.2*max(abs(Fragment));

Fragment Fragment+NoiseAmp*randn(size(Fragment));
Full sig = Full sig+NoiseAmp*randn(size(Full sig));
% To hear, type soundsc(Fragment,Fs)

plot(Time,Full sig,[timeA timeB;timeA timeB],[m m;M M],'r--")
xlabel('Time (s)"')

The sound cannot
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ylabel('Noisy"')
axis tight

Moisy
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The procedure finds the missing fragment despite the high noise level.
[xCorr,lags] = xcorr(Full sig,Fragment);

plot(lags/Fs,xCorr)
grid

xlabel('Lags (s)"')
ylabel('Noisy"')
axis tight
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[~,I1 = max(abs(xCorr));
maxt = lags(I);

Trial = NaN(size(Full sig));
Trial(maxt+1l:maxt+length(Fragment)) = Fragment;

figure

plot(Time,Full sig,Time,Trial)
xlabel('Time (s)')
ylabel('Noisy"')

axis tight
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See Also
xcorr
Related Examples
. “Measuring Signal Similarities”
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Find Periodicity Using Autocorrelation

Measurement uncertainty and noise sometimes make it difficult to spot oscillatory
behavior in a signal, even if such behavior is expected.

The autocorrelation sequence of a periodic signal has the same cyclic characteristics as
the signal itself. Thus, autocorrelation can help verify the presence of cycles and
determine their durations.

Consider a set of temperature data collected by a thermometer inside an office building.
The device takes a reading every half hour for four months. Load the data and plot it.
Subtract the mean to concentrate on temperature fluctuations. Convert the temperature
to degrees Celsius. Measure time in days. The sample rate is thus 2 measurements/hour
x 24 hours/day = 48 measurements/day.

load officetemp
tempC = (temp-32)*5/9;
tempnorm = tempC-mean(tempC);

fs = 2*%24;
t = (0:length(tempnorm) - 1)/fs;

plot(t,tempnorm)

xlabel('Time (days)"')
ylabel('Temperature ( {}"\circC )"')
axis tight
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Temperature { C )
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Time (days)

The temperature does seem to oscillate, but the lengths of the cycles cannot be read out
easily.

Compute the autocorrelation of the temperature such that it is unity at zero lag. Restrict
the positive and negative lags to three weeks. Note the double periodicity of the signal.

[autocor,lags] = xcorr(tempnorm,3*7*fs, 'coeff');
plot(lags/fs,autocor)
xlabel('Lag (days)"')

ylabel('Autocorrelation')
axis([-21 21 -0.4 1.11)
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Determine the short and long periods by finding the peak locations and determining the
average time differences between them.

To find the long period, restrict findpeaks to look for peaks separated by more than the
short period and with a minimum height of 0.3.

[pksh,lcsh] = findpeaks(autocor);
short = mean(diff(lcsh))/fs

short = 1.0021

[pklg,lclg] = findpeaks(autocor, .
'MinPeakDistance',ceil(short)*fs,
long = mean(diff(lclg))/fs

'MinPeakheight',0.3);
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long = 6.9896

hold on

pks = plot(lags(lcsh)/fs,pksh,'or', ...
lags(lclg)/fs,pklg+0.05, 'vk');

hold off

legend(pks, [repmat('Period: ',[2 1]) num2str([short;long]l,0)])

axis([-21 21 -0.4 1.1])

Al g & Period: 1| A
v Period: ¥
0.8 [ |
0.6 |
5 v ol @ 4
: . ¢ I ¥ v
%_ 0.4 ||' ? || |||.| |i|| || cl? -||
S ¢ | | | |
Seefl qle Ao b M0 bk T
oo ogoctll g ol Yool Vizcoallll I
| ||ﬁﬁ ﬁll |||' |I | mf lL' |h| ||(|i|)|| |||| | || | ||ﬁ| 'ul "l ||ﬁ|| |I 'l |L|| ||:'TW'| |
H i " |,,| | i i | | | ‘l b
02 | |l|| lul | |I|| |III i| | |.| A | ||.I| I|,| | A
040 58 a0 = 0 : 10 5 2
Lag (days)

To a very good approximation, the autocorrelation oscillates both daily and weekly. This is
to be expected, since the temperature in the building is higher when people are at work
and lower at nights and on weekends.
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See Also

findpeaks | xcorr

Related Examples
. “Find Periodicity Using Frequency Analysis” on page 20-96
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Extract Features of a Clock Signal

How sharply does an on/off signal turn on and off? How often and for how long is it
activated? Determine all those characteristics for the output of a clock.

Load the signal and plot it. The time is measured in seconds and the level in volts.

load(fullfile(matlabroot, 'examples', 'signal', 'clock.mat"'))

plot(tclock,clocksig)
xlabel('Time (s)"')
ylabel('Level (V)")
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Use statelevels to find the lower and upper levels of the signal by means of a
histogram. If you do not specify an output, the function plots the signal, marks the levels,

and displays the histogram.

levels = statelevels(clocksig)
levels = Ix2
0.0138 5.1848

statelevels(clocksig);
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Determine how fast the signal rises at each transition. risetime uses the lower and
upper levels found by statelevels. It defines the rise time as the time it takes the
signal to rise from 10% to 90% of the difference between the levels.

[Rise,LoTime,HiTime, LoLev,HiLev] = risetime(clocksig, tclock);
Levels = [LoLev HiLev; (levels(2)-levels(1l))*[0.1 0.9]+levels(1)]
Levels = 2x2

0.5309 4.6677
0.5309 4.6677

If you call risetime without outputs, the function draws an annotated plot of the signal.
The rise times are shaded, the crossing points are marked, and the levels are displayed.
You can use the time vector or the sample rate as input.

risetime(clocksig,Fs);
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overshoot and undershoot show how far the signal deviates from the state levels at
each transition. The results are expressed as percentages of the difference between the
levels. Further outputs give the actual times and signal values.

overshoot(clocksig,Fs);

[pctgs,values,times] = undershoot(clocksig,Fs);

hold on

text(1l.1le-3,2," Undershoot', 'Background', 'w', 'Edge’', 'k")
plot([times;1.17e-3],[values;2], '"m', 'HandleVisibility', 'off")

hold off
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6 - - - .
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Determine how fast the signal falls using falltime. You can set the state levels and the
percentage reference levels manually. You can do the same with risetime.

falltime(clocksig, tclock, ...
'PercentReferencelLevels',[30 80], 'StateLevels',[0 5]);
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Find the period of the signal. By default, the period is defined as the time elapsed
between consecutive rising crossings of the reference level halfway between the state
levels. You can change the polarity of the crossings, specify the state levels, or adjust the

reference level.

per

per = 4x1

103 x

0.4143
0.4200
0.4188

pulseperiod(clocksig,tclock)
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0.4111

pulseperiod(clocksig,Fs, 'Polarity', 'negative', 'MidPct',25);

6 pulse period
signal
X mid cross
upper boundary
""""" upper state
lower boundary
— — —mid reference
upper boundary
""""" lower state
lower boundary

Level (Volts)

Time (seconds) w102

The duty cycle is the ratio of pulse width to pulse period. Determine it directly or using a
dedicated function.

dut dutycycle(clocksig,Fs);

wdt pulsewidth(clocksig,Fs);

compare = [wdt./per dut]
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compare = 4x2

See Also

dutycycle | falltime | overshoot | pulseperiod | pulsewidth | risetime |
slewrate | statelevels | undershoot

Related Examples

0.4862
0.4756
0.4871
0.4886

“Measurement of Pulse and Transition Characteristics”

0.4862
0.4756
0.4871
0.4886
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Find Periodicity in a Categorical Time Series

20-72

This example shows how to perform spectral analysis of categorical-valued time-series
data. The spectral analysis of categorical-valued time series is useful when you are
interested in cyclic behavior of data whose values are not inherently numerical. This
example reproduces in part the analysis reported in Stoffer et al. (1988). The data are
taken from Stoffer, Tyler, and Wendt (2000).

The data are from a study of sleep states in newborn children. A pediatric neurologist
scored an infant's electroencephalographic (EEG) recording every minute for
approximately two hours. The neurologist categorized the infant's sleep state into one of
the following:

* qt - Quiet sleep, trace alternant
* gh - Quiet sleep, high voltage

* tr - Transitional sleep

* al - Active sleep, low voltage

* ah - Active sleep, high voltage

* aw - Awake

Enter the data. The infant was never awake during the EEG recording.

data = {'ah','ah','ah','ah','ah",'ah", 'ah','ah', "tr',"ah", "tr', 'ah’,
‘ah','qh','qt', 'qt','qt', 'qt', 'qt", "tr','qt', 'qt', 'qt', 'qt', 'qt’,
‘qt','qt','qt', 'qt','qt"', 'tr',al’, 'alt’,'alt','alt', 'al’, 'tr', 'ah’,
'al','al','al','al','al', 'ah','ah', 'ah', 'ah', 'ah', 'ah', 'ah', "tr',
"tr','ah','ah','ah','ah', "tr', "tr', "tr','qh*,'qgh', 'qt', 'qt', 'qt’,
‘qt’,'qt’,'qt’,'qt’,'qt’, ‘qt’,'qt’, 'qt’, ‘qt’, 'qt’, 'qt’, ‘qt’, 'qt ",
‘qt',‘'qt', 'tr','al','al','alt', 'at', 'at’, 'at*, 'at', 'al', 'al', 'al’,
'al','al','al','al','al', at',alt', 'ah', 'ah', 'ah', 'ah', 'ah', 'ah',
'ah', 'ah','ah', 'tr'};

lend = length(data);
t = 1:lend;

The easiest way to analyze categorical-valued time series data for cyclic patterns involves
assigning numerical values to the categories. There are at least two meaningful ways of
assigning values to the infant's sleep states. First, note that you can order the six states
from 1 to 6. This assignment makes sense along the scale of least active to most active.

Replace the six sleep states with their numerical equivalents and plot the data.



Find Periodicity in a Categorical Time Series

Sleep State

states =
levelssix

for nn =

datasix(strcmp(data,states(nn,:))) = levelssix(nn);

end

plot(t,datasix)
axis([0 lend 0 6])

ax = gca;

ax.YTick = [1 2 4 5];

grid

xLlabel('Minutes"')
ylabel('Sleep State')

[Iqtl;Ith;Itrl;lall;lahl;lawl];
[123456];
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The data exhibit cyclic behavior when you focus on the transitions between the quietest
states (1 and 2) and the most active ones (4 and 5). To determine the cycle of that
behavior, use spectral analysis. Recall that the sleep states are assigned in one-minute
intervals. Sampling the data in one-minute intervals is equivalent to sampling the data 60
times per hour.

Fs = 60;
[Pxx,F] = periodogram(detrend(datasix,0),[],240,Fs);

plot(F,Pxx)

grid

xlabel('Cycles/Hour")
title('Periodogram of Sleep States')

Periodogram of Sleep States
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The spectral analysis shows a clear peak indicating a dominant oscillation, or cycle in the
data. Determine the frequency of the peak.

[~,maxidx] = max(Pxx);
Fsix = F(maxidx)

Fsix = 1.2500

The infant's sleep states exhibit cyclic behavior with a frequency of approximately 1.25
cycles/hour.

Instead of assigning the sleep states the values 1 to 6, repeat the analysis focusing only
on the distinction between quiet and active sleep. Assign the quiet states, qt and gh, the
value 1. Assign the transitional state, tr, the value 2. Finally, assign the two active sleep
states, al and ah, the value 3. For completeness, assign the awake state, aw, the value 4,
even though the state does not occur in the data.

states = ['qt';'gh"; 'tr';'al';'ah'; "aw'];
levelsfou = [1 12 3 3 4];

for nn = 1:6
datafou(strcmp(data,states(nn,:))) = levelsfou(nn);
end

plot(t,datafou)

axis ([0 lend 0 41])

ax = gca;

ax.YTick = [1 2 3];
grid
xlabel('Minutes"')
ylabel('Sleep State')
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Sleep State
M3
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With this rule of assignment between the sleep states and the values 1 to 3, the cyclic
behavior of the data is clearer. Repeat the spectral analysis with the new assignment.

[Pxx,F] = periodogram(detrend(datafou,Q),[],240,Fs);

plot(F,Pxx)

grid

xlabel('Cycles/Hour")
title('Periodogram of Sleep States')
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Periodogram of Sleep States
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[maxval,maxidx] = max(Pxx);
F(maxidx)

ans = 1.2500

The new assignment has not changed the conclusion. The data show a dominant
oscillation at 1.25 cycles/hour. Because the mapping between the sleep states and the
integers representing those states was consistent, the analysis and conclusions were not
affected. Based on a spectral analysis of this categorical data, you conclude that the
infant's sleep state cycles between quiet and active sleep approximately once every hour.

References
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See Also
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Compensate for the Delay Introduced by an FIR Filter

Filtering a signal introduces a delay. This means that the output signal is shifted in time
with respect to the input. This example shows you how to counteract this effect.

Finite impulse response filters often delay all frequency components by the same amount.
This makes it easy to correct for the delay by shifting the signal in time.

Take an electrocardiogram reading sampled at 500 Hz for 1 s. Add random noise. Reset
the random number generator for reproducibility.

Fs = 500;
N = 500;
rng default

Xn
tn

ecg(N)+0.25*randn([1 N]);
(0:N-1)/Fs;

Remove some of the noise with a filter that stops frequencies above 75 Hz. Use
designfilt to design a filter of order 70.

nfilt = 70;
Fst = 75;

d = designfilt('lowpassfir', 'FilterOrder',nfilt,
‘CutoffFrequency',Fst, 'SampleRate',Fs);

Filter the signal and plot it. The result is smoother than the original, but lags behind it.
xf = filter(d,xn);

plot(tn,xn)

hold on, plot(tn,xf,'-r','linewidth',1.5), hold off

title 'Electrocardiogram’
xlabel 'Time (s)', legend('Original Signal', 'Filtered Signal')
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Use grpdelay to check that the delay caused by the filter equals half the filter order.
grpdelay(d,N,Fs)
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Group delay
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delay mean(grpdelay(d))

delay = 35

Shift the filtered signal to line up the data. Remove its first delay samples. Remove the
last delay samples of the original and of the time vector.

tt = tn(l:end-delay);
sn = xn(1l:end-delay);
sf = xf;

sf(l:delay) = [];

Plot the signals and verify that they are aligned.
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plot(tt,sn)

hold on, plot(tt,sf,'-r', 'linewidth',1.5), hold off

title 'Electrocardiogram'

xlabel('Time (s)'), legend('Original Signal','Filtered Shifted Signal')

Electrocardiogram
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See Also
designfilt | filter | filtfilt | grpdelay

Related Examples
. “Compensate for the Delay Introduced by an IIR Filter” on page 20-84
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“Practical Introduction to Digital Filtering”
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Compensate for the Delay Introduced by an IIR Filter

20-84

Filtering a signal introduces a delay. This means that the output signal is shifted in time
with respect to the input.

Infinite impulse response filters delay some frequency components more than others.
They effectively distort the input signal. The function filtfilt compensates for the
delays introduced by such filters, and thus corrects for filter distortion. This "zero-phase
filtering" results from filtering the signal in the forward and backward directions.

Take an electrocardiogram reading sampled at 500 Hz for 1 s. Add random noise.

Fs = 500;
N = 500;

rng default
xn = ecg(N) + 0.2*randn([1 NJ]);

tn = (0:N-1)/Fs;

Remove some of the noise with a filter that stops frequencies above 75 Hz. Specify a 7th-
order IIR filter with 1 dB of passband ripple and 60 dB of stopband attenuation.

Nf = 7;
Fp = 75;
Ap = 1;
As = 60;

d = designfilt('lowpassiir','FilterOrder', Nf, 'PassbandFrequency',Fp,
'PassbandRipple’',Ap, 'StopbandAttenuation',bAs, 'SampleRate',Fs);

Filter the signal. The filtered signal is cleaner than the original, but lags in time with
respect to it. It is also distorted due to the nonlinear phase of the filter. Zoom in close to
the peak.

xfilter = filter(d,xn);
plot(tn,xn,tn,xfilter)
title 'Electrocardiogram’

xlabel 'Time (s)', legend('Original Signal', 'Filtered Signal')
axis([0.25 0.55 -1 1.5])
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A look at the group delay introduced by the filter shows that the delay is frequency-

dependent.
grpdelay(d,N,Fs)
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Group delay (in samples)
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Filter the signal using filtfilt. The delay and distortion have been effectively removed.
Use filtfilt when it is critical to keep the phase information of a signal intact.

xfiltfilt = filtfilt(d,xn);

plot(tn,xn,tn,xfilter)

hold on
plot(tn,xfiltfilt, 'r', 'linewidth',2)
hold off

title 'Electrocardiogram’
xlabel 'Time (s)'
legend('Original Signal', 'Filtered Signal’



See Also

'Zero-phase filtered with ''filtfilt''")
axis([0.25 0.55 -1 1.5])
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See Also

designfilt | filter | filtfilt | grpdelay

“Practical Introduction to Digital Filtering”

Related Examples
“Compensate for the Delay Introduced by an FIR Filter” on page 20-79
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Take Derivatives of a Signal

You want to differentiate a signal without increasing the noise power. MATLAB®'s
function diff amplifies the noise, and the resulting inaccuracy worsens for higher
derivatives. To fix this problem, use a differentiator filter instead.

Analyze the displacement of a building floor during an earthquake. Find the speed and
acceleration as functions of time.

Load the file earthquake. The file contains the following variables:

* drift: Floor displacement, measured in centimeters
* t: Time, measured in seconds
* Fs: Sample rate, equal to 1 kHz

load(fullfile(matlabroot, 'examples', 'signal', 'earthquake.mat"'))

Use pwelch to display an estimate of the power spectrum of the signal. Note how most of
the signal energy is contained in frequencies below 100 Hz.

pwelch(drift,[1,[1,[1,Fs)
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Fowerffrequency (dB/Hz)

Welch Power Spectral Density Estimate
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Use designfilt to design an FIR differentiator of order 50. To include most of the signal
energy, specify a passband frequency of 100 Hz and a stopband frequency of 120 Hz.
Inspect the filter with fvtool.

Nf = 50;
Fpass = 100;
Fstop = 120;

d = designfilt('differentiatorfir', 'FilterOrder', Nf,
'PassbandFrequency',Fpass, 'StopbandFrequency',Fstop,
'SampleRate',Fs);

fvtool(d, 'MagnitudeDisplay', 'zero-phase','Fs',Fs)
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Zero-phase Response
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Differentiate the drift to find the speed. Divide the derivative by dt, the time interval
between consecutive samples, to set the correct units.

dt = t(2)-t(1);

vdrift = filter(d,drift)/dt;

The filtered signal is delayed. Use grpdelay to determine that the delay is half the filter
order. Compensate for it by discarding samples.

delay = mean(grpdelay(d))
delay = 25
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tt = t(l:end-delay);
vd vdrift;
vd(1l:delay) = [];

The output also includes a transient whose length equals the filter order, or twice the
group delay. delay samples were discarded above. Discard delay more to eliminate the
transient.

tt(1l:delay)
vd(1l:delay)

[1;
[1;

Plot the drift and the drift speed. Use findpeaks to verify that the maxima and minima
of the drift correspond to the zero crossings of its derivative.

[pkp,lcp] = findpeaks(drift);
zcp = zeros(size(lcp));

[pkm,lcm] = findpeaks(-drift);
zcm = zeros(size(lcm));

subplot(2,1,1)

plot(t,drift,t([lcp lcm]), [pkp -pkm],'or")
xlabel('Time (s)')

ylabel('Displacement (cm)"')

grid

subplot(2,1,2)

plot(tt,vd,t([lcp lcml),[zcp zcm], 'or')
xlabel('Time (s)')

ylabel('Speed (cm/s)"')

grid
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Differentiate the drift speed to find the acceleration. The lag is twice as long. Discard
twice as many samples to compensate for the delay, and the same number to eliminate

the transient. Plot the speed and acceleration.

adrift = filter(d,vdrift)/dt;
at = t(l:end-2*delay);
ad = adrift;

ad(1:2*delay) [1;

at(1l:2*delay)
ad(1:2*delay) [1;

subplot(2,1,1)
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Acceleration (cm!sz}

plot(tt,vd)
xlabel('Time (s)"')
ylabel('Speed (cm/s)')
grid

subplot(2,1,2)
plot(at,ad)

= gca;
ax.YLim = 2000*%[-1 1];
xLlabel('Time (s)')
ylabel('Acceleration (cm/s”2)")
grid
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Compute the acceleration using diff. Add zeros to compensate for the change in array
size. Compare the result to that obtained with the filter. Notice the amount of high-
frequency noise.

vdiff
adiff

diff([drift;0])/dt;
diff([vdiff;0])/dt;

subplot(2,1,1)

plot(at,ad)

ax = gca;

ax.YLim = 2000*[-1 11];

xlabel('Time (s)')

ylabel('Acceleration (cm/s"2)"')

grid

legend('Filter")

title('Acceleration with Differentiation Filter')

subplot(2,1,2)

plot(t,adiff)

ax = gca;

ax.YLim = 2000*[-1 11];
xlabel('Time (s)')
ylabel('Acceleration (cm/s”2)"')
grid

legend('diff")
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Acceleration [cm;‘sz}

Acceleration (cm;‘sz}
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See Also
designfilt | findpeaks | fvtool | grpdelay | periodogram

Related Examples

“Practical Introduction to Digital Filtering”
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Find Periodicity Using Frequency Analysis

20-96

It is often difficult to characterize oscillatory behavior in data by looking at time
measurements. Spectral analysis can help determine if a signal is periodic and measure
the different cycles.

A thermometer in an office building measures the inside temperature every half hour for
four months. Load the data and plot it. Convert the temperature to degrees Celsius.
Measure time in weeks. The sample rate is thus 2 measurements/hour x 24 hours/day x 7
days/week = 336 measurements/week.

load officetemp
tempC = (temp - 32)*5/9;

fs = 2%¥24*7;
t = (0:length(tempC) - 1)/fs;

plot(t,tempC)

xlabel('Time (weeks)"')
ylabel('Temperature ( {}™\circC )"')
axis tight



Find Periodicity Using Frequency Analysis
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The temperature does seem to oscillate, but the lengths of the cycles cannot be
determined easily. Look at the signal's frequency content instead.

Subtract the mean to concentrate on temperature fluctuations. Compute and plot the
periodogram.

tempnorm = tempC - mean(tempC);
[pxx,f] = periodogram(tempnorm,[],[],fs);
plot(f,pxx)

ax = gca;
ax.XLim = [0 10];
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xlabel('Frequency (cycles/week)")
ylabel('Magnitude")
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The temperature clearly has a daily cycle and a weekly cycle. The result is not surprising:
the temperature is higher when people are at work and lower at nights and on weekends.

See Also

findpeaks | periodogram | xcorr
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See Also

Related Examples
. “Find Periodicity Using Autocorrelation” on page 20-59
. “Practical Introduction to Frequency-Domain Analysis”
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Detect a Distorted Signal in Noise

20-100

The presence of noise often makes it difficult to determine the spectral content of a
signal. Frequency analysis can help in such cases.

Consider for example the simulated output of a nonlinear amplifier that introduces third-
order distortion.

The input signal is a 180 Hz unit-amplitude sinusoid sampled at 3.6 kHz. Generate 10000
samples.

N = le4;

n=0:N

f=3600

fOo = 180;

t = n/fs

y = sin (2*p1*f0*t),

Add unit-variance white noise to the input. Model the amplifier using a third-order
polynomial. Pass the input signal through the amplifier using polyval. Plot a section of
the output. For comparison plot the output of a pure sinusoid.

rng default
noise = randn(size(y));

dispol = [0.5 0.75 1 0];
out = polyval(dispol,y+noise);

= 300:500;

plot(t(ns), [out(ns);polyval(dispol,y(ns))])
xlabel('Time (s)")

ylabel('Signals"')

axis tight

legend('With white noise', 'No white noise')



Detect a Distorted Signal in Noise
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Use pwelch to compute and plot the power spectral density of the output.
[pxx,f] = pwelch(out,[1,[1,[1,fs);

pwelch(out, [1,[1,[1,fs)
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Welch Power Spectral Density Estimate
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Because the amplifier introduces third-order distortion, the output signal is expected to
have:

* A DC (zero-frequency) component;
* A fundamental component with the same frequency as the input, 180 Hz;

* Two harmonics -- frequency components at twice and three times the frequency of the
input, 360 and 540 Hz.

Verify that the output is as expected for a cubic nonlinearity.
[pks,lox] = findpeaks(pxx, 'NPeaks',4, 'SortStr', 'descend');

hold on
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Fowerffrequency (dB/Hz)

plot(f(lox)/1000,10*logl0O(pks),'or")
hold off

legend('PSD', 'Frequency Components')

Welch Power Spectral Density Estimate
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components = sort([f(lox) fO*(0:3)'])"
components = 2x4

0.8789 180.1758 360.3516 540.5273
0 180.0000 360.0000 540.0000
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Fowerffrequency (dB/Hz)

20-104

pwelch works by dividing the signal into overlapping segments, computing the
periodogram of each segment, and averaging. By default, the function uses eight
segments with 50% overlap. For 10000 samples, this corresponds to 2222 samples per
segment.

Dividing the signal into shorter segments results in more averaging. The periodogram is
smoother, but has lower resolution. The higher harmonic cannot be distinguished.

pwelch(out,222,[1,[],fs)

Welch Power Spectral Density Estimate
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Dividing the signal into longer segments increases the resolution, but also the
randomness. The signal and the harmonics are precisely at the expected locations.
However, there is at least one spurious high-frequency peak with more power than the
higher harmonic.



See Also

Fowerffrequency (dB/Hz)

pwelch(out,4444,[1,[1,fs)

Welch Power Spectral Density Estimate
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See Also
findpeaks | pwelch

Related Examples
. “Practical Introduction to Frequency-Domain Analysis”

1.6
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Measure the Power of a Signal

The power of a signal is the sum of the absolute squares of its time-domain samples
divided by the signal length, or, equivalently, the square of its RMS level. The function
bandpower allows you to estimate signal power in one step.

Consider a unit chirp embedded in white Gaussian noise and sampled at 1 kHz for 1.2
seconds. The chirp's frequency increases in one second from an initial value of 100 Hz to

300 Hz. The noise has variance ?-017, Reset the random number generator for
reproducible results.

N = 1200;
Fs = 1000;
t = (0:N-1)/Fs;

sigma = 0.01;
rng('default')

s = chirp(t,100,1,300)+sigma*randn(size(t));

Verify that the power estimate given by bandpower is equivalent to the definition.

pRMS = rms(s)"2
PRMS = 0.5003
powbp = bandpower(s,Fs,[0 Fs/2])

powbp = 0.5005

Use the obw function to estimate the width of the frequency band that contains 99% of
the power of the signal, the lower and upper bounds of the band, and the power in the
band. The function also plots the spectrum estimate and annotates the occupied
bandwidth.

obw(s,Fs);
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Fowerffrequency (dB/Hz)
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[wd,lo,hi,power] = obw(s,Fs);

powtot =

powtot =

power/0.99

0.5003

A nonlinear power amplifier is given a 60 Hz sinusoid as input and outputs a noisy signal
with third-order distortion. The sample rate is 3.6 kHz. Subtract the zero-frequency (DC)
component to concentrate on the spectral content.

load(fullfile(matlabroot, 'examples', 'signal', 'AmpOutput.mat'))
Fs = 3600;
y = y-mean(y);
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20-108

Because the amplifier introduces third-order distortion, the output signal is expected to
have

* A fundamental component with the same frequency as the input, 60 Hz;

» Two harmonics -- frequency components at twice and three times the frequency of the
input, 120 and 180 Hz.

Use bandpower to determine the power stored in the fundamental and the harmonics.
Express each value as a percentage of the total power and in decibels. Display the values
as a table.

pwrTot = bandpower(y,Fs,[0 Fs/21);

Harmonic = {'Fundamental';'First';'Second'};

Freqs = [60 120 180]1';
Power = zeros([3 11);
for k = 1:3

Power (k) = bandpower(y,Fs,Freqs(k)+[-10 10]);
end

Percent = Power/pwrTot*100;
inDB = pow2db(Power);

T = table(Freqgs,Power,Percent,inDB, 'RowNames', Harmonic)

T=3x4 table
Freqs Power Percent inDB
Fundamental 60 1.0079 12.563 0.034136
First 120 0.14483 1.8053 -8.3914
Second 180 0.090023 1.1221 -10.456
See Also

bandpower | pow2db | pwelch | snr



See Also

Related Examples
. “Practical Introduction to Frequency-Domain Analysis”

20-109



20 common Applications

Compare the Frequency Content of Two Signals

20-110

Spectral coherence helps identify similarity between signals in the frequency domain.
Large values indicate frequency components common to the signals.

Load two sound signals into the workspace. They are sampled at 1 kHz. Compute their
power spectra using periodogram and plot them next to each other.

load relatedsig
Fs = FsSig;

[P1,f1]
[P2,f2]

periodogram(sigl,[],[],Fs, 'power"');
periodogram(sig2,[],[],Fs, 'power"');

subplot(2,1,1)
plot(fl,P1,'k")

grid

ylabel('P 1")
title('Power Spectrum')

subplot(2,1,2)
plot(f2,P2,'r")

grid

ylabel('P 2")
xlabel('Frequency (Hz)"')



Compare the Frequency Content of Two Signals
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Each signal has three frequency components with significant energy. Two of those
components appear to be shared. Find the corresponding frequencies using findpeaks.

[pkl,1cl] = findpeaks(P1, 'SortStr', 'descend', 'NPeaks',3);
PlpeakFreqs = fl(1lcl)

PlpeakFreqs = 3x1
165.0391

35.1563
94.7266
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[pk2,1c2] = findpeaks (P2, 'SortStr', 'descend', 'NPeaks',3);
P2peakFregs = f2(1c2)

P2peakFreqs = 3x1

165.0391
35.1563
134.7656

The common components are located around 165 and 35 Hz. You can use mscohere to
find the matching frequencies directly. Plot the coherence estimate. Find the peaks above
a threshold of 0.75.

[Cxy,f] = mscohere(sigl,sig2,[],[],[],Fs);

thresh = 0.75;
[pks,locs] = findpeaks(Cxy, 'MinPeakHeight',thresh);
MatchingFreqs = f(locs)

MatchingFreqs = 2x1

35.1563
164.0625

figure

plot(f,Cxy)

ax = gca;

grid

xlabel('Frequency (Hz)"')
title('Coherence Estimate')
ax.XTick = MatchingFreqs;
ax.YTick = thresh;

axis ([0 200 0 1])
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Coherence Estimate
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You get the same values as before. You can find the frequency content common to two
signals without studying the two signals separately.

See Also

findpeaks | mscohere | periodogram

Related Examples

. “Practical Introduction to Frequency-Domain Analysis”
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Detect Periodicity in a Signal with Missing Samples

20-114

Consider the weight of a person as recorded (in pounds) during the leap year 2012. The
person did not record their weight every day. You would like to study the periodicity of the
signal, even though some data points are missing.

Load the data and convert the measurements to kilograms. Missed readings are set to
NaN. Determine how many points are missing.

load(fullfile(matlabroot, 'examples', 'signal', 'weight2012.dat"'))
wgt = weight2012(:,2)/2.20462;

fprintf('Missing %d samples of %d\n',sum(isnan(wgt)),length(wgt))
Missing 27 samples of 366

Determine if the signal is periodic by analyzing it in the frequency domain. The Lomb-
Scargle algorithm is designed to handle data with missing samples or data that have been
sampled irregularly.

Find the cycle durations, measuring time in weeks.
[p,f] = plomb(wgt,7, 'normalized"');

plot(f,p)
xlabel('Frequency (week™{-13})")



Detect Periodicity in a Signal with Missing Samples
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Notice how the person's weight oscillates weekly. Is there a noticeable pattern from week
to week? Eliminate the last two days of the year to get 52 weeks. Reorder the
measurements according to the day of the week.

wgd = reshape(wgt(1l:7*52),[7 52])';
plot(wgd)

xlabel( 'Week")

ylabel('Weight (kg)"')

g = legend(datestr(datenum(2012,1,1:7),'dddd"));
g.Location = 'NorthWest';
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Weight (kg)
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Smooth out the fluctuations using a filter that fits low-order polynomials to subsets of the
data. Specifically, set it to fit cubic polynomials to sets of seven days.

wgs = sgolayfilt(wgd,3,7);
plot(wgs)

xlabel( 'Week")
ylabel('Smoothed weight (kg)")

g = legend(datestr(datenum(2012,1,1:7),'dddd"));
g.Location = 'SouthEast';
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This person tends to eat more, and thus weigh more, during the weekend. Verify by

computing the daily means. Exclude the missing values from the calculation.

for jk = 1:7

wgm = find(~isnan(wgd(:,jk)));

fprintf('%3s mean: %5.1f kg\n',

datestr(datenum(2012,1,jk), 'ddd"')"',mean(wgd(wgm,jk)))

end

Sun
Mon
Tue
Wed
Thu

mean:
mean:
mean:
mean:
mean:

76.3 kg
75.7 kg
75.2 kg
74.9 kg
75.1 kg
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Fri mean: 75.3 kg
Sat mean: 75.8 kg

See Also
datestr | plomb | sgolayfilt

Related Examples
. “Signal Smoothing”



Technical Conventions

This manual and all Signal Processing Toolbox functions use the following technical

notations.

Term or Symbol Description

Nyquist frequency One-half the sampling frequency. Some toolbox
functions normalize this value to 1.

Xx(1) The first element of a data sequence or filter,
corresponding to zero lag.

Qorw Analog frequency in radians per second.

W or w Digital frequency in radians per sample.

f Digital frequency in hertz.

[x, y) The interval from x to y, including x but not including y.
Ellipses in the argument list for a given syntax on a
function reference page indicate all possible argument
lists for that function appearing prior to the given
syntax are valid.







